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Inventory Adapters and Connectors

FlexNet Manager Suite 2022 R1 (On-Premises)

FlexNet Manager Suite relies on software and hardware inventory collected from the computers in your computing estate
to calculate what licenses are required. While the system includes a full inventory-gathering capacity, it also allows you to
import inventory collected by other tools you may already have.

As well, the system uses a considerable amount of business-related data, including organizational structure, and records
of purchases, to correctly track your existing license entitlements. This business data can also be imported from other
sources in your enterprise. However, business-related data is not the subject of this document: instead, see Using FlexNet
Business Adapters, which covers both the creation of business adapters and import of data through them.

This document, therefore, focuses on the collection of software and hardware inventory.

The data collected by the 'third party' tools usually needs to be rationalized in different ways, and mapped into the data
fields within the FlexNet Manager Suite database. The interfaces that allow this mapping are called adapters, structured
as XML files. Several adapters are provided by default with the system, or are available for download from the Flexera
Product and License Center. You can also build custom adapters for inventory using the Inventory Adapter Studio,
supplied with the product.

Some other inventory systems allow a rather simpler interface, where the preparation of XML-based adapters is not
necessary. Instead, it is enough to declare a connection to these systems, most often from an inventory beacon. Some
such systems are databases for third-party tools, where a direct connection may be possible, given a suitable connection
string. The incoming data can then be mapped automatically into the operations databases for FlexNet Manager Suite,
most often directly into the compliance database. Since the preparation of XML-based adapter files is not required in
these cases, they are referred to simply as connectors.

This document gives priority to several of the standard adapters available for FlexNet Manager Suite, because these are
the more complex cases that may require special installation, or custom XML files and the like. Over time, coverage of
connectors will also increase.

Before diving into the details of the various connectors and adapters, some useful tables compare the kinds of
information available from various data sources (see Inventory Comparison Matrix).

Following the details about available adapters and connectors, the Inventory Adapter Studio is documented. This is for
advanced and experienced developers who wish to create custom adapters (see The Inventory Adapter Studio).

Between these 'bookends', the following adapters and connectors are documented, in this (alphabetical) order:

* ADDM — now rebranded as BMC Discovery (see below)

e App-V —see App-V Server Adapter

o Atrium — see BMC Atrium and Remedy Integration

e AWS EC2 — see Amazon Connector

* BMC Discovery — see BMC Discovery Adapter and Connector
» Data Platform — see Data Platform Integration

e HP DDMI — see HP DDMI Adapter



HPE Universal Discovery — see HPE Universal Discovery Adapter
Microsoft Azure - see Microsoft Azure Connector

Office 365 — see Managing Microsoft 365 Licenses

Oracle Enterprise Manager — see Oracle Enterprise Manager Adapter*
Flexera SaaS Manager — see Flexera SaaS Manager Connector
Salesforce — see Salesforce Subscription Management

ServiceNow — see ServiceNow Integration with FlexNet Manager Suite
Tanium Connector — see Tanium Connector

VMware Horizon adapter — see VMware Horizon Adapter

XenApp server adapter — see XenApp Server Adapter.
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Inventory Comparison Matrix

FlexNet Manager Suite 2022 R1 (On-Premises)

Not all inventory sources are created equal. Some sources do better at collecting details necessary for licensing
calculations than others. The following tables let you quickly assess what data may be missing from various sources.

Strictly speaking, not all the products listed in these tables are inventory sources (particularly in the later tables).
However, they are all data sources that can provide data for FlexNet Manager Suite to use in license compliance
calculations.

D Note: For supported versions of these products, please review the FlexNet Manager Suite System Requirements and
Compatibility on docs.flexera.com for the current version of FlexNet Manager Suite.

Inventory Sources

Information Collected per Product

Computer User Product Evidence Usage Virtualization Clusters Oracle

code . . .- DB
Installer File Server Application

FlexNet inventory agent (previously Managesoft)

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Flexera Normalize (Data Platform)1

Yes Yes No No No No No No No No

BigFix platform (previously Tivoli Endpoint Manager and IBM BigFix)2
Yes Yes Yes Yes No No No No No No
BMC Discovery (previously ADDM)

Yes Yes Yes Yes Yes No Yes No Yes No

BMC Bladelogic Client Automation (previously Marimbcr)3

Yes Yes Yes Yes Yes Yes Partial No No No

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition) 17


http://docs.flexera.com/

Inventory Comparison Matrix

Information Collected per Product

Computer User Product Evidence Virtualization Clusters Oracle

code . . .. DB
Installer File Server Application

HP Discovery and Dependency Mapping Inventory (DDMI)

Yes Yes Yes Yes Yes No No No No No
HPE Universal Discovery (HP-UD)

Yes Yes Yes Yes Yes No No No No No
IBM License Metric Tool (ILMT) on Microsoft SQL Server

Yes No Yes Yes No No Yes No Yes No
IBM License Metric Tool (ILMT) on IBM DB2

Yes No Yes Yes No No Yes No Yes No

Microsoft Exchange ActiveSync4

Yes Yes No No No No No No No No

Microsoft SCCM (previously sms)°

Yes Yes Yes Yes Yes Yes No Yes No No

Symantec IT Management Suite (formerIyAltiris)6

Yes Yes Yes Yes Yes No Partial No No No
Tanium Asset
Yes Yes Yes Yes Yes No No No No No

1. Doesn't support BDNA running on Oracle DB. Flexera Normalize v5 was released April 9th, 2018 as a separate download.

2. Doesn't collect publisher information, and has potential for false recognition positives. BigFix platform inventory
source does not provide the serial number from UNIX-like platforms.

3. Virtualization: VMware, and Solaris Zones. Collects VM properties, but doesn't collect host-VM relationships.
4. Mobile devices only.
5. App-V integration provides application virtualization in Microsoft SCCM (previously SMS).

6. Virtualization: VMware, and Hyper-V. Doesn't collect pool or resource allocations.

Server Virtualization

Information Collected per Product

Computer User Product Evidence Usage Virtualization Clusters Oracle

code . . .- ] ]
Installer File Server Application

Microsoft Hyper-V*
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Information Collected per Product

Computer User Product Evidence Virtualization Clusters Oracle
code Installer Server Application pE
Yes Yes
Oracle VM Server for x86
Yes Yes
VMware vCenter*
Yes Yes
VMware ESXi Server*
Yes
VMware vSphere*
Yes

* Refer to the Inventory Sources table above for sources that provide data for these technologies.

Application Virtualization

Information Collected per Product

Computer User Product Evidence Virtualization Clusters Oracle

code . . .- DB
Installer File Server Application

App-V Server'

Partial Partial Yes No No Yes No Yes No No

App-V integrated with scem?

Yes Yes Yes No No Yes No Yes No No

EdgeSight for Citrix Virtual Apps (previously XenApp EdgeSight)3
Yes Yes Partial No Yes Yes No Yes No No

Citrix XenApp server

Yes Yes Yes No Yes Yes No Yes No No
Citrix Virtual Deskt.‘ops4
Yes
Flexera SaaS Manager
Dummy5 Yes Yes Partial®  No Yes No Yes No No

1. Requires mapping of packages to applications within FlexNet Manager Suite. Requires Active Directory integration and
FlexNet inventory agent.
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2. Provided by SCCM adapter.
3. Installer evidence is gathered when combined with Flexera's XenApp server agent.
4. Provided by a dedicated FlexNet inventory agent.

5. Flexera SaaS Manager does not track computers. Since FlexNet Manager Suite requires a computer record for various
database links, a single dummy record is created (if not already present from previous imports) during import from this
connector. Note that this connector imports completed licenses managed in Flexera SaaS Manager, including all
entitlements, for inclusion in the nightly license compliance calculations.

6. Imports from the Flexera SaaS Manager connector import installer evidence for Office 365, allowing for application
recognition in the nightly license reconciliation. This matches the behavior of earlier connectors for Office 365.

Other System Integrations

Information Collected per Product

Computer User Product Evidence Usage Virtualization Clusters Oracle
code Installer File Server Application b8
Oracle Database*
Yes
Oracle E-Business Suite*
Yes

Oracle Enterprise Manager1

Salesforce

Yes
Office 365

Yes
SAP BASIS*

Yes

* Provided by a dedicated FlexNet inventory agent.

1. Provides Oracle database connection details for use with a dedicated FlexNet inventory agent.

ITSM System Integrations

Information Collected per Product

Computer User Product Evidence Usage Virtualization Clusters Oracle

d DB
€06€ Installer File Server Application

ServiceNow*
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Information Collected per Product

Computer User Product Evidence Usage Virtualization Clusters Oracle

code . . .. DB
Installer File Server Application

BMC Atrium CMDB and Remedy?

1. Export computers and installed applications to ServiceNow. Import contracts and assets from ServiceNow into FlexNet
Manager Suite.

2. Export computers and installed applications to Atrium. Import asset details from Remedy and Atrium into FlexNet
Manager Suite.
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BMC Discovery Adapter and
Connector

FlexNet Manager Suite 2022 R1 (On-Premises)

BMC Discovery is a tool for collecting hardware and software information, and can be a useful inventory source as input to
FlexNet Manager Suite to help in calculating license consumption as part of assessing your overall license compliance.

FlexNet Manager Suite supports two different methods of collecting data from BMC Discovery. Using the distinction made
throughout this reference (see Inventory Adapters and Connectors), these are:

* An XML-based adapter that first extracts data into an SQL staging database for mapping into the data fields within the

FlexNet Manager Suite database

o Adirect connector to BMC Discovery that allows automatic upload of the data directly to the FlexNet Manager Suite

database.

Both the adapter and the connector are documented in the following chapters. Please ensure that you keep the
distinction clear and that you read the topics that relate to your chosen technology.

Supported versions

BMC Discovery was previously known as Atrium Discovery and Dependency Mapping (ADDM), and was renamed from
version 11.

o Adapter: The BMC Discovery adapter supports inventory import from the following releases of the BMC tool: 9.0,
10.0-10.2 (ADDM), 11.0-21.05 (12.2)

» Connector: The BMC Discovery connector supports inventory import from the following releases of the BMC tool: 20.02
(12.0),20.08 (12.1), 21.05 (12.2).
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Choosing a Configuration

FlexNet Manager Suite 2022 R1 (On-Premises)

With two ways (an adapter, and a connector) to collect data from BMC Discovery, you need to decide which of these to
implement in your environment:

o The connector is relatively straight-forward. For details about the connector, skip ahead to How the Connector Works,
and Prerequisites.

» The adapter to extract data from BMC Discovery can operate at different levels of detail, and with different overheads,
that depend on what level of licensing information you need to collect. The following section gives a brief overview of
how the adapter works, and explains the different configurations and how to choose between them. You need to
choose the configuration appropriate for your enterprise before implementing the adapter.

How the Adapter Works

FlexNet Manager Suite 2022 R1 (On-Premises)

Although it is downloaded as a single zipped archive, the adapter includes several components to improve your license
reporting. The overview of the finished system shows:

¢ Anoptional set of patterns that can be deployed to each BMC Discovery instance to improve the initial level of
inventory detail collected by BMC Discovery.
-
= Tip: The optional patterns are available for use with BMC Discovery, whether you use the connector or the
adapter.

» Forthe adapter only, a staging server, which includes a simple SQL database where data collected from BMC
Discovery can be massaged for upload to FlexNet Manager Suite. The executable that speeds the data extraction
process also resides here. For on-premises solutions, this staging database may optionally reside on the central
operations databases server.

¢ The conversion and upload component, which converts data formats and uploads the result to the central
operations databases maintained by FlexNet Manager Suite.

Operation is summarized in this high-level diagram:
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Figure 1: Process overview
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The diagram shows:

1. Optionally making use of additional patterns packaged with the adapter download, inventory details are collected
by BMC Discovery (previously ADDM).

2. The executable FnmpADDMStage . exe uses the web API to extract the information from BMC Discovery. This
method is used because the export process is 100 times faster than using mappings, and there is no requirement
to configure custom mappings for each BMC Discovery instance. This executable optionally writes the gathered
data into local XML files (available for inspection when required), and (determined by the mode of operation) also
writes the data from these XML files into the staging database.

3. Astandard component of FlexNet Manager Suite called a Compliance Reader, executing from the central
application server, collects data from the staging database and imports it into the operations databases. This final
stage occurs when you run an inventory import to process the incoming inventory.

Adapter components explained

The following topics describe each of the adapter components in more detail, with information to help you decide
which of these you will implement in your enterprise. Installation and setup follows in a separate section. The adapter
components described in later topics are:

» Optional collection patterns to enrich the inventory detail collected by BMC Discovery (see Optional Patterns in the
section about configuring BMC Discovery - and this configuration is common, whether you are using the adapter or
the connector)

o The FlexNet inventory agent (see The FlexNet inventory agent, which is required for either the adapter or the

connector)

» For the adapter only, the scripts for creating the staging database in Microsoft SQL Server (see Database Table

Creation)

« The FnmpADDMStage . exe executable to extract inventory information from BMC Discovery, optionally write it to

XML files, and insert it into the staging database (see The Adapter Executable).

Database Table Creation
FlexNet Manager Suite 2022 R1 (On-Premises)

The staging server requires an operating version of Microsoft SQL Server 2012 or later. Any edition is suitable,
including Microsoft SQL Server Express (if its limitations on CPU, RAM, and database size are adequate for your
purposes). As described in Choosing a Staging Server, the staging database may be located on a separate staging
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server, or on your central (on-premises) operations databases on your FlexNet Manager Suite server.

In the SQL\ subdirectory of your unzipped adapter archive, the script ADDM_staging.sql is provided for creating the
staging database, its tables, and its stored procedure. Obviously, this must be run on the SQL Server instance that is to
host the staging database.

|_¢ Important: If you have been using an earlier version of ADDM, and are now migrating to BMC Discovery release 11
(or later), you must run the same ADDM_staging. sql script to update your staging database schema. If you are
continuing to use ADDM release 10 (or earlier), the update to the staging database schema is not required, and you
may omit it for now; but if you choose to apply the upgrade now (so that the staging database is prepared for any
future migration to BMC Discovery 11 or later), you must also use the latest version of the FnmpADDMStage . exe
executable from the same Adapter Tools for FlexNet Manager Suite 2022 R1.z1ip archive. This executable
transfers BMC Discovery data (for any BMC Discovery/ADDM version) to the staging database, and is schema-aware
for the upgraded staging database.

The Adapter Executable

FlexNet Manager Suite 2022 R1 (On-Premises)

For use with the adapter, BMC Discovery supports two ways of extracting inventory data it has collected:
« Using export mapping sets

e Using aweb API.

While the former is more commonly used, the BMC Discovery adapter for FlexNet Manager Suite uses the latter, for the
following reasons:

» Itavoids the need to deploy and maintain export mapping sets on every BMC Discovery instance in your enterprise.

o Performance of data collection can be 100 times faster using the web API. For example, data extraction that can
take over 24 hours using mapping sets can be completed in 20 minutes with the web API. This is because the export
feature in BMC Discovery is designed for more complex export capabilities and can therefore be slow to perform
simple queries. FlexNet Manager Suite requires only simple queries to be executed on BMC Discovery, and these are
performed far more efficiently using the web API.

The adapter's tool to query the web API consists of two parts:

e FnmpADDMStage.exe — A.NET 4.5 console program capable of querying the XML API of BMC Discovery and writing
the results into an SQL Server database, and optionally to XML files on the local file system. This program supports
command line arguments, available using FnmpADDMStage -h

e FnmpADDMSettings.xml — The self-documenting configuration file for FnmpADDMStage . exe which contains the
queries executed against BMC Discovery (in the BMC Discovery query language), and can include connection
settings for BMC Discovery and SQL Server.

In operation, the executable, FnmpADDMStage . exe, extracts the inventory data from BMC Discovery and saves it for
further processing. There are different ways that it can save the data, based on the following values of its method

parameter:

o Stage — Summary: BMC Discovery to XML. Inventory gathered from BMC Discovery is saved to a series of XML files
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on the staging server. It is not imported into the staging database. The XML files allow for review of the gathered
data, but the inventory is not imported into FlexNet Manager Suite from these files.

.I..'-'..
' Tip: The XML file option also allows for disconnected scenarios, where inventory collected from an BMC Discovery

server that is out of reach of the staging server can be written to XML, manually copied and transferred to
another staging server, and the upload process resumed. See also the Prestaged method below.

o Staged — Summary: BMC Discovery to XML/SQL. Inventory gathered from BMC Discovery is first written to the
XML files on disk (for example for review), and then copied into the staging database where it can be imported into
FlexNet Manager Suite for use in compliance calculations.

e Prestaged — Summary: XML to SQL. In this mode, inventory is not gathered from BMC Discovery. Instead, the
XML files present on the disk from a previous inventory collection (and perhaps reviewed and approved by a
human agent in this format) are now copied into the staging database where it can be imported into FlexNet
Manager Suite for use in compliance calculations.

e Stream— Summary: BMC Discovery to SQL. Inventory is gathered from BMC Discovery, and loaded into the
staging database where it can be imported into FlexNet Manager Suite for use in compliance calculations. In this
method, inventory is not recorded in XML files on the staging server.

Default values for the method and all other parameters are set in the companion FnmpADDMSettings.xml file, and

these are the values used when the executable is triggered (or run) without other command-line options. The settings
file is self-documented, and the matching command-line options are available using FnmpADDMStage -h option.

When the executable writes XML files to (or reads them from) the local disk on the staging server, the files include the
following (details are available in FnmpADDMSettings.xml):

Filename Content

Cluster.xml Details for each cluster.

ClusterHost.xml Computers (host nodes) that are members of a cluster, including a key to
the Cluster node to identify that cluster.

CPUInformationDetail.xml Details of computer processors.

DiscoveredPackages.xml Raw installer evidence gathered by BMC Discovery from the installer
technologies supported by each operating system.

DiscoveredService.xml A report of particular services, used to help identify capabilities of hosts.
This includes the VMMS service used to identify Windows machines with
the Hyper-V role enabled.

DiscoveredVirtualMachine.xml Raw results from BMC Discovery querying the list of virtual machines on
avirtualization host.

FileEvidenceDetail.xml File evidence produced by the
Flexera.FNMP.InventoryRawData.FileEvidence pattern, covering
software tag files and Windows executables.

FileSystem.xml Name and size of all local file systems, used to approximate the total
disks and storage of host.
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Filename Content

HardwareEvidenceDetail.xml Hardware details produced by the
Flexera.FNMP.InventoryRawData.UnixHardwareEvidence

pattern, using information gathered by the FlexNet inventory agent.

Host.xml Details of all hosts known by BMC Discovery including their host name,
operating system details, unique identification, processor, memory, and
other hardware details.

HostInfo.xml Raw host details not represented in a Host node, mainly the raw LPAR
information from an IBM AIX LPAR environment.

HostContainerProcessorInfo.xml Processor details for systems that are a container for hosts. For example,
a container is a device partitioned into a number of logical hosts.

InstallerEvidenceDetail.xml Installation evidence gathered using the patterns in the BMC Discovery
adaptor, including evidence from installations by Install Anywhere and
InstallShield Multi-platform.

LastLoggedOnUserDetail.xml Details of the last logged-on user for Windows systems. (There is no
equivalent data available for UNIX-like systems.)

NetworkInterface.xml The IP and MAC addresses of each network interface, used to build a list
of these addresses for each host.

D Note: ADDM 9.0 introduced the IPAddress nodes which cover both
IPv4 and IPv6. Prior to that, the IPv4 IP address was in the
NetworkInterface node. This query checks both of these sources.

SoftwareInstance.xml Software installations identified by BMC Discovery's pattern language.
BMC Discovery queries various properties such as processes and files of a
host to determine which software is installed and its version.

SoftwareInstanceVirtual These SoftwareInstance nodes are used to represent virtual
Machine.xml machines on a host. These records are typically only created when the
virtual machine is running.

Conditions for Use

FlexNet Manager Suite 2022 R1 (On-Premises)

Use of the adapter's executable, FnmpADDMStage . exe, imposes the following conditions:

« Within BMC Discovery, the XML-based APl must be enabled (by default, it is enabled). BMC documentation for the
XML API is available at https://docs.bmc.com/docs/display/DISCO111/XML+API.

o There must be HTTP or HTTPS communication available between the staging server, on which this executable
runs, and the server hosting BMC Discovery.

» The staging server requires the .NET 4.5 (minimum) runtime environment.
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« The staging tool must be configured with credentials that provide read access to the BMC Discovery instance.
These credentials may either be configured in FnmpADDMSettings.xml or supplied on the command line for
FnmpADDMStage . exe (for details see Account Configuration for Adapter). For Discovery 11.1 and later, you need
to grant the API access permission (api-access group), or update group permissions to include the api/access
permission for the user that is specified in the FnmpADDMSettings.xml, who requires access to the XML Web

APIs.

» For linking upstream to the staging database, you can either:

o Use a trusted connection to the SQL server and run the executable under an account that has read/write access

to the staging database; or

o Use service account credentials for SQL through a connection string, which may either be configured in
FnmpADDMSettings.xml or supplied on the command line for FNMPAddmStage . exe (see Creating the
Staging Database Tables for details).

I} Important: It is critical that the FnmpADDMStage . exe tool is not run simultaneously with the
ComplianceReader tool that uploads from the staging database to the compliance server. The adapter
executable commences its writing activity with a truncate of the staging database to clear old results, an action
which (if it occurred in the middle of an upload to the compliance server) could clearly corrupt the imported
dataset. While ComplianceReader is blocked until FnmpADDMStage . exe finishes, you must adjust your
schedules to prevent starting FnmpADDMStage . exe while the ComplianceReader is running.

How the Connector Works, and
Prerequisites

FlexNet Manager Suite 2022 R1 (On-Premises)
There are two sides to configuring the connector and its interaction with BMC Discovery:
* An optional set of patterns that can be deployed to each BMC Discovery instance to improve the initial level of

inventory detail collected by BMC Discovery.

.
= Tip: The optional patterns are available for use with BMC Discovery, whether you use the connector or the
adapter.

o The connector itself, which is configured on an appropriate inventory beacon. A suitable inventory beacon meets the

following requirements:

o It has network access to your BMC Discovery instance

o It connects to the application server for FlexNet Manager Suite (optionally, through a hierarchy of inventory

beacons)
o FlexNet Beacon is release 17.2.0 (available with FlexNet Manager Suite 2021 R1.2) or later
o PowerShell 5.1 or later is installed

o Aweb browser that can access the central application server for FlexNet Manager Suite is installed
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o You have the ability to log into the inventory beacon, and run FlexNet Beacon, using an account with
administrator privileges.

Operation is straight-forward, and is summarized in this high-level diagram:

Figure 2: Process overview

Target device EMC Discovery Inventory Beacon Flexflet Manager Suite
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The diagram shows:

1. Optionally making use of additional patterns packaged with the connector, inventory details are collected by BMC
Discovery.

2. Configured on an appropriate inventory beacon (one with network access to BMC Discovery), the connector
accesses the REST APIs provided by BMC Discovery to extract the required data. You determine the timing of this
connection by setting an appropriate schedule as part of the connector configuration.

3. Once the required information is collected, the connector uploads it to the central application server, where it is
imported into the inventory database. In the final stage, the regular (default nightly) full inventory import
transfers the information to the compliance database, where it is used for license consumption calculations to
help determine license compliance.

The FlexNet inventory agent

FlexNet Manager Suite 2022 R1 (On-Premises)

By default, the BMC Discovery agent does not support inventory collection from UNIX-like inventory devices; but the
optional pattern UnixHardwareData extends its capacity to use the FlexNet inventory agent on those platforms to
collect the appropriate data. Since this is a functional extension of BMC Discovery, this optional pattern, and
corresponding use of the FlexNet inventory agent on UNIX-like platforms, applies to whichever of the methods you
have chosen for collecting information from BMC Discovery (the adapter or the connector). Installation to suit BMC
Discovery is described in Installing the FlexNet inventory agent.

The FlexNet inventory agent is a standard component of any installation of FlexNet Beacon, and of the application
server that is included with FlexNet Manager Suite. For this reason, if you are downloading the adapter, you do not find
the necessary files included in the BMC Discovery adapter zip archive, since they are already present in any standard
implementation of FlexNet Manager Suite. Similarly, if you need the FlexNet inventory agent for UNIX-like platforms
when you are configuring the connector, you can find the relevant files already available on the inventory beacon.
.
' Tip: If you are gathering FlexNet inventory in parallel with your use of BMC Discovery, it's possible that the FlexNet
inventory agent may already be installed on target inventory devices. Check before undertaking your own
deployment.

For use on Linux or UNIX platforms, the agent has two component files:
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« ndtrack.sh, the component responsible for collecting inventory details (in this case, for the BMC Discovery
inventory system) and writing them in an intermediate format to a data file, ready for upload to an application
server. The script has no active elements until it is triggered by BMC Discovery through the enhanced

UnixHardwareData collection pattern.
e ndtrack.ini, a text file that contains configuration variables for ndtrack. sh.

The combined disk space requirement of both files is under 13MB.

R’ Important: Iinventory fails to upload from FlexNet inventory agent if the account running ndtrack. sh has a hash
(#) character in the user name. The hash (#) character is not permitted, and causes failure of the upload of the

generated . nd1 files to the application server.
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Configuring BMC Discovery

FlexNet Manager Suite 2022 R1 (On-Premises)

There are three customizations needed for BMC Discovery, the first two of which apply whether you choose to use the
adapter or the connector:

« Installing any of the optional patterns needed for BMC Discovery in your environment (see Optional Patterns to assess
your needs, and then Installing Optional Patterns and Enabling Optional Patterns)

» Ensuring that BMC Discovery applies these patterns to the appropriate target computers (see Rediscovering Affected

Computers)

« Onlyif you are using the adapter, ensuring that the account running the adapter has access to BMC Discovery (see

Account Configuration for Adapter).

Optional Patterns

FlexNet Manager Suite 2022 R1 (On-Premises)

The optional patterns described here (and in the two sub-topics) apply in both cases, whether you are using the
adapter or the connector to collect information from BMC Discovery.

BMC Discovery allows its data collection to be shaped by a set of optional patterns for choosing what data to collect.
FlexNet Manager Suite provides five collection patterns in all. This overview may help you choose which patterns you
wish to import into BMC Discovery for use in your environment.

1. FileEvidence allows collection of file evidence for use within FlexNet Manager Suite. This evidence may be of

two sub-types:

» Executable files that form part of the application, which are gathered only for Window platforms, and may
allow application recognition (particularly to the level of editions and versions)

« Identification files including 1SO tag files, which may be gathered across any platform (including Windows and

UNIX-based environments).

The next two collection patterns run both on Windows and on non-Windows devices, instructing the BMC
Discovery inventory agent to gather additional data:

2. InstallAnywhereEvidence returns the list of package titles found in the repository maintained by Flexera’s
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InstallAnywhere.

. InstallShieldMultiplatformEvidence returns the list of packages installed by InstallShield Multiplatform,
an earlier installation technology developed by Flexera.
The next collection pattern is for non-Windows devices only, and uses the FlexNet inventory agent to capture
additional data elements and integrate these with the BMC Discovery inventory collected in the standard way:

. UnixHardwareData gets accurate hardware details to allow license metrics for capacity-based license
calculations (such as for Processor, Core, IBM PVU, and other license types).

=3

I=| Note: This pattern relies on the installation on UNIX-like devices of two files, ndtrack. sh and ndtrack. int,
that are available with any installation of the FlexNet Beacon or application server. Configuring this pattern
requires that you identify the installation path for these files on the target UNIX-like devices (or accessible file

share) - for more information, see The FlexNet inventory agent, and most especially Installing the FlexNet
inventory agent.

The last collection pattern contains instructions for the BMC Discovery inventory agent to pull additional data
from the Windows Registry and WMI on Windows-based computers:

5. WindowsLastLoggedOnUser recovers information about end-users that is required for user-based licensing
(such as Named User license types).

=4

I==| Note: There is no equivalent data available for UNIX-like systems.

To help you assess which of the patterns you wish to use, the following table summarizes the available collection
patterns. The default state, whether the pattern is enabled or disabled, is shown in the Pattern column. The Footprint
column details the additional installation impact (other than loading the pattern into BMC Discovery) required for the
collection pattern (the downside of using the pattern), and the Impact column shows what will not work if you omit
this pattern (the downside of not using it).
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Pattern Footprint Impact of omitting pattern
FileEvidence No installation required. An application that
Default: Fu'nctlonallty is This pattern is configurable for Is not already correctly recognized by BMC
controlled in two parts: paths searched (per platform), . L
. . Discovery (perhaps because it is installed but
L . and for file name extensions .
» Gathering identity (or tag) not currently running), and

used for tag files. Search times
on target machines willdepend  + Relies exclusively on file evidence (as distinct
on configuration and the from installer evidence) for recognition

« Gathering executable numbers of installed within FlexNet Manager Suite
applications found.

files (all platforms) is enabled
by default

evidence (Windows only) is

disabled by default. will not be recognized for inventory collected

through BMC Discovery without this pattern.
While the Application Recognition Library
rarely makes use of file evidence for Windows-
based applications, some publishers including
IBM and Oracle make use of special identity
files. Software identity (SWID) tags are also in
increasing use, and these are identified using
this pattern.

Likely impact of omitting this pattern in total is
medium (through the loss of identity files).
Likely impact of leaving executable-gathering
turned off is low.

Ij Note: Within FlexNet Manager Suite, file
evidence is also required for application
usage tracking; but no application usage
tracking is possible through the BMC
Discovery inventory tool.

InstallAnywhere Evidence Noinstallation required. By default, BMC Discovery does not recognize

Default: Enabled installation evidence from InstallAnywhere.
Unless it recognizes the application by other
means, the application will be missed without
this pattern.

InstallShield No installation required. By default, BMC Discovery does not recognize
MultiplatformEvidence installation evidence from InstallShield
Default: Enabled Multiplatform. Unless it recognizes the

application by other means, the application will
be missed without this pattern.
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Pattern Footprint Impact of omitting pattern

UnixHardwareData Requires less than 13 MB Without this, BMC Discovery does not capture

Default: Enabled installation (ndtrack.sh and sufficient hardware attributes from servers to
ndtrack.ini), either on the support license consumption calculations for
hard disk of the target license types based on hardware capacity
machines, or on a network metrics (such as Processor, Core, IBM PVU, and
share accessible to them all. other license types). Assess impact based on
Run-time is a second or so when the license types you need to support through
triggered by BMC Discovery. BMC Discovery inventory (mandatory for

capacity metrics).
WindowsLast LoggedOnUser No installation required. Without this pattern, BMC Discovery does not
Default: Enabled report any end-user identification that is

needed for licenses requiring identification of
the individual (such as Named User license
types). Note that for general user-based
licensing, in the absence of end-user identities,
FlexNet Manager Suite will calculate every
installation of such software as usage by an
unknown end-user, so that only license types
depending specifically on identity will be
affected. If you wish to allocate license
entitlements to specific individuals, you also
require this identification. Impact: medium.

The patterns are written in the BMC Discovery Pattern Language (TPL), for which documentation is available at .
For more information:

« About each of these patterns, please see Appendix A: Details of Patterns

« About installing these patterns, see Installing Optional Patterns

« About enabling or disabling each of the patterns, see Enabling Optional Patterns.

Installing Optional Patterns
FlexNet Manager Suite 2022 R1 (On-Premises)

For information about choosing which patterns to use, see Optional Patterns. For further details about each of the
patterns, and modifying their behavior, see Appendix A: Details of Patterns. All these patterns are contained in a single
template (Flexera.FNMP.InventoryRawData.tpl), which must be installed first. Thereafter, individual patterns
can be enabled, disabled, and modified.

1. Login tothe BMC Discovery interface, and select the Discovery tab.

2. Select the Knowledge Management button in ADDM version 10, or BMC Discovery version 11 or later (in earlier
versions of ADDM, select the Pattern Management button).
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Figure 3: The workspace in ADDM 10
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3. Click on Upload (orin earlier versions, Upload New Package).

Figure 4: Choose the file from your unzipped archive
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4. Click on Choose File, and:

« Ifyou are using the adapter, in your unzipped archive of the adapter, select the FlexNet Manager
Platform\Installers\BMC Atrium Discovery and Dependency Mapping Tools\patterns\
Flexera.FNMP.InventoryRawData.tpl file.

« Ifyou are using the connector, on the inventory beacon navigate to C: \ProgramData\Flexera
Software\Compliance\ImportProcedures\Inventory\Reader\BMC Discovery\patterns.zip,

unzip that archive, and select the Flexera.FNMP.InventoryRawData.tpl file.

5. Ifyou are using ADDM version 8:
a. Optionally modify (or accept) the default name of the package as Flexera.FNMP.InventoryRawData.
b. Optionally, set the description to something you will find helpful, such as FNMP export patterns.

6. Click Upload (orin earlier versions, Upload & Activate).

Ensure that the message The Requested Changes were Successful isdisplayed. The
Flexera.FNMP.InventoryRawData patternis now inthe Active state. For further fine tuning, jump ahead
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to step 4 in the following procedure.

Tip: For releases of BMC Atrium Discovery and Dependency Mapping up to and including 11.0, if you are using data
imported through the BMC Discovery adapter to manage points-based licenses for IBM and Oracle, there is an
additional optional pattern that collect further details about processors available on request from Flexera. Notice
that for BMC Discovery release 11.1 or later, the additional pattern is deprecated. BMC Discovery 11.1 (and later) has
improved processor information collection which makes this additional pattern unnecessary.

Enabling Optional Patterns
FlexNet Manager Suite 2022 R1 (On-Premises)

By default, after installation some patterns are enabled and others disabled (see Optional Patterns). The following
procedure allows you to turn individual patterns on and off as required, as well as enabling (or disabling) the entire
module.

-
[_] To enable optional patterns within BMC Discovery:
1. Inthe userinterface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that the
Flexera.FNMP.InventoryRawData item is enabled, and selectit. (The module must be enabled before any of

its member patterns can operate.)
3. From the Pattern Package properties, select the link for the Pattern Module.
4. Scroll down to the Pattern Configuration area.

Several closed groups are displayed, one for each optional pattern and another for configuration of the FlexNet
inventory agent on UNIX platforms.

5. For each group that you want to modify, select Edit Configuration to the right of the group. The group opens,
and configurable controls are displayed. Select the True radio button to turn on a pattern, and the False radio
button to turn off a pattern.

More details about configuration are included in Appendix A: Details of Patterns.
6. Click Apply.

The modified settings are displayed.

.
= Tip: If you later use the Edit Module button to modify the module, be sure to activate, validate, and then commit
your changes.

Rediscovering Affected Computers

FlexNet Manager Suite 2022 R1 (On-Premises)
This topic applies in both cases, whether you are configuring the adapter or the connector.

Where (as is common) you are adding these patterns to an operational BMC Discovery instance that has already taken
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inventory of computers in your estate, you must rediscover any computers that are to be targeted through these new
patterns, so that BMC Discovery applies to patterns to the rediscovered computers. To achieve this, you may either:

« Create (or wait for) a scheduled scan
« Initiate a Snapshot discovery scan
« Manually execute each pattern for suitably grouped targets, as summarized in the following procedure.

For more information about these options, see the BMC Discovery documentation available at
http://discovery.bmc.com/confluence/display/90/Documentation.

=
[_] To manually execute the new patterns:

1. Inthe BMC Discovery interface, select target computers (hosts or other nodes) by adding them to a group, creating
separate groups to receive distinct types of patterns (for example, one group for Windows-related patterns, and
another group for UNIX-related patterns). Create your groups using either of these approaches:

o From aview node (including host) page, select Groups from the Actions list and add the node to a group.

« From a report or other search result, select the required target computers. Then, select Groups from the
Actions list and add the target machines to a group.

2. From the Discovery tab, click Pattern Management.

3. Selectthe Flexera.FNMP.InventoryRawData pattern from the package list.

4. Click the Pattern Modules link.

5. Selectthe Pattern Module containing the pattern that you want to run.

6. Click the Pattern link in the heading table.

7. From the Actions list, select Run Pattern.

8. Inthe Run against Group list, select the group containing your target machines for the current pattern(s).
9. Setthe Expand and Execution Logging preferences forthe run.

10. SetAdditional Discovery to Get all new discovery data. This forces a new discovery.

More details about this procedure are available from http://discovery.bmc.com/confluence/display/90/
Manual+pattern+execution.

Account Configuration for Adapter

FlexNet Manager Suite 2022 R1 (On-Premises)

The user name and password that the adapter needs to access the BMC Discovery XML API are defined in
FnmpADDMSettings.xml (see Installing and Configuring the Staging Tool). Here we grant that account adequate
rights.

3
[_] To configure rights for the account calling the XML API:

1. Inthe BMC Discovery interface, select the Administration tab.
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2. In the Security section of the Administration page, click the Users icon.

3. To create a new account in the Users page, click Add at the bottom of the page.

7

' Tip: If the account has already been registered in BMC Discovery, you can select it from the list of users and

review its settings.

4. Configure the adapter account, which can be a member of the readonly group. Ensure that the user name and
password are exactly same values that you configured in FnmpADDMSettings.xml. For BMC Discovery 11.1 and

later, the permission required to access the XML API has changed. You need to grant the new APl access
permission (api-access group), or update group permissions to include the api-access permission for users who
require access to the XML Web APIs. Existing integrations will fail if you do not add the permission.

Figure 5: Sample settings for a adapter account to access BMC Discovery

Add User
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5. Save your settings.
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Now that you have:

« Configured the optional patterns for data collection (see Installing Optional Patterns)

o Ensured that all affected inventory devices are recognized in BMC Discovery (see Rediscovering Affected Computers)

« Set up the necessary account permissions (in this topic)

BMC Discovery is now configured for use of the adapter.
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Adapter Installation and
Configuration

FlexNet Manager Suite 2022 R1 (On-Premises)

The topics within this section apply only to the case where you are choosing the adapter to manage your imports from
BMC Discovery.

For on-premises implementations of the adapter, files are included in your product installation archive for the
application server. As well, the latest version of the adapter is available for download from the Flexera Customer
Community knowledge base. For cloud implementations of FlexNet Manager Suite, you need to download the adapter
archive from the Flexera Customer Community knowledge base. Although this archive also contains enhancements for
on-premises implementations of the application server, there are additional components you require in the download.

You need credentials supplied by Flexera to access this download. Details of the download are included in Download the
Adapter.

o The BMC Discovery adapter suits FlexNet Manager Suite releases 9.2.3, and 2014 and later for on-premises

implementations.

o The build number for this adapter is 12.0 (or higher). You can identify this number by right-clicking on
FNMPADDMStage. exe, selecting Properties and looking at the Details tab.

Full details of setting up the BMC Discovery adapter are included in the following sections.

Choosing a Staging Server

FlexNet Manager Suite 2022 R1 (On-Premises)

The FlexNet adapter for BMC Discovery requires a ‘staging server’ that supports installation of the adapter’s executable
and configuration file. Optionally, this server may also support the staging database, or at least has fast network access
to the database server providing the staging database. Several configurations are possible. The staging server may be
installed on:

« Adedicated stand-alone server (or virtual machine)

« Any other suitable machine in your enterprise, such as a print server
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* Aninventory beacon
o The central application server where FlexNet Manager Suite is installed (for on-premises installations).
The requirements for a suitable server include:

* AWindows-based operating system

o Access to an installation of Microsoft Microsoft SQL Server 2012 or later, in any edition, where the staging database

may be implemented (it may be on the staging server, or on a separate database server)
o The .NET 4.5 runtime environment installed
« Network access to the central application server (when not co-installed there)

« Efficient network access to each BMC Discovery server in your enterprise, using the HTTP or HTTPS protocols.

ﬂ Note: Disconnected scenarios are also possible, using the intermediate XML files saved to disk to allow manual

intervention. For more information, see The Adapter Executable.

Download the Adapter

FlexNet Manager Suite 2022 R1 (On-Premises)

The download includes the executable for the adapter, its configuration file for you to customize, a script to create the

staging database, some optimized patterns for BMC Discovery, and so on. All these resources are included in a
combined downloadable archive for all adapters.

3
[_] To download the adapter and resources:

1. Download the Adapter Tools for FlexNet Manager Suite 2022 R1.zip archive. One path is through the
Flexera Community:

-
= Tip: Your Community credentials are required for login.

a. Loginto community.flexera.com.
b. Inthe top right, in the navigation bar, expand More and select Product and License Center.

c. Under the right-hand list of products that includes FlexNet Manager Suite, click LET'S GO! (and
subsequently wait for the redirection to occur).

d. On theright side, scroll down through the list of Your Downloads and click FlexNet Manager Platform.
The Download Packages page for FlexNet Manager Platformappears.
e. Inthe Latest Versions tab, click FlexNet Manager Suite 2022 R1.

A EULA page may appear. If so, click I agree to accept the license, as this grants access to the list of
Downloads.

f. Inthe list of available Downloads, in the Files tab, in the File Name column, click Adapter Tools for
FlexNet Manager Suite 2022 R1.zip.
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A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet Manager

Suite 2022 R1.zip commences.

g. Inyour browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C: \temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it to
the appropriate working location when the download is finished.

2. Right-click the downloaded zip archive, and choose Extract All..., saving the files in your working location.

The path of interest in the unzipped archiveis Tier 1 Adapter Tools\BMC ADDM - Atrium Discovery
and Dependency Mapping Tools, which contains three folders:

« FnmpADDMStage
« patterns
e SQL.

You will access the extracted archive in the following procedures, setting up and configuring the adapter and
supporting infrastructure.

Creating the Staging Database Tables

FlexNet Manager Suite 2022 R1 (On-Premises)

Once you have selected your staging server to be used with your adapter, and that staging server can access an
operating implementation of Microsoft SQL Server running a database instance you intend to use for the staging
database, you should use the script provided to create the staging database and set up the appropriate database tables
within it. This can be done from SQL Server Management Studio, or from the command line as described in the
following procedure.

3
[_] To create staging database tables from the command line:

1. Navigate through the unzipped archive to Adapter Tools for FlexNet Manager Suite 2022 R1.zip>BMC
Atrium Discovery and Dependency Mapping Tools >SQL.

2. If necessary, copy the script ADDM_staging.sql from the \SQL folder of your unzipped adapter archive to a

temporary folder on your staging server.
3. Open acommand prompt on the staging server, and navigate to the folder containing the script.

4. Inthe command prompt window, execute the following command, as amended:
sqlcmd -S ServerName\InstanceName -i TemporaryPath\ADDM_staging.sql

where:

« ServerName is the name of the database server hosting the staging database, or its IP address, or “.” (dot) if

you are running the staging script on the same server as the database instance

» InstanceName is the name of the database instance to use for the staging tables (this parameter may be

omitted if the instance is the default instance)
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o TemporaryPath is the location where you saved the SQL procedure.
Example:

sqlcmd -S 192.100.0.20\Development -i C:\temp\ADDM_staging.sql

The database ADDM_Staging is created with all necessary tables, indices, and so on.

5. Ensure that the account under which the adapter executable will run has read/write/execute permissions on this
database instance.

7
= Tip: Configuration of the account is done through SQL Server Management Studio.

Authentication may be through Windows NT authentication or SQL Server authentication. Using Windows NT
authentication:

o The default account is the username running the FnmpADDMStage . exe adapter

» The SQL connection is specified as a standard connection string, which you may supply in
FnmpADDMSettings.xml, or override with the -c option on the command line.

The staging database is now ready for operation.

Installing and Configuring the Staging Tool
FlexNet Manager Suite 2022 R1 (On-Premises)

This procedure includes some separate sub-processes to complete the set-up of the adapter executable on your staging
server, and arrange for regular upload of staged data.

3
[_] To install and configure the staging tool:
1. Install the adapter executable along with its configuration file.
a. Create afolder (suggested: ADDMAdapter) to contain the adapter executable and its configuration file.

Location is not critical: a suggested path is under C: \Program Files\Flexera Software (this path
already exists if you have chosen to use an inventory beacon as your staging server).

b. From the FnmpADDMStage\ folder within your unzipped archive, copy both FnmpADDMStage . exe and
FnmpADDMSettings.xml to your newly created folder (such as C: \Program Files\Flexera
Software\ADDMAdapter). Both files must be in the same folder.

2. Update the configuration file (at the very minimum, correct the IP address of your BMC Discovery server).

a. Open your copy of FnmpADDMSettings.xml in a text editor of choice, and review the self-documenting
comments within that file.

b. BMC has changed the permission required to access the XML API. You need to grant the new APl access
permission (api-access group), or update group permissions to include the api-access permission for
users who require access to the XML web API.
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|_a] Important: Existing integrations will fail if you do not add the permission.

c. Update values in the first element describing the downstream connection to the BMC Discovery server,
including the IP address, the account name and password for access.

Keep a record of the account name and password for registering with BMC Discovery (see Account
Configuration for Adapter). The default values are:

<server protocol="http" address="10.200.20.138" username="exportuser"
password="Pa$$word" timeout="3600"/>

i
= Tip: If you do not wish to record the password in the plain text configuration file, you can use a script

to retrieve the password from an encrypted store, and supply it as a command-line option when
starting the FnmpADDMStage . exe tool.

d. Update the second element for the connection to the staging database.
The default values are:

<database
connection-string="Server=.;Database=ADDM_Staging;Trusted_Connection=yes;"/>

This default assumes that the database is running on this same staging server (represented with the dot
character). If not, modify to suit your situation, using either of the server name or its IP address.

e. Update the third element to configure whether, and where, the executable should save XML files of the
inventory collected from BMC Discovery.

The default value stores any XML files below the location of the executable (but turns off storage anyway):

<staging path="." method="stream"/>

You may wish to redirect the path setting for easier access for human inspection. The method parameter
may have any of the values stage, staged (these are two distinct values), prestaged, or stream (for
details, look back to The Adapter Executable).

f. Save your modified settings file.

3. Assuming that you do not wish to trigger the adapter manually every time it needs to run, start Windows Task
Scheduler, and create a basic task to run the adapter.

The command line for the scheduled task (assuming that you have saved your preferred settings, as described
above) is simply to invoke the executable. Any parameters not specified on the command line are taken from the
settings file in the same folder as the executable.

R] Important: It is critical that you schedule the adapter to run at times which cannot overlap with the inventory
beacon uploading the results to the central compliance server. Check the schedule for the compliance reader
on the compliance server, and avoid this time slot.

By default, the inventory import is triggered around 2am. Therefore you might consider scheduling this task for
some time such as 10pm daily. Remember to allow sufficient time for inventory collection from BMC Discovery,
followed by extraction from the staging database, and upload to the central application server.
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4. Select an inventory beacon with a good network connection to the server hosting your staging database, and
configure data extraction and upload.

b.

-

Log into the FlexNet Beacon interface as an administrator, and navigate to the Scheduling page.

Either identify, or create, a schedule appropriate for data uploads from the staging database to the central
application server.

For details about creating a schedule on the inventory beacon, see FlexNet Manager Suite Help >
Inventory Beacons > Scheduling Page > Creating a Data Gathering Schedule.

. Inthe navigation pane on the left, select the Inventory systems page.

Click New... (choosing the SQL Server option if you opened the drop-down) to open the Create SQL
Source Connection dialog.

Add a Connection Name that is easily recognized within the first few characters (for when it is later
displayed in narrow columns).

For Source type, choose BUC Atrium Discovery and Dependency Mapping.

Enter the Server name (or IP address) where the staging database is running. (If it is running on this
inventory beacon, use the special value (1ocalhost) including the parentheses.)

7
= Tip: If the database instance you need is not the default one on the server you identify, add the
instance name, separated with a backslash character. Example:

(localhost)\myInstance

Choose the authentication method, and if required add the Username and Password for accessing the
database.

Enter (or choose) the Database name.

Click Test Connection. For more information, see the online help for this page.

= Tip: Your batch server (or, in a single-server implementation, your application server) also requires files to help the
inventory reader process the data uploaded from the staging database. There are at least 10 XML files, and a reader
configuration file. However, you do not need to do any set-up or configuration for these files, as they are installed as

part of the standard implementation of your batch (or application) server. You can validate the existence of these files
atC:\ProgrambData\Flexera Software\Compliance\ ImportProcedures\Inventory\Reader\ on that

server.

This completes the configuration of the adapter executable itself, and of the upload from the staging database to the
central application server. Now we can turn our attention downstream, to possible installations on target UNIX-based

machines. You also need to configure enhancements to BMC Discovery itself (as discussed earlier in Configuring BMC

Discovery).

Installing the FlexNet inventory agent

FlexNet Manager Suite 2022 R1 (On-Premises)

If you have chosen to install any of the UNIX-related collection patterns to enhance the inventory collection available
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through BMC Discovery, the FlexNet inventory agent must be copied either:

* Onto each UNIX-based machine that is a target for enhanced inventory collection; or

» To a pre-configured NFS share that is accessible from each of the target UNIX-based machines.

In the following procedure, your choice of either of the above two locations is referred to as the ‘target location’.

(For background information about the FlexNet inventory agent, see The FlexNet inventory agent. For choosing
between the collection patterns, see Optional Patterns. Further information about deploying the FlexNet inventory
agent is available in the separate PDF file Gathering FlexNet Inventory.)

.

= Tip: If you are also collecting FlexNet inventory in parallel with your use of information from BMC Discovery, it is

possible that the FlexNet inventory agent may already be installed on target UNIX-based devices as part of that
process. Check before undertaking the manual deployment outlined here.

o>
[_] To install the FlexNet inventory agent for UNIX collection patterns:

1. Usingtheinstallations of either FlexNet Beacon, or application server, locate the subdirectory that contains the
ndtrack files. The default location is C: \Program Files\Flexera Software\Inventory Beacon\

RemoteExecution\Public\Inventory.

2. From this folder, copy the two files ndtrack. sh and ndtrack. ini to the target location you selected above

(that is, either to a pre-configured NFS file share, or to each target UNIX-based machine). The default location pre-
configured in the . ini file is /opt/flexera/, but you may modify this as required.

BJ Important: The file path on all individual UNIX-based machines must be identical.

3. Note the file path used (whether a file share, or the identical path used across all target devices) for entry into BMC
Discovery when you are enabling the optional collection patterns (see Optional Patterns and following topics).

Validation and Operation

FlexNet Manager Suite 2022 R1 (On-Premises)
Normal operation of the adapter relies on the following sequence of events:

1. BMC Discovery gathers inventory using the enhanced patterns you have enabled (details: Installing Optional
Patterns, and Rediscovering Affected Computers).

2. Atthetime you scheduled (Installing and Configuring the Staging Tool), the adapter reads the current content of
the BMC Discovery database and stages the new data in the staging database (previous data is first removed with a
single truncate statement). The resulting status is flagged within the database.

3. Following the schedule on the central compliance server, and provided that the staging status is Success, the
import reader uploads this content to the inventory database.

4. The next inventory import brings the final data set into the compliance database, where it is automatically taken
into account for compliance calculations. As always, the inventory records must be recognized by the Application
Recognition Library, and you must have the resulting application records linked to the appropriate license, for
compliance calculations to proceed.
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oy
[_] To validate operation of the adapter:

1. Wait until BMC Discovery collects new inventory, so that the enhanced collection patterns are exercised. For
further details, see the BMC Discovery documentation.

2. Manually trigger the adapter executable.

By specifying a different method parameter in the command line, you have a one-time override of the default
you set in the settings XML file. For example:

C:\Program Files\Flexera Software\ADDMAdapter\FnmpADDMStage.exe
-f "C:\temp" -m staged

This will write XML files under your C: \temp directory for review. As well, it writes data into the staging
database.

3. Inspect the saved XML files to validate the inventory gathered.

4. Use SQL Server Management Studio to validate that the data is written to the staging database. Also review the
StagingState property in the ADDMStagingDatabaseConfiguration table in the staging database. Possible

values are Running, Failed, or Success. This value must be Success before the BMC Discovery data can be
uploaded from the staging database to the central inventory database.

5. Wait (for example, overnight) until the next inventory import and calculations have run.

6. Use FlexNet Manager Suite to validate that new evidence has been recovered. Identify which evidence has been
recognized by the ARL and which new rules are required. Link the applications to appropriate licenses.
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FlexNet Manager Suite 2022 R1 (On-Premises)

Accounts used to connect to the REST APIs of BMC Discovery (as this connector does) do not use passwords. Instead,
they use a bearer token that allows the account to make API calls. For this reason, before setting up the connector in the
FlexNet Beacon interface, you need to correctly configure the account details in BMC Discovery, and obtain the bearer
token.

[i] To configure FlexNet Beacon to connect with BMC Discovery:
1. First, collect the bearer token:
a. Inthe BMC Discovery interface, select the Administration tab.
b. In the Security section of the Administration page, click the Users icon.

c. If you need to create a new account in the Users page, click Add at the bottom of the page. (Otherwise,
locate the appropriate account within the list of accounts.)

d. Inthe Add User page, complete the details for the account:

» For Template, the API Access is appropriate for the connector account. (This choice disables the

password-related fields.)

« For Username, create a convenient account name such as FNMSConnector.

¥
= Tip: There is no requirement for this username to match the account name used on the inventory

beacon to trigger the connector.

» For Full Name, enter a useful value - perhaps your own name as the contact person for maintaining

this account.
» When done, click OK to save your changes.

e. Inthe list of users, locate this account, and on the right-hand end of the row, expand the Actions drop-
down and select Generate API Token.

f. Intheresulting dialog displaying the bearer token, click Copy to Clipboard.

g. For safety, paste the value into a Notepad document or similar.
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2. Loginto the inventory beacon interface as an administrator (for example, in the Windows Start menu, search for
FlexNet Beacon, right-click it, and select Run as administrator).

¥
= Tip: Starting the FlexNet Beacon interface requires that you are logged in with administrator privileges.

3. Select the Inventory systems page and click the down arrow on the right of the New... split button, and
choose PowerShell.

i
= Tip: Alternatively, you can edit a connection you have defined previously, by selecting it from the list of

connections and clicking Edit....
4. Inthe dialog that appears, complete (or modify) the following required fields:

« Connection Name: The name you give this inventory connection is also used in the web interface of FlexNet
Manager Suite to name the data import task. The name may contain alphanumeric characters, underscores or
spaces, but it must start with either a letter or a number, for example BUC Discovery.

» Source Type: Select BUC Discovery from the drop-down list.

5. Optionally, if your enterprise uses a proxy server to enable communication between FlexNet Beacon and BMC
Discovery, select the Use Proxy check box, and complete the following additional details:

» Proxy Server: Enter the address of the proxy server using HTTP, HTTPS, or an IP address. Use the format
https://ProxyServerURL:PortNumber, http://ProxyServerURL:PortNumber, or
IPAddress:PortNumber). If the protocol is omitted, it defaults to http:. If the port number is omitted, it
defaults to : 80 for http, or 443 for https.

» Username and Password: If your enterprise is using an authenticated proxy, specify the credentials to access
the proxy server you just identified.

6. Inthe BMC Discovery section, complete the following fields:
a. BMC Discovery Server: Enter the IP address of your BMC Discovery instance, for example 10.20.300.40
Do notinclude the http:// orhttps:// protocol with the IP address.
b. Bearer Token: Paste in the bearer token that you retrieved from BMC Discovery instep 1.

c. Optionally, select the Import Software Key check box (for more information, see the notes below this
process).

7. Click Test Connection to make sure that your specifications are correct (adjusting as necessary for success).

When FlexNet Beacon has successfully accessed the BMC Discovery REST APIs using the details supplied, a Test
connection succeeded message displays.

8. Click OK to close this dialog, and you may also click Save.
The new connection is added to the connections list in the Inventory Systems page.

9. If you do not already have a suitable schedule for this connection available on this inventory beacon, select the
Scheduling page and click New... to open the Edit Schedule dialog and define one.

For more details see Scheduling a Connection in the online help.
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10. Back on the Inventory systems page, select the new connection in the list, click Schedule... to select your
appropriate schedule in the Select schedule dialog and then click OK to confirm your selection.

11. In the main FlexNet Beacon interface, click Save to store your newly scheduled connection.
12, Select the newly-added connection and click Execute Now.

The Execute Now confirmation dialog displays and the import of BMC Discovery inventory data commences.
13. Click OK to confirm.

The resulting import (which follows immediately) may take some time to complete. You may monitor progress in the

web interface for FlexNet Manager Suite — navigate to the system menu (#" ¥ in the top right corner) and choose
System Health > System Tasks, and periodically refresh this page. When the process is complete, you can inspect the
inventory imported from BMC Discovery in the All Inventory page on FlexNet Manager Suite.

¥
= Tip: In the All Inventory page:

1. Add the Connection name column to the page.
2. Display the simple filter bar.

3. Filter for the name you gave your BMC Discovery connection (the example given was BMC Discovery).

You may also find it useful to troubleshoot using the log file on the inventory beacon. To do so:

1. Ontheinventory beacon, navigate to ProgramData\Flexera Software\Compliance\Logging\
ComplianceReader.

2. Inyour preferred flat text editor, open the file importer-digits that was modified on today's date (or the date of
the last import), and scroll to the end of the log file. The following entries indicate success:

[INFO] @ source data warnings
[INFO] © errors, @ warnings
[INFO] Import has been completed successfully

If there are warnings or errors in the log file, try to correct the issues. If you are unable to do so, save the log file and
attach it to a support ticket for examination by a Flexera support engineer. Some typical early issues include:

* Incorrect details for the account name or bearer token for the connector accessing the BMC Discovery server
« Proxy or firewall settings preventing access to the Internet

» Import fails with hexadecimal character in the data stream

» Import fails with unable to create the intermediate zip file (is there sufficient disk space?).

After a successful data import, the hardware and software inventory data from BMC Discovery are visible in the
appropriate pages of FlexNet Manager Suite.

Using the Import Software Key option

The Import Software Key option, mentioned in step 6 in the above process, is clear (false) by default. If you select the
check box (setting the option to true), two changes occur in data gathering through the connector:

» When the connector calls the API to retrieve discovered packages from BMC Discovery, it also fetches the
PackageKey value
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« When the connector calls the API to retrieve software instances from BMC Discovery, it also fetches the

SoftwareInstanceKey value.

These two values are useful if you are using BMC Atrium configuration management database (CMDB), and you are using
IT Visibility to enrich the collected software data. In this scenario, the process works like this:

1.

2.

BMC Discovery collects hardware and software details from devices on the network.

BMC Discovery writes the results into BMC Atrium CMDB. When the check box is selected, the PackageKey and

SoftwareInstanceKey values are also imported into the CMDB.

Inventory is extracted from BMC Discovery using the connector, and is processed by IT Visibility, where the software
records are both normalized and enriched (for example, data is added about the end of service life of products).

Subsequently, inventory is again exported from IT Visibility into BMC Atrium CMDB. As software records are
processed, the PackageKey and SoftwareInstanceKey are used to match the corresponding records in the
CMDB created in step 2, updating the records with normalized and enriched data from IT Visibility.

If you are not using BMC Atrium CMDB and passing data through IT Visibility, leave the Import Software Key check box
clear (not selected).
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Known Issues

FlexNet Manager Suite 2022 R1 (On-Premises)
The following issue has been identified:

» UNIX-based devices that have the same host name and no detected serial number in BMC Discovery are merged into a
single computer record in FlexNet Manager Suite.
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Appendix A: Details of Patterns

FlexNet Manager Suite 2022 R1 (On-Premises)

While the BMC Discovery discovery tool is a state-of-the-art tool to support ITAM, the out-of-the-box collection of
inventory does not capture all of the data elements required by FlexNet Manager Suite to perform an accurate software
license calculation. The optional patterns in this appendix extend those data capture capacities.

Overview of Patterns

FlexNet Manager Suite 2022 R1 (On-Premises)

The BMC Discovery Adapter available for FlexNet Manager Suite includes six additional patterns that can be
incorporated into BMC Discovery to capture these additional data attributes.

Pattern name FlexNet inventory agent Default
dependency
FileEvidence No dependency. Tag files (all platforms):
Enabled

Executables (Windows
only): Disabled

InstallAnywhereEvidence None Enabled
InstallShieldMultiplatformEvidence None Enabled
UnixHardwareData Required Disabled
WindowsLastLoggedOnUser None Enabled

The patterns are written in the BMC Discovery Pattern Language (TPL), for which documentation is available at
http://discovery.bmc.com/confluence/display/90/The+Pattern+Language+TPL.

For a summary of the patterns to help decide which ones to enable or disable for your enterprise, see Optional

Patterns. The following sections go into more detail about each of the patterns.

Note: For releases of BMC Atrium Discovery and Dependency Mapping up to and including 11.0, the optional patterns
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listed above do not provide enough detail about processors to allow management of points-based licenses for IBM
and Oracle based on data collected through BMC Discovery. If you need this capability through BMC ADDM (up to
release 11.0), ask your Flexera consultant to request additional optional patterns for you. Notice that for BMC Atrium
Discovery and Dependency Mapping release 11.1 or later, the additional pattern is deprecated. BMC Discovery 11.1
(and later) has improved processor information collection which makes this additional pattern unnecessary.

FileEvidence

FlexNet Manager Suite 2022 R1 (On-Premises)

Some applications cannot be recognized by installer package information alone. It is sometimes necessary to examine
files that form part of the software installation, for either of two reasons:

« Some files are intended to provide identification details about an application, sometimes in human-readable
formats

» Examining executable files installed with the application may help with identification, even though this is not their

primary purpose.

Of the first class, identification files may take various forms. For example, many IBM applications are correctly
identified by specific files that IBM installs for this purpose. Oracle and Adobe are among other publishers using specific
files to identify some applications. Thus the Application Recognition Library (ARL) requires this file information to
correctly identify such applications. ISO/IEC 19770-2 SWID tags are also increasingly available, and these ID tags are
another useful form of identification file. The BMC Discovery Inventory Agent by default does not capture the complete
set of identity files.

Secondly, in addition to gathering those specific files that identify an application (and have no other function in the
application), it is sometimes necessary to identify installed executable files that are part of the application. These may
be the only way to identify an application, such as a particular edition or version of a product. A standard
implementation of BMC Discovery does not track executable files.

With this pattern, the functionality of BMC Discovery is extended to gather identification (tag) files on all platforms, and
executable file evidence on Windows platforms. Note that the pattern does not search network shares or NFS mounts;
nor does it follow symlinks (because of the risk of self-referencing loops). It also skips any files or folders that are
inaccessible. Within these constraints, it provides details of files matching the specification and found within the
defined paths on the local file system.

|_b Important: Enabling and configuring the tracking of executables within this pattern should be handled with skill
and care, for two reasons:

 Tracking Windows executables using BMC Discovery is slow. It may be unacceptably slow to use for a wide range of

directories, and you may require very targeted inventory gathering using this facility.

« Tracking executable files can produce a very large data set. Across large Windows server farms, the number of
installation records can quickly run even into the millions, which may comprise a stress test for BMC Discovery
implementations and concentrators, and (to a slightly lesser extent) for your FlexNet Manager Suite

implementation.

=2

|=| Note: In FlexNet Manager Suite, you can use file evidence to track the usage of an application (perhaps with a view
to reclaiming under-used licenses). While that functionality requires you to identify a watch-list of at least one
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executable file for each tracked application, file evidence alone is not sufficient for usage tracking: it also requires
additional FlexNet agents on the managed device, and an upload path through inventory beacons that preserves the
additional usage data. File evidence gathered through the BMC Discovery adaptor is not sufficient for usage tracking.

Results
The file evidence gathered on Windows servers is somewhat richer than on UNIX-based servers.

» On both platforms, the pattern first collects the target directories from the pattern configuration file (under
Flexera.FNMP.InventoryRawData.FileEvidenceConfigs).

¢ Inthe specified folders and their subfolders, the pattern retrieves:

o Allfiles with extensions listed under File extensions to report as tag files (assuming that Report software tag
files has its default value of true). For each matching file found, BMC Discovery creates a Detail node linked to

the host record. This happens for both Windows and UNIX-based systems.

o On Windows only, and only when the setting for Report executable files on Windows platforms has been
changed to true, files with a . exe extension from the same paths. For each executable file found, by default a WMI
query is used to retrieve the file’s name, version, and manufacturer. ADiscoveredWMI node in BMC Discovery is
created for each WMI query (essentially for each file). However, because DiscoveredWMI nodes are ephemeral
(may not survive future inventory gathering), the information is duplicated into a Detail node under the host

server for each file discovered there.

By the appropriate means, then, aDetail node is created for each file evidence record, with the following properties
dependent on the collection method:

Property Value Notes

name File path and name

type FNMP_FileEvidence

size File size

key A unique key for this file, combining the values of

name/type/host. key

version The release number of the file Available only on Windows servers when
executables are tracked.

company The publisher of the application of which this file Available only on Windows servers when
forms a part executables are tracked.
Configuration

Inthe FileEvidence pattern, you may:

o Separately enable or disable collection of:

o ldentity tag files

o Executable files (remember to consider the potential volume of data for this option)
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« Identify the file name extensions for tag files (but there is no need to identify executable file name extensions)

o Separately for Windows and UNIX-like hosts, specify the starting point(s) in the file systems for inventory scanning to

begin (searches recurse through local subdirectories).

|_¢' Important: The BMC Discovery inventory agent stops scanning at partition boundaries, even those on the local file
system. This has important implications on systems, such as IBM AlX, that typically mount key paths like /opt on
separate partitions. You must specify a search starting point within each target partition on the file system. For
example, the default values of /opt, /var, and /usr are well suited for inventory gathering with BMC Discovery.

All configuration items are covered in the following procedure.

To configure the FileEvidence pattern

FlexNet Manager Suite 2022 R1 (On-Premises)

1. Inthe userinterface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current
Flexera.FNMP.InventoryRawData item isenabled, and selectit. (The module must be enabled before any of
its member patterns can operate.)

3. From the Pattern Package properties, select the link for the Pattern Module.
4. Scroll down to the Pattern Configuration area.
5. Inthe FileEvidence group, click Edit Configuration.

6. Select the appropriate true/false radio button for Report software tag files. If you are turning off the collection
of tag files, skip the next step.

7. Adjust the list of File extensions to report as tag files, if necessary deleting values or adding new ones that you
have identified. Each extension must stand alone on its own line.

8. Select the appropriate true/false radio button for Report executable files. Review the discussion before this
procedure while considering the data quantities implied by enabling this option.

If you have now turned off both options, so that both options now have False selected, you have completed the
process, and may skip the next step. If either option has True selected, continue to define the paths for the
inventory gathering.

The configuration changes are saved.

9. For both types of operating system, customize the ...scan these file paths for evidence list.
» Each file path must stand alone on its own line, and must be absolute (starting from root).
o For Windows, the path must include the drive letter with its colon delimiter.
» These same paths are scanned for identity (tag) files and for executable files.

10. Click Apply (at the bottom of this group).

The configuration changes are saved.
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InstallAnywhereEvidence

FlexNet Manager Suite 2022 R1 (On-Premises)

InstallAnywhere is a package installation solution developed by Flexera. Packages track their installation status in an
XML file, which is interrogated by this pattern.

After collection of the inventory data, a Detail node is linked to the host computer for each package installed on the

computer:
name The name of the application as identified by InstallAnywhere.
type FNMP_InstallerEvidence
vendor The publisher of the application
version The release number of the application.
install_date The date that the application was installed on this host computer.
evidence IA (fixed string literal).
key A unique key for this installation record, combining (with the different literal text

separators shown) the values of name : version/type:evidence/host. key

To configure the InstallAnywhereEvidence pattern:
1. Inthe userinterface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current
Flexera.FNMP.InventoryRawData item is enabled, and select it. (The module must be enabled before any of

its member patterns can operate.)

ir Tip: The Instal lAnywhereEvidence pattern is enabled by default when the pattern collection is initially
enabled. If it has previously been disabled, you can re-enable it with the remainder of this procedure.
3. From the Pattern Package properties, select the link for the Pattern Module.
4. Scroll down to the Pattern Configuration area.
5. Inthe InstallAnywhereEvidence group, click Edit Configuration.

6. Select the True radio button for Report installations by InstallAnywhere.

7. Click Apply (at the bottom of this group).

InstallShieldMultiplatformEvidence

FlexNet Manager Suite 2022 R1 (On-Premises)

InstallShield Multiplatform is an older packaging solution from Flexera, in use by many software publishers.
InstallShield stores software information in “vital product data” (VPD) collections, which were originally stored in flat
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files and subsequently in SQL scripts.

This pattern locates either format of VPD storage (which may exist in a range of locations across different platforms),
extracts the data, and creates a Detail node for the software installation linked to the host computer:

name The name of the application as identified by InstallShield.
type FNMP_InstallerEvidence

vendor The publisher of the application

version The release number of the application.

install_date The date thatthe application was installed on this host computer.
evidence ISMP (fixed string literal).
product_code The product identification code recorded (usually) by the publisher for the particular application.

This is not standardized and may be used as the publisher desires.

key A unique key for this installation record, combining (with the different literal text separators shown)
the values of name : version/type:evidence/host. key
To configure the InstallShieldMultiplatformEvidence pattern:
1. Inthe userinterface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current
Flexera.FNMP.InventoryRawData item is enabled, and selectit. (The module must be enabled before any of
its member patterns can operate.)

i
W Tip: The InstallShieldMutiplatformEvidence pattern is enabled by default when the pattern

collection is initially enabled. If it has previously been disabled, you can re-enable it with the remainder of this
procedure.

3. From the Pattern Package properties, select the link for the Pattern Module.

4. Scroll down to the Pattern Configuration area.

5. In the InstallShieldMultiplatformEvidence group, click Edit Configuration.

6. Select the True radio button for Report installations by InstallShield Multiplatform.

7. Click Apply (at the bottom of this group).

UnixHardwareData

FlexNet Manager Suite 2022 R1 (On-Premises)

Especially for managing the corporate Data Centre, it is critical for FlexNet Manager Suite to have accurate hardware
inventory for capacity-based license metrics (Processor, Core, IBM PVU, and so on). While BMC Discovery can capture
this information for a Windows server, it may not consistently capture it for servers running UNIX or Linux. For example,
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BMC Discovery does not currently report:

e CPUs and cores on Linux, nor cores on virtual machines
¢ LPARs on IBM AIX (correctly)

» Solaris resource pools.

This pattern retrieves hardware data on UNIX-based systems using the FlexNet inventory agent.

Note: The pattern must be configured with the installed location of the FlexNet inventory agent. The FlexNet
inventory agent may be installed either in the same location on the file system of each target UNIX server, or on a file
share accessible to all target devices. This is included in the configuration process described below.

The pattern executes the FlexNet inventory agent, which writes the collected data to afile in the /var/tmp/flexera/
addm/ folder on the host server. BMC Discovery then reads this output, and for each installed file, creates a Detail
node linked to the host record:

Property Value

Name FNMP hardware evidence for %host.name%
Type FNMP_HardwareEvidence
Key %type%/%host.key%
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Property Value

(Additional Each records one of the following hardware properties:
properties)

o Disksize

« IPAddress

» MAC Address

* Model

e Number of cores

o Number of disks

o Number of logical processors

¢ Number of processors

« OS

¢ Processor speed

* Processor type

¢ RAM (total physical memory)

» Vendor.

If the machine is found to be a virtual machine, the following additional properties are
collected:

« Node capacity

» Node capacity in cores

» Node capacity in threads

» Physical shared pool capacity
o Physical shared pool capacity in cores
» Physical shared pool ID

o Shared pool capacity

» Shared pool capacity in cores
» Shared pool ID

» VM capacity

» VM capacity in cores

* VM entitlement

« VMID
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Property Value

e VMis capped
» VMis shared type
e VMname

¢ VMtype

To configure the UnixHardware pattern:
1. Inthe userinterface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current
Flexera.FNMP.InventoryRawData item isenabled, and selectit. (The module must be enabled before any of
its member patterns can operate.)

3. From the Pattern Package properties, select the link for the Pattern Module.
4. Scroll down to the Pattern Configuration area.

5. In the Flexera.FNMP.InventoryRawData.CommonFlexeralnventoryAgentConfigs group, click Edit
Configuration.

6. Enterthe path (path only, not including the file name) to the FlexNet inventory agent executable. (For details
about installing the FlexNet inventory agent, see Installing the FlexNet inventory agent.)

7. Click Apply (at the bottom of this group).
8. Inthe UnixHardware group, click Edit Configuration.
9. Select the True radio button for Report UNIX hardware properties.

10. Click Apply (at the bottom of this group).

WindowsLastLoggedOnUser

FlexNet Manager Suite 2022 R1 (On-Premises)

For a Windows-based computer, standard BMC Discovery collection does not capture any inventory related to the
Windows Logon. User identification is important for FlexNet Manager Suite to accurately calculate license consumption
for user-based licensed, such as a Named User license. (There is no equivalent data for UNIX-like systems available
through the BMC Discovery adapter.)

This pattern queries the registry at HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Authentication\
LogonUI\LastLoggedOnUser to find the last logged-on user (for legacy Windows platforms before Vista, it queries
WMI for the value of UserName from Win32_ComputerSystem). If the query is successful, a
DiscoveredRegistryValue node is created for the host computer:

Property Value

Name The user name.
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Property Value

Type FNMP_LastLoggedOnUser

Key %type%/%host.key%

To configure the WindowsLastLoggedOnUser pattern:
1. Inthe userinterface for BMC Discovery, select the Discovery tab.

2. Click Pattern Management, and from the list of patterns at the bottom of the page, ensure that your current
Flexera.FNMP.InventoryRawData item is enabled, and selectit. (The module must be enabled before any of
its member patterns can operate.)

I:-- Tip: The WindowsLastLoggedOnUser pattern is enabled by default when the pattern collection is initially
enabled. If it has previously been disabled, you can re-enable it with the remainder of this procedure.
3. From the Pattern Package properties, select the link for the Pattern Module.
4. Scroll down to the Pattern Configuration area.
5. Inthe WindowsLastLoggedOnUser group, click Edit Configuration.

6. Select the True radio button for Report Windows last logged-on user.

7. Click Apply (at the bottom of this group).
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Appendix B: Data Mappings

FlexNet Manager Suite 2022 R1 (On-Premises)

This appendix maps the data transformations from BMC Discovery to FlexNet Manager Suite in two stages:

From the source nodes in BMC Discovery datastore to the staging database (suggested: ADDM_Stage). The data
constructs within this database are mirrored in the XML files that may be saved on the staging server for your
inspection. For this reason, this section may also be used as a guide to understanding the sources of data within BMC
Discovery that populate the various XML entities.

From the staging database (suggested: ADDM_Stage) to the final destination within the web interface of FlexNet
Manager Suite. This is not a simple and direct path: the ComplianceReader component first loads the data from the
staging database to various compliance database tables with names starting with Imported, where the data waits
until the next "data import" (usually associated with a full license consumption calculation, by default scheduled
overnight). In effect, the data first moves from remote staging tables to local staging tables. Thereafter the data is
normalized and loaded into a range of compliance database tables, for the most part arrayed around the
ComplianceComputer table. Since navigating these tables is not straight-forward, we here present the data in its
more visible form, within the web interface. Serious devotees of database structures can find all compliance database
tables documented in the FlexNet Manager Suite Schema Reference PDF file, available through the title page of online
help.

In both parts, each destination has its own topic, so that you can jump to destination names using the table of contents
of this PDF (in the first of these sections, the destinations are table names within the staging database; and in the
second, the destinations are "object" names presented in the web interface).

Because an individual node in BMC Discovery may link to multiple staging tables, it's not quite so easy to find the
original nodes in BMC Discovery. One way is to do a search in the PDF file for "SEARCH nodeName", since each staging

database topic begins with the Query Language statements used to extract the related data from BMC Discovery.

=3

| Note: This appendix documents the structure released with FlexNet Manager Suite version 2020 R1.2 (if necessary, you
can validate this version by checking the operating system file properties of FnmpADDMStage . exe). The database
schema is version 1.10 (or later) for these changes. If needed, you can check the staging database schema version with
the following query in Microsoft SQL Studio:

SELECT TOP (1000) [Property],[Value]
FROM [ADDM_Stage].[dbo].[ADDMStagingDatabaseConfiguration]
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(If necessary, substitute your chosen staging database name in place of the proposed ADDM_Stage.) It is important to
be aware that this schema update makes no change at all to the data from BMC Discovery imported into FlexNet
Manager Suite. Instead, the changes to the adapter and staging database schema enable integration with the
Discovery and Inventory capabilities within Flexera One, while maintaining existing imports and performance with
FlexNet Manager Suite.

Source to Staging

FlexNet Manager Suite 2022 R1 (On-Premises)

This section provides:

» The Query Language queries exercised against BMC Discovery to extract data

» Thetablesin the staging database, and within each table the individual properties (database columns), where the
data is staged.

For each table topic, the following details are included:

o The source alias (usually identical to the following)

o The property/column name in the staging table

o The data type in the staging table

« For string types, the maximum number of characters (except as noted, excess string length is truncated).

Each topic also notes the name of the XML file that may be saved on the staging server (depending on the command
line given to the staging tool).

ADDMVersion_ci (Staging Table)

FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in ADDMVersion.xml on the staging server.

BMC Discovery query

This query extracts the version information for BMC Discovery, saving the details in the table below:

LOOKUP Version

Mapping into ADDMVersion_ci

Source alias ADDMVersion_ci property Type Max
Version Version varchar 32
Release Release varchar 32
Release Name Release Name varchar 32
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Cluster_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in Cluster.xml on the staging server.

BMC Discovery query

This query extracts data from the Cluster node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH Cluster
SHOW
key AS 'ClusterKey',
type AS 'ClusterType',
(type = 'vCenter Cluster' AND
(single(#ManagedElement:Management:Manager:SoftwareInstance.instance)
+ |+ id)
OR NONE) AS 'Internalldentifier',
(cluster_name OR name) AS 'InternalName',
single(#HostContainer:HostContainment:ContainedHost:Host.domain)
AS 'Domain’',
formatTime(modified(#), "%FT%T") AS 'LastUpdate’

Mapping into Cluster_ci

Source alias Cluster_ci property Type Max
ClusterKey ClusterKey nvarchar 400
ClusterType ClusterType nvarchar 255
Domain Domain nvarchar 512

Internalldentifier Internalldentifier nvarchar 512
InternalName InternalName nvarchar 512

LastUpdate LastUpdate datetime

ClusterHost_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in ClusterHost.xml on the staging server.
BMC Discovery query

This query extracts data from the Cluster node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:
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SEARCH Cluster
WHERE (NODECOUNT
(TRAVERSE HostContainer:HostContainment:ContainedHost:Host) > )
SHOW
key AS 'ClusterKey',
EXPLODE #HostContainer:HostContainment:ContainedHost:Host.key
AS 'HostKey'

Mapping into ClusterHost_ci

Source alias ClusterHost_ci property Type Max
ClusterKey ClusterKey nvarchar 400
HostKey HostKey varchar 64

CPUinformationDetail_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in CPUInformationDetail.xml on the staging server.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for properties
referenced in the table below.

]

' Tip: This data relies on a custom CPU pattern available through your Flexera consultant. Be aware that from BMC
Discovery release 11.1, BMC provided improved data gathering with new ProcessorInfo functionality. However,
this does not gather the full dataset enabled through the custom pattern, and it remains best practice to combine

the data gathered by BMC Discovery with additional data available through the custom pattern.

SEARCH Detail
WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > 9)
AND (type = 'CPU Information')
SHOW
host_partitioning_type AS ‘'HostType',
(
(host_partitioning type = 'physical' AND total logical cpus
OR allocated_threads) OR none
) AS 'LogicalProcessors',
(
(host_partitioning_type = 'physical' AND total_cpu_cores
OR involved_cores) OR none
) AS 'Cores’,
(
(host_partitioning_type = 'physical' AND total_cpu_sockets
OR involved_sockets) OR none
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) AS 'Processors’,

(total_logical cpus OR none) AS 'PhysicallogicalProcessors’,
(total_cpu_cores OR none) AS 'PhysicalCores’,

(total_cpu_sockets OR none) AS 'PhysicalProcessors’,

zone_pool _name AS 'ZonePoolName',
lpar_id_to_partition AS 'LPARIdToPartition’,
lpar_id_to_system AS 'LPARIdToSystem',

(

(lpar_partition_number <>

) AS 'LPARPartitionNumber',
lpar_partition_name AS 'LPARPartitionName',

lpar_type AS 'LPARType',
lpar_mode AS 'LPARMode’,

(lpar_active_physical _cpus_in_system OR none)
AS 'LPARActivePhysicalCpusInSystem',
(1lpar_shared_physical_cpus_in_system OR none)
AS 'LPARSharedPhysicalCpusInSystem',

((lpar_shared_pool id <>

AS 'LPARSharedPoolID',
(lpar_active_cpus_in_pool OR none) AS 'LPARActiveCpusInPool’,
(lpar_entitled_capacity OR none) AS 'LPAREntitledCapacity’,

#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into CPUInformationDetail_ci

Source alias

CPUInformationDetail_ci property

AND lpar_partition_number) OR none

-'" AND lpar_shared _pool id) OR none)

Type
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Cores

HostKey

HostType
LogicalProcessors
LPARActiveCpusInPool

LPARActivePhysical
CpusInSystem

LPAREntitledCapacity
LPARIdToPartition
LPARIdToSystem
LPARMode
LPARPartitionName

LPARPartitionNumber
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Cores

HostKey

HostType
LogicalProcessors
LPARActiveCpusInPool

LPARActivePhysical
CpusInSystem

LPAREntitledCapacity
LPARIdToPartition
LPARIdToSystem
LPARMode
LPARPartitionName

LPARPartitionNumber

int

varchar

varchar

int

int

int

float

nvarchar

nvarchar

nvarchar

nvarchar

int

64

32

200

200

255

255
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Source alias CPUInformationDetail_ci property Type Max
LPARSharedPhysical LPARSharedPhysical int

CpusInSystem CpusInSystem

LPARSharedPoolID LPARSharedPoolID int

LPARType LPARType nvarchar 255
PhysicalCores PhysicalCores int
PhysicallLogicalProcessors PhysicallLogicalProcessors int
PhysicalProcessors PhysicalProcessors int

Processors Processors int

ZonePoolName ZonePoolName nvarchar 200

DiscoveredinstalledPackages_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in DiscoveredInstalledPackages.xml on the staging server.

BMC Discovery query

This query extracts data from the Host node in the BMC Discovery datastore to find installed packages, and provides
the aliases for properties referenced in the table below:

SEARCH Host
STEP IN Host:HostedSoftware:InstalledSoftware:Package
SHOW
#:InstalledSoftware:Package.key AS 'PackageKey',
#:Host:Host.key as 'HostKey'

Mapping into DiscoveredinstalledPackages_ci

Source alias DiscoveredPackages_ci property Type
PackageKey PackageKey nvarchar 450
HostKey HostKey varchar 64

DiscoveredPackages_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)
Data in this staging table may also be saved in DiscoveredPackages.xml on the staging server.

|'|?--'|
' Tip: The PackageKey property is ignored for FlexNet Manager Suite.
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This query extracts data from the Package node in the BMC Discovery datastore, and provides the aliases for

properties referenced in the table below:

SEARCH Package
SHOW
key AS 'PackageKey',
name AS 'Package’,
version AS 'Version',
vendor AS 'Vendor'

Mapping into DiscoveredPackages_ci

Source alias DiscoveredPackages_ci property Type Max
PackageKey PackageKey varchar 450
Package Package nvarchar 255
Vendor Vendor nvarchar 255
Version Version nvarchar 255

DiscoveredService_ci (Staging Table)

FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in DiscoveredService.xml on the staging server.

BMC Discovery query

This query extracts data from the Host node in the BMC Discovery datastore, and provides the aliases for properties

referenced in the table below:

SEARCH Host
TRAVERSE InferredElement:Inference:Associate:DiscoveryAccess

WHERE end_state = 'GoodAccess'

TRAVERSE DiscoveryAccess:DiscoveryAccessResult:DiscoveryResult:Servicelist

TRAVERSE List:List:Member:DiscoveredService

WHERE name = ‘vmms' AND display name = 'Hyper-V Virtual Machine Management

SHOW

name AS 'Name’,
#Member:List:List:ServicelList.#DiscoveryResult:DiscoveryAccessResult:

DiscoveryAccess:DiscoveryAccess.#Associate:Inference:
InferredElement:Host.key AS 'HostKey'
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Mapping into DiscoveredService_ci

Source alias DiscoveredService_ci property Type Max
HostKey HostKey varchar 64
Name Name nvarchar 255

DiscoveredVirtualMachine_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in DiscoveredVirtualMachine.xml on the staging server.

BMC Discovery query

This query extracts data from the Host node in the BMC Discovery datastore, and provides the aliases for properties
referenced in the table below:

SEARCH Host
TRAVERSE InferredElement:Inference:Associate:DiscoveryAccess
WHERE end_state = 'GoodAccess'
TRAVERSE DiscoveryAccess:DiscoveryAccessResult:DiscoveryResult:VirtualMachinelist
WHERE access_method IS DEFINED
TRAVERSE List:List:Member:DiscoveredVirtualMachine
SHOW
name AS 'Name',
uuid AS 'UUID',
config_os_full AS 'ConfigOSFull',
power_state AS 'PowerState’,
vsphere_id AS 'vSpherelD',
#Member:List:List:VirtualMachinelList.access_method AS 'AccessMethod’,
formatTime(modified(#), "%FT%T") AS 'LastUpdate',
#Member:List:List:VirtualMachinelList.#DiscoveryResult:DiscoveryAccessResult:
DiscoveryAccess:DiscoveryAccess.#Associate:
Inference:InferredElement:Host.key AS 'HostKey'

Mapping into DiscoveredVirtualMachine_ci

Source alias DiscoveredVirtualMachine_ci

property
AccessMethod AccessMethod nvarchar 255
ConfigOSFull ConfigOSFull nvarchar 512
HostKey HostKey varchar 64
LastUpdate LastUpdate datetime
Name Name nvarchar 512
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Source alias DiscoveredVirtualMachine_ci

property
PowerState PowerState nvarchar 255
uuIiD Uuib nvarchar 255
vSphereID vSphereID nvarchar 255

FileEvidenceDetail_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in FileEvidenceDetail.xml on the staging server.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for properties
referenced in the table below:

SEARCH Detail

WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > ©)
AND (type = 'FNMP_FileEvidence')

SHOW name AS 'FileName',

size AS 'FileSize',

description AS 'Description’,

company AS 'Company’,

version AS 'FileVersion',

#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into FileEvidenceDetail_ci

Source alias FileEvidenceDetail_ci property Type

Company Company nvarchar 255
Description Description nvarchar 255
FileName FileName nvarchar 800
FileSize FileSize bigint
FileVersion FileVersion nvarchar 255
HostKey HostKey varchar 64

FileSystem_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in FileSystem.xml on the staging server.
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BMC Discovery query

This query extracts data from the FileSystem node in the BMC Discovery datastore, and provides the aliases for

properties referenced in the table below:

SEARCH FileSystem
WHERE (NODECOUNT
(TRAVERSE MountedFileSystem:FileSystemMount:Mounter:Host) > 0)

AND fs_kind = 'LOCAL'

AND size IS DEFINED

AND size > @

AND fs_type <> 'tmpfs'

AND fs_type <> 'devtmpfs'

AND fs_type <> 'DevFS'

SHOW

fs_name AS ‘'Name’,

size AS 'Size’,
#MountedFileSystem:FileSystemMount:Mounter:Host.key AS 'HostKey'

Mapping into FileSystem_ci

Source alias FileSystem_ci property Type Max
HostKey HostKey varchar 64
Name Name nvarchar 255
Size Size bigint

[ ] [ ] (3 (3
HardwareEvidenceDetail_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in HardwareEvidenceDetail.xml on the staging server.

This data is generated through use of the optional UnixHardwareData pattern, which triggers the Flexera inventory
component ndtrack ("the tracker"). Before staging, the information is visible in the Detail node of BMC Discovery,

with a type of FNMP_HardwareEvidence.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for properties

referenced in the table below:

SEARCH Detail
WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > ©)
AND (type = 'FNMP_HardwareEvidence')
SHOW
os AS '0S',
num_processors AS 'Processors’,
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num_cores AS 'Cores',

num_logical_processors AS 'LogicalProcessors’,
processor_type AS 'ProcessorType’,
processor_speed AS 'ProcessorSpeed’,

ram AS 'RAM',

vendor AS 'Vendor',

model AS 'Model’,

ip_address AS 'IPAddress',

mac_address AS 'MACAddress’,

num_disks AS 'NumDisks',

disk_size AS 'DiskSize',

vm_type AS 'VMType',

node_capacity AS 'NodeCapacity’,
node_capacity_in_cores AS ‘NodeCapacityInCores’,
node_capacity_in_threads AS 'NodeCapacityInThreads’,

physical shared_pool capacity AS 'PhysicalSharedPoolCapacity"’,

physical shared_pool capacity_in_cores

AS 'PhysicalSharedPoolCapacityInCores’,
physical_shared_pool_id AS 'PhysicalSharedPoolID’,
shared_pool_capacity AS 'SharedPoolCapacity’,

shared_pool_capacity_in_cores AS 'SharedPoolCapacityInCores’,

shared_pool_id AS 'SharedPoolID’,
vm_capacity AS 'VMCapacity',
vm_capacity_in_cores AS 'VMCapacityInCores',
vm_entitlement AS 'VMEntitlement',

vm_id AS 'VvMID',

vm_is_capped AS 'VMIsCapped',
vm_is_shared_type AS 'VMIsSharedType',
vm_name AS 'VMName',

partition_id AS 'PartitionID',
partition_number AS ‘'PartitionNumber’,
#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into HardwareEvidenceDetail_ci

Appendix B: Data Mappings

Source alias HardwareEvidenceDetail_ci
property

Cores Cores

DiskSize DiskSize

HostKey HostKey

IPAddress IP

LogicalProcessors LogicalProcessors

MACAddress MAC

Model Model
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smallint

bigint
varchar
nvarchar
smallint
nvarchar

nvarchar

64

512

512

512
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Source alias

NodeCapacity
NodeCapacityInCores
NodeCapacityInThreads
NumDisks

0s

PartitionID
PartitionNumber

PhysicalShared
PoolCapacity

PhysicalSharedPool
CapacityInCores

PhysicalSharedPoolID
Processors

ProcessorSpeed
PhysicallogicalProcessors
ProcessorType

RAM

SharedPoolCapacity
SharedPoolCapacityInCores
SharedPoolID

Vendor

VMCapacity
VMCapacityInCores
VMEntitlement

VMID

VMIsCapped
VMIsSharedType

VMName

VMType

74

HardwareEvidenceDetail_ci

property

NodeCapacity
NodeCapacityInCores
NodeCapacityInThreads
NumDisks

0s

PartitionID
PartitionNumber

PhysicalShared
PoolCapacity

PhysicalSharedPool
CapacityInCores

PhysicalSharedPoolID
Processors

ProcessorSpeed
PhysicallogicalProcessors
ProcessorType

RAM

SharedPoolCapacity
SharedPoolCapacityInCores
SharedPoolID

Vendor

VMCapacity
VMCapacityInCores
VMEntitlement

VMID

VMIsCapped

VMIsSharedType

VMName

VMType
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smallint
smallint
smallint
int

nvarchar
nvarchar
int

smallint

smallint

nvarchar
smallint
int

int
nvarchar
bigint
smallint
smallint
nvarchar
nvarchar
float
float
float
nvarchar
bit

bit
nvarchar

nvarchar

256

512

255

128

255

255

255

512
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Host_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in Host . xm1 on the staging server.

BMC Discovery query

Appendix B: Data Mappings

This query extracts data from the Host node in the BMC Discovery datastore, and provides the aliases for properties

referenced in the table below.

7
' Tip: The following properties are recent additions to BMC Discovery:
e num_cores is available from BMC Discovery release 11.0

e zone_pool_name is available from BMC Discovery release 11.1.

SEARCH Host

SHOW

hostname AS ‘'Hostname',
(dns_domain OR domain) AS 'Domain',
os AS '0S',

os_type AS 'OSType',

os_class AS 'OSClass',
os_edition AS 'OSEdition’,
os_version AS 'OSVersion',
os_vendor AS 'OSVendor',
os_build AS 'OSBuild',
service_pack AS 'ServicePack',
uuid AS 'UUID',

(

num_processors

OR nodecount(traverse Host:Detail:Hardware:ProcessorInfo)

) AS 'Processors’,
(
num_cores
OR ((num_processors > © AND cores_per_processor > 0)
AND (num_processors * cores_per_processor))

OR ((num_logical_processors > © AND threads_per_core > 0)

AND (num_logical processors/threads_per_core))
OR none
) AS 'Cores’,
num_logical processors AS ‘LogicalProcessors’,
processor_type AS 'ProcessorType’,
processor_speed AS 'ProcessorSpeed’,
ram AS 'RAM‘,
vendor AS 'Vendor',
model AS 'Model’,
serial AS 'Serial’,
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hostid AS 'HostID',

partition_id AS 'PartitionID',

lpar_name AS ‘'LPARName’,
lpar_partition_number AS 'LPARNumber’,
wparid AS 'WPARID',

npar_partition_number AS 'NPARNumber',
vpar_partition_number AS 'VPARNumber',
ldom_name AS 'LDOMName’,

ldom_role AS 'LDOMRole’,

zonename AS 'Zonename',

zone_uuid AS 'ZoneUUID',

(zone_pool name OR none) AS 'ZonePoolName',
formatTime(modified(#), "%FT%T") as 'ModifiedDate’,
key AS 'HostKey

Mapping into Host_ci

Source alias Host_ci property Type Max
Cores Cores smallint
Domain Domain nvarchar 255
HostID HostID nvarchar 255
HostKey HostKey varchar 64
Hostname Hostname nvarchar 255
LDOMName LDOMName nvarchar 255
LDOMRole LDOMRole nvarchar 255

LogicalProcessors LogicalProcessors smallint

LPARName LPARName nvarchar 255
LPARNumber LPARNumber int

Model Model nvarchar 512
ModifiedDate ModifiedDate datetime
NPARNumber NPARNumber nvarchar 64
0s 0s nvarchar 1024
0SClass 0SClass nvarchar 64
OSBuild OSBuild nvarchar 255
OSEdition OSEdition nvarchar 255
OSType OSType nvarchar 255
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Source alias Host_ci property Type Max
OSVendor OSVendor nvarchar 255
OSVersion OSVersion nvarchar 255
PartitionID PartitionID nvarchar 255
Processors Processors smallint
ProcessorSpeed ProcessorSpeed int
ProcessorType ProcessorType nvarchar 128
RAM RAM bigint
Serial Serial nvarchar 255
ServicePack ServicePack nvarchar 128
uuIiD UuID nvarchar 255
Vendor Vendor nvarchar 255
VPARNumber VPARNumber nvarchar 64
WPARID WPARID int

Zonename Zonename nvarchar 255
ZonePoolName ZonePoolName nvarchar 255
ZoneUUID ZoneUUID nvarchar 255

HostContainerProcessorinfo_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

This data is available only from ADDM 11.0 and later releases.

Data in this staging table may also be saved in HostContainerProcessorInfo.xml on the staging server.

BMC Discovery query

This query extracts data from the ProcessorInfo node in the BMC Discovery datastore, and provides the aliases for
properties referenced in the table below:

SEARCH ProcessorInfo
WHERE NODECOUNT (TRAVERSE Hardware:Detail:HostContainer:HostContainer) > ©
SHOW
#Hardware:Detail:HostContainer:HostContainer.num_logical processors
AS 'LogicalProcessors',
#Hardware:Detail :HostContainer:HostContainer.num_cores AS 'Cores’,
#Hardware:Detail :HostContainer:HostContainer.num_processors
AS 'Processors’,
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EXPLODE #Hardware:Detail:HostContainer:HostContainer.#HostContainer:
HostContainment:ContainedHost:Host.#InferredElement:Inference:Associate:
DiscoveryAccess.#DiscoveryAccess:DiscoveryAccessResult:DiscoveryResult:
HostInfo.systemid AS 'SystemID',

EXPLODE #Hardware:Detail:HostContainer:HostContainer.#HostContainer:
HostContainment:ContainedHost:Host.hostid AS 'HostID',

#Hardware:Detail:HostContainer:HostContainer.#HostContainer:HostContainment:
ContainedHost:Host.vendor AS 'Vendor'

Mapping into HostContainerProcessorinfo_ci

Source alias HostContainerProcessorinfo_ci
property

Cores Cores smallint

HostID HostID nvarchar 255
LogicalProcessors LogicalProcessors smallint
Processors Processors smallint

SystemID SystemID nvarchar 255
Vendor Vendor nvarchar 255

HostDetail_ci (Staging Table)

FlexNet Manager Suite 2022 R1 (On-Premises)

This data is available only from BMC Discovery 11.1 and later releases. The latest Technology Knowledge Update must
be applied to the BMC Discovery 11.1 release.

Data in this staging table may also be saved in HostDetail.xml on the staging server.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for properties
referenced in the table below:

SEARCH Detail
WHERE type = 'LPAR Resource’
SHOW
id_to_partition as 'LPARIdToPartition',
id_to_system as 'LPARIdToSystem',
#Detail:Detail:ElementWithDetail:Host.key as 'HostKey'
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Mapping into HostDetail_ci

Source alias HostDetail_ci property Type Max
HostKey HostKey varchar 64
LPARIdToPartition LPARIdToPartition nvarchar 200

LPARIdToSystem LPARIdToSystem nvarchar 200

Hostinfo_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in HostInfo.xml on the staging server.

BMC Discovery query

Appendix B: Data Mappings

This query extracts data from the Host node in the BMC Discovery datastore, and provides the aliases for properties

referenced in the table below:

SEARCH Host

TRAVERSE InferredElement:Inference:Associate:DiscoveryAccess

WHERE end_state = 'GoodAccess'

TRAVERSE DiscoveryAccess:DiscoveryAccessResult:DiscoveryResult:HostInfo
WHERE NODECOUNT(TRAVERSE Primary:Inference:InferredElement:Host) > @

SHOW

systemid AS 'SystemID',

lpar_partition_number AS 'LPARPartitionNumber',
lpar_partition_name AS 'LPARPartitionName’,
lpar_type AS 'LPARType',

lpar_mode AS 'LPARMode’,

lpar_active_physical cpus_in_system AS 'LPARActivePhysicalCpusInSystem',
lpar_shared_physical_cpus_in_system AS 'LPARSharedPhysicalCpusInSystem',

lpar_shared_pool_id AS 'LPARSharedPoolID’,
lpar_active_cpus_in_pool AS 'LPARActiveCpusInPool’,
lpar_entitled_capacity AS 'LPAREntitledCapacity’,

formatTime (#DiscoveryResult:DiscoveryAccessResult:DiscoveryAccess:
DiscoveryAccess.starttime,"%FT%T") as 'InventoryDate',

#Primary:Inference:InferredElement:Host.key AS 'HostKey'

Mapping into HostInfo_ci

Source alias HostInfo_ci property Type Max
HostKey HostKey varchar 64
InventoryDate InventoryDate datetime
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Source alias Hostinfo_ci property Type Max
LPARActiveCpusInPool LPARActiveCpusInPool int

LPARActivePhysical LPARActivePhysical int
CpusInSystem CpusInSystem

LPAREntitledCapacity LPAREntitledCapacity float

LPARMode LPARMode nvarchar 255
LPARPartitionName LPARPartitionName nvarchar 255
LPARPartitionNumber LPARPartitionNumber int

LPARSharedPhysical LPARSharedPhysical int

CpusInSystem CpusInSystem

LPARSharedPoolID LPARSharedPoolID int

LPARType LPARType nvarchar 255
SystemID SystemID nvarchar 255

InstallerEvidenceDetail_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in InstallerEvidenceDetail.xml on the staging server.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for properties
referenced in the table below:

SEARCH Detail
WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > 0)
AND (type = 'FNMP_InstallerEvidence')
SHOW name AS ‘Name',
version AS 'Version',
vendor AS 'Vendor',
install_date AS 'InstallDate',
evidence AS 'Evidence',
product_code AS 'ProductCode',
#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into InstallerEvidenceDetail_ci

Source alias InstallerEvidenceDetail_ci

property

Evidence Evidence nvarchar 64
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Source alias InstallerEvidenceDetail_ci
property

HostKey HostKey varchar 64

InstallDate InstallDate nvarchar 255
Name Name nvarchar 512
ProductCode ProductCode nvarchar 110
Vendor Vendor nvarchar 400
Version Version nvarchar 144

LastLoggedOnUserDetail_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in LastLoggedOnUserDetail.xml on the staging server.

BMC Discovery query

This query extracts data from the Detail node in the BMC Discovery datastore, and provides the aliases for properties
referenced in the table below:

SEARCH Detail
WHERE (NODECOUNT(TRAVERSE Detail:Detail:ElementWithDetail:Host) > 0)
AND (type = 'FNMP_LastLoggedOnUser')
SHOW name AS ‘'UserName',
#Detail:Detail:ElementWithDetail:Host.key AS 'HostKey'

Mapping into LastLoggedOnUserDetail_ci

Source alias LastLoggedOnUserDetail_ci

property
HostKey HostKey varchar 64
UserName UserName nvarchar 255

Networkinterface_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in NetworkInterface.xml on the staging server.
BMC Discovery query

This query extracts data from the NetworkInterface nodein the BMC Discovery datastore, and provides the aliases

for properties referenced in the table below:
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SEARCH NetworkInterface
WHERE (NODECOUNT
(TRAVERSE InterfaceOfDevice:DevicelInterface:
DeviceWithInterface:Host) > 9)
SHOW
(ip_addr
OR (NODECOUNT(TRAVERSE InterfaceWithAddress:InterfaceAddress:
IPv4Address:IPAddress) > ©
AND fmt("%.510s", join(#InterfaceWithAddress:InterfaceAddress:
IPv4Address:IPAddress.ip_addr, ', ')))
OR "'
) AS 'IP',
mac_addr AS 'MAC’,
#InterfaceOfDevice:DeviceInterface:DeviceWithInterface:Host.key
AS 'HostKey'

Mapping into Networklinterface_ci

Source alias NetworkInterface_ci property Type Max
HostKey HostKey varchar 64

IpP IpP nvarchar 512
MAC MAC nvarchar 512

Softwarelnstance_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in SoftwareInstance.xml on the staging server.

|'|/--'|
' Tip: The SoftwareInstanceKey property is ignored for FlexNet Manager Suite.

BMC Discovery query

This query extracts data from the SoftwareInstance nodein the BMC Discovery datastore, and provides the aliases
for properties referenced in the table below:

SEARCH SoftwareInstance

WHERE (NODECOUNT(TRAVERSE RunningSoftware:HostedSoftware:Host:Host) > ©)
AND vm_type IS NOT DEFINED
SHOW

type + (edition AND (' ' + edition) OR '') AS 'Name',

product_version AS 'Version',

(publisher OR single(#Element:Maintainer:Pattern:Pattern.publishers))

AS 'Publisher’',
EXPLODE #RunningSoftware:HostedSoftware:Host:Host.key AS 'HostKey',
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key AS 'SoftwareInstanceKey'

Mapping into Softwarelnstance_ci

Source alias Softwarelnstance_ci property Type Max
HostKey HostKey varchar 64

Name Name nvarchar 255
Version Version nvarchar 255
Publisher Publisher nvarchar 255
SoftwareInstanceKey SoftwareInstanceKey nvarchar 512

SoftwarelnstanceVirtualMachine_ci (Staging Table)
FlexNet Manager Suite 2022 R1 (On-Premises)

Data in this staging table may also be saved in SoftwareInstanceVirtualMachine.xml on the staging server.

BMC Discovery query

This query extracts data from the SoftwareInstance node in the BMC Discovery datastore, and provides the aliases
for properties referenced in the table below (note that the regex is wrapped for printing, and should appear all on

one line):

SEARCH SoftwareInstance
WHERE (NODECOUNT(TRAVERSE RunningSoftware:HostedSoftware:Host:Host) > 0)
AND vm_type IS DEFINED
SHOW
vm_type AS 'VMType',
(zone_uuid OR vm_bios_serial) AS 'VMSerial',
(zonename OR vm_name) AS 'VMName',
(zoneid OR
(vm_type = 'VMware Virtual Machine'

AND extract(vm_uuid, regex "~(..) (..) (..) (..) (..) (..) (..)
G- G G G G )
(..) (..)%",

regex "\1\2\3\4-\5\6-\7\8-\9\10-\11\12\13\14\15\16")
OR vm_uuid
)
) AS VMID,
vm_guest_os AS 'GuestFullName',
zonepath AS 'VMPath',
formatTime(last_update_success, "%FT%T") as 'LastUpdateSuccess',
single(#HostContainer:HostContainment:ContainedHost:Host.key)
AS 'GuestHostKey"',
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single(#RunningSoftware:HostedSoftware:Host:Host.key) AS 'HostKey

Mapping into SoftwarelnstanceVirtualMachine_ci

Source alias SoftwarelnstanceVirtualMachine_ci Type
property

GuestFullName GuestFullName nvarchar 512
GuestHostKey GuestHostKey varchar 64
HostKey HostKey varchar 64
LastUpdateSuccess LastUpdateSuccess datetime

VMID VMID nvarchar 255
VMName VMName nvarchar 512
VMPath VMPath nvarchar 512
VMSerial VMSerial nvarchar 255
VMType VMType nvarchar 255

Staging to FlexNet Manager Suite

FlexNet Manager Suite 2022 R1 (On-Premises)

This section provides the mapping from the staging database to the final presentation in the web interface for FlexNet
Manager Suite.

This section is organized alphabetically by object names in FlexNet Manager Suite (for example, 'computers' are known
as 'inventory devices'). This is useful when you are starting from data displayed in FlexNet Manager Suite, tracing it
back to the staging database, and then using the preceding section to see the source of that data point in BMC
Discovery.

If you are coming the other direction, it is easiest to use your PDF search tool to find the staging database table name, a
dot separator, and the property name. For example, to find out where the Hostname property from the Host_ci table
of the staging database ends up, search for Host_ci.Hostname. You will find it listed against the Name property in the
All Inventory page (and other similar listings) of the web interface.

For each object-based topic, the following details are included:

o Whether the import of new data that was not previously in the compliance database creates new records on import.

o Whether the import of changed data for records with matching key values is allowed to update the compliance
database.

« Whether the absence of records previously imported from only the BMC Discovery source causes the old records to
be removed from the compliance database.

» The source table and property (in dot-separated format) from the staging database. Look back to the previous
section to check data types and maximum string sizes in the staging database.
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o The property name in the destination page of the web interface. Each listing is sorted alphabetically on this property
name. Where a property forms part of a compound key identifying records in the underlying compliance database, it
is appropriately marked as a partial key ("p/key").

o The data type of the property.

» For string values, the maximum length allowed in the web interface (which is also normally the maximum string
length available in compliance database). If this is less than the string length allowed in the staging database, the
string is normally truncated to length (except as noted in the comments for an individual property).

» Any general notes.

Inventory Device (Computer)
FlexNet Manager Suite 2022 R1 (On-Premises)

Inventory devices are (in the main) computers that have been found in imported inventory; and in the current context,
they are found in data imported from BMC Discovery. (Keep in mind that it is possible for a device to be reported in
more than one inventory source, which becomes important when you are assessing automatic deletion of records no
longer appearing in the source inventory.)

FlexNet Manager Suite correlates data from several points within BMC Discovery to create inventory device records.
For example, the main sources from lowest to highest priority are:

1. TheHostInfo node, by default populated during the discovery phrase of data gathering by BMC Discovery.
Current data is staged in the HostInfo_ci staging table; but if BMC Discovery does not inventory the target
device regularly, its information may be cleaned up and lost from this node.

2. TheHost node, which by default BMC Discovery populates with data from the HostInfo node.

3. Data (of type CPU Information) visible in the Detail node of BMC Discovery, and staged into the
CPUInformationDetail_ci stagingtable.

L
= Tip: This data depends on a custom CPU pattern available only by request (see CPUInformationDetail_ci

(Staging Table) for details).

4. The optional UnixHardwareData pattern (delivered as part of the BMC Discovery adapter). Data from this
source is also visible in the Detail node of BMC Discovery (with the type FNMP_HardwareEvidence), and is
staged in the HardwareEvidenceDetail_ci table.

Generally, after import into FlexNet Manager Suite, inventory devices are stored in the ComplianceComputer table of
the underlying compliance database.

Because inventory devices have so many properties, the following tables group their properties into smaller subsets.
Within each subset, the tables are sorted alphabetically by the Display property column.

« Are new records created by imports from the staging database table? — Yes.
» Can records with matching compound keys be updated by these imports? — Yes.

o Arerecords unmatched by an import from the staging table deleted from the compliance database (provided that
the staging database for BMC Discovery data is the last/only source for these records)? — Yes.

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition) 85



Appendix B: Data Mappings

Inventory device: Computer (general properties)

All these properties are available in listings such as the All Inventory page; and within the properties of an individual
inventory device, these all appear on the General tab.

Source table.property Display property Type Max Notes

Host_ci.Domain Domain name (p/key) String 100

Host_ci.Serial Firmware serial String 100  Visible in the General tab of the
number inventory device properties. Identifies

the firmware on the inventory device.

NetworkInterface_ci. IP address String 256

IpP

NetworkInterface_ci. MAC address String 256

MAC

Host_ci.Vendor Manufacturer String 128

Host_ci.Model Model String 128

Host_ci.Hostname Name (p/key) String 256

Host.Serial Serial number String 100 Aduplicate of Host_ci.Serial, this

time taken from the Host database

view.

Inventory device: Hardware properties

Except as noted, these properties are available in listings such as the All Inventory page; and within the properties of
an individual inventory device, these mostly appear on the Hardware tab (where several values may be manually
overridden if the collected inventory data is inaccurate).

Source table.property Display property Type Max Notes
Host_ci.ProcessorSpeed Clock speed Integer The maximum clock speed of
(MHz) the fastest processor in the

computer in megahertz.

Host_ci.Cores (or Cores Integer The number of cores in the

CPUInformationDetail device (or, for a virtual machine,

ci.Cores for ADDM 11.0 or earlier); or, the number of cores assigned to
the VM).

when the optional UnixHardwareData

pattern has been used,
HardwareEvidenceDetail ci.Cores
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Source table.property

FileSystem_ci.Size (summed) Disk (GB)

Not applicable

Display adapters

Display property Type

Integer

Integer

Integer

Integer

FileSystem_ci. Hard drives

COUNT (HostKey)

Not applicable Inventory chassis String
type

NetworkInterface ci. Network cards

Ip

(counted)

Host_ci.LogicalProcessors (or Threads

CPUInformationDetail ci.
LogicalProcessors for ADDM 11.0 or
earlier); or, when the optional
UnixHardwareData pattern has been

used,
HardwareEvidenceDetail ci.Cores

Host_ci.0S
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Max Notes

AllFileSystem_ci records
with an identical HostKey are
selected from the staging
database, and their Size values
are summed and the result
converted to GB for display.

The number of display adapters
is not returned by BMC
Discovery.

After import from BMC
Discovery, this value is always
Unknown (although some
inventory tools can return the
chassis type, BMC Discovery is
not among them). The result is
only available in the property
sheet for an inventory device
(and its linked asset, if any), and
not in device listings. There is
also an Assigned chassis type
where you can correct inventory
data if required.

The number of network cards in
the device is not returned by BMC
Discovery. Instead, the count of
distinct IP-enabled interfaces
sharing a common HostKey is
used.

Saved in the
ComplianceComputer tablein
the compliance database, and
generally represented in the web
interface as Threads for virtual
machines.
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Source table.property Display property Type Max Notes
Host_ci.Processors (or Processors Integer The number of processors
CPUInformationDetail_ reported in the inventory device.

ci.Processors

(for ADDM 11.0 or earlier); or, when the
optional UnixHardwareData pattern has
been used,
HardwareEvidenceDetail ci.Cores

Host_ci.ProcessorType Processor type String 256

Host_ci.RAM RAM (GB) String 128  Theimported value (in bytes) is
converted to GB for display.

Host_ci.ServicePack Service pack String 128

n/a Sockets Integer The number of sockets — a value
that is not reported by BMC
Discovery.

Inventory device: Last inventory details

These properties are available in listings such as the All Inventory page; and within the properties of an individual
inventory device, these appear on the General tab.

Source table.property Display property Type Max Notes
HostInfo_ci. Last inventory date Date For virtual hosts, the most recent
InventoryDate inventory date for any guest system

may update this value.

BMC Atrium Discovery and Lastinventory String 128 The string literal "BMC Atrium

Dependency Mapping source Discovery and Dependency Mapping"
is always inserted as the source value
when using this adapter.

Inventory device: User details

These properties are available in listings such as the All Inventory page; and within the properties of an individual
inventory device, these appear on the Ownership tab.

Source table.property Display property Type Max Notes

n/a Assigned user String 512 This value is set manually by an
operator in FlexNet Manager Suite.

n/a Calculated user String 512 Set automatically as the logged-on
user seen most frequently in the last 10
inventory imports.
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Source table.property Display property Type Max Notes

LastLoggedOnUser Last logged onuser  String 512 This information is available only for
Detail ci.Username (when Windows platforms, and only when
the optional pattern WindowsLastLoggedOnUser has
WindowsLastLoggedOnUser been used. On data import, if the
has been used) username cannot be matched in the

ComplianceUser table of the
compliance database, a new record is
created, and appropriately linked to
the ComplianceComputer record.

Installer Evidence
FlexNet Manager Suite 2022 R1 (On-Premises)

Installer evidence is a record of software installation on an inventory device. 'Normalized' installer evidence (meaning
installer evidence that includes standard string values as noted below) allows the automatic matching of the evidence
to the application that it represents, using the Application Recognition Library (ARL), frequently updated by Flexera.

« Are new records created by imports from the staging database table? — Yes.
» Can records with matching compound keys be updated by these imports? — No.

o Arerecords unmatched by an import from the staging table deleted from the compliance database (provided that
the staging database for BMC Discovery data is the last/only source for these records)? — Yes (records linking
applications to inventory devices are deleted under these conditions).

Installer evidence mapping

The properties for installer evidence are taken as a UNION of values from the DiscoveredPackages_ci,
InstallerEvidenceDetail_ci, and SoftwareInstance_ci tables of the staging database. The union is used to
create a de-duplicated, distinct set of values as listed below. If there are clashes in the values (for example, if one table
lists the Publisher as Adobe and another lists to Vendor as Adobe Software), separate records are created of
distinct evidence listing each of those different values. Since most of the properties are combined to form the primary
key for the compliance database, this may give the appearance of duplicate records at first glance, so examine the
values carefully for slight variations that trigger the creation of separate inventory evidence records.

Most of these properties are available in listings such as the Installer evidence tab of the All Evidence page; and
within the properties of an individual installer evidence record, these appear on the General tab.
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Source table.property Display Max Notes

property

DiscoveredInstalledPackages_ci.HostKey, Notdisplayed. varchar 64 Identifies the inventory
InstallerEvidenceDetail ci.HostKey,and (p/key) device on which the

SoftwareInstance_ci.HostKey installer evidence was
found. This value is not

displayed in listings of,
nor properties for,
installer evidence
(because in those
contexts, the installer
evidence may be relevant
to many different
devices). However, the
link from the installer
evidence to the
application, plus this link
to an individual device
where the installer
evidence has been found,
allows the list of installed
applications to appear on
the Applications tab of
the inventory device

properties.
DiscoveredPackages_ Name (p/key)  String 256  For recognition using the
ci.Package, standard ARL to work
InstallerEvidenceDetail_ci.Name,and reliably, this value must

SoftwareInstance ci.Name betheDisplay Name
from Add/Remove
Programs on Windows

(or equivalent).

InstallerEvidenceDetail_ci.ProductCode Not String 110 The publisher's product
displayed. code is not displayed in
FlexNet Manager Suite.

DiscoveredPackages_ Publisher (p/  String 200 For recognition using the
ci.Vendor, key) standard ARL to work
InstallerEvidenceDetail ci.Vendor,and reliably, this value must

SoftwareInstance_ci.Publisher be the Publisher from
Add/Remove Programs
on Windows (or

equivalent).
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Display

Appendix B: Data Mappings

ADDM (string literal)

DiscoveredPackages_

ci.Version,

InstallerkEvidenceDetail ci.Version,and

SoftwareInstance_ci.Version

File Evidence

FlexNet Manager Suite 2022 R1 (On-Premises)

property

Type String

Version (p/ String
key)

32

72

The string literal "ADDM"
is supplied as the installer
evidence type for this
adapter.

For recognition using the
standard ARL to work
reliably, this value must
be theDisplay
Version from Add/
Remove Programs on
Windows (or equivalent).

File evidence consists of files found on the disk of an inventory device. 'Normalized' file evidence (meaning file
evidence that includes standard string values as noted below) allows the automatic matching of the file evidence to
the application of which it forms part, using the Application Recognition Library (ARL), frequently updated by Flexera.

* Are new records created by imports from the staging database table? — Yes.

« Can records with matching compound keys be updated by these imports? — No.

o Arerecords unmatched by an import from the staging table deleted from the compliance database (provided that

the staging database for BMC Discovery data is the last/only source for these records)? — Yes.

File evidence mapping

Most of these properties are available in listings such as the File evidence tab of the All Evidence page; and within the
properties of an individual file evidence record, these appear on the General tab. (This listing is alphabetical by

Display property values.)
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Source table.property Display property Type Max Notes

Host_ci.HostKey Not displayed. (p/key) n/a Identifies the inventory device on
which the file evidence was found. This
value is not displayed in listings of, nor
properties for, file evidence (because
in those contexts, the file evidence
may be relevant to many different
devices). However, once the file
evidence is linked to an application,
this link to an individual device where
the file evidence has been found may
affect the list of installed applications
that appears on the Applications tab
of the inventory device properties.

FileEvidenceDetail _ Company (p/key) String 100 For recognition using the standard ARL

ci.Company to work reliably, this value must be the
Company WinPE header property from
Windows executables.

FileEvidenceDetail_ Description (p/key) String 200 For recognition using the standard ARL

ci.Description to work reliably, this value must be the
Description WinPE header property
from Windows executables.

FileEvidenceDetail_ Name (in listings) or ~ String 256 For recognition using the standard ARL
ci.FileName File name (in file to work reliably, this value must be:
ewience properties) « On Windows, the file name without
(p/key) path
o On UNIX-like platforms, the full
absolute file path.
FileEvidenceDetail_ Size Integer
ci.FileSize
FileEvidenceDetail Version (p/key) String 100 For recognition using the standard ARL
ci.FileVersion to work reliably, this value must be the

File Version WinPE header
property from Windows executables.

The following extended properties of file evidence records are not populated in an BMC Discovery import:

File path
Language
Product name

Product version.

92 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)



Appendix B: Data Mappings

WMI Evidence

FlexNet Manager Suite 2022 R1 (On-Premises)

Windows Management Instrumentation (WMI) evidence is most often customized to help recognize operating systems,
and (when the FlexNet inventory agent is in use) to help recognize aspects of special applications like Microsoft SQL
Server. 'Normalized' WMI evidence (meaning WMI evidence that includes standard string values as noted below)
allows the automatic matching of the WMI evidence to the application to which it relates, using the Application
Recognition Library (ARL), frequently updated by Flexera.

« Are new records created by imports from the staging database table? — Yes.
» Can records with matching compound keys be updated by these imports? — No.

* Arerecords unmatched by an import from the staging table deleted from the compliance database (provided that
the staging database for BMC Discovery data is the last/only source for these records)? — Yes.

WMI evidence mapping

In the web interface for FlexNet Manager Suite, there is no separate listing of WMI evidence. It is only possible to see
these properties using the search facility in the WMI section of the Evidence tab of application properties. (This listing
is alphabetical by Display property values.)

Source table.property Display property Type Max Notes

Host_ci.HostKey Not displayed. (p/key) n/a Identifies the inventory device on
which the WMI evidence was found.
This value is not displayed in the
application properties Evidence tab.
However, once the WMI evidence is
linked to an application, this link to an
individual device where the WMI
evidence has been found may affect
the list of installed applications that
appears on the Applications tab of the
inventory device properties.

Caption (string literal) Property name (p/ String 50 The string literal "Caption" is inserted
key) for all WMI evidence records from BMC
Discovery.
Host_ci.OS (left-most 256 Property value (p/ String 256 For OS recognition using the standard
characters) key) ARL to work reliably, this value must be

the equivalent of the
Win32_OperatingSystem.Name
WMI property.
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Source table.property Display property Type Max Notes
Host_ci.0SType converted as WMI class (p/key) String 50 The BMC Discovery data converts to
per notes. standard class types used by FlexNet

Manager Suite as follows:
e Windows becomes

Win32_OperatingSystem

e Either of VMMware ESXorVMware
ESXi becomes
VMWARE_OperatingSystem

e Any other value is replaced by
MGS_OperatingSystem.
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Microsoft App-V (full name Microsoft Application Virtualization) is an application virtualization and application streaming
solution. It allows access to applications in three different ways:

Users may stream applications directly from a central App-V Management Server to their client computers, executing
the code locally in light virtual machines that provide a protective 'bubble' around the executing software.

The applications may be deployed using Microsoft System Center Configuration Manager (SCCM).

Applications may be deployed in 'stand alone' mode, such as manual delivery through file shares or on a USB stick,
without the use of any server infrastructure.

Applications delivered in any of these ways require licensing, and you can manage the appropriate licenses using FlexNet
Manager Suite:

Applications streamed from the App-V Publishing Server(s) are monitored using the App-V server adapter supplied as a
standard part of FlexNet Manager Suite, and (for App-V release 5.0 and later) the AppVMgmtSvr.ps1 PowerShell script
installed on the App-V Management Server. Both the App-V server adapter and the AppVMgmtSvr.ps1 PowerShell

script are documented in this chapter.

Applications deployed using Microsoft SCCM are recorded automatically as part of the standard inventory import from
SCCM.

Applications deployed manually can be recorded manually in FlexNet Manager Suite. Manual deployment is not a
recommended best practice because of the inherent difficulties in management and demonstrating compliance, and
there is no automation possible through FlexNet direct inventory gathering to cover manual deployment.

Supported versions

The App-V server adapter supports the current version of FlexNet Manager Suite, and releases 4.6, 5.0, and 5.1 of Microsoft
Application Virtualization.

Because of significant architectural change between release 4.6 and release 5.0 of App-V, there are matching significant
differences in the App-V server adapter for the different versions. It is important to read this document carefully, noting
the differences that apply to "release 4.6" and "release 5.0 and later".
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Architecture, Components, and
Prerequisites

FlexNet Manager Suite 2022 R1 (On-Premises)

Following the changes that Microsoft made in the architecture of App-V between release 4.6 and release 5.0, the App-V
server adapter is also significantly different when interfacing to the different App-V releases. There are separate chapters
for each different architecture. Identify the release of Microsoft App-V in use in your enterprise, and focus on the
architecture that is appropriate to that release.

Architecture and Operation for App-V 4.6

FlexNet Manager Suite 2022 R1 (On-Premises)

This discussion applies to use of Microsoft App-V server infrastructure, streaming applications to App-V clients on end-
point devices. (Where applications are instead installed by Microsoft SCCM, use the inventory import from SCCM instead
of this adapter.)

In its streaming implementation, Microsoft App-V release 4.6 has three main kinds of components:

« Adatabase (referred to here as the App-V Management Server database), which may be on a separate server

» One or more Management Servers that access the App-V Management Server database and provide a user interface

for system control
« One or more streaming servers that may directly deliver application packages.

Of these, only the App-V Management Server database is relevant to the App-V server adapter for FlexNet Manager
Suite.

Prerequisites
Operation requires that you have:

» Asupported version of Microsoft App-V (see App-V Server Adapter).

» Anoperational App-V Management Server database.
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» AFlexNet inventory beacon that has network access to your App-V Management Server database, and is also able to
upload gathered inventory to the central FlexNet Manager Suite server (either directly or through a hierarchy of

inventory beacons).

e Aninventory beacon importing Active Directory data from the same domain where the App-V server resides. (This
may be the same inventory beacon that runs the App-V server adapter, but this is not a requirement.)

¥
= Tip: If you have App-V applications secured by security groups from multiple Active Directory domains, ensure that

the Active Directory import runs against all applicable domains in your environment. The simplest approach may
well be to ensure that you import from all your Active Directory domains, since if you use foreign security principals
from multiple trusted domains, it can be difficult to keep track of access to App-V packages. FlexNet Manager Suite
imports only from each individually specified Active Directory domain; so you need to ensure that all applicable
domains are specified. As an example of multiple domains being affected:

o Suppose you have Group-A in Domain-A that contains a child Group-B, where Group-B actually comes from

Domain-B.

o In this case, granting access to an App-V package to Group-A also grants access to Group-B (because of the

parent-child relationship between the groups).
o This inheritance continues to work even when there is only one-way trust from Domain-B to Domain-A.

o Insuch a case, itis imperative that you run an Active Directory import against both Domain-A and Domain-B.
When you have many domains, the simplest path is just to run an Active Directory import from every domain.

» Operators who can identify the applications represented by the App-V packages, and link those applications to the

appropriate licenses.

¥
= Tip: You may have multiple App-V Management Servers, and multiple streaming servers, that link to a single App-V

Management Server database. This requires only one connection from the FlexNet Manager Suite App-V server
adapter, because this connects only to the database. However, if you have multiple App-V Management Server
databases in your estate, configure a separate connection to each of them on appropriate inventory beacons. Where
helpful, you may configure multiple such connections (each separately scheduled as you choose) on one inventory
beacon.

In operation

The following diagram shows the operational architecture for the App-V server adapter for App-V release 4.6.
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The numbers here refer to the numbers shown in the diagram above:

1. Theinventory beacon imports data from Active Directory, including groups (and their members), users, and
computers, and the security identifiers for each item within Active Directory. (These security identifiers, or SIDs,
are the same identifiers that App-V reports for usage of the applications delivered through App-V packages.)

o These are immediately uploaded to the central application server for FlexNet Manager Suite.
* Assoon as the upload is completed, the data is imported into the compliance database.

2. Onthe schedule you specify on the inventory beacon, the App-V adapter:

» Connects to the App-V Management Server database

o Imports a list of the App-V packages from the database, and the access control lists (ACLs) that determine which
Active Directory groups and users have access to the applications inside the packages. The latter are identified
by their security identifiers (SIDs).

« Immediately uploads the data to the central application server for FlexNet Manager Suite. (If the upload fails for
some reason, there is a catch-up upload task that by default is scheduled overnight.)

« The data waits in the staging area on the central application server for the next scheduled inventory import and
compliance calculation (by default, scheduled overnight).

3. When information about a new App-V package is first imported, an operator must identify the package and link it
(like installer evidence) to an application record. This work must be done manually because (in release 4.6) App-V
packages are opaque about the applications they contain. As well, for any meaningful calculations of
consumption, the application must be linked to a suitable license. This linking effort is required only for the first
import of each new package.

Once the links are established, each subsequent compliance calculation assigns consumption by the correct users and
computers to the appropriate (linked) license. This consumption information is then available both in the management
views and in reports.

Architecture and Operation for App-V 5 and
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Later

FlexNet Manager Suite 2022 R1 (On-Premises)

This discussion applies to use of Microsoft App-V server infrastructure, streaming applications to App-V clients on end-
point devices. (Where applications are instead installed by Microsoft SCCM, use the inventory import from SCCM instead
of this adapter.)

In its streaming implementation, Microsoft App-V release 5.0 (and later) has the following components, apart from the
App-V clients:

o Adatabase (referred to here as the App-V Management Server database), which may be on a separate server

o Aseparate reporting database (referred to here as the App-V reporting database), which may also be on a separate
server (importantly, this database stores application usage information)

« One or more Management Servers that access the App-V Management Server database and provide a user interface
for system control

» One or more Reporting Servers that access the App-V reporting database and provide operational reports to help
manage the App-V infrastructure

e One or more streaming servers (called App-V Publishing Servers) that may directly deliver application packages.

Of these, for App-V 5.0 and later, only the App-V reporting database and an App-V Management Server are relevant to
the App-V server adapter for FlexNet Manager Suite. (If you are familiar with the adapter for release 4.6 of App-V, notice
that we have switched databases, and added the Management Server — the architecture is completely different.)

Prerequisites
Operation requires that you have:

« Asupported version of Microsoft App-V (see App-V Server Adapter).
o Anoperational App-V reporting database.
» Anoperational AppV Management Server.

o The AppvMgmtSvr.psl PowerShell script installed, configured and scheduled on your AppV Management Server
(see Obtaining (and Deploying) the Adapter Components for details). This is one of the significant changes since the
previous adapter.

» AFlexNet inventory beacon that has network access to your App-V reporting database, and is also able to upload
gathered inventory to the central FlexNet Manager Suite server (either directly or through a hierarchy of inventory
beacons).

* Aninventory beacon importing Active Directory data from the same domain where the App-V server resides. (This
may be the same inventory beacon that runs the App-V server adapter, but this is not a requirement.)

¥
= Tip: If you have App-V applications secured by security groups from multiple Active Directory domains, ensure that

the Active Directory import runs against all applicable domains in your environment. The simplest approach may
well be to ensure that you import from all your Active Directory domains, since if you use foreign security principals
from multiple trusted domains, it can be difficult to keep track of access to App-V packages. FlexNet Manager Suite
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imports only from each individually specified Active Directory domain; so you need to ensure that all applicable
domains are specified. As an example of multiple domains being affected:

o Suppose you have Group-A in Domain-A that contains a child Group-B, where Group-B actually comes from
Domain-B.

o In this case, granting access to an App-V package to Group-A also grants access to Group-B (because of the

parent-child relationship between the groups).
o This inheritance continues to work even when there is only one-way trust from Domain-B to Domain-A.

o Insuch a case, it is imperative that you run an Active Directory import against both Domain-A and Domain-B.
When you have many domains, the simplest path is just to run an Active Directory import from every domain.

« Operators who can link the applications identified in the App-V packages to the appropriate licenses.

L
= Tip: You need only one connection from the FlexNet Manager Suite App-V server adapter (on an inventory beacon) to

the App-V reporting database. This single App-V reporting database may support multiple App-V Management
Servers, and multiple Publishing Servers; but only a single connection to the database is required.

Limitation

For App-V release 5.0 and later, the system supports installation of the AppVMgmtSvr. ps1 PowerShell script on only
one App-V Management Server. This single Management Server may support multiple Publishing Servers (if necessary
spread worldwide for faster distribution of App-V packages to App-V clients); and the App-V clients may report to
multiple Reporting Servers (independent of the source from which the App-V packages were downloaded). Different
App-V Management Servers do not self-identify in the . raa inventory file, and the App-V reporting database does not
identify which application usage information is associated with which App-V Management Server. For these reasons,
only a single App-V Management Server (for release 5.0 and later) is supported.

If your App-V (release 5.0 or later) environment has multiple Management Servers, choose one as the data source for
App-V packages and the applications they contain. For example, if you have Production, Dev, and Test servers, place
the AppVMgmtSvr.psl1 PowerShell script on the Production App-V Management Server. Also ensure that the App-V
server adapter (on an inventory beacon) connects to the matching Production App-V reporting database.

In operation

The following diagram shows the operational architecture for the App-V server adapter for release 5.0 and later.
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The numbers here refer to the numbers shown in the diagram above:

1. Theinventory beacon imports data from Active Directory, including groups (and their members), users, and
computers, and the security identifiers for each item within Active Directory. (These security identifiers, or SIDs,
are the same identifiers that App-V reports for usage of the applications delivered through App-V packages.)

o These are immediately uploaded to the central application server for FlexNet Manager Suite.
o Assoon as the upload is completed, the data is imported into the compliance database.

2. On the schedule you specify on the App-V Management Server, the AppVMgmtSvr . ps1 PowerShell script:
o Uses the API to gather a list of the available App-V packages

» Imports from the database, and the access control lists (ACLs) that determine which Active Directory groups
and users have access to the applications inside the packages. The latter are identified by their security
identifiers (SIDs)

» Uploads the collected data in a remote application access (. raa) file to its configured inventory beacon, which

in turn uploads the file to the central application server for FlexNet Manager Suite.

« The data waits in the staging area on the central application server for the next scheduled inventory import and

compliance calculation (by default, scheduled overnight).

3. Onthe schedule you specify on the inventory beacon, the App-V adapter:

» Connects to the App-V reporting database

« Imports App-V package usage by users and computers. These are all identified by their security identifiers
(SIDs).

« Immediately uploads the data to the central application server for FlexNet Manager Suite. (If the upload fails for
some reason, there is a catch-up upload task that by default is scheduled overnight.)

o The .raafile collected by the PowerShell script is uploaded and immediately resolved into staging tables in

the database.
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¥
= Tip: If you manually copy an . raa file to your application server, you can import it with the following

command:

> mgsimport -t remoteApplication

« The data waits in the staging area on the central application server for the next scheduled inventory import and
compliance calculation (by default, scheduled overnight).

4. When the compliance calculation is run, FlexNet Manager Suite uses the uploaded SIDs to correlate the various
data elements:

o App-V packages are shown as installer evidence (based on the MSI information uploaded by the
AppVMgmtSvr. ps1 PowerShell script).

« Ifan appropriate application record exists (either in the Application Recognition Library or as a locally-created
record) with a suitable installer evidence rule, the installed evidence (package) is automatically matched with
the application.

« Allusers with access to an App-V package are shown as having an installation of the related application on
every computer for which the user is either the assigned or calculated user.

o All computers with access to an App-V package are shown as having an installation of the related application.

« Ifthe application is linked to a license, consumption is shown for the correct users and computers on that
license (or, if it is linked to multiple licenses, on the highest priority license still having unconsumed
entitlements). This consumption information is then available both in the management views and in reports. (If
this is the first import to reveal an application in an App-V package, an operator needs to link the application
record to an appropriate license.)
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Set Up and Operations

FlexNet Manager Suite 2022 R1 (On-Premises)

This chapter covers the configuration of the adapter, and the work needed to enable application recognition from the
imported inventory.

Keep clearly in mind the distinctions required for App-V release 4.6, and release 5.0 and later. For example, Obtaining
(and Deploying) the Adapter Components documents processes needed only for release 5.0 and later; and Configuring
the Adapter requires a distinct database connection in each of the cases.

Obtaining (and Deploying) the Adapter
Components

FlexNet Manager Suite 2022 R1 (On-Premises)

L
U To download the adapters archive:

1. Download the Adapter Tools for FlexNet Manager Suite 2022 R1.zip archive. One path is through the

Flexera Community:

(]
= Tip: Your Community credentials are required for login.

a. Loginto community.flexera.com.
b. Inthe top right, in the navigation bar, expand More and select Product and License Center.

c. Under the right-hand list of products that includes FlexNet Manager Suite, click LET'S GO! (and
subsequently wait for the redirection to occur).

d. On theright side, scroll down through the list of Your Downloads and click FlexNet Manager Platform.
The Download Packages page for FlexNet Manager Platformappears.
e. Inthe Latest Versions tab, click FlexNet Manager Suite 2022 R1.

A EULA page may appear. If so, click I agree to accept the license, as this grants access to the list of
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Downloads.

f. Inthe list of available Downloads, in the Files tab, in the File Name column, click Adapter Tools for
FlexNet Manager Suite 2022 R1.zip.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet Manager

Suite 2022 R1.zip commences.

g. Inyour browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C: \temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it to

the appropriate working location when the download is finished.
2. Right-click the zip archive, and choose Extract All....
3. Inthe extracted archive, navigate to Adapter Tools\App-V Management Server Agent\

AppVManagementServers5.

L
= Tip: As an alternative to downloading the archive again, if you still have access to the 'CD image' you

downloaded to install FlexNet Manager Suite itself on your application server(s), you can also find these files in
the unzipped installation archive under FLlexNet Manager Suite\Installers\App-V Management

Server Agent\AppVManagementServers.

4. Use your preferred method to deploy the AppVMgmtSvr. ps1 PowerShell script to your App-V Management

Server.
You may install the script in your preferred folder.
5. Use your preferred task scheduling technology to schedule data collection by the PowerShell script.

Typically you want the . raa file uploaded to the central FlexNet Manager Suite operations databases before the
system import and license calculations take place. By default, this occurs daily at 2am central server time. As a
two-hour upload buffer should be more than adequate, this suggests (within a single time zone) a data collection
trigger at around midnight.

These example steps are for Windows Server 2012. Adjust as necessary for your server operating system, or your
chosen scheduling tool.

a. In Windows Explorer, navigate to Control Panel > System and Security > Administrative Tools, and
double-click Task Scheduler.

The Task Scheduler window appears.

b. Inthe navigation tree on the left, select Task Scheduler Library, and then in the Actions list on the right,
click New Folder....

A dialog appears for entering the folder name.
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A suggested value is FlexNet Manager Suite.
c. Click OK, and select the new folder in the navigation tree.
d. Select Action > Create Task....

The Create Task dialog appears.

e. Enteranappropriate Name, such as FlexNet Manager Agent for App-V 5.x,andaddany
Description to help future maintenance of this task.

Your description may be something like Collects App-V data from the Management Server
and uploads to an inventory beacon.

f. Click Change User or Group....
The Select User, Service Account, or Group dialog appears.

g. Enter the account name that is to run the scheduled task, and click OK.
An appropriate account:
e Can run a Windows scheduled task on the App-V Management Server
o Can execute the PowerShell script
* Isan App-V Management Server administrator

« May conveniently be a domain account that can upload the results (using HTTP PUT) to the inventory
beacon, although a separate account and password can be configured in the command line (required
only where that inventory beacon is using Basic Authentication — if the inventory beacon uses
anonymous authentication, ignore this requirement).

h. Further down in the Security options group, select Run whether user is logged in or not.
i. Switch to the Triggers tab, and click New....
The New Trigger dialog appears.

jo Ensure that the default setting Begin the task On a schedule is selected, set the parameters for the
schedule, and from the Advanced settings group, be sure that Enabled is selected.

The suggested schedule is daily at or before midnight local time, but be sure that this suits the upload
procedures for your enterprise.
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k. Switch to the Action tab, and click New....
The New Action dialog appears.

l. Ensure that the default Action, Start a program, is selected, and browse to your local copy of
AppVMgmtSvr.psl.

m. In the Add arguments (optional) field, specify all the command-line arguments you need for the agent.
All command line arguments are documented in Command Line for PowerShell Script. For common

implementations, you need to define only the URL to the inventory beacon.

This example uploads the . raa file to the fLexnetbeacon inventory beacon, using the credentials of the
account running the scheduled task.

. \AppVMgmtSvr.psl -beaconUrl http://flexnetbeacon

¥
= Tip: You need to specify only the basis server in the URL. Internally, the FlexNet Beacon service

briefly saves the uploaded file to XCommonAppData%\Flexera Software\Incoming\
RemoteApplications before uploading the file to its parent. (If security within your enterprise
prevents the PowerShell script uploading the . raa file to a inventory beacon, you can arrange an
alternative method to save the . raa file to this folder on a convenient inventory beacon, and it is
automatically uploaded and processed from this point.)

n. Click OK.

o. Optionally, make any preferred adjustments to the Conditions or Settings tabs (normally the defaults are
acceptable).

p. Click OKto close the Create Task dialog.

The new task appears in the list of scheduled tasks for this server.
g. Right-click the new task, and click Run in the context menu.

This checks that the scheduled task completes successfully.
r. Validate operations in the following ways:

o Review the log file (by default, AppvMgmtSvr. log in the same folder as the PowerShell script) for any

errors or warning messages.

» Review the content of the output file (by default, FNMS_AppV. raa in the same folder as the
PowerShell script). This file contains the results of the most recent execution of the PowerShell script,
and is replaced at each invocation of the script. For more details of the file format, see File Format for

.raa.

« If uploaded to the inventory beacon, check for the presence of the FNMS_AppV. raa output file in
%CommonAppData%\Flexera Software\Incoming\RemoteApplications on theinventory
beacon. Remember that you have only a brief time window to check this before it is uploaded to the
central application server and removed (by default, around 10 minutes).

The AppVMgmtSvr.ps1 PowerShell script is now configured on your App-V release 5.0 or later Management Server. You
can now configure the adapter itself that runs on the inventory beacon (see Configuring the Adapter).
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Command Line for PowerShell Script
FlexNet Manager Suite 2022 R1 (On-Premises)

The AppVMgmtSvr.psl PowerShell script is required only when importing inventory from Microsoft App-V release 5.0
or later. (It is not required if you are using App-V release 4.6.)

For applicable releases, AppVMgmtSvr. ps1isinstalled on the App-V Management Server, where, on a schedule that
you determine, it collects details of the available App-V packages, and the users and computers that have access to
the packages. (Separately, usage information is collected by the App-V server adapter, with its separate configuration
described in Configuring the Adapter.)

The following options are supported, both for running AppVMgmtSvr. ps1 manually and for executing it from a

scheduled task or other scheduling tool. None of the options is mandatory, although some are required for normal
operation.

Syntax

Syntax:
AppVMgmtSvr.ps1l [ options...]

Options

-beaconUrl validURL
-logFilePath Log file
-outputFilePath output file
-password password
-upload $true | $false
-username account

where

-beaconUrl validURL  The URL to the appropriate inventory beacon to which the script should upload the
generated . raa file. Include the protocol (HTTP or HTTPS), and if your inventory
beacon uses a non-default port, include the port number in the standard way.

E

I=I" Note: Include only the basic URL of the server. No internal paths are needed, as
these details are added automatically by AppVMgmtSvr. ps1.

There is no default value for beaconuUr1l, so that in production use (when -upload
$true), a value must be supplied. It can be omitted for local testing on the server
when uploading is not required. If -upload $true and beaconUrlis not set,
obviously the upload must fail.

Example values:

http://flexnetbeacon.example.com
https://flexnetbeacon.example.com:499
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-logFilePath
Log file

-outputFilePath
output_file

-password "password"

-upload $true |
$false

-username "account"

Examples

Afile path (either absolute, or relative to the folder in which the script is executing)
and file name for the log file generated by AppVMgmtSvr.ps1. Enclose the pathin
double quotation marks. A file with consistent name and path over time is replaced
at each execution, containing only the results of the last execution, thus preventing
unmanaged storage requirements. When this option is not specified, the default
value is AppVMgmtSvr. log, saved in the folder where the script is executing.

Afile path (either absolute, or relative to the folder in which the script is executing)
and file name for the output remote application access (. raa) file generated by
AppVMgmtSvr.ps1l. Enclose the path in double quotation marks. If the same name
and path is used, the file is overwritten at each run of the script. When the option is
not specified, the default value is FNMS_AppV. raa, saved in the folder where the
script is executing.

The password (in plain text) for the account specified in username. Omitted when
that option is not required. If specified, enclose the value in double quotation marks.
When required and not specified, the script uses details of the account running the
process.

A Boolean that determines whether to attempt uploading the output file to an
inventory beacon identified in beaconUrl. When not specified, the default is true,
requiring that beaconUr1 is specified so that the upload can succeed.

The account name used to upload the generated . raa file to the inventory beacon
identified in beaconUr1. This is not required for inventory beacons using
anonymous authentication. It may be specified for inventory beacons using
Windows Basic Authentication. If specified, enclose the value in double quotation
marks. When it is specified, the matching password must be provided in the
-password option. When required and not specified, the script uses details of the
account running the process.

(Examples here may be line-wrapped for convenient presentation; but should be entered on a single command line.)

Collect the inventory from the App-V Management Server, saving the file locally for inspection:

.\AppVMgmtSvr.psl -upload $false

Similarly, collect the inventory, saving the output and logs to temporary locations to avoid overwriting the normal

output:

.\AppVMgmtSvr.psl -outputFilePath "C:\temp\FNMS_AppV.raa"
-logFilePath "C:\temp\AppVMgmtSvr.log"
-upload $false

Collect the inventory, and upload it to the specified inventory beacon, using the username and password for the
account currently running the script:

.\AppVMgmtSvr.psl -beaconUrl http://flexnetbeacon.example.com
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Upload the collected inventory to the specified inventory beacon, using the testdomain\administrator account:

.\AppVMgmtSvr.psl -beaconUrl http://flexnetbeacon.example.com
-username “"testdomain\administrator”
-password "somepassword"

File Format for .raa
FlexNet Manager Suite 2022 R1 (On-Premises)

The AppVMgmtSvr.ps1 PowerShell script interrogates the App-V Management Server, and saves the resulting data in
a remote application access file (filename extension . raa), by default called FNMS_AppV. raa. This is an XML file that
encapsulates data about each application's App-V package, and the MSl installer information known to App-V.

Here is an excerpt from an FNMS_AppV. raa file (here line-wrapped for presentation):

<remoteApplications accessModeID="2">
<app farmName=""

appID="9b09bcOd-9634-4838-bOba-8c256ef4710d"

appName="Blender"

appFileName=

appFileVersion=

appFilePublisher=

appFileDesc=""

userSid=

serverName=
serverDomainName=""
isStreamingProfile="1" />

<msiData farmName=""

appID="9b09bcOd-9634-4838-bOba-8c256ef4710d"

msiDisplayName="Blender"

msiPublisher="Blender"

msiVersion="1.0"

msiProductCode="{DFFFEOC6-3E9A-44E9-9EC1-B5C92DCEE4AF}" />
<app farmName=""
appID="5d80bef6-deda-44f6-b4f8-9aa6a657880e"
appName="Filezilla 3.2.4.1 win32-setup”
appFileName=""
appFileVersion=
appFilePublisher=
appFileDesc=""

userSid="S-1-5-21-1336908958-3350896562-3141117955-1690"

serverName=
serverDomainName=""
isStreamingProfile="1" />
<msiData farmName=""
appID="5d80bef6-deda-44f6-b4f8-9aa6a657880e"
msiDisplayName="Filezilla Client 3.2.4.1"

msiPublisher=
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msiVersion="3.2.4.1"

msiProductCode="filezilla client" />
<app farmName=""
appID="02787044-d434-4e7d-8770-cdad6c988de8"
appName="AdobeReader9"
appFileName=""
appFileVersion=
appFilePublisher=

appFileDesc=
userSid="S-1-5-21-1336908958-3350896562-3141117955-1690"

serverName=

serverDomainName=
isStreamingProfile="1" />

<msiData farmName=
appID="02787044-d434-4e7d-8770-cdad6c988de8"
msiDisplayName="Adobe Reader 9.1"
msiPublisher="Adobe Systems Incorporated"
msiVersion="9.1.0"
msiProductCode="{ac76ba86-7ad7-1033-7b44-a91000000001}" />

</remoteApplications>

Some points of interest to note:

o The complete set of MSI attributes needed for FlexNet Manager Suite makes use of Asset Intelligence on the App-V
release 5.0+ system, which saves a series of AssetIntelligenceProperties in the manifest file. From these

properties, AppVMgmtSvr. ps1 extracts the fourmsi. .. properties shown for the applications above.

» Not all applications deployed through App-V use MSI, as some applications use third-party installers. App-V
packages using third-party installers cannot include the Asset Intelligence properties available through MSI. For
such cases, the AppVMgmtSvr.ps1 PowerShell script interrogates the App-V application registry to get complete
installer evidence, populating the same attributes in the . raa file. (Thus the presence of
AssetIntelligenceProperties in the manifest file does not necessarily mean that Asset Intelligence was

available; but does mean that equivalent data has been obtained.)

o ThemsiDisplayName becomesthe Name property of the installer evidence record, the msiPublisher maps to
Publisher, msiVersion maps to Version. As with all installer evidence, the resulting record is matched against
installer evidence "rules" (previously-recorded installer evidence records, most often generalized with judicious use
of wild card % characters), and when matched, adds an installation count to the application linked to the rule. This
means that in listings of installer evidence, the visible entry remains the generalized rule that matched our
individual piece of installer evidence. However, the individual installer evidence record is visible by drilling down
into the properties of the inventory device on which the inventory evidence was found.

o For aworked example of how the installer evidence for the FileZilla application in the extract above is matched
against an installer evidence rule, see Investigating Issues.
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Configuring the Adapter

FlexNet Manager Suite 2022 R1 (On-Premises)

The (core) App-V server adapter is set up on an inventory beacon. Only two tasks are required for configuring this built-

in adapter:

« Specifying the connection to the appropriate database. There are distinct databases in the two versions:

o For App-V release 4.6, the App-V server adapter connects to the Microsoft App-V Management Server database

o For App-V release 5.0 and later, the App-V server adapter connects to the Microsoft App-V reporting database.

o Scheduling the imports.

Both tasks are summarized here. Further details are available in the inventory beacon help.

=
[_] To configure the App-V server adapter (summary):

1.

On the appropriate inventory beacon, start the FlexNet Beacon interface.

An appropriate inventory beacon has network access to the appropriate database as described above; and it can
upload to the central FlexNet Manager Suite server, either directly or through a hierarchy of inventory beacons.

;

= Tip: Remember that logging into an inventory beacon requires an account with administrator privileges.

. Select the Inventory systems page in the FlexNet Beacon interface.

. At the bottom of the page, click New....

The Create SQL Source Connection dialog opens.

Connection name

Source Type

Server

. Complete the values required in this dialog:

A descriptive name for this connection that you will recognize later in lists.

Select App-V Standalone. (Use this same value whether you are connecting to App-V
release 4.6, or release 5.0 or later.)

=

= Tip: 'Standalone' means that you are using the adapter to connect directly to the

appropriate App-V database, rather than collecting inventory through another
source such as Microsoft SCCM.

Type the server name or IP address where the database is hosted. If the database
instance you need is not the default one on the server you identify, add the instance
name, separated with a backslash character.
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Authentication Select one of:

» Windows Authentication — Select this option to use standard Windows
authentication to access the database server. The credentials of the account (on
the inventory beacon) running the scheduled task for importing inventory are used
to access the SQL Server database. This account must be added to an Active
Directory security group that has access to the database.

» Windows (specific account) — Use the following two fields (enabled when you
make this choice) to specify an account on the inventory beacon that can make a
connection to the SQL database.

» SQL Authentication — Use the following two fields to specify an account and
password registered as a user with database access on SQL Server . This account is
used to access the database, regardless of the local account running the scheduled
task on the inventory beacon server.

(i
= Tip: The account used needs read-only privileges.

Username The account name used for SQL authentication, or Windows (specific account). (Not
required for Windows Authentication.)

Password The password for the account name required for SQL authentication, or Windows
(specific account). (Not required for Windows Authentication.)

Database Enter the name of the database, or use the pull-down list to select from database
names automatically detected on your specified server. For example, for a connection
to Technopedia, select BDNA_Publish from the drop-down list.

Connectionisintest Ensure that this check box is clear for production use. (For more details, see Managing
mode (do notimport  Microsoft SQL Server Database Connections in the online help for FlexNet Manager
results) Suite, in the section covering the inventory beacon.)

(d

= Tip: When using App-V release 4.6, you cannot complete configuration for operation
of this adapter (specifically, you cannot map the App-V packages to real
applications) until you have run an import in production mode, with this check box
clear.
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Overlapping If you use more than one inventory source, it is possible to get overlapping inventory

Inventory Filter (records about the same endpoint device from multiple inventory tools). Because of
differences between inventory tools, the overlapping inventory records may contain
slightly different data. In the web interface (in FlexNet Manager Suite), you may
nominate one inventory source as Primary, which gives its collected data priority for
hardware properties imported from target inventory devices. The choices here give
another, separate axis of control, based on whether or not the data from this
particular source is to be considered "stale". This is different from the Primary setting
in the following ways:

« Itis assessed first (before the primary setting is taken into account), and so may
even modify the effect of your Primary setting. It is best practice to make sure that
your chosen primary inventory source is not marked as stale with the following
settings.

o It affects not only imported hardware properties, but also software inventory
(installer evidence, file evidence, and so on), as follows:

o With two inventory sources (when neither one is considered stale), the total
software inventory is a union (merging) of the results from both sources. This is
useful when two different inventory tools have different specializations for
software detection: the union means you are not blind-sided by a software
inventory tool that missed something you should have licensed. This is
considered the 'normal’ operational case in a stable environment using multiple
inventory sources.

o When one of the two available sources is declared "stale" (using either of the
first two choices below), all of its overlapping software inventory is excluded
from the possible union of data sources (hardware inventory too, but here we're
considering software). This behavior is valuable, for instance, when a target
inventory device has migrated from one inventory source to another (perhaps
by moving offices), but has not yet been obsoleted from this first source.
Imagine that, as part of the office move, the MyApp application had also been
uninstalled from the inventory device. You do not want the old and stale record
from this source insisting there's an installation of MyApp when in fact it's no
longer on the device. Of course, best practice is to obsolete the device from this
stale source so that it is no longer reported in this inventory source; but these
first two settings allow a quick control of all the overlapping data from this
source, rather than having to obsolete devices one by one in the source tool.
Another common scenario is when you are migrating over time from an old
version of your chosen inventory tool to a newer version (on a new connection),
and during transition both systems are still running. Declaring the old version's
connection as "stale" means that as soon as a record appears in the new
version's inventory for a particular device, the old device import is automatically
superseded, and updates rely entirely on the new version of your inventory tool.

Each of the following settings only takes affect when FlexNet Manager Suite is
comparing the inventory dates of a device from this current inventory source and an
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5.
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overlapping record from another inventory source:

 Ignore the device’s inventory from this data source — When you have more recent
inventory from another source for the same target inventory device, the record from
this source is completely ignored. (Technically, the device record is deleted from the
staging table in the database, and so can never be imported.)

« Ignore this device’s inventory if older than nn days — If you select this option,
overlapping inventory collected by this source more than the set number of days
before the import is ignored. Fresher overlapping data is still imported and
considered for data merging.

(4
= Tip: In the interests of keeping inventory current, this control has a maximum

value of 60 days.

» Import the inventory from this source for possible merging — Choose this option
(the default) to declare that overlapping inventory collected from this connection is
never considered stale. This is the normal operating setting when you are not trying
to manage transitions from one inventory source to another. With this setting,

overlapping records are merged in this way:
a. If a data point exists in the Primary inventory source, it is used

b. If two equal-priority sources have different inventory dates, the data point is
taken from the most recent inventory

c. As atie-breaker, the connection ID for this source recorded in the database is
used (normally meaning that the earliest-created inventory source has
priority).

Click Test Connection.

« If the inventory beacon can successfully connect to the nominated database using the details supplied, a
Database connection succeeded message displays. Click OK to close the message. Click Save to

complete the addition. The connection is added to (or updated in) the list.

« Ifthe inventory beacon cannot connect, aDatabase connection failed message is displayed, with
information about why that connection could not be made. Click OK to close the message. Edit the
connection details and retest the connection.

You cannot save the connection details if the connection test fails. If you cannot get the connection test to
succeed, click Cancel to cancel the addition of these connection details.

If you do not already have a schedule specified that can be used to run the adapter for this connection, create one
now (see Creating a Data Gathering Schedule in the online help).

. With the connection for this adapter selected in the Inventory systems page, click Schedule....

The Select Schedule dialog opens.

From the drop-down list, select the schedule you wish to apply.

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)



Set Up and Operations

.
= Tip: As you select each schedule from the list, the area below displays a summary of the schedule settings and
the expected Next run time for this schedule.
9. Click OK to apply the selected schedule.

10. Click Save to store these details.

The list of connections is updated, and the Next run column for your selected connection shows the projected run
time from the schedule you just attached.

11. With the connection for this adapter still selected in the Inventory systems page, click Execute now.

The adapter collects information from the appropriate database (App-V Management Server database for App-V
release 4.6, and App-V reporting database for App-V release 5.0 and later), packages it, and uploads it to the
central FlexNet Manager Suite (or, if it uploads to a parent inventory beacon, the file is briefly saved in
%CommonAppData%\Flexera Software\Incoming\RemoteApplications on the parentinventory beacon).

Allow time for this process to complete before continuing with the next setup procedure.

Import Evidence and Recognize
Applications

FlexNet Manager Suite 2022 R1 (On-Premises)

Because your App-V package naming may be unique to your enterprise, you may need to identify the applications they
contain.

If you have many App-V packages, setting up application recognition may be a significant effort on the first import from
your App-V server adapter. Once the initial work is done, it is a simpler task to maintain recognition as new App-V
packages are put into production.

This procedure continues from the work just completed at the inventory beacon where the adapter runs. Move now to
the web interface for FlexNet Manager Suite.

3
[_] To import evidence for application recognition:

1. Ensure that the upload of data from the App-V server adapter is complete:

a. Inthe Management view, navigate to the system menu (#° ¥ in the top right corner) and select Data
Inputs.

The Data Inputs page displays.
b. Select the Inventory Data tab, and select the Show details check box near to top.

c. Find the App-V server adapter listed for the appropriate inventory beacon, and check its Last import date,
Duration, Validation issues, and Status.

When these are appropriate (in particular, Status is Successful on the appropriate Last import date),
continue this procedure. Until then, you need either to remediate any upload problems, or simply wait
until the upload is completed.
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(i
= Tip: This page does not dynamically update results, but shows the status when the page was opened.

Therefore, if you are waiting for an upload to finish, refresh the page (F5) from time to time to see

updated information.

For App-V 5.0 and later, the upload of the . raa file saves the contents into staging tables in the compliance
database, awaiting the arrival of usage information. For both App-V 4.6 and 5.0 (and later), the upload of the
datafile from the App-V server adapter (on an inventory beacon) queues a job with the batch scheduler. When this
job can next be processed, the adapter data (which, for App-V 5.0 and later, is combined in this process with the
installer evidence from the . raa file) is imported into the compliance database. Thereafter, either of two results

applies:

« Recognized installer evidence is linked to the application, and shows an installation count for each device on
which the evidence was found (and can be further examined on the properties for each of those devices).

(4
= Tip: The next step, showing consumption against an appropriate license, requires both that the application

is linked to the license, and that a reconcile has been run, either automatically on schedule or manually.

o Theinstaller evidence that was successfully imported but not matched to an application record needs your
attention to map it to the correct application. (This is more common with the adapter for release 4.6.) To do

that, continue with this process.
2. Identify newly-imported evidence (the App-V packages) that requires a link to application records:
a. Navigate to License Compliance > Discovered Evidence (in the Evidence group).
The Discovered Evidence page displays. Ensure that the default Installer evidence tab is selected.
b. Near the top of the tab, click Add filter, and from the drop-down list select Type.
A second drop-down list appears, listing the possible values of the evidence type.
c. Select App-V.

d. Click Add filter again, and from the pull-down drop-down list select Assigned, then choose the value No.
With both filters defined, click the blue check mark (tick) to apply this filter.

The list is redrawn to show only evidence of type App-V (the list of App-V packages discovered through the
adapter) that have not been matched (manually or automatically) to an application.

(d

= Tip: You may have no results when these filters are applied. This is a healthy state, meaning that all
your App-V evidence is successfully matched to applications. When you have no records here, and want
further validation of success, you can drill down into the properties of devices that have a record of
installation for the appropriate application.

3. Use your special knowledge of the App-V packages to link each piece of unassigned evidence to an application
record. You may do this either by:

« Clicking the Name of the evidence, which opens the property sheet for this evidence where you can work on

the Applications tab
« Following these guidelines to edit locally, still on the Discovered Evidence page:

a. Click anywhere else in a row (other than on the Name) to select that App-V package from the list.
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The action buttons above the list become active.
b. Click Assign.
Ablue editor Assign evidence to an application appears above the tabs.
c. Clickin the search field, optionally enter a few characters from the application name, and click Search.

The editing area expands to include a list of application results matching your search. These applications
include any previously created in your enterprise, together with all matching applications from the
Application Recognition Library regularly updated by Flexera.

d. Select your chosen application from the list, and (above the list) click Add.

The search field is updated to show the name of the application you selected.

(i
= Tip: If you cannot find the correct application in the search results, you may create a new application

record by clicking Create an application, and completing the details in the application properties (the
App-V package is automatically listed in the Evidence tab of the application properties).

e. Click Assign.
o The blue editing area closes.

o The App-V package is linked to the application you chose (the App-V package now functions like
installer evidence to show consumption against any license linked to the application).

 Inthe list of evidence, the Assigned column is updated to Yes, showing that this package has been
linked (or assigned) to an application. (If you currently have a filter on the Assigned column to show
only rows with a No value, the evidence you just assigned must disappear from the list.)

(i
= Tip: This links the evidence to the application as an exact match across publisher, name, and version

records. To protect against future upgrades of the App-V package, you may wish to generalize the
version number with a % wild-card. For example, if the original version was 1.0, manually editing the

Version property of the installer evidence to 1.% means the link to the application remains valid
through all the minor upgrades of this package.

4. |If the selected application is not yet linked to a license, you can:
a. Double-click the App-V package in the evidence list (or, while it is selected, click Open).
The evidence property sheet opens.
b. Select the Applications tab.

c. Inthelist of applications, click the name of the one you have just assigned to the App-V package (or
double-click elsewhere in the row; or select the row and click Open).

The application property sheet opens.
d. Select the Licenses tab in the application properties.
e. Optionally enter a few characters of a license name (where you know it); click Search.
The search area expands to show the list of available licenses (matching any characters you entered).

f. Select the appropriate license from those offered, and click Add license.
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Where a suitable license does not already exist, you may instead create one (for example, navigate to
License Compliance > Create a license (in the Licenses column)).

¥
= Tip: Don't forget to link some purchase records to the license to provide your entitlement count.
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Issues and Limitations

FlexNet Manager Suite 2022 R1 (On-Premises)

Diagnosis is covered in this chapter, along with limitations and known issues.

Limitations

FlexNet Manager Suite 2022 R1 (On-Premises)

The following limitations apply to the current releases of the App-V server adapter:

« Inthe unlikely event that App-V packages have been shared to non-persistent Citrix Virtual Desktops (formerly
XenDesktop) VDI devices (instead of users), and FlexNet Manager Suite is linked to a Citrix Virtual Desktops broker, no
license consumption occurs for those non-persistent devices (because non-persistent VDI devices are not modeled
within FlexNet Manager Suite when Citrix Virtual Desktops broker information is available).

o License consumption calculations depend on the integration of data both from Active Directory, and from the
appropriate App-V database (App-V Management Server database for release 4.6, or reporting database for release
5.0 and later) and the AppVMgmtSvr. ps1 PowerShell script. As linking of this data occurs when the App-V server
adapter data is imported, current users, computers, and groups must be imported from Active Directory first, before
the latest App-V server adapter import occurs. From FlexNet Manager Suite 2014 R2, this ordering is automatic, since
Active Directory data is imported to the central database as soon as it is uploaded from an inventory beacon.

¥
= Tip: You may have multiple App-V Management Servers, and multiple streaming servers, that link to a single App-

V Management Server database. This requires only one connection from the FlexNet Manager Suite App-V server
adapter, because this connects only to the database. However, if you have multiple App-V Management Server
databases in your estate, configure a separate connection to each of them on appropriate inventory beacons.
Where helpful, you may configure multiple such connections (each separately scheduled as you choose) on one
inventory beacon.

o The quality of installer evidence recovered from App-V release 4.6 is not high. You should expect to do remedial work
both to generalize the evidence found (for example, using the % wild card to generalize version numbering), and to

link the evidence to appropriate applications.

o For App-V release 5.0 and later, the system supports installation of the AppvVMgmtSvr. ps1 PowerShell script on only

one App-V Management Server. This single Management Server may support multiple Publishing Servers (if
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necessary spread worldwide for faster distribution of App-V packages to App-V clients); and the App-V clients may
report to multiple Reporting Servers (independent of the source from which the App-V packages were downloaded).
Different App-V Management Servers do not self-identify in the . raa inventory file, and the App-V reporting
database does not identify which application usage information is associated with which App-V Management Server.
For these reasons, only a single App-V Management Server (for release 5.0 and later) is supported.

Investigating Issues

FlexNet Manager Suite 2022 R1 (On-Premises)

Proof that the App-V server adapter is operational, and the data upload is also successful, can be seen in either or both
of two ways:

« Installation records for the appropriate applications against expected inventory devices (possibly including Remote

devices for which no hardware inventory is available)

o The presence of any newly-discovered inventory of type App-V in the Discovered Inventory list, typically with an
Assigned value of No.
If neither of these is the case, the issues could be with:

o Imports from the App-V server adapter on an inventory beacon (for both App-V release 4.6, and App-V release 5.0 or
later)

o Imports of the . raa file from your App-V Management Server (only for App-V release 5.0 or later)
« Missing links between the installer evidence (representing App-V packages) and the applications in the packages
* Missing consumption on an appropriate license.

Each of these is covered in turn below.

No data imports from adapter on inventory beacon
Check the following to identify the problem with imports from the App-V server adapter:

1. Areyou sure that there should be new records? Have new packages been brought into production since the last
time inventory was collected and fully processed?

2. Check the Status of the latest upload (navigate to the system menu (% ¥ in the top right corner), select Data
Inputs, choose the Inventory Data tab and select Show details). Also validate that the Last import date is as
expected, so that the upload occurred after new App-V packages were brought into production.

3. If uploads are not happening, move to the inventory beacon where the adapter runs, and check the status of the
App-V connection. Use the Test connection button to ensure it can connect to the appropriate database (App-V
Management Server database for App-V release 4.6, and the App-V reporting database for release 5.0 and later).
Details about setting the connection are in Configuring the Adapter.

4. Onthe sameinventory beacon, test its connection to the central application server for FlexNet Manager Suite,
using the Parent connection page and the Test connection button there. (If this inventory beacon is part of a
hierarchy, check the connections all the way up the hierarchy to prove that uploads can reach the central server.)

5. Check for stalled uploads by looking for an App-V inventory file in the CommonAppData%\Flexera Software\
Beacon\IntermediateData directory on the inventory beacon (or, in a hierarchy, in the chain of inventory
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beacons). (Notice that the folder for files from the App-V server adapter is separate from the folder for . raa files
from the PowerShell scripts used with release 5.0 and later.) App-V data files are named in part for the connection
you established (see Configuring the Adapter). Once an inventory file of this type is successfully uploaded, it is
removed from this intermediate data location on the inventory beacon; so any file in this folder on any server in
the hierarchy has not yet been uploaded to the parent server. Upload failures may occur for temporary reasons,
such as a network timeout; but there is a catch-up task run overnight to re-attempt uploads of any stalled files.

6. Has a reconciliation calculation occurred since the upload? Until this occurs (normally overnight), new App-V
inventory cannot be displayed in the web interface for FlexNet Manager Suite. Check the date and time on the
System Health page (=’ ¥ > System Health), in the License reconciliation card. The last import and
reconciliation must be after the latest upload from the inventory beacon.

7. If you are using App-V release 5.0 or later, a failure to upload and save . raa files may also prevent presentation of
results, even when the application usage information is successfully imported from the App-V server adapter.
Issues with . raa files are covered in the next section.

No data imports from the PowerShell script for App-V release 5.0 and later
If uploads of . raa files do not appear to be working:

1. Ensure that a new upload is required: that is, that the AppVMgmtSvr. ps1 script has executed successfully since
the last inventory import and license consumption calculation (the most recent file is always saved on the App-V
Management Server for checking, and is only replaced the next time that the script executes):

o Check your scheduling for the script's execution, in particular that the command line options are correct (see
Obtaining (and Deploying) the Adapter Components).

o Check the log file for the last run (you may have renamed or relocated the log file, as described in Command
Line for PowerShell Script). In particular, ensure that there were no problems with the file upload to the

inventory beacon.

2. Move to that inventory beacon, and check for stalled uploads by looking for an . raa file in
%CommonAppData%\Flexera Software\Incoming\RemoteApplications (this file path is different from the
one used for files uploaded by the App-V server adapter). If you have a hierarchy of inventory beacons, check each
inturn.

3. Iffile uploads are happening successfully, has there been a reconcile since the last . raa file was uploaded? Check
the date and time on the System Health page (=° ¥ > System Health), in the License reconciliation card. The
last import and reconciliation must be after the latest upload from the inventory beacon. If not, you may (as an
administrator) manually trigger a reconcile (navigate to License Compliance > Reconcile).

Missing application recognition

For App-V release 4.6, data imported from the App-V server adapter includes only the App-V package name and the
Active Directory groups (or individuals) that may access the package, according to the Access Control Lists (ACL).
Specifically, this imported information cannot recognize what application is hidden within the App-V package.
Application recognition requires a separate step. Even for App-V release 5.0 and later, where much better installer
evidence allows automatic matching of the evidence rules for the appropriate application, there may be cases where
the installer evidence needs manual attention. This will be the case when:

« Thereis no matching application available within FlexNet Manager Suite, either in application records that you have
created locally, or in the Application Recognition Library
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o Thereis an appropriate application, but the values returned from App-V do not match with the existing inventory

rules for the application record.

In cases where installer evidence from App-V is unmatched, you can check as follows:

1. First be sure that data uploads and imports are happening, as validated in the previous sections.

2. Navigate to License Compliance > Evidence column > Discovered Evidence > Installer evidence tab. Filter for
Type=App-V, and check the Assigned column. If it displays No, you need to link this package to an application, as
described in Import Evidence and Recognize Applications.) For App-V release 4.6, newly imported evidence is
always unassigned, and requires you to manually associate the evidence (or App-V package) with an application.

3. ForApp-Vrelease 5.0 (and later), when installer evidence appears in the above listing, it may be worth checking
why the data from the App-V installer evidence did not match existing evidence rules for the appropriate
application (assuming the application is already present locally or in the Application Recognition Library). To do
this, navigate to the Evidence tab of the application's properties, where all existing evidence "rules" are listed
(making sure that Installer is the selected subtab). Compare the data displayed there with content in your .raa
file (see sample . raa file in File Format for .raa). Here is a worked example of successful matching using the

FileZilla 3 application:

App-V element's attribute Application's installer evidence property

msiDisplayName="FileZilla Client 3.2.4.1" NameFilezilla Client 3.2.%

msiPublisher="" Publisher (blank)
msiVersion="3.2.4.1" Version3.2.%
accessModeID="2" (produces the evidence type Type Any

App-V)

Thus the . raa entry produces installer evidence that is immediately matched by the existing installer evidence
rule for the application, and produces an installation count against that application. But looking ahead (in
imagination) to the day when the . raa entry covers a version of 4.2. 3.1, the App-V package data in the . raa file
would no longer match this evidence rule. At that time, if a new rule was yet to be published in the Application
Recognition Library, the installer evidence created from the . raa file would appear in the Discovered Evidence
listing, and you could link it to the application, preferably generalizing it (similarly to the example above) to create
arule that would match several minor releases.

Missing consumption
Showing consumption of license entitlements for App-V packages (and the applications they contain) requires:

o The adapter gathers data from the App-V server and uploads and imports it into FlexNet Manager Suite (see first

section above for more details).
o For App-V release 5.0 or later, the . raa file is uploaded from your App-V Management Server

o The application is recognized, either automatically, or because you have linked the App-V package to an application

record (see previous section)

o The application is linked to a license (and in turn the license should be linked to purchase records to show your legal
entitlements) — here, this is left as an exercise for the reader.
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« Active Directory imports are current, allowing mapping of the groups and users from the ACLs in the App-V
Management Server database to user records in FlexNet Manager Suite.

These notes address the last stage, enabling Active Directory to map from the ACL lists to user records. This process is
automatic, provided that all the necessary data is available.

1. Onthe appropriate inventory beacon, open the Active Directory page (from the Connections group), and
validate that a connection is both established and scheduled. (For details, see Importing from Active Directory in
the online help.) Review the Last run time to see when data was last collected, uploaded, and imported. You may
also choose Execute Now if imports have been disrupted.

2. Once sufficient time has passed for Active Directory data collection, upload, and import (normally, 30 minutes
should be more than adequate), review the list of All Users to establish that the expected user names are all
available (navigate to Enterprise > All Users).

¥
= Tip: If you have App-V applications secured by security groups from multiple Active Directory domains, ensure

that the Active Directory import runs against all applicable domains in your environment. The simplest
approach may well be to ensure that you import from all your Active Directory domains, since if you use foreign
security principals from multiple trusted domains, it can be difficult to keep track of access to App-V packages.
FlexNet Manager Suite imports only from each individually specified Active Directory domain; so you need to
ensure that all applicable domains are specified. As an example of multiple domains being affected:

« Suppose you have Group-A in Domain-A that contains a child Group-B, where Group-B actually comes from

Domain-B.

« Inthis case, granting access to an App-V package to Group-A also grants access to Group-B (because of the

parent-child relationship between the groups).
« This inheritance continues to work even when there is only one-way trust from Domain-B to Domain-A.

« Insuch a case, it is imperative that you run an Active Directory import against both Domain-A and Domain-B.
When you have many domains, the simplest path is just to run an Active Directory import from every domain.

=2

I=| Note: You cannot review Active Directory group memberships within FlexNet Manager Suite. Only the resulting
list of users is available (along with computers, sites, and subnets).

Known Issues

FlexNet Manager Suite 2022 R1 (On-Premises)

The following issues relate primarily to the stability of data available for collection from the App-V server.

Renaming packages

App-V allows you to rename packages (without necessarily changing their contents). When a package is renamed, the
App-V application record no longer links to usage records within the appropriate App-V database. This means that the
App-V server adapter (and, for App-V release 5.0 and later, the AppVMgmtSvr. ps1 PowerShell script) cannot import
meaningful data for license consumption calculations. As well, the installer evidence generated from the App-V import
now has a different name, which may not match evidence rules for the appropriate application. If that is the case, the
consumption calculations for any license linked to an application that was linked to the previous installer evidence
from App-V drops to zero (from this import connection).
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For this reason, it is strongly recommended that you do not change the name of existing App-V packages in the App-V
Management Server interface. Where renaming is unavoidable, remember that you may need to link the new package
(represented as installer evidence in FlexNet Manager Suite) to the application to restore consumption calculations
(especially for App-V release 4.6).

Updating package versions

Typical "rules" for applying installer evidence to identify applications use the publisher, the application, and the
version recorded in the installer evidence. If you use a version number for your App-V packages (such as 1.0), and link
exactly this App-V 'installer' evidence to the application record in FlexNet Manager Suite, then updating the version
number of the package on your App-V Server (say, to 1.1) may break the link to the application, and the linked license
loses its consumption as a result.

You can avoid this problem (at least for minor version changes) by using wild-cards in the linking of evidence to
applications. To do this, after you have linked the App-V evidence to the application:

1. Navigate to the Installer Evidence Properties page.
2. Select the General tab.

3. Edit the Version property, using a wild-card percentage sign (%) to generalize the match across multiple versions.

For example:

o The original (say 9. 2) is an exact match for only one version number.
o Avalue of 9.% matches all the minor releases of version 9.

» Avalue of % matches all versions of the App-V package with the same name and publisher.
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Data mapping

FlexNet Manager Suite 2022 R1 (On-Premises)

This chapter covers the relationships between the data fields in the source App-V data and the final locations of the data
inside the FlexNet Manager Suite database.

App-V Release 4.6 Data Transfers

FlexNet Manager Suite 2022 R1 (On-Premises)

This table lists the data extracted from App-V release 4.6, and where it is stored the compliance database in FlexNet
Manager Suite. Imported data is stored in temporary staging tables for data manipulation, and then moved into their
final destination tables as noted below. These columns in the compliance database are available for use in custom
reports, and the like.

App-V (Table)/Column FNMS (Table)/Column Notes

(REPORTING_CLIENT_INFORMATION) (ComplianceComputer) Ifthe computer name already existsin the

host_name ComputerName ComplianceComputer table, this device is
identified as the consuming device.
If it does not already exist, the device is added
to the ComplianceComputer table with a
ComplianceComputerTypelD of 4, which
(through the ComplianceComputerType
table) indicates a remote device from which
inventory cannot be collected. All such created
records display their connection name (as the
Inventory Agent), are marked as incomplete
records, and are given a fictitious serial
number of 1.
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App-V (Table)/Column FNMS (Table)/Column Notes

(REPORTING_CLIENT_INFORMATION) (ComplianceComputer) The domainname isextracted from the host

host_name ComplianceDomainID record on the App-V server. If the domain does
not already exist in the compliance database, it
is added to the ComplianceDomain table, and
as required the ComplianceDomainID may be
updated in the ComplianceComputer table.

(APPLICATION_USAGE) (ComplianceComputer) The lastlogged on user for this computer.
username ComplianceUserID

(VW_APPLICATIONS) (InstallerEvidence) The name of the App-V package (which may
app_name DisplayName bear no resemblance to the application inside)

is used to identify the evidence record.

D Note: It is possible for an App-V package to
contain more than one application. This
makes it impossible to link the App-V
evidence to a single application record. Best
practice is to make each package contain
exactly one licensable application.

(VW_APPLICATIONS) (InstallerEvidence) The version of the App-V package. Again, this

version Version bears no necessary relationship to the version
of the application inside the package, and is at
the whim of the person preparing the package
(for example, it may represent the number of
times the application package was modified).

String literal App-V (InstallerEvidence) All App-V evidence is given the publisher name
Publisher of App-V.

App-V Release 5.0 (and Later) Data
Transfers

FlexNet Manager Suite 2022 R1 (On-Premises)

This data is imported from Microsoft App-V release 5.0 and later. It is imported by the combination of the PowerShell
script installed on your App-v Management Server, and the App-V server adapter on an inventory beacon that can
access the App-V reporting database.

Several staging tables in the compliance database store information uploaded from the App-V reporting database and
the . raafiles. These include:

e ImportedComputer

e ImportedInstalledInstallerEvidenceUsage
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o ImportedInstallerEvidence

e ImportedRemoteApplication

e ImportedRemoteApplicationAccess

e ImportedRemoteApplicationServer

o ImportedRemoteApplicationInstallerData.

Data is held in these tables until the import from the App-V server adapter is complete, and then the resolvers are
triggered to combine the data from:

¢ The most recent Active Directory import(s) across all relevant domains

o The most recent imports of the . raa file from all App-V Management Server

o The App-V reporting database.

For this reason, it is important that the import from the App-V reporting database happens last.

The following table lists the elements and their attributes from the . raa file, and their final table and column in the

compliance database within FlexNet Manager Suite.

XML (Element) [ Attribute FNMS (Table) / Column Notes

(app) appID n.a. Used as a key as required across the temporary tables
listed above.
(app) userSid n.a. The group SID (from Active Directory) identifying the

users and computers with access to the package. This
drives the linking of inventory device and user records to
the application.

(msiData) (InstallerEvidence) Visible as the Name in Installer Evidence properties.
msiDisplayName DisplayName

(msiData) (InstallerEvidence) Visible as the Publisher in Installer Evidence properties.
msiPublisher Publisher

(msiData) msiVersion (InstallerEvidence) Visible as the Version in Installer Evidence properties.

Version
(msiData) (InstallerEvidence) Not visible in the web interface.
msiProductCode ProductCode

The following are the views used for source data from the App-V reporting database. It is not possible to give a simple
mapping of this source data to columns in particular database tables within FlexNet Manager Suite, because the data is
normalized and otherwise processed at each stage. For example, the usernamecolumn collected from
view_ApplicationUsage inthe App-V reporting database is already subject to considerable validation and
processing before it is stored in the lastloggedonuser column in the staging tables (staging tables are listed above).
Thereafter, the user name is correlated with other inventory sources, resulting in further processing before it is used to
determine a link between the application and the user. For that reason, this table shows only the source content in the
App-V reporting database.
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App-V View Columns

dbo.view_ApplicationUsage e app_name
e app_version
e end_time
e host_id
o start_time
e username

e version_guid

dbo.view_ClientInformation « host_id

e host_name

dbo.view_PackageInformation e« host_id
o package_id

e version_guid
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The BMC Atrium adapter is a mechanism for two-way information synchronization between an on-premises
implementation of FlexNet Manager Suite, and BMC Software's Atrium configuration management database (CMDB) and
Remedy IT Services Management product. Data flows in two directions, which in this document are described from the
viewpoint of FlexNet Manager Suite as export and import:

o The adapter exports computer system and recognized product information from FlexNet Manager Suite to the CMDB.
(Details of fields exported are available in Appendix 1: Export of Computers and Appendix 2: Export of Applications/
Products.)

o The adapter also imports Asset role, status and owner information from the CMDB and Remedy into FlexNet Manager
Suite. (Details of the imported data are available in Appendix 3: Import of Assets.)

—
=3

I==| Note: This adapter is only available for on-premises implementations of FlexNet Manager Suite. Specifically, it cannot
be used with the cloud implementation.

This documentation (and the BMC Atrium adapter) assume that the Atrium server is running on a Microsoft Windows
operating system.

This documentation covers the following supported products:

o FlexNet Manager Suite Version 2022 R1

o BMC Atrium CMDB version 8.1 through 20.02 (together with Atrium Integrator version 8.1 through 9.1.10). The BMC
Atrium server must run a Microsoft Windows operating system.

o BMC Remedy ITSM Version 7.6.04 SP4-9.1
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Architecture, Operation, and
Prerequisites

FlexNet Manager Suite 2022 R1 (On-Premises)

This chapter provides a framework for your understanding of later, more detailed information.

Architecture and Operations

FlexNet Manager Suite 2022 R1 (On-Premises)

To facilitate the two-way exchange of data between FlexNet Manager Suite and BMC Atrium, components already
supplied with both systems are used, and additional elements are supplied with the downloaded adapter.

The following diagram combines the positioning of these elements on different servers, with the data flows for both
export and import (as defined in BMC Atrium and Remedy Integration). There are two determining factors in this
structural arrangement:

o The schedule for triggering both exports and imports is configured within Atrium, and the Atrium Integrator needs to
invoke the data export utility and the FlexNet Business Importer. For this reason, all three components (Atrium
Integrator, export utility, and Business Importer) are located on the same server.

« For performance, it is preferable that the intermediate database be on the same database server as your compliance
database for FlexNet Manager Suite. (Where you choose a different location, ensure there is a high-speed network
connection between the two servers, and a trust relationship for the accounts used during operations.)

The combination of these two determinants produces the following physical architecture. Net data flows are shown
here, with each process also shown separately below.
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Once the adapter components are installed and all systems are configured (as described in the chapter Installing the
Adapter), operation is fully automatic, triggered by schedules you set during configuration. The two directions of data
exchange function independently, and are summarized below.

Export of Computers and Products

In summary, the process for exporting computer and product information from FlexNet Manager Suite to BMC Atrium

(shown below in blue arrows) is as follows:

FlexNet Manager
Platform Server

Compliance
DB

e

Intermediate

e

BMC Atrium Server

Flexera
Business
Importer

DB

Adapter
components

Remedy
DB

CMDB

1. The schedule for export fires in Atrium, and the Atrium Integrator calls the data export tool (installed as part of the

adapter).

2. The data export tool reads content from the compliance database for FlexNet Manager Suite, and writes the data
into the intermediate database. (It also creates entries in the log file, and sends alert emails if there any errors.)

3. On success, the Atrium Integrator reads the data from the intermediate database, maps it using the defined data

transforms to the fields required in Atrium
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4. The Atrium Integrator writes the results into the CMDB.

Import of Assets

In summary, the process for importing assets (and their ownership) from BMC Atrium into FlexNet Manager Suite

(shown below in green arrows) is as follows:

FlexNet Manager BMC Atrium Server
Platform Server
: _— Flexera _
Compliance = o Business Remedy
DB #  Importer DB
= - TﬁQQ\GFA - — -
Atrium @
L~ Integrator
- /e/ . _
Intermediate Export CMDB
DB Tool
Adapter
components

1. The schedule for import fires in Atrium.

2. The Atrium Integrator reads data from both the Remedy database and the CMDB, and writes the results into the
Intermediate database. (It also sends alert emails if there are any errors.)

3. Onsuccess, the Atrium Integrator calls the FlexNet Business Importer.

4. The Business Importer reads the data from the intermediate database, transforms it as required, and writes the
results into the compliance database of FlexNet Manager Suite.

Prerequisites

FlexNet Manager Suite 2022 R1 (On-Premises)

The prerequisites for the BMC Atrium adapter include the following:

» On the server where the data utility is to be installed, .NET Framework 4.5 is required. (To validate, open Windows

Programs and Features, and search for . NET.)

o FlexNet Business Importer must be installed on the same server where the Atrium Integrator is installed. This is
installed as a part of the FlexNet Business Adapter Studio. Collecting the installer files is covered in Obtaining the
Adapter Components, and completing the installation and configuration is detailed in Install the Business Importer

and Link with Remedy.

« The adapter requires an intermediate database to be installed, conceptually between the compliance database for
FlexNet Manager Suite and the CMDB for BMC Remedy. In practice, this intermediate database may reside on the
same database server as the compliance database; or any other convenient server running at least Microsoft SQL
Server 2012 that is accessible from both your BMC Atrium server and your FlexNet Manager Suite database server.
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Scripts to set up the database are included with the adapter, and the process is covered in Preparing the Databases.
o FlexNet Manager Suite Version 2022 R1

o AFlexNet Manager Platform BMC Atrium CMDB Option license. To verify that you have this license term, navigate to
the system menu (#° ¥ in the top right corner) > FlexNet Manager Suite License, and look for this item in the list of
Licensed products. If not present, you can request the license term through the Contact us to renew or

upgrade email link on the same page.

o BMC Atrium CMDB version 8.1 through 20.02 (together with Atrium Integrator version 8.1 through 9.1.10). The BMC
Atrium server must run a Microsoft Windows operating system.

e BMC Remedy ITSM Version 7.6.04 SP4-9.1

Obtaining the Adapter Components

FlexNet Manager Suite 2022 R1 (On-Premises)

It is most convenient to collect the adapter, and the main elements it contains is to complete this procedure on the
computer where you will install the adapter (see Architecture and Operations).

3
[_] To download adapter components:
1. Use your browser to access the Flexera Customer Community.

a. On https://community.flexera.com/, use the account details emailed to you with your order confirmation
from Flexera to log in (using the Login link in the top right).
7
= Tip: Access requires your Customer Community user name and password. If you do not have one, click
the Let's go! button on the login page to request one. Your credentials are configured for access to
content you have licensed.

b. Select Find My Product and choose FlexNet Manager from the top menu. Now click the button PRODUCT
RESOURCES - PRODUCT INFORMATION which will expose the Download Products and Licenses link.
Click on this option.

Arouting page appears to let you Access Product and License Center,displaying lists of products

from Flexera.
c. Inthe lists of products, identify FlexNet Manager Platform,and immediately below it, click LET'S GO.
The Product and License Center site displays.

d. Inthe Your Downloads section of the Home page, click the link for ElexNet Manager Platform.

e. IntheDownload Packages page, click the link for ElexNet Manager Platform 2022 R1 to access the
downloads.

2. Selectthe Adapter Tools for FlexNet Manager Suite 2022 R1 archive (Adapter Tools for FlexNet
Manager Suite 2022 R1.zip), and save to a convenient location (such as C: \temp) on the server where Atrium
Integrator Spoon is installed.
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3. Similarly, download Business Adapter Studio for FlexNet Manager Suite version.zip and save on the

same server.
Installation of the Business Adapter Studio is covered in Install the Business Importer and Link with Remedy.

4. Unzip the adapter tools archive, navigate through Tier 1 Adapter Tools>BMCAtriumAdapter, and copy the
contentsinto C:\Program Files\Flexera\.

I} Important: This path is referenced in various steps in the Atrium jobs and transformations (see file list below).
If you do not use the same path, you must edit the Atrium Integrator Spoon jobs and transformations manually
to point the shell scripts to different location.

The archive includes the following key components:

« An SQL script to create the intermediate staging database (archive\BMCAtriumAdapter\scripts\

CreateIntermediateDatabase.sql)

o Another SQL script to modify the database for FlexNet Manager Suite (archive\BMCAtriumAdapter\scripts\
FNMPDatabaseChanges.sql)

o The definition of Atrium Integrator jobs (. kjb) and transformations (. ktr):

o archive\BMCAtriumAdapter\BMCAtriumAdapter.kjb

o archive\BMCAtriumAdapter\FNMPExports\Execute FNMP Export Tool.kjb

o archive\BMCAtriumAdapter\FNMPExports\ExportComputerProductRelationshipsTransform.ktr
o archive\BMCAtriumAdapter\FNMPExports\ExportComputersTransform.ktr

o archive\BMCAtriumAdapter\FNMPExports\ExportProductsTransform.ktr

o archive\BMCAtriumAdapter\FNMPExports\ExportUpdateIntermediateDBTransform.ktr

o archive\BMCAtriumAdapter\FNMPExports\FNMPExports.kjb

o archive\BMCAtriumAdapter\FNMPImports\Asset.ktr

o archive\BMCAtriumAdapter\FNMPImports\ImportUpdateIntermediateDBTransform.ktr

o The adapter's main executable (archive\BMCAtriumAdapter\FNMPExports\Utility
\FNMPDataExportUtility.exe), and its many dependencies, including:
o Query files (archive\BMCAtriumAdapter\FNMPExports\Utility\Queries\Computers.txt,
ProductIds.txt,Products.txt)

o Adapter configuration file (archive\BMCAtriumAdapter\FNMPExports\Utility\
FNMPDataExportUtility.exe.config)

¢ Business Importer adapter definition file (archive\BMCAtriumAdapter\FNMPImports\
FNMPImportDefinition\Asset.xml).
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FlexNet Manager Suite 2022 R1 (On-Premises)

Integrating two sophisticated systems likes these involves a number of procedures, documented in the topics shown:

1. Installing the new, intermediate DB used for data manipulation and transfer (see Preparing the Databases).

2. Modify the compliance database in FlexNet Manager Suite with a custom property for additional values (also in
Preparing the Databases).

3. Installing and configuring the export utility that brings data out of FlexNet Manager Suite and into the intermediate
database (still in Preparing the Databases).

4. Declaring a dataset within Atrium for data exchange, and authorizing an account to use that dataset (see Reserving
an Atrium Dataset).

5. Importing the supplied Atrium jobs and data transforms into your Atrium system (see Importing Atrium Jobs and
Transforms).

6. Configuring the supplied Atrium jobs with appropriate settings for your environment (see Configure Atrium Jobs).

7. Fortheimport of asset data from Atrium to FlexNet Manager Suite, installing the FlexNet Business Adapter Studio
(which brings with it the Business Importer), and integrating the Business Importer with BMC Remedy Mid-Tier (see
Install the Business Importer and Link with Remedy).

8. Initially populating the CMBD with configuration items from FlexNet Manager Suite, and then adjusting settings to
allow for reuse for future imports (see Tuning Creation of Configuration Items).

9. Schedule regular operations of the adapter (see Scheduling the Adapter).
This chapter also includes details about Verifying Data Export to BMC Atrium.

If you are transferring large datasets, you should also prepare an environment variable as described in Preparing for
Large Datasets. (Other configuration options, including relocating or renaming the log file, are also documented in the
chapter Additional Customization of the Adapter.)

Preparing the Databases

FlexNet Manager Suite 2022 R1 (On-Premises)

You have a clear understanding of your physical architecture for the installation (see Architecture and Operations), and
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have downloaded and unzipped the archive containing the adapter (see Obtaining the Adapter Components).

=
[_] To prepare the databases:

1.

Determine where the intermediate database used by the adapter will reside, and log into that database server
using an account that has DB Owner privileges.

For details, refer back to Architecture and Operations.

7
= Tip: If the archive cannot be accessed from this database server, first copy the script (or both scripts for a

common DB server) from this folder to a location accessible from SQL Server Studio. If you use copies of the
scripts, modify the paths described below to suit.

. On this server, in Microsoft SQL Server Studio, create the intermediate database (suggested name

AtriumIntermediateDB).

Open a query window that is connected to your new database, and execute
CreateIntermediateDatabase.sql (located in the unzipped archive, by defaultin C: \Program Files\
Flexera\BMCAtriumAdapter\scripts).

This SQL procedure creates the required tables and pre-populates some fixed values.

. If the intermediate database is on another server separate from your compliance database for FlexNet Manager

Suite, switch over and log into the FlexNet Manager Suite database server, again using an account that has DB
Owner privileges.

You need access to the second SQL script here, so if necessary, copy the second script to this server before
continuing.

. In Microsoft SQL Server Studio, navigate to and execute C: \Program Files\Flexera\BMCAtriumAdapter\

scripts\FNMPDatabaseChanges.sql.

This SQL script adds a custom property to the Details tab of computer properties in FlexNet Manager Suite where
the machine's Role can be imported from BMC Atrium.

. On the server where the data extraction executable will run (likely, the Atrium server), open a command prompt,

and navigate to C: \ProgramFiles\Flexera\BMCAtriumAdapter\FNMPExports\Utility.

This executable requires .NET Framework 4.5 installed, a high-speed network access to the database(s), and an
account trusted to access both the compliance database and the intermediate database. It must be callable by
the Atrium Integrator. If need be, first copy the entire contents of the folder shown above (including
subdirectories) to a convenient location on the appropriate machine.

7
= Tip: To validate that the host in correctly configured with .NET Framework 4.5 or later, execute

FNMPDataExportUtility.exe /help

A list of command-line options is displayed. If not, investigate the version of .NET installed.

7. Execute the following (on a single line):
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FNMPDataExportUtility.exe
/Source "FNMP-DBConnectionString"
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/Target "IntermediateDBConnectionString"
/Encrypt true

where:

Parameter Notes

FNMP-DBConnectionString The connection string (enclosed in double quotation marks) for the export
utility to connection with the compliance database for FlexNet Manager Suite.
TheData Source value must be the fully-qualified domain name of the
database server. Where the compliance database is not in the default
instance on this server, add the instance name (separated by a slash).
An example connection string when the default name for the compliance
database is FNMSCompliance, is (all on one line):

Data Source=DBServer.example.com/myInstance;
Initial Catalog=FNMSCompliance;Integrated Security=SSPI;
Connection Timeout=60;Min Pool Size=2;Max Pool Size=20;

IntermediateDB The connection string (enclosed in double quotation marks) for the export

ConnectionString utility to connection with the intermediate database you recently created. An
example connection string when this is on the same server and instance as
the compliance database, and the default name for the intermediate database
is IntermediateDB, is (all on one line):

Data Source=DBServer.example.com/myInstance;
Initial Catalog=IntermediateDB;Integrated Security=SSPI;
Connection Timeout=60;Min Pool Size=2;Max Pool Size=20;

/Encrypt Required field. When set to true the connection strings are encrypted when
they are saved into the configuration file for the export utility. Use false
when not encrypting the connection strings. (The configuration file lives in the
same folder as the executable, and is called
FNMPDataExportUtility.exe.config).

8. Configure where the export utility sends email notifications about any export errors.
a. From the same folder, open FNMPDataExportUtility.exe.configin a flat text (or XML) editor.

b. Locate the following section and replace the values shown:

<appender name="SmtpAppender" type="log4net.Appender.SmtpAppender">
<to value="toaddress@somedomain.com"></to>
<from value="fromaddress@somedomain.com"></from>
<subject value=" Atrium Integration Adapter Error"></subject>
<smtpHost value="smtp.somedomain.com"></smtpHost>

where:
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Value Notes

toaddress Valid email address for the person who is to receive alerts when errors
@somedomain.com occur during export.

fromaddress Valid email address for an account known on the specified SMTP host
@somedomain. com that is identified as the sender of the email when an error occurs.
smtp.somedomain.com The fully qualified domain name of the SMTP email server.

c. While here, you may want to customize the location of the log file for the export utility:

<log4net>
<appender name="RollingFileAppender"
type="1logdnet.Appender.RollingFileAppender">
<file value="C:\Log.txt" />

d. Save the edited file, and exit the editor.

Creating a View Only SQL User in FlexNet
Manager Suite

FlexNet Manager Suite 2022 R1 (On-Premises)

This task outlines how to create and configure accounts for the SQL user and to promote this user to a FlexNet Manager
Suite View only operator. These accounts are required to fetch data from FlexNet Manager Suite using BMC Atrium
Integrator Job and to populate the BMC Atrium CMDB Intermediate database.

To prepare the view-only SQL user for FlexNet Manager Suite compliance database, begin by creating a user (for
example, fnmsintegrator) for the FNMSCompliance database that can log in using SQL Authentication.

B To prepare view-only SQL user:
1. Open the Microsoft SQL Server Management Studio.
2. Expand the Security folder (first-level child of the top SQL Server node) and right-click Logins.
3. Right-click fnmsintegrator user and select Properties from the context menu.
4. Configure the Login properties for fnmsintegrator user as follows:
a. Setthe Server Role as public to grant server-wide security privileges to the user.
b. Inthe User Mapping section, select FNMSCompliance database for this user.

c. Selectthe public and db_datareader role membership for this user against FNMSCompliance

database.

d. Selectdb_datawriter membership only if the fnmsintegrator user is used for populating data to
FNMSCompliance database from IntermediateDB.

5. Add the above user to the ComplianceOperator group for the FNMSCompliance database. For example, the
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following SQL query can be used for adding a fnmsintegrator user:

Insert into ComplianceOperator(OperatorLogin,IsEnabled,GlobalOperator,Interactive)

values('fnmsintegrator',1,0,0)
6. In FlexNet Manager Suite, navigate to the system menu (#° ¥ in the top right corner) and choose Accounts.
7. GrantView Only permissions to the operator that you created in the above steps.

8. Connect to SQL Management Studio as the above user to validate that these read permissions have propagated

and run the following query.

select * from ComplianceComputerCurrentUser
9. Ifthe query does not return results, execute the SyncPreCalculatedAccessRightsForOperator stored
procedure for this ComplianceOperator as follows:
a. Open Microsoft SQL Server Management Studio.
b. Login to FNMSCompliance database as Administrator.

c. Execute the following against corresponding Tenant UID.

SetTenantUID '[Tenant UID]'
Declare @OutputBit BIT = 1
Declare @OperatorID INT = (select
ComplianceOperatorID from ComplianceOperator where OperatorLogin =

'fnmsintegrator ')
Exec SyncPreCalculatedAccessRightsForOperator

@OperatorID, O, @OutputBit

For example, the last line may be:

EXEC SyncPreCalculatedAccessRightsForOperator 2,0,1

10. Retry the SELECT on ComplianceComputerCurrentUser to ensure it works correctly.

11. Ensure that the exporter utility config file is using this SQL user in the connection string for the FNMSCompliance

database.

Reserving an Atrium Dataset

FlexNet Manager Suite 2022 R1 (On-Premises)

You must specify a dataset for information exchange, and ensure you have an account with write access to that dataset.
This procedure sets up a data area within Atrium reserved for data exchange with the FlexNet Manager Suite adapter.
Your Atrium Administrator may assist with an account that had permissions to access this dataset. You will reference
this dataset later in the installation of the adapter.
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oy
[_] To reserve the area in Atrium for data exchange:

1.

2,

4.

5.

In the BMC Remedy User application, open the CMDB console.
Select Reconciliation Manager > Create > Dataset.

A Dataset Information form appears.

. Complete the following parameters:

Dataset name A friendly name for the dataset that you will recognize later in other listings.
Dataset ID The system identifier for the dataset.
7

= Tip: This value is needed when you configure your Atrium jobs.

Accessibility Use the drop-down list to set this to Writable.
DatasetType Use the drop-down list to set this to Regular.
Click Save.

The new dataset is created.

Consult with your Atrium Administrator about an account with write access to the created dataset. This account
must be used on the Atrium side to run the adapter.

For more information about creating the dataset, seeis! http://discovery.bmc.com/confluence/display/81/
Configuring+the+BMC+Atrium+Adapter.

Importing Atrium Jobs and Transforms

FlexNet Manager Suite 2022 R1 (On-Premises)

You need to get the supplied files into the Atrium repository, configured for your local connections. For this procedure,
you must be logged into your Atrium server with administrator privileges. This server needs access to the unzipped

archive for the adapter (in this procedure, shown as on the same server).

£
[_] To import jobs and transforms to Atrium:

1.

2,
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Open the Atrium Integrator Spoon tool.

Select File > Open URL..., navigate to and open C: \Program Files\Flexera\BMCAtriumAdapter\
FNMPExports\iimExportComputersTransform. ktr.

. Modify the connection strings for each of:

e Atrium_CMDB
« AR Server
¢ IntermediateDB.

Click File > Save.
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Repeat this procedure for each of the following files in the order listed:

1. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\it#ExportProductsTransform.ktr

2. C:\Program Files\Flexera\BMCAtriumAdapter\
FNMPExports\stExportComputerProductRelationshipsTransform.ktr

3. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\stsExportUpdatelntermediateDBTransform.ktr
4. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPImports\ Asset.ktr

5. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPImports\ ImportUpdatelntermediateDBTransform.ktr
6. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\FNMPExports.kjb

7. C:\Program Files\Flexera\BMCAtriumAdapter\FNMPExports\ Execute FNMP Export Tool.kjb

8. C:\Program Files\Flexera\BMCAtriumAdapter\BMCAtriumAdapter.kjb

Configure Atrium Jobs

FlexNet Manager Suite 2022 R1 (On-Premises)

Once you have completed the import of both tasks and jobs into the Atrium repository (as in Importing Atrium Jobs
and Transforms), you must configure the jobs, while still logged into Atrium Spoon, by linking them to transforms.

=
[_] To configure the jobs in Atrium:
1. Select  File > Open..., and select FNMPExports. k3jb from the repository.

A map of the transformations required for the job is displayed.

ExportProducts Transiom

r ET4

# - ExportUpdatointe me distoDE Trarsdom
o

EspanComputerFroductiRelssonships Trrmom

2. Right-click ExportComputersTransform, and from the context menu select Edit job entry.

The Job entry details for this transformation dialog appears. The transform name as recorded in the job entry
appears in the first field, Name of job entry.
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3. Select the Specify by name and directory option.

4. To provide a value in the associated field, browse the repository and select the transform name matching the first
field.

For example, when processing the job entry for ExportComputersTransform, select the transform of the same
name from the repository.

5. Click OK.
6. Repeat steps 2-5 for each of the remaining job entries in this chart:
e ExportProductsTransform.ktr
o ExportComputerProductRelationshipsTransform.ktr
e« ExportUpdateIntermediateDBTransform.ktr.
7. Select File > Save.
8. Select File > Open..., and select BMCAtriumAdapter.kjb from the repository.

A map of the job displays.

Pl |
I

D """ Setvariables Exscute FNMP Expiost Tool
START S
vl L
&
N *,
&
s LA

Success

Expcute Business Importer Import

9. Repeat steps 2-5 for the transform in this chart:

o Asset.ktr.
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11

12

13

14

15

16

17

The Executing a job dialog appears. The Job entry name appears as the first field.

Installing the Adapter

<! Executing ajob ..
lob entry name:  FNMPExports

Job specification . Advanced Logging settings  Argurment | Parameters

Job filename

[E=% EOR ==

@ Repository: specify by name FNMPExports|

fryserver_BMC.TEST3

Repository: specify by reference

I oK |[ Cancel l

12 <2
B o) [

. Select the Respository: specify by name option.

. To provide a value in the associated field, browse the repository and select the job name matching the first field.

. Click OK.
. Repeat steps 10-13 for the remaining job in this chart:
o Execute FNMP Export Tool.kjb.

. Select File > Save.

. Either press Ctrl-3J;or right-click the BMCAtriumAdapter diagram background, and from the context menu

select Job settings.

The Job properties dialog opens.

. lob properties

Job | Pararmeters - Settings | Log

Parareters :
w’ Parameter Default value Description
1 COMPANYMNAME TEST
2 COMPUTERQUERNID Computers
3 COMPUTERTABLEMAME ComputerSystern
4 DATASETID BRC TEST31
5 PRODUCTIDSQUERYID Productlds
£ PRODUCTQUERYID Products
7 PRODUCTTABLEMARE Product
8 TEMANTID 2

. Edit the following values:

COMPANYNAME Enter your company name as it is recorded in the CMDB. (A match is required.)

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)

143



Installing the Adapter

DATASETID Enter the ID for the dataset that you created for the adapter (see Reserving an
Atrium Dataset).

18. Select File > Save.

19. To configure email alerts for errors occurring on the Atrium side of the adapter:
a. Inthe BMCAtriumAdapter job, right-click on the Mail step in the center.
b. From the option menu, select Edit job entry.

The Job mail details dialog appears.

7 Job mail detailz = | = | [
Mame of meil job entry: Mail
Addrassas SQNQ;’_ EPRAail PAessage | Attachaed Filas |
Cimstination
Diestination address:  toaddressiisomedomain.com *
o >
ECc: g
Sender
Zander narna | MNaral &
Sender address:  toaddress@sormedarmain.comm . o
Feply to &
Contact persomn: =

Cortact phonel

l (ald J l Cancel ]

c. Inthe Addresses tab, insert the following:
« Destination address — the person who is to receive the email alert for each error.
* Sender name — the value to appear on the emails as the sender.

« Sender address — The email address from which the email will appear to come. This must be a valid

email account known to the mail server (specified next).
d. Switch to the Server tab, and complete the SMTP Server details.
e. Click OK.

20. Select File > Save.

Install the Business Importer and Link with
Remedy

FlexNet Manager Suite 2022 R1 (On-Premises)

The Business Importer performs parts of the integration work, writing data from Remedy into the FlexNet Manager
Suite database. The Business Importer is installed as part of the Business Adapter Studio, a stand-alone environment
you can use to build business adapters. These 'adapt' the format of data from other business systems in your computer
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estate for import into FlexNet Manager Suite, and are exercised by the Business Importer. You downloaded the installer
for the Business Adapter Studio in Obtaining the Adapter Components. To enable the business import process, you also
configure the reconciliation process to link with the Business Importer. Since the Atrium Integrator must trigger the
Business Importer, the normal architecture is to install the Business Adapter Studio on the Atrium server. In this
location, the business adapter for importing asset records must also be amended to update its access to the
compliance database.

[i] To install the Business Importer and link with Remedy:
1. Onthe Atrium server, navigate to the downloaded archive, and extract the Business Adapter Studio folder.
2. ExecuteBusiness Adapter Studio\setup.exe.
The installation wizard for Business Adapter Studio opens.
3. Complete the installation wizard using the default values it provides.

4. Use the Business Adapter Studio to update connection details for the asset business adapter for both output and
input:

a. On the Atrium server, launch the newly-installed Business Adapter Studio.
b. Do either of the following:

o Click the Openicon ( .f?) in the tool bar.

o From the File menu, click Open....

c. Navigate to the asset business adapter, by default located at C: \ProgramFiles\Flexera\
BMCAtriumAdapter\FNMPImports\FNMPImportDefinition\Asset.xml, and click Open.

d. Inthe navigation bar on the left, click the top-most node, labeled FlexNet Manager Platform

Database, to display the output connection properties for this adapter.

¥
= Tip: This node is visible only when the Business Adapter Studio isrunningon a server other

than an inventory beacon. (On an inventory beacon, the Business Adapter Studio takesthe
connection details from the inventory beacon, which already has them recorded.)

e. Inthe Database Connection panel, select Use the specific connection information below, and click the
ellipsis (...) at the right-hand end of the Connection String field to expose the Data Link Properties
dialog.

f. Edit the connection details so that they apply to your compliance database:

a. Forstep 1, enter the SQL Server instance name for your compliance database. Examples:

o IPv4address: 198.51.100.123

o The database server hostname: MyFNMSServer

» Anon-default database instance: 198.51.100.123\MSInst3
« Non-standard connection port: 198.51.100.123,5678

b. Supply the credentials for writing to the compliance database. If you are using an account specific
to your database server, choose Use a specific user name and password, and complete the
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account name and password in the next two fields.

c. For Select the database on the server, use the drop-down to choose your compliance database
(the default name suggested during installation was FNMSCompliance).

d. Click Test Connection, and rejoice at success (or remedy any issues until the connection succeeds).
g. Click OK to close the dialog.
h. Inthe left-hand navigation bar, click on the next row that names the adapter (Asset).

i. Inthe second panel, Connection and Query Properties, click the ellipsis (...) on the right end of the
Connection field to expose the relevant Data Link Properties dialog for the staging database.

j. Inthe Provider tab, select the database type (typically Microsoft OLE DB Provider for SQL
Server), and click Next.

k. Inthe same way as before, complete the details in the Connection tab, but this time for the staging
database, and validate your data with the Test Connection button.

L. Click OK to close the dialog, and save the updated adapter (Ctr1+S, or click the diskette icon in the
toolbar, or File > Save).

5. Login to BMC Remedy Mid-Tier using an account name and password provided by your BMC Administrator.

The IT Home page appears.

BMC REMEDY IT SERVICE MANAGEMENT
IT Home

Owerview Console

Shaw |An=gn=d Te Me =] Compary | -

1
E
g
§ Showing 0-0of 0
"

| Parent Request |0 | Request Type

Click here.

6. Click the Applications tab on the left boundary.

The Applications menu expands.
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BMC REMEDY IT SERVICE MANAGEMENT

IT Home

00

([20) G [« MHome

Guick Link=

;l Company L[

Atrium [ntegration Engine

AR System Administration

suoneddy

AR Sysiem Sample Application puest 1D | Request Type Bummary
Administrator Consale
Analyties

Asset Management

Change Management
Change Management Dashboarnd

Contract Management

Data Management

Foundation Elements
T Click here.
[T R Y F——
Requester Console

Retumn on Invesiment

7. Select Atrium Core, and in the sub-menu select Atrium Core Console.

The BMC Atrium Core Console window opens.

BMC Atrium Core Console

L =
o©
=
3]
=
=
©
_
c
e,
=t
©
L
=
o
<T

Click here

8. Click the Application Launcher tab on the left edge, then select Applications from the menu, and in the sub-
menu select Reconciliation.

The Reconciliation tab opens.
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BMC Atrium Core Console

Iﬁnonciliation
B [l

MYSERVER - Jobs
Sort On

Click here

[Name 'J [] Ascending

Atrium Explorer - Copy to Sandbox

Run Time:
Runs (Failed): 0 (0)
Activity Count: 1

Application Launcher

Source Dataset:

Target Dataset:

Atrium Explorer - Identification and Merge
Run Time:
Runs (Failed): 0 (0)
Activity Count: 2
Source Dataset:

Target Dataset:

9. Click the new job icon in the toolbar.

The Job Editor page appears.

Job Editor b4
MName # FNMP Aszet Recondlation ,‘_____‘-__ Status Active =
Sescrption 1 Fillin the name
Use standard rules for partiopating datasets |v]  Process normalzed CIs only ] Delete Tes on exit || Murriber of Job Runs to Retan in Logs =

Hew Ly (n] t

Create new activity

Scheduk I
Facay Satwntay

AL least one activity must be added to make this job maaningful.

Dissble Progress Bar in UT during Job Execution ]

10. In the Name field, provide a name for this job that you will recognize later.
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Suggested value: FNMP Asset Reconciliation.
11. In the Activities group, click New.

The Activities group changes to the Edit Activity area.

it Actity | Name the Activity | Uncheck

o # Aecon 1D Status | Active v Contrue: on Ermor

Hamespace Al Hamespaces - Type » Sedquanoe |50 =

Add the dataset Set the sequence
number
Gualification Additional Parameters.
Use ol dasses and instances |v] Production Dataset | B Asset v
Generate IDs ||
Exchude Subdasses ||

12. Complete the details for the first (Identify) activity:
a. Inthe Name field, provide a name you will recognize later.
Suggested value: Identify.
b. Ensure that the Continue on Error check box is clear.

Recall that the system is configured to send emails on any errors in exporting the assets to FlexNet
Manager Suite.

c. Setthe Sequence number to control ordering of activities in the job.
Recommendation: Number in hundreds to allow for later changes. Suggested value: 500.

d. Inthe Dataset Configuration area, click the first icon to add a new dataset, and select the one you created
for this exchange.

The suggested value was BMC. FNMS.
e. Click Done to save details of this activity.
The Activities group reappears, showing this first activity in the list.

13. Once again, in the Activities group, click New, and complete the details for a merge activity:

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition) 149



Installing the Adapter

Bt Activity Uncheck
Mame o |Merge ] States | Actwe v Contrue on Eror

1 s J -
Al \ - Type . Sequene

b
rn— Name the activity | e
R m 28 oty b
. 600 .
) BMCASS = BMC Asset ]
L] esc.ITSM,CLDATA "‘“\_ t. o)
L] B, Only select checkbox on [‘ 0| Select
] e “BMC.FNMS"” dataset | “BMC Asset” dataset J
=] =]
Qualfication Precedence Additional Parameters
Create a new precedence rule
= I"“"""""““""‘“"t’ﬂ‘fﬂl‘.”.FNI‘»‘1.'3,B|‘»'1[: AESEI:] [ Enchrle Lanchanged CTs
Frecedence Azsooabon ST Merge Ordeer
* | BC Defaudt Merge Precedence s |+ | @) ©) e | By class in separate bangactions | v

a. Add a Name for the activity.
Suggested value: Merge.

b. Ensure that the Continue on Error check box is clear.

c. Setthe Sequence number to a value higher than the identification step.
Suggested value: 600.

d. From the list of Source Datasets, select only the one identified in the previous activity.
The suggested value was BMC. FNMS.

e. From the list under Target Dataset, select the BUC Asset dataset.

f. Inthe Precedence group, click the +icon to add a new Precedence Association Set.
Suggested value: BMC. FNMS,BMC Asset.

g. Click Done to save details of this activity.

The Activities group reappears, showing your two activities.
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Job Editor x

Mame # FNMP Asset Recondliation Status Active v
Description

Use standard rules for particpating datasets (V]  Process normalized Cls only || Delete files on exit || Mumber of Job Runs to Retain in Logs | | - [ A
ame e sewvece s
Identify Identify 500 Actve

Merge Merge 600 Active

| Create new job schedule ‘

Schedule | Contiwous | New | ke |

Tome ey ™ Moy Tueadoy | Wedmedoy | Thwrey | Py |

" Disable Progress Bar in UL during Job Execution ]

(e |Gtlosed) (el

14. In the Schedule group, click New.
Set the values to suit your business processes, with a suggested frequency being once every 2-4 weeks.

15. At the bottom of the Job Editor, click Save to store your job details in the repository.

Tuning Creation of Configuration Items

FlexNet Manager Suite 2022 R1 (On-Premises)

Atrium requires an initial run to populate the database, and then customization for regular scheduled operations. In the
first run of the adapter, all the products and computers exported from FlexNet Manager Suite are inserted as
configuration items in the CMDB. Thereafter, matching records should be updated, and only new items inserted. We
therefore run the first pass with the default settings, and then modify the settings to schedule the regular data

exchange.

Iil To configure the creation process for configuration items:

1. In BMC Atrium Integrator console, from the list of Jobs on the left, choose the BMCAtriumAdapter job.

2. Inthe toolbar, click the third icon (with the play button) to run the selected job once.
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Click this to run the job one time

BMC Atrium Integrator

BRELSEER GE o J

Integration Job Details

History

Show all Job Runs With Status | All

|

As there may be a large backlog of data to handle, and Spoon processes a line at a time, the first import can be
quite time-consuming. Wait for the first import to complete successfully before continuing with this procedure.

3. InAtrium Integrator, update the way Atrium receives the export of computers as follows:

a. Open the ExportComputersTransform transformation from the repository.

b. Double-click the CMDBoutput step to expose its properties.

c. Clear (turn off) the Always Insert Cls check box.

d. Select (turn on) the Only insert new Cls check box.

e. Click OKto close the CMDBoutput step, and click Save to store the changes to the transform.
4. Update the processing of the export of products:

a. Openthe ExportProductsTransform transformation from the repository.

b. Double-click the CMDBoutput step to expose its properties.

c. Clear (turn off) the Always Insert Cls check box.

d. Click OK to close the CMDBoutput step, and click Save to store the changes to the transform.

Scheduling the Adapter

FlexNet Manager Suite 2022 R1 (On-Premises)

The adapter to exchange data between FlexNet Manager Suite and BMC Atrium is driven by a schedule set up in Atrium.

|j To configure the schedule for data exchange:
1. If you are not already in the Atrium Integrator console:
a. Login to BMC Remedy Mid-Tier using user name and password provided by BMC Administrator.

b. Click the Applications tab on the left edge.
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The Applications menu expands.
c. Select Atrium Integrator, and then click Atrium Integrator Console.

2. Inthe Jobs list on the left, select your BMCAtriumAdapter job.

el TR D e d

Integration Job Details

ob Runs With Status | Al w | AND StartDateBetween 05/
Source Typa:

Target Type:
Runs (Failed): 0 (0)
Average time: 00:00:00

BMCAtriumAdapter
Directory:
Source Type:
Target Type:
Runs (Failed):  0(0)
Average time:

First Select the Job on left
menu then click the tool bar
button on top to set the
schedule.

1 [

=L
3. Inthe tool bar, select the icon to manage the job schedule (l‘g).
4. Select Active.

5. Select the Create new schedule option.

The Schedules - "BMCAtriumAdapter" page appears.

Schedules - "BMCAtriumAdapter” x

(_) Edit Existing Schedule (=) Create New schedule Enter Schedule Name
(V] Active CarteServer | v Start Time T@ 5_@ M| v
Recurrence Type Recurrence Details
(») Once
() Daily
() Weekly

() Interval Based

Send faied

== JI Cancel || Delete || Help I

|

6. Complete the details for the regular operation of the adapter (this schedule controls data flow both ways, for
import and export):
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a. Give the schedule a meaningful name in the top right corner (Enter Schedule Name).

b. Use the Start Time spinners to dial up the time of day to start operation of the adapter.

7
=" Tip: This is local time on the BMC Remedy AR System server.

c. Inthe Recurrence Type area, specify how frequently you want the job to run.

Recommendation: The process is quite time-consuming. In a stable environment, consider a monthly
data exchange (Interval Based).

d. Dependingon your choice, complete the Recurrence Details.
e. Click Save.

The integration between FlexNet Manager Suite and BMC Atrium is now operational.
However, before the next scheduled run, you should consider any further customization that may be necessary,
especially in relation to large data sets.

Verifying Data Export to BMC Atrium

FlexNet Manager Suite 2022 R1 (On-Premises)

This process confirms that data has been exported from FlexNet Manager Suite and successfully imported by Atrium.
This procedure uses the Atrium Core application (not Atrium Integrator).

[i] To verify successful data transfer into Atrium:
1. Ifyou are not already in the Atrium Core console:
a. Login to BMC Remedy Mid-Tier using user name and password provided by BMC Administrator.
b. Click the Applications tab on the left edge.
The Applications menu expands.
c. Select Atrium Core, and then click Atrium Core Console.
A new window opens with the Application Launcher tab on the left edge.

2. Click the Application Launcher tab, and in the fly-out menu, click Applications.
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Click here

i
o
=
3}
c
=
©
=3
=
2
=
©
2
o
a
=

3. Inthe sub-menu, click Explorer.

The Explorer tab opens, with multiple accordion folds. Ensure that the Find fold is open.
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4. Inthe Find area, use the drop-down list on the left below the tool icons to select the BMC. FNMS dataset.

5. Optionally choose an object type to search for, or expand the Quick search of all Cls.

6. Optionally, add data (or partial values) to the Name and Short Description fields (and controls for matching) to
narrow the search for particular configuration items, or leave the fields blank for a full listing of all results.

7. Click Search.

Alist of results (shown inset) displays. Validate that the data is as expected.
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Additional Customization of the
Adapter

FlexNet Manager Suite 2022 R1 (On-Premises)

The following notes help with minor changes to configuration, especially for future changes to configuration. The one
case that may be critical to your initial implementation is the first topic, covering preparations for large datasets.

Preparing for Large Datasets

FlexNet Manager Suite 2022 R1 (On-Premises)

Large numbers of data records require a customized environment variable. If your integration between FlexNet
Manager Suite and BMC Atrium will exchange large numbers of records (for example, 100,000 computer records or
more), you need to configure an environment variable on the Atrium server.

=
[_] To prepare for large datasets:

1. Ensuring that you are logged onto the Atrium server with Administrator privileges, open the Windows start menu,
and right-click Computer.

2. From the context menu, select Properties.
The Control Panel page of system properties appears.
3. Inthe navigation bar, select Advanced system settings.
The System Properties dialog appears. Confirm that the Advanced tab is selected.
4. Click Environment Variables....
The Environment Variables dialog appears.
5. Inthe System Variables (lower) group, click New....
The New System Variable dialog appears.

6. Insertthe Variable name:
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_JAVA_OPTIONS

7. Insert the Variable value:

-Xms512m -Xmx15360m

This configures the Java heap size above 15GB.

8. Click OK three times to close the various dialogs, and you can close the Control Panel window.

Updating Connection Details

FlexNet Manager Suite 2022 R1 (On-Premises)

When system passwords change, you need to update the adapter's configuration file. Connection details are stored,
encrypted, in the adapter's configuration file (by default located at C: \Program Files\Flexera\
BMCAtriumAdapter\ FNMPExports\Utility\ FNMPDataExportUtility.exe.config on the Atrium server).
The encryption process happens the first time the adapter runs after the configuration file is edited. Once the process
has run, the connection strings are unreadable and not editable, something similar to the following:

<connectionStrings configProtectionProvider="DataProtectionConfigurationProvider">
<EncryptedData>
<CipherData>
<CipherValue>AQAAANCMNnd8BFAERjHOAWE /C1+sBAAAAeNhcGMAVKOUVGNTq
0g/WbQQAAAACAAAAAAADZgAAWAAAABAAAACTO9kpn6BptpLysXExg1UBAAAAAASAAACEA
AAAEAAAAELCyiwz5AXZWOXZXFEPiAAAAgAAPIQYe+GOATScFMITYgAONDbAgZdRA9NBI1
DN42A1xjeCskUs9+KNjVU1PSFRV4ujtad0evf3I0Zy50dyHsIrIJRCKOOGdhDb1wh4ISEK
pJk/QDna6LeCbbtXXsQK2LoAHQc/plz77UkQZxnxkL5E1PIGH16A0jEXT2F5NGJE1IX6G
XbUXQDKNnDf1i206XI/CDbX8gCuMonY1cTLYGe6+AQPpDgcY3rA02ZF0s7/ZbocKOw7IoZ
dB6H80IvrC1SzgNkVBd3YFfLhP/KOrkQFP8orqj54BIW74E1v3VUZntelESgLASMYb/F9A
h3M5x12Q6ITXOQMVRGESrivsdqrényGz5APx2yVBUEcoVhpOMYURbEbBSW+6/aydg8nY1
DrcMzkP1XiZ@CQs4yZYHSWt3+bFEN30xh6XKFH7Tpc8e5y9TqlBhwk+Kw6AFfZhcdewAp
JAZkGAr4ixE6gNgWXnomk2puKNFImhJIfqLLIuQx9T00Uu2bjJI9Y+dUlrcuov12hQX0Ch9
nqOdmeIQHPXgw8//eHYOzwy2TgMcq2M2LxXRbQqCTeWt1PlucIVyct9gnJI1k2L3FSBNgM
ulCOmncR7MsGDBWoQMXnwC5+Y6P1GT45sP0edBQVIQITj7MCuzfgDD1R9c7wlgejTGmrl
3Kmf33tGPMRYPV7CPNET3DUVOAGQUAAAAATIEkjyqfExrbeiYIvG2usqYO3Nk=</CipherValue>
</CipherData>
</EncryptedData>
</connectionStrings>

3
U To replace connection strings and/or passwords:
1. Open the adapter's configuration file in a flat text (or XML) editor.

Default location: C: \Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\
FNMPDataExportUtility.exe.config

2. Locate the connectionStrings element (similar to that shown above), select it all, and delete it.

3. Copy the following example, paste into the same place in the configuration file, and replace the placeholder
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values (including their containing brackets) as described below (you may also remove the white space from the
connection strings):

<connectionStrings>
<clear />
<add name="FNMPDBConnection"
connectionString="Data Source=[FNMPDBServerName];
Initial Catalog=FNMSCompliance;
User ID=[accountNamel];Password=[somePassword];
Integrated Security=false;
Connection Timeout=60;"/>
<add name="IntermediateDBConn"
connectionString="Data Source=[intermediateDBServerName];
Initial Catalog=IntermediateDB;
User ID=[accountName2];
Password=[anotherPassword];
Integrated Security=false;
Connection Timeout=60;"/>
</connectionStrings>

where:

Placeholder Notes

[FNMPDBServerName ] The database server (and optionally, the database instance name) containing the
FlexNet Manager Suite compliance database. You may use:

o Adot (.) when the database is installed on the same server where the adapter

executable runs
¢ The flat name of the server
¢ TheIP address of the server

o Where the database instance is not the default instance on that server, any of
the above with a slash (/) separator, and the database instance name.

FNMSCompliance This is the recommended database name for the compliance database. If you
used a different name, substitute the name you used.

[accountNamel] The user name that the executable uses to connect to the compliance database.
[ somePassword] The (newly current) password for the above account.

[intermediate The database server (and if necessary, instance) for the intermediate database.
DBServerName] The same formats are supported as described above for [ FNMPDBServerName].
[accountName2] The user name that the executable uses to connect to the intermediate database.
[anotherPassword] The password for [accountName2].

4. Save the edited configuration file.
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Thefile is saved in plain text. The next time the adapter runs, this section of the configuration file is automatically
encrypted. If you are unhappy about leaving the file unencrypted until then, trigger an additional run of the
adapter by adding a one-time schedule (see Scheduling the Adapter).

Updating Email Details

FlexNet Manager Suite 2022 R1 (On-Premises)

With data flows in both directions between FlexNet Manager Suite and BMC Atrium, errors may occur in either export or
import. The adapter sends emails to inform you when an error occurs. The emails for the two directions are defined

separately:

For export from FlexNet Manager Suite, the data export utility generates the emails, with settings in its configuration
file. If the details of your email server are changed, you need to update the adapter's configuration file. It also
defines who receives the alerts, and the address from which alerts originate. You can modify any of those detail with

this procedure.

Similarly, for imports from BMC, the email is generated by Atrium based on settings in that system. Those settings
are also summarized in this procedure, since it is likely that a change in your infrastructure or personnel affects both

kinds of email alerts equally.

We start with emails for exports from FlexNet Manager Suite; and then continue with those for imports to the same
system (that is, data is exported from BMC Atrium).

|j To update email details:

1. Open the adapter's configuration file in a flat text (or XML) editor.

Default location: C: \Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\
FNMPDataExportUtility.exe.config

2. Locate the <appender> element for the SmtpAppender node in the file and update the settings marked here

with placeholders:

<appender name="SmtpAppender" type="logdnet.Appender.SmtpAppender">
<to value="toaddress@somedomain.com"></to>
<from value="fromaddress@somedomain.com"></from>
<subject value=" Atrium Integration Adapter Error"></subject>
<smtpHost value="smtp.somedomain.com"></smtpHost>

where:
Value Notes
toaddress Valid email address for the person who is to receive alerts when errors occur
@somedomain.com during export.
fromaddress Valid email address for an account known on the specified SMTP host that is
@somedomain.com identified as the sender of the email when an error occurs.
smtp.somedomain.com The fully qualified domain name of the SMTP email server.
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3. Save the edited file.
4. Open the Atrium Integrator Spoon tool.

5. Select File > Open..., and select BUCAtriumAdapter.kjb from the repository.

A map of the job displays.
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6. To configure email alerts for errors occurring on the Atrium side of the adapter:
a. Inthe BMCAtriumAdapter job, right-click on the Mail step in the center.
b. From the option menu, select Edit job entry.

The Job mail details dialog appears.
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c. Inthe Addresses tab, insert the following:
« Destination address — the person who is to receive the email alert for each error.
« Sender name — the value to appear on the emails as the sender.

« Sender address — The email address from which the email will appear to come. This must be a valid

email account known to the mail server (specified next).
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d. Switch to the Server tab, and complete the SMTP Server details.

e. Click OK.

The revised email settings for data transfer in both directions take effect for the next run of the adapter.

Turning Off Email Alerts for Export Errors

FlexNet Manager Suite 2022 R1 (On-Premises)

You can disable email alerts for problems arising during export from FlexNet Manager Suite. This procedure provides a
quick way to temporarily disable emails sent by the data utility during data export from FlexNet Manager Suite for
transfer to BMC Atrium. This procedure turns the emails off without removing the settings details.

2]

' Tip: For emails generated by BMC Atrium about data preparation for import to FlexNet Manager Suite, there is no
single "off switch". To stop those emails, re-do the settings to remove the email details (as described in Updating
Email Details).

3
U To turn off email alerts:
1. Open the adapter's configuration file in a flat text (or XML) editor.

Default location: C: \Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\
FNMPDataExportUtility.exe.config

2. Locate the following section (towards the end of the configuration file):

<root>
<level value="ALL" />
<appender-ref ref="RollingFileAppender" />
<appender-ref ref="SmtpAppender" />
</root>

3. Comment out the appender-ref element for the SmtpAppender:
XML comments are surrounded by <! -- -->:

<root>
<level value="ALL" />
<appender-ref ref="RollingFileAppender" />
<!-- appender-ref ref="SmtpAppender" / -->
</root>

4. Save the amended file.

Email alerts for export errors are suspended until you reverse this process, re-editing the file to remove the comment
tags and restored the original value.
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Changing the Log File

FlexNet Manager Suite 2022 R1 (On-Premises)
You can rename or relocate the log file generated by the adapter for exports from FlexNet Manager Suite.

By default, five copies of the log file, each capped at 10MB, rotate in the nominated folder (total disk space requirement
is therefore about 50MB for logging). You can customize the location and base name of the log file as follows:

o
U To rename or relocate the log files:
1. Open the adapter's configuration file in a flat text (or XML) editor.

Default location: C: \Program Files\Flexera\BMCAtriumAdapter\ FNMPExports\Utility\
FNMPDataExportUtility.exe.config

2. Locate the following section in the file:

<appender name="RollingFileAppender"
type="1logdnet.Appender.RollingFileAppender">
<file value="C:\Program Files\Flexera\BMC Atrium Adapter\Log.txt" />

</appender>
3. Editthe value attribute with the new path and file name.
.rf-'..

' Tip: Keep in mind that the file name will be expanded with dating information to differentiate the various

logs.

4. Save the modified file.
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Appendices

FlexNet Manager Suite 2022 R1 (On-Premises)

The following topics provide data mapping between attributes recorded in the FlexNet Manager Suite database and
those recorded in the BMC Atrium CMDB. In addition, some values are generated as part of the export and import
processes, and are included in the following listings.

Two separate data objects are exported from FlexNet Manager Suite: Computers, and Products. A much smaller
dataset is imported from Atrium into FlexNet Manager Suite, updating information about assets to show their role and
owner.

Appendix 1: Export of Computers

FlexNet Manager Suite 2022 R1 (On-Premises)

For optimal performance, exports are differential (that is, only data changed since the last export is included). The
following table shows:

o Columns from the ComplianceComputers table (and related tables) in FlexNet Manager Suite that are exported

o The equivalent column name in the ComputerSystemChanges table of the intermediate database (in case you wish

to inspect the dataset there)

» The matching column in the BUC_ComputerSystem table in the Atrium CMDB.

D Note:

1. Some values are not read from the source database, but inserted as fixed values. These are shown in double
quotation marks, and explained in the associated comments.

2. Some values exported from FlexNet Manager Suite to the intermediate database are not transferred to BMC
Atrium. Instead, they are used to manage the exported data, removing records not relevant to the CMDB and so
on.
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Not applicable. GeneratedTokenID  TokenID TokenID takes different formats for
different types of computers. In the
following examples, the placeholder X
represents any hexadecimal digit (0-9, A-
F).

o For physical hosts and computers, the
TokenIDis

hostname : DNSdomainName.

o For some virtual machines, TokenID
takes the form of a prefix, a colon, and
a UuID:

o ForVMware, VI-
UUID : XXXX-XX-XX-XX-XXXXXX

o For Hyper-V, HYPERV -
ID : XXXX-XX-XX-XX-XXXXXX

D Note: With Hyper-V, the UUID is
only available on the physical
machine, so TokenId is only set
for virtual machines that have
been successfully linked to their
hosting physical machines.

o For Xen (including Oracle VM), XEN-
ID : XXXX-XX-XX-XX-XXXXXX

o For KVM (including RedHat
Enterprise Virtualization), KVM-
ID : XXXX-XX-XX-XX-XXXXXX.

TokenID is generated dynamically,
checking the value in ComputerType.
For virtual machines, the value in
ComputerToVirtualMachine_
VMTypeID is used to determine the
prefix, and the UUID is attached from
ComputerToVirtualMachine UUID.

Compliance ComputerID CITag The identifier for the computer in the

ComputerID FlexNet Manager Suite database, passed
to BMC as the configuration item tag.
(This is passed back again if Asset records
are imported by FlexNet Manager Suite.)
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ComputerName ComputerName

“DNS”

[ComplianceDomain] Domain
QualifiedName

[ComplianceDomain] FlatDomain
FlatName

HostName

Name Format

Domain

Domain

Appendices

Comments

The name of the computer, limited to 256
characters.

A fixed string value determining the data
type for Name.

The fully qualified domain name for the
domain where this computer exists.
Extracted from
ComplianceDomain.QualifiedName
using ComplianceComputers.
ComplianceDomainID as a foreign key.
Used when there is no value for
FlatDomain received from FlexNet
Manager Suite.

The unqualified name of the domain
containing the computer. Extracted from
ComplianceDomain.FlatName using
ComplianceComputers.
ComplianceDomainID as a foreign key.
Where this value is present, it is stored in
BMC_ComputerSystem.Domain; if not,
the qualified domain name is used
instead.
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[Compliance ComputerStatus (Not stored.) The current status of this computer within
ComputerStatus] the inventory records. Values include:

Defaultvalue  Neuw (this is the first appearance of this

computer in inventory)

« Ignored (an operator has marked this

computer to be ignored)

o Registered (thisinventory record is

linked to an asset record)

o Awaiting Inventory (adummy
computer record, allowing its
associated asset record to exist, which
will be removed when an operator
links the asset record to a real
inventory item)

Discarded.

These values are extracted from
ComplianceComputerStatus.
DefaultValue based on the foreign key
ComplianceComputers.
ComplianceComputerStatusID.

F

('a' Tip: The DefaultValue is the US
English representation of the values,
not localized.

The status is used to make sure that
computers that are Awaiting
Inventory,Discarded, or Ignored
are not transferred to BMC Atrium.

Not applicable. "Workstation" Capabilitylist Fixed literal string inserted in the BMC
Primary database.

Capability
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[Compliance
ComputerType]
DefaultValue

InventoryDate

Manufacturer

SerialNo

[VirtualMachine]
Compliance
ComputerID

[VirtualMachine]
UUID

ComputerType

InventoryDate

Manufacturer

SerialNo

ComputerTo
VirtualMachine_
Compliance
ComputerID

ComputerTo
VirtualMachine_
UUID

isVirtual

(Not stored.)

ManufacturerName

SerialNumber

(Not stored.)

(Not stored.)

Appendices

Comments

The boolean isVirtual is set true
whenever the ComputerType in the
intermediate database is either VMHost
orVirtual Machine. Possible values
are extracted from
ComplianceComputerType.
DefaultValue based on the foreign key
ComplianceComputers.
ComplianceComputerTypelD.

The date inventory was last collected
from this computer.

Values from FlexNet Manager Suite are
provided to avoid data normalization by
the CMDB that may modify names.

The serial number of the computer.

Populated only for virtual machines. A
foreign key that links records in the
VirtualMachine table to the matching
records in the ComputerCompliance
table. Used here in the calculation of
TokenID.

Populated only for virtual machines.
The UUID (Universally Unique Identifier)
of the virtual machine. Used to match
virtual machine properties to their
associated ComplianceComputer.
Used here in the calculation of TokenID
for virtual machines.
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[VirtualMachine] ComputerToVirtual (Notstored.) Populated only for virtual machines. A

VMTypeID Machine_ VMTypeID foreign key to the VMType table, which
identifies the kind of virtual machine,
including:

* VMware

¢ Hyper-V
« LPAR

« WPAR

¢ nPar

e VvPar

*« SRP

e Zone

o Unknown.

Used here in the calculation of TokenID.

Not applicable. UpdatedDate (Not stored.) Used when identifying changed data for
differential exports to BMC Atrium.

Compliance Compliance (Not stored.) This value is used to filter out remote

Computer TypelD Computer TypelD devices (those from which inventory

cannot be collected) and VDI templates,
which are not relevant to the CMDB.

Not applicable. ViewID (Not stored.) Deprecated and not in use.

Not applicable. TenantID (Ignored.) Always contains a zero value (a string of
16 zeroes) for an on-premises
implementation.

Not applicable. “BMC_ ClassID Fixed literal string inserted in these
COMPUTERSYSTEM” records to identify the data class in the
data set.

Not applicable. "CompanyName" Company A fixed value that must match the
company identifier embedded in the
Atrium CMDB.

Not applicable. "DataSetID" DataSetID Value attached to the dataset considered.
Must match the value embedded in the
Atrium CMDB.
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Appendix 2: Export of Applications/
Products

FlexNet Manager Suite 2022 R1 (On-Premises)

The term 'product’ is used in two slightly different ways in FlexNet Manager Suite and BMC Atrium.

* In FlexNet Manager Suite, the base unit of software is called an "application", which is specific to a particular release
(version) and edition. A 'product' is the same software unit, but across multiple versions (and perhaps editions as
well). In our terms, then, FlexNet Manager Suite exports application records. To confuse things further, the
underlying database table is called SoftwareTitle.

e InAtrium, a "product"” is the base unit of software, and related to an individual installation. The CMDB also offers a
catalog of the products available for installation. In BMC terminology, Atrium imports product records, from which
the Product Catalog may also be updated.

The following table shows:

o Columns from the SoftwareTitle table (and related tables) in FlexNet Manager Suite that are exported

¢ The equivalent column name in the ProductChanges table of the intermediate database (in case you wish to

inspect the dataset there)

e The matching column in the BUC_Product in the Atrium CMDB. This indirectly populates the Product Catalog.

D Note:

1. Some values are not read from the source database, but inserted as fixed values. These are shown in double
quotation marks, and explained in the associated comments.

2. Some values exported from FlexNet Manager Suite to the intermediate database are not transferred to BMC
Atrium. Instead, they are used to manage the exported data, removing records not relevant to the CMDB and so
on.

Not applicable. GeneratedTokenID ParentCITag The token ID generated for the
computer system on which this
product is installed is assigned to the
ParentCITag column in BMC. For

details about the generated
TokenID, see Appendix 1: Export of

Computers.

SoftwareTitleID ApplicationID (Not stored.) Used internally in data management.

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)

169



Appendices

FullName

[SoftwareTitle
Version]
VersionName

(Generated ID)

170

ApplicationName

ApplicationVersion

FlexeralD

ShortDescription

MarketVersion

TokenID

By default, the full name of the
application is the concatenation of
the product, version, and edition
fields (for example, “Microsoft
Office Professional 2010”).
However, an operator may
overwrite this with any preferred
value.

The marketing version number (such
as "2010"). Extracted from
SoftwareTitleVersion.

VersionName using
SoftwareTitle.
SoftwareTitleVersionID asa
foreign key.

FlexeralD is a unique identifier for
application records used for
unambiguous identification across
various Flexera solutions. The format
is either:

» Forapplications published in the
FlexNet ARL, arl://MGS-
APP-00000000000 (where the
11-digit number varies by
application)

o Forapplications defined locally,
app://serverGUID/LOCAL-
APP-SoftwareTitleID (where
serverGUID depends on the
identity of the central application
server, and SoftwareTitlelIDis
the value of SoftwareTitleID

assigned to this application).

The result is presented as the
TokenID inthe BMC_Product table,

and as SignatureID inthe Product
Catalog.
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[SoftwareTitle
Publisher]
PublisherName

[Compliance
Computer]
ComputerName

ComputerID

[Compliance
Connection]
LastImportDate

CategoryID

Publisher

ApplicationTo

Installation_

ComputerName

InstallationTo

Computer_
ComputerID

InstallationTo

Computer_
InventoryDate

InstallationTo

Application_
Category

ManufacturerName

SystemName

(Not stored.)

(Not stored.)

Category

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)

Identifies the company that
produces the application/product
(for example, “Microsoft”).
Extracted from
SoftwareTitlePublisher.
PublisherName via
SoftwareTitleProduct.
SoftwareTitlePublisherID,
using SoftwareTitle.
SoftwareTitleProductIDasa
foreign key.

Name of the computing device
reported in inventory (such as
“vincent-Itp”). Extracted from
ComplianceComputer.
ComputerName using the foreign key
InstalledSoftware.
ComplianceComputerID. The view
InstalledSoftware isitself linked
to the application by the foreign key
SoftwareTitleID.

The computer identifier, extracted in
much the same way as described for
ComputerName. Used internally for

data management.

The date of the most recent
inventory collection that recorded
the installation of this application on
the current computer. When no other
value is available, this defaults to the
date of data export from FlexNet
Manager Suite. Used internally for
data management.

First level of application
categorization.

The full path of categorization is
extracted from the GroupEx table
using SoftwareTitle.
CategoryID as the foreign key. The
full path is then broken up on its /
separators, and the first level is
passed to Category in the
BMC_Product table.
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CategoryID

CategoryID

Not applicable.

Not applicable.

Not applicable.

Not applicable.

Not applicable.

Not applicable.

Not applicable.

Not applicable.

Not applicable.

Not applicable.
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InstallationTo
Application_
Category

InstallationTo
Application_
Category

ViewID

TenantID

EvidenceVersion

“BMC_PRODUCT”

"CompanyName"

"DataSetID"

Ful LName:VersionName

“ProductName:
Version®

Ful LName on
ComputerName

“Deployed”

Calculated value

Type

Item

(Not stored.)

(Ignored.)

ClassID

Company

DataSetID

Name

NameFormat

Description

Status

MarkAsDeleted

Second level of application
categorization. (See Category for
details.)

Third level of application
categorization. (See Category for
details.)

Deprecated and not in use.

Always contains a zero value (a string
of 16 zeroes) for an on-premises
implementation.

Deprecated and not in use.

A string literal that identifies the
class in the BMC dataset.

A fixed value that must match the
company identifier embedded in the
Atrium CMDB.

Value attached to the dataset
considered. Must match the value
embedded in the Atrium CMDB.

Full name separated by a colon from
the market version of the software
product (for example, “Microsoft
Office Professional:2010”).

A string literal describing the format
of the Name attribute.

Composite of the software name and
device name (such as “Microsoft
Office Professional 2010 on vincent-

Itp”).

A fixed value, since the records are
extracted from the installed software
listings.

Boolean (0 = no, 1 =yes). Whether or
not this product has been deleted
from the computer system under
consideration. Note that this flag is
raised only for the first import after
the product is deleted; thereafter,
further imports do not contain this
row.
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Appendix 3: Import of Assets

FlexNet Manager Suite 2022 R1 (On-Premises)

The following table shows:

o Columns from the BMC_ComputerSystemview (and AST : ComputerSystem form) in Atrium CMDB that are

exported

o The equivalent column name in the Assets table of the intermediate database (in case you wish to inspect the

dataset there)

» The matching columns in the FlexNet Manager Suite database where this information is imported.

Reconciliation
Identity

Domain

HostName

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)

Reconciliation

Identity

DOMAIN

HostName

Not stored.

[ComplianceDomain]
QualifiedName and

FlatName

ComputerName

Used internally to link the
BMC_ComputerSystem view and
AST:ComputerSystem form.

The domain extracted from BMC
Atrium is processed to provide a dot-
separated qualified name in the form
flexerasoftware.com. The same
value is processed again to provide a
flat domain name (such as
flexerasoftware). Where these
values match existing entries in the
ComplianceDomain table, no
further action is taken with them
(other than to return the
ComplianceDomainID key); but
where they are not already known,
they are added to this table for use in
FlexNet Manager Suite.

As well, the ComplianceDomainID
value returned form this update is
then written into the
ComplianceComputer record,
which may update the domain for
the current computer.

The name of this computer. Based on
a matching
ComplianceComputerID, thisvalue
may be over-written with the value
imported from Atrium.
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CITag CITag Compliance The identity for the computer record.
ComputerID Where this matches an existing
record, its other columns may be
updated. Otherwise, a new record is
created for ComplianceComputerin
FlexNet Manager Suite.

Instanceld Not stored. Deprecated and not in use.

ImportLog table LastImportDate Not stored. Calculated from data in the
ImportLog table.

[AST: System Role Custom property Role  Both systems record roles for servers,
ComputerSystem] in the Details tab (User  but the FlexNet Manager Suite role
System Role group) of the has various licensing implications,

inventoried computer and so is not updated by imports

properties. from Atrium. Instead, a read-only
custom field is added to FlexNet
Manager Suite to accept the asset
role for each BMC_ComputerSystem.
The role is displayed in the Details
tab of the computer properties.
Values include:

« Lab

« Development
o SIT

o UAT

e Training

e Performance
« Contingency

e Production.

[AST: Reconciliation Not stored. Used internally to link the
ComputerSystem] Identity BMC_ComputerSystem view and
Reconciliation AST:ComputerSystem form.
Identity

[AST: Assigned To AssignedUserID The ID associated with
ComputerSystem] ComplianceUser.UserName,
Assigned To written here to link the

ComplianceComputer to the user
record.
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[AST:
ComputerSystem]
Owner_name

[AST:
ComputerSystem]
AssetlLifecycle
Status

[AST:
ComputerSystem] DNS
Host Name

[AST:
ComputerSystem]
Domain

[AST:
ComputerSystem]
Instance Id

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)

Modified Date

Owner_name

AssetLifecycle
Status

DNS Host Name

Domain_1

Instance Id

Not stored.

[ComplianceUser]
UserName

Compliance
Computer StatusID

Not stored.

Not stored.

Not stored.

Appendices

Deprecated and not in use.

The full name of the user assigned to
this computer. FlexNet Manager Suite
defaults to a concatenation of title,
first name, middle name, last name
and suffix, so any of these parts may
be present, based on the record in
BMC Atrium. Where this matches an
existing user record, no further action
is taken with it; otherwise a new user
record is created. In either case, the
ID for this user is returned, and
written into the AssignedUserID
column.

L Tip: Beware of small changes in
record data from Atrium causing
near-duplicate records to
represent the same person. Also
note that when new records are
created, you may wish to update
additional details about this
person in FlexNet Manager Suite.

Atranslation of the BMC Atrium
status values into the nearest
equivalent status value supported in
FlexNet Manager Suite. This is then
mapped by the Business Importer
into the correct ID for the status value
before being written into the
ComplianceComputer record.

Host name from the
BMC_ComputerSystemisused in
preference to this one.

Domain from the
BMC_ComputerSystemisused in
preference to this one.

Used internally.
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[AST: Data Set Id Not stored. Used internally.
ComputerSystem]
Data Set Id
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Amazon Connector

FlexNet Manager Suite 2022 R1 (On-Premises)

This part introduces the Amazon connector, with a particular focus on managing licenses that you provide for software
used in the cloud (often called "bring your own [software] license", or BYOL). The complementary case, where you
purchase instances fully provisioned by Amazon Web Services (including the provision of relevant licenses), is of less
interest to your license management team, and is perhaps more the focus of your finance team.

The Amazon connector serves two main, and closely related, purposes:
o It tracksinstances (typically, virtual machines that are tracked as inventory devices) that are hosted for you in the

Amazon Elastic Compute Cloud (EC2)

« It performs discovery of Oracle Database installations in Amazon Relational Database Service (RDS). From the data
uploaded from the Amazon connector, FlexNet Manager Suite automatically creates both discovered device and
inventory device records. The discovered device records allow you to target those Oracle Databases for direct inventory
collection; and the database inventory is combined with data received from the connector to provide licensable results

for your matching inventory device records.

In relation to EC2 instances, the Amazon connector is only a part of a complete BYOL management strategy for this cloud
service provider. By itself, the Amazon connector does not gather sufficient data to allow for license management: for
example, it does not gather software inventory for the applications that are running on your cloud-hosted devices.

For that reason, this part covers more than the Amazon connector itself. As well as details of prerequisites, set up, and
data gathering with the Amazon connector, the part includes some insights into:

» Processes for gathering complete hardware and software inventory for your EC2 instances
» Considerations for license management

» Preparing different Amazon Machine Images (AMI) from which to launch instances capable of reporting software and

hardware inventory.

In fact, using those guidelines, you could configure inventory gathering in AWS EC2 without using the Amazon connector
at all. Provided that you are deploying the latest FlexNet inventory agent (13.2.x or later), inventory alone even identifies
the cloud service provider. What the Amazon connector adds is:

» Automatically setting the Hosted in property in the inventory device records created when inventory is returned

* Adding the cloud service provider and instance details when these are missing from inventory collected by legacy
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versions of FlexNet inventory agent, or from third-party inventory sources

o Populating the Cloud Service Provider Inventory page with records of instances currently running in your AWS EC2
environment, including a few properties that are additional to the normal hardware and software inventory

* Importing permanent records of instances that were previously running but that have now been terminated (and for
which, as a result, any prior inventory devices records have now been deleted)

« Triggering automatic deletion (completed at the next fullimport and compliance calculation) of any inventory device
record linked to an instance that is now terminated

» Discovering Oracle Database installations in Amazon RDS.

This part focuses on background about the Amazon connector, and additional material you need in order to build license
management around the Amazon connector. You will not find details about how to choose the right connection method
for your business processes (there are three methods available), or how to undertake the actual connection here. Instead,
step-by-step instructions for configuring the connection to AWS EC2 are available in the online help at FlexNet Manager
Suite Online Help > Inventory Beacons > Inventory Systems Page > Connecting to External Inventory Systems >
Managing PowerShell Connections > Managing AWS Connections.
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Prerequisites and Setting Up

FlexNet Manager Suite 2022 R1 (On-Premises)
The Amazon connector is configured on a convenient inventory beacon, for which there are the following prerequisites:

e PowerShell 3.0 or later is running on Windows Server 2008 R2 SP1 or later, or Windows 7 SP1 or later; with the

PowerShell execution policy set to RemoteSigned.

=3

=] Note: If you choose to install AWS . Tools.Common, which is the modular collection where you can install individual
AWS Tools for PowerShell, the minimum version is increased to PowerShell 5.1 or later.

* .NET Framework 4.7.2 or newer is required.

o The FlexNet Beacon software installed on the inventory beacon must be release 13.1.1 (shipped with FlexNet Manager
Suite 2018 R2) or later.

o Theinventory beacon must have Internet access to the central application server for FlexNet Manager Suite, so that it
can upload inventories and download policies.

* A web browser is installed and enabled on the inventory beacon.
« You must log onto the inventory beacon, and run FlexNet Beacon, using an account with administrator privileges.

¢ You must have downloaded AWS Tools for PowerShell from https://aws.amazon.com/powershell/, and installed them
on the inventory beacon. The minimum required version of these tools is 3.3.283.0.

¥
= Tip: To check the version installed on your inventory beacon:

1. As administrator, run PowerShell.
2. Execute the Get-AWSPowerShel LVersion cmdlet.

New versions are available for download from https://aws.amazon.com/powershell/.

=]
I=| Note: The permissible values for Instance region are currently hard coded in the AWS Tools for PowerShell. This
means that if AWS create additional regions, and you want to have instances in one of the new regions, you will

need to update AWS Tools for PowerShell at that time.

From release 2.0.0 of the PowerShellGet cmdlet (which allows you to Install-Module), the Scope option
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defaults to CurrentUser. Unless you are installing the modules using the account that normally runs your FlexNet

Beacon and triggers the AWS connector, you must specify the non-default value of A11Users, such that the inventory

beacon's operating account (typically SYSTEM) can run the connector. Example command lines for installation are:

o For the modular AWS Tools for PowerShell (requires PowerShell 5.1 or later):

PS> Install-Module -Name AWS.Tools.moduleName -Scope AllUsers

¥

Tip: Repeat this instruction amended for each of the required modules. The modules needed to run the
connector include:

AWS.

AWS.

AWS.

AWS.

AWS.

Tools.Common
Tools.EC2

Tools.S3
Tools.SecurityToken

Tools.IdentityManagement.

o For the bundled, legacy AWS Tools for PowerShell (requires PowerShell 3.0 or later):

PS> Install-Module -Name AWSPowerShell -Scope AllUsers

After installation, the tools are found in one of the paths listed in the preference PSModulePath, such as

C:\Program Files\WindowsPowerShell\Modules (check the preference value on your inventory beacon).

On the AWS side, you must first create:

« Apolicy allowing access to your EC2 service

o Anpolicy allowing access to an Identity and Access Management (IAM) entity

» ThelAM roles to grant access to AWS resources (not required when using the Configuring Connections to AWS EC2

using IAM Users method)

o The IAM user account (still within AWS) with minimum privileges that makes the connection to AWS APIs and imports

the available data (only required for the Configuring Connections to AWS EC2 using IAM Roles without FlexNet Beacon

installed on EC2 instance only).

Finally, on the inventory beacon that is to make the connection to AWS, you must specify the connection (which is
automatically scheduled for you).

Using Proxy Connections

The connection to AWS supports optional use of a proxy for connections that do not connect using a locally installed
FlexNet Beacon.

Step-by-step instructions for creating these, and then configuring the connection to AWS ECS, are available in the online
help at FlexNet Manager Suite Online Help > Inventory Beacon Help > Inventory Systems Page > Connecting to
External Inventory Systems > Managing PowerShell Connections > Managing AWS Connections.
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Thinking about Inventory and
Licensing

FlexNet Manager Suite 2022 R1 (On-Premises)

In many ways, collecting inventory and working out license consumption for instances in AWS EC2 is much the same as
licensing virtual machines on host servers sitting within the data center in your own offices. However, there are some
differences that are worth thinking about. For example, within your own data center, you have full control of, and
presumably full inventory for, the host server as well as the VMs running on it; and for some license types, host details
are relevant even when licensing software on a virtual machine. Depending on what you purchase, this may not be the
case in AWS EC2.

The following topics bring together some points to consider, first about inventory collection, and then about licensing.

Collecting Inventory from Instances

FlexNet Manager Suite 2022 R1 (On-Premises)

The Amazon connector gathers useful information, but it cannot gather information valuable for license consumption
calculations from each of the instances running in your AWS cloud. To gather useful inventory from all instances, best
practice is to include the FlexNet inventory agent (release 13.2.buildNumber or later) in the Amazon Machine Image
(AMI) from which your devices are instantiated. For details, see the AWS documentation, Create a Standard Amazon
Machine Image Using Sysprep for Windows, or for Linux Creating an Amazon EBS-Backed Linux AMI. For additional
guidance about the kinds of customizations your AMI may need (depending on the life expectancy of instances to be
launched from the image), see either:

o Configuring an AMI for Short-Lived Instances

» Configuring an AMI for Longer-Life Instances.

Unique device naming is critical

Itis critical to your license management in AWS to ensure that each instance is uniquely named on instantiation. If you
do not do this, incoming inventory reports are not differentiated, and are interpreted as updated inventory from a
single device, named with the default device name provided by the base image.

One easy way that appears to give each instance a unique name different from its AMI is through the AWS Ec2 Launch
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Settings dialog, by selecting the Set Computer Name check box (or setting the Boolean in the LaunchConfig. json
file). However, be aware that, since this name is of the form ip-hexInternal IP,the name may not be unique over
time, particularly if you have short-life instances. If an internal IP address is dropped when a first instance is shut down,
and reused for another instance that is instantiated later, then these different instances are overlaid in the FlexNet
inventory database as being updates to the same device (having the same name). However, when the inventory records
are then imported over time into the compliance database, they are differentiated by their different instance IDs,
producing separate (duplicate) device records with the same device name. Therefore, the following topics provide
another way to get a truly unique name for each device reported in inventory; and recommended best practice is to
always leave the Set Computer Name check box clear. At the very least, use this convenient AWS method for naming
instances only when you deem the risk of duplicate device records in FlexNet Manager Suite to be low enough to ignore
(or you are prepared to manually fix any duplicate inventory device records that do occur).

To ensure a device name for each instance that is unique over time, methods vary across platforms, and are detailed in
following topics. In summary:

o The easiest method on Windows is to use Sysprep when creating your AMI, leaving the name unset so that a new

name is provided on instantiation.

e For Linux, if you already provide for unique Hostname values on all your instances, no further action is required; and
otherwise, a little extra preparation can ensure that the unique InstanceID for each instance is also returned in
inventory as the MachineID, where it differentiates all returned inventory as coming from devices with distinct

names.

Schedule specialization

Scheduling inventory collection by the locally-installed FlexNet inventory agent requires that you take either of two
different approaches, based the 'life expectancy' of each instance:

« Short-lived, on-demand instances may not have a long enough life cycle for default FlexNet inventory processes to

come to full operation. For these short-lived instances, consider a customized default schedule and configuration file
in the AMI that will:

o Provide an upload location (ManageSoftRL) for inventory collection

o Omit any download location, since the instance life-cycle is projected to be too short to require any policy update
or system-wide schedule update

o Trigger inventory collection on start-up, followed immediately by inventory upload to the defined ManageSoftRL
(this cycle might typically require 3-5 minutes all up, a figure which may change based on other customizations
you may want to include in your AMI)

o Provide a back-up schedule of daily inventory collection, covering off the possibility that, unexpectedly, this

instance now needs to run for a longer period.

Keep in mind, as well, that removing the normal paths for policy update also removes the normal updates to
InventorySettings.xml, which includes arange of advanced capabilities for FlexNet inventory agent, including
Oracle inventory collection and advanced inventory techniques for Microsoft and other vendors. Your strategy
therefore includes embedding your most recently downloaded InventorySettings.xml in your AMI (and later,
updating it as required). For more guidance on customizing short-lived instances, see Configuring an AMI for Short-
Lived Instances.

« Instances with longer life spans can be managed exactly as you manage third-party installations on other inventory
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devices (particularly virtual machines) within your enterprise. These instances do not require a custom schedule,
since they can share the same schedule for local inventory collection that applies throughout your enterprise. You
do still need to consider customizations built into the AMI for these instances, such as providing a bootstrap
inventory beacon with upload and download locations, as well as giving the instance its unique device name. For
more details, see Configuring an AMI for Longer-Life Instances.

Planning your inventory beacons

The final major question is the location of your inventory beacon(s) for uploading inventory data from these instances.
Depending on the reliability of network communications between your cloud-based instances and your own enterprise
network, you may choose either:

« Torun (at least) one instance within your AWS cloud as an inventory beacon, ready 24/7 for any of your instances in
the cloud to upload their inventory. This is especially valuable for short-lived instances, where the locally-installed
FlexNet inventory agent has no opportunity to retry uploads around any network failures; and where fast network
speeds may best support your planned short life-cycle for these instances. The cloud-based inventory beacon can
then provide a more rugged upload to your enterprise network, since it has longer up-time and built-in mechanisms
for retrying any uploads that are interrupted by transient networking issues. As always, this inventory beacon must
have Internet access so that it can connect to the central application server for FlexNet Manager Suite to upload
collected inventories and download changed policies. This approach also enables running the Amazon connector
without having to create an IAM User.

* Run an inventory beacon within your enterprise network (or even, potentially, in a demilitarized zone outside your
firewall), to which all the cloud-based instances have network access, allowing them to upload their inventory files
as and when needed. This approach may be most helpful for direct inventory of Oracle Database in Amazon RDS,
since it allows the inventory beacon to be 'steered' to the appropriate AWS region, limiting its inventory collection
and uploads in a way similar to managing subnets in your local network. If you have a large number of Oracle
Databases spread across various Amazon RDS regions, or a large number of EC2 instances to upload from, consider
installing multiple inventory beacons and 'filtering' each one appropriately.

Choosing between these alternative places for your inventory beacon(s) may require balancing questions of security
and performance against cost. Whichever choice you make, a good practice is to use a DNS alias to identify the
inventory beacon(s) , so that you can quickly and easily make changes without disrupting the rest of your
infrastructure.

¥
= Tip: As for all communication between your enterprise network and the AWS network, an Amazon Virtual Private

Cloud (VPC) is required for either of the above architectures; and if you require a link from your inventory beacon in
the AWS cloud to your central application server in your datacenter, consider a hardware VPN connection as well (see
the AWS documentation for details).

Keep in mind that an inventory beacon does not normally initiate ('push') communication to FlexNet inventory agents
installed on your AWS instances. (The only exceptions are for the 'remote execution' tasks known as adoption and zero
footprint inventory collection, neither of which you expect to use in a cloud environment.) Since all other
communications are initiated by the FlexNet inventory agent ('pull' communications, such as policy updates, collection
of self-update packages, and the upload of inventory), this means that your implementation only needs to point the
FlexNet inventory agent on each instance to its bootstrap inventory beacon (as described in following topics). You do
not need to know details like the IP addresses (public or private) for the instances reporting inventory through the
FlexNet inventory agent.
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Inventory records and exceptions

After a full inventory import and license reconciliation, you can expect to see records created/updated in FlexNet
Manager Suite as follows:

o Forevery instance where the locally-installed FlexNet inventory agent has uploaded inventory, an inventory device

record

« Similarly, for every instance reporting inventory through a third-party tool (such as SCCM), an inventory device

record

« For every cloud instance appearing in EC2 data from the Amazon connector, regardless of whether it appears in
uploaded inventory or not, a cloud instance record in the CloudServiceInstance table (and of those, the ones

that also have an inventory device record show a link to it in the Cloud Service Provider Inventory page)

o Forevery installation of Oracle Database in Amazon RDS, a linked pair of discovered device and inventory device

records

o For dedicated hosts identified through the Amazon connector (and only dedicated hosts, not any other kind of host),
an inventory device record for the host.
You will not find inventory device records for any of the following:

« Acloud instance that does not report inventory
* Ahost device that is anything other than a dedicate host (such as a default host, or a host for dedicated instances)
» Any instance that you have terminated.

Terminated instances are a special case.

1. Before termination, the running instance may have had an inventory device record (provided that it was reporting
inventory).

2. When you terminate the instance, AWS keeps the terminated instance visible through the API for about an hour,
and if you have implemented your Amazon connector on an inventory beacon with the default 30 minute
schedule, the termination is imported through the Amazon connector, and the record in the
CloudServicelInstance tableis updated with the terminated status. (This record, with its terminated status, is
visible in the Cloud Service Provider Inventory page, if you set the filters on that page appropriately.)

3. Atthe next full inventory import (by default, overnight, immediately before the license compliance calculations),
any inventory device record linked to a terminated instance is deleted, because you do not want terminated
instances consuming from your licenses.

4. Of course, the terminated instance no longer reports inventory; but its previously-recorded inventory is still in the
inventory database (and in normal processes is not cleaned up for a while). Although the next full import (typically
the next night) normally imports records from the inventory database, for terminated instances this is prevented
by the terminated flag in the CloudServiceInstance table. This prevents the deleted inventory device record

from reappearing.

Should you ever need to review the software previously installed on a terminated instance, you can:

1. Navigate to Discovery & Inventory > Cloud Service Provider Inventory.
2. Change the default filter (top left) for Include terminated instances to Yes.

3. Optionally, filter the Last known state column to show only Terminated.
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4. Optionally, use other filters, such as Instances reported in an appropriate period, or the Instance type and
Instance region columns, to narrow your search for this instance.

5. Check the Image ID column to identify the original image from which this instance was launched (you may need
to drag this column out of the column chooser).

6. Through your AWS console, identify this AMI, and inspect its software load and resulting license impacts.

Data integration

Inventory from a hosted EC2 instance may come from multiple sources, and must be integrated correctly. Various rules
are used depending on the sources being combined:

* Amazon connector + current FlexNet inventory agent are linked by:

o CloudServiceProviderID (displayed as the Cloud service provider name in the web interface)
o Instance ID

» Amazon connector + other inventory sources (such as legacy versions of FlexNet inventory agent, or third-party
inventory tools, neither of which provides the instance ID) are linked by:

o MAC address (provided that the MAC address is unique in the unmatched inventory and cloud data).

Matching of the incoming data with existing inventory device records (that is, determining whether this is an update to
an existing record, or a new record) uses the standard device matching rules, with the Cloud service provider and
Instance ID checked as last priority.

Finally, the merging of data between the Amazon connector and the current FlexNet inventory agent uses these
priorities:

1. If one source contains a data point that the other does not, the data is used.

2. If both sources contain the same data point but with different values, the data with the most recent inventory date
is used.

3. If different values were imported on the same day, the FlexNet inventory agent is given priority if it has been set as
the primary inventory source.

4. Otherwise, the data is used from the most recently created inventory source, with the winning source visible in the
inventory device properties as Last inventory source.

BYOL Licensing Considerations

FlexNet Manager Suite 2022 R1 (On-Premises)

Full software and hardware inventory may be returned from an AWS EC2 instance when either:

o FlexNet inventory agent is locally installed on the instance, usually because it is part of the Amazon Machine Image
(AMI) from which the instance was launched

« You have some third-party tool (such as Microsoft SCCM) collecting inventory from your AWS instances, and these
results are then being imported into FlexNet Manager Suite.

Whatever the method, when inventory is returned from a running AWS EC2 instance, it has an inventory device record
in FlexNet Manager Suite. As always for all inventory devices, the installations found in software inventory for that
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device consume entitlements from the licenses to which each software record is linked.

However, there are a few special adjustments for inventory from AWS EC2 instances.

Beware of terminating short-lived instances

For some special purposes, instances in the AWS EC2 cloud may be launched, run for a short period (from a few
minutes to a few hours), and then shut down until needed again.

Itis quite possible to configure the AMI from which short-lived instances are launched so that inventory is collected and
uploaded through one or more inventory beacons to your FlexNet Manager Suite application server (for details, see
Configuring an AMI for Short-Lived Instances).

However, the licensing implications are quite different when you stop an EBS-backed instance than when you terminate
an instance:

« The assumption is that a stopped instance may be restarted when required, and resume operation with (quite likely)
the same software installed. It is therefore reasonable to calculate license consumption for such an instance, and, if
you use the configuration described in Configuring an AMI for Short-Lived Instances, this happens as usual for virtual
machines (whether those are VMs within your enterprise network or instances in the cloud).

o Aterminated AWS instance cannot be restarted, and if you are choosing BYOSL for instances that you terminate, you
should check your license terms carefully and make appropriate provision. The working assumption in FlexNet
Manager Suite is that a terminated instance should no longer consume from your software licenses, just as license
consumption stops when you uninstall software from a device, or decommission a hardware asset. As described in
Collecting Inventory from Instances, this is achieved by permanently deleting any inventory device record that may
have previously been created for the instance that is now terminated. (See the same topic for a way of re-discovering
the software load for a terminated instance, and hence its potential license implications.)

The complexity of managing licenses on transient instances is why it is more common to purchase these based on a
fully-loaded image provided by (and licensed through) AWS. However, if you need repeated runs of a short-lived
instance for special purposes, and such an instance must include software for which you provide the license (BYOL),
consider running such an instance as a stop/start instance, rather than terminating it and re-launching it, to simplify
your license management.

Thirty-minute inventory and IBM PVU licenses

The default schedule for the Amazon connector is to have it run every 30 minutes. Coincidentally, this happens to be
the same interval that IBM requires for hardware checks of devices linked to IBM PVU licenses (when you have IBM's
approval to use FlexNet Manager Suite as the source for sub-capacity licensing calculations, for which see the Sub-
Capacity Licensing with IBM PVU chapter of the FlexNet Manager Suite System Reference PDF, available through the title
page of online help).

However, each of these coincidental but distinct schedules has its own separate reasons:

« The Amazon connector should run every 30 minutes to allow it to capture transient information that AWS keeps
available for only an hour, so that you can track your terminated instances where required. This is the connector
schedule, and the Amazon connector does not return enough inventory detail to satisfy the IBM requirements.

o The hardware check for IBM PVU licenses must run every 30 minutes as part of your amended contractual agreement
with IBM. This is an inventory schedule that controls operations of FlexNet inventory agent embedded on an
operational instance.

186 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)



Thinking about Inventory and Licensing

If you are providing IBM PVU licenses for use in the AWS EC2 cloud, and have the IBM amended agreement to allow sub-
capacity calculations within FlexNet Manager Suite, these two default schedules conveniently satisfy both
requirements within AWS. However, be aware of the following requirements:

o IBM PVU licenses in the BYOL model are not appropriate for very short-life instances that are then terminated (see
previous section about the pitfalls of terminating instances with BYOL). Start/stop operations can be used when
necessary, if the instance is maintained and not terminated.

o Persistent (unchanging) inventory device names and matching instance IDs are critical to this license model,
allowing proper calculations of peak consumption values over time. For details about setting a unique but persistent
device name for inventory, see Configuring an AMI for Longer-Life Instances.

» Asalways, full hardware and software inventory (from the instance) is required for IBM PVU licensing. Compliance
with your IBM license requires regular software inventory (daily is recommended best practice) as well as the
30-minute hardware check. Use of the FlexNet inventory agent is also mandated by your adjusted license
agreement. The techniques in Configuring an AMI for Longer-Life Instances prepare an AMI from which you can
launch instances with the operational FlexNet inventory agent embedded, satisfying those requirements.

* Asalways, the first full software and hardware inventory must be uploaded and processed on the central application
server before the 30-minute hardware checks take effect. (This allows the calculation of updated rule targets that
identify all devices affected by IBM PVU licensing processes.) Typically the relevant compliance calculations take
place overnight, after which the revised device policy must be distributed through the inventory beacon hierarchy to
affected installations of FlexNet inventory agent, bringing with it the special schedule for the hardware check. All of
this process means that in the normal course of events, IBM PVU operations typically are running effectively from the
day after an instance is launched with PVU-licensed software in operation.

Uncapped calculations except on dedicated hosts

Some license types allow that, where the total license liabilities for many VMs on the same host theoretically exceed
factors like the total number of cores available on the host, the summing process is 'capped' or given an upper limit by
the actual capacity of the host. For example, if five VMs on a host are each allocated 2 cores, for a total of 10 allocated
cores when the host actually only has 8 cores available, then, just as in reality the time-sharing between the VMs limits
the cores in use at any moment, so also the license rules cap (or reduce) the calculated figure (10 cores) to the total
capacity of the host (8 cores).

Obviously, capping of consumption calculations requires inventory not only of all the VMs on a host, but also of the
host itself. However, in the case of AWS EC2 instances, inventory details are not available for any host types other than
'dedicated hosts', over which you have full control. This means that on all other, non-dedicated hosts in AWS EC2,
capping of license calculations cannot occur.

All calculations for BOYSL licensing of instances on non-dedicated AWS hosts are based entirely on the inventory taken
from the instances themselves, without capping. This does not expose you to any risk of under-licensing (provided that
allinstances are returning inventory); the only risk is that you may perhaps be over-calculating the consumption that
might apply on a known host with capping applied.

However, this may not be an issue at all. Carefully check your BYOL terms and use rights. You may find that software
publishers already disallow capping in cloud environments, because of the impossibility of tracking instances that may
pop up now on this host and now on another, depending on resource allocations within AWS.
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Instances

FlexNet Manager Suite 2022 R1 (On-Premises)

The easiest way to collect inventory from all your EC2 instances is to make sure that they are launched from Amazon
Machine Images (AMI) that already contain everything needed for the collection of FlexNet inventory.

However, the required customization varies somewhat, based on your plans for the resulting instances:

« Instances with short lifespans (from a few minutes to a few hours) need special provision so that they collect and
upload inventory as soon as they are launched. For details of ways to achieve this, see Configuring an AMI for Short-

Lived Instances.

« Instances with longer lifespans (two days or more, whether or not they are actually running for all of that period) can
use a more conventional customization that brings them into the normal policy-based management processes used
everywhere by FlexNet Manager Suite. For these, see Configuring an AMI for Longer-Life Instances.

Configuring an AMI for Short-Lived
Instances

FlexNet Manager Suite 2022 R1 (On-Premises)

The requirements for short-lived on demand instances in your AWS EC2 service are somewhat specialized because of
the need to capture and upload inventory within a short space of time. This means you need to prepare a separate
Amazon Machine Image (AMI) from which to instantiate these short-lived instances. The requirements include:

« Installing the latest approved FlexNet inventory agent into the image
» Adding a customized configuration file that identifies the upload location for inventory

« Installing a customized schedule to manage FlexNet inventory agent in the resulting instances, triggering inventory
gathering on start-up (and best practice is to include a backup schedule for further inventory collection in case an
instance from this AMI runs for an unexpectedly long time)

 Including the current version of InventorySettings.xml that provides advanced functionality for FlexNet
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inventory agent, since the short lifetime does not allow for normal policy-based downloads

Ensuring a unique name for each instance created from this AMI.

At this summary level, the requirements are the same for Windows and Linux platforms. In the details, of course, there

are platform specifics.

=
[_] To prepare an AMI for short-lived instances:

1.

In the web interface for FlexNet Manager Suite, navigate to Discovery & Inventory > Inventory Settings.
The Inventory Settings page displays.

Expand the Inventory agent for download section.

. Collect the template configuration file:

o For aWindows-based AMI, click Download bootstrapping template file, and save mgssetup.initoa

convenient working folder (such as C: \temp). (Do not change the file name.)

 For a Linux-based AMI, in the Gathering FlexNet Inventory PDF (available through the title page of online help),
copy the text from Agent third-party deployment: Sample UNIX Bootstrap Configuration File and save it as
mgsft_rollout_response in a convenient working folder (such as C: \temp).

. From the Inventory agent drop-down list, select the version of FlexNet inventory agent you want to install in your

AMI, and save it to your working folder.

In general, install the latest available version, subject to your corporate policies. This provides access to the latest
functionality. For example, to include advanced inventory for AWS EC2, you must use FlexNet inventory agent
13.2.0 or later.

. Inyour preferred flat text editor, customize your bootstrapping template file to be used for FlexNet inventory

agent in your AWS EC2 environment as follows, saving the edited version in a separate subfolder.

For Windows, the only mandatory change is to identify the upload location for gathered inventory, as described
below. (A download location for policy updates is not needed for short-life instances on Windows.) On Linux,
FlexNet inventory agent requires both an upload location and a download location. As always, on either
platform, experts may also customize other preferences needed for your implementation, as described in the
platform-specific topics in the Gathering FlexNet Inventory PDF:

o Agent third-party deployment: Edit the Configuration File for Microsoft Windows
« Agent third-party deployment: Configure the Bootstrap File for UNIX.

The upload (and download) locations require a URL to the host inventory beacon. Best practice is to provide a
DNS alias for your chosen inventory beacon, so that when circumstances change, a simple switch of the alias
leaves any running and future instances fully operational, without requiring changes to the AMI.

« For Windows, inmgssetup.ini:

a. Locate this section for Common preferences, and uncomment (remove the leading semi-colon) and edit the
following settings:

; Registry settings to be created under
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; HKLM\Software\ManageSoft Corp\ManageSoft\Common

[Common]

desc@® = UploadSettings\Bootstrap Server\Protocol
vale = http

descl = UploadSettings\Bootstrap Server\Priority
vall = 100

desc2 = UploadSettings\Bootstrap Server\AutoPriority
val2 = False
desc3 = UploadSettings\Bootstrap Server\Host

val3 = beacon.fnms.com
desc4 = UploadSettings\Bootstrap Server\Port
vald = 80

desc5 = UploadSettings\Bootstrap Server\Directory
val5 = /ManageSoftRL/

b. Optionally, modify the Protocol value if you want to use HTTPS (vale = https).

c. You must customize the Host preference (shown above as val3 = beacon.fnms.com) to your chosen

DNS alias (or preferred host setting) and your own enterprise name if the inventory beacon is located in
your enterprise network rather than on an AWS EC2 instance. For an inventory beacon hosted on an AWS
instance, you can identify its public and private DNS hostnames on the AWS console (select Instances in
the navigation pane, choose the instance hosting the inventory beacon, and read both its public and
private DNS hostnames in the details pane).
.
= Tip: If you have an inventory beacon on an AWS instance, your installations of FlexNet inventory agent
on other instances can be configured to use the private DNS hostname for accessing the inventory
beacon (provided that both are within the scope of your VPC). The private hostname has greater
stability, particular if the inventory beacon host is stopped and started from time to time.

. Optionally, customize the port setting (for example, if you are switching to the HTTPS protocol, the default

portis 443).

I} Important: The Directory preference is mandatory, and must be set as shown above.

. Create a subfolder (such as ShortLifeAMI) and save your edited mgssetup.ini there. Do not change

the file name, which is mandatory.

e ForLinux,inmgsft_rollout_response:

. Inthefirst section of the file, customize the setting for the download location (see also the comments for

the upload location, next):

# The initial download location(s) for the installation.

# For example, http://myhost.mydomain.com/
ManageSoftDL/

# Refer to the documentation for further
details.

MGSFT_BOOTSTRAP_DOWNLOAD=http://beacon.fnms.com:8080/ManageSoftDL/
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b. In the next section of the file, customize the setting for the reporting (upload) location:

# The initial reporting location(s) for the installation.

# For example, http://myhost.mydomain.com/
ManageSoftRL/

# Refer to the documentation for further
details.

MGSFT_BOOTSTRAP_UPLOAD=http://beacon.fnms.com:8080/ManageSoftRL/

You may customize the protocol to HTTPS if required, and omit or customize the port number as
required. You must customize the host URL (shown above as beacon.fnms. com) to your chosen DNS
alias (or preferred host setting) and your own enterprise name if the inventory beacon is located in your
enterprise network rather than on an AWS EC2 instance. For an inventory beacon hosted on an AWS
instance, you can identify its DNS hostname on the AWS console (select Instances in the navigation pane,
choose the instance hosting the inventory beacon, and read its DNS hostname in the details pane).

B’ Important: In each case, the trailing /ManageSoftDL/ (download location) or /ManageSoftRL/
(upload or reporting location) is mandatory, and must be specified as shown above.

c. Inthe last line of the file, switch the value to prevent policy running after installation, as short-lived
instances do not have time to wait for policy and its outcomes:

MGSFT_RUNPOLICY=0

d. Create a subfolder (such as ShortLifeAMI) and save your edited mgsft_rollout_response there. Do
not change the file name, which is mandatory.

e. Unlessyou already have a strategy and practice that gives every Linux instance a unique name, also create
a new text file for your Linux AMI, called tmpconfig. ini, with exactly the following two lines:

[ManageSoft\Common]
MachineID=

This file is deliberately incomplete at this stage, and is to be completed at instance start-up, as described
later.

6. For either platform, copy the following and paste it into a plain ASCII text file, and save it in your ShortLifeAMI
folder as DefaultSchedule.nds (this file name is mandatory). Of course, you may choose to unwrap those lines
wrapped for readability here.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE Schedule PUBLIC "Flexera Inventory Manager schedule"
"http://www.managesoft.com/dtd/schedule.dtd">

<Schedule NAME="Default Schedule" TIMEDATESTAMP="20180903T044104Z"
SCHEDSCHEMA="60" >
<Event NETWORK="False"
NAME="Generate Inventory"
CATCHUP="Never" ID="{FO65A477-B500-4611-8340-3BF313FB785B}">
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<LogicalCommand PARAM=" -o UserInteractionLevel=Quiet"
ACTION="Report" COMPONENT="Tracker"/>
<Trigger TYPE_PARAM="0" TIMESTART="143950"
DATESTART="20180903" TYPE="Logon" MAXDELAY="0"/>
</Event>
<!-- Following two events are optional (see notes) --!>
<Event NETWORK="False"
NAME="Generate Inventory" IDLEDURATION="86400"
CATCHUP="Never" ID="{FO65A477-B500-4611-8340-3BF313FB785B}">
<LogicalCommand PARAM=" -o UserInteractionLevel=Quiet"
ACTION="Report" COMPONENT="Tracker"/>
<Trigger TYPE_PARAM="1" TIMESTART="001000"
DATESTART="20180903" TYPE="Daily" REPEAT="21600"
TIMEWINDOW="3600" DURATION="86400"/>
</Event>
<Event NETWORK="False"
NAME="Upload Client Files"
CATCHUP="Never" ID="{9CB87BAE-2829-498C-8643-10A9BD3BFA56}">
<LogicalCommand PARAM="-a"
ACTION="Upload" COMPONENT="Uploader"/>
<Trigger TYPE_PARAM="1" TIMESTART="002000"
DATESTART="20180903" TYPE="Daily" REPEAT="600"
DURATION="86400"/>
</Event>
</Schedule>

The first event in this schedule triggers machine inventory collection on startup (TYPE="Logon"), and the
tracker component automatically attempts an upload to the bootstrap inventory beacon as soon as inventory
gathering is complete. If you are certain that all instances from this image are short-lived, only this event is
required. If you are using an EBS-backed instance, and you choose to stop and restart your instance (rather than
to terminate and re-launch it), this inventory is checked on each restart.

In addition, two further schedule events provide easy management of cases where an instance proposed to have
a short life in fact keeps on running for some longer time.

The second event also generates inventory, and is triggered every 6 hours (REPEAT="21600", with all times
expressed in seconds), to start within an hour thereafter (TIMEWINDOW="3600"). However, this inventory
collection is different than the first case, because here the FlexNet inventory agent does not repeat the inventory
collection if it has been successful within the last 24 hours (IDLEDURATION="86400"). This means that,
effectively, the FlexNet inventory agent checks four times a day whether there has been a successful inventory
collection in the last 24 hours, and if not, it runs a new inventory collection.

In a perfect world, the third event is redundant because the tracker component uploads inventory as soon as it
is collected. This third, separate upload event is a catch-up to work around transient network issues. It checks
every 10 minutes to see whether any inventory files have failed to upload (and are therefore still waiting in the
staging folder). In normal cases, nothing is waiting, and the uploader shuts down immediately, causing
negligible load on the instance. But where there have been networking issues, upload is attempted again every
10 minutes until all files are successfully uploaded and removed from the staging folder.

7. Ona convenient inventory beacon, navigate to %CommonAppData%\Flexera Software\Staging\Common\
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ClientConfiguration,take a copy of InventorySettings.xml, and save it to your ShortLifeAMI working
folder.

This completes the preparation of materials for your AMI for instances of this expected life. Now continue to use
these materials to prepare the AMI. For both platforms, the high-level process is to customize a running instance,
and then save it as an AMI.

For a Windows-based AMI, the recommended best practice is to run Sysprep, as this can easily ensure that each
instantiation from this AMI receives a unique device name. For Sysprep, AWS offers two different sets of scripts to
assist, with separate documentation:

o ForaWindows 2016 AMI, use EC2Launch, and see https://docs.aws.amazon.com/AWSEC2/latest/
WindowsGuide/ec2launch.html#ec2launch-sysprep

« For an AMI for an earlier version of Microsoft Windows, use the EC2Config service, and see
https://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/ami-create-standard.html

For a Linux AMI, the following notes relate to an EBS-backed instance, since this is the simpler process, and the
flexibility of the resulting instances is greater (for example, supporting stopping an instance without necessarily
terminating it). If you have instead chosen to use an instance store-backed instance, follow the AWS
documentation closely, and give it priority where there may be any disparities with this document. Choose from
either:

o https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-ebs.html (preferred, for your EBS-
backed instance)

e https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-instance-store.html (for an instance
backed by the instance store).

8. Following the AWS documentation, select (or create), launch and connect to your chosen instance from which you
are creating your AMI.

9. To customize your instance:

a. Ensure that the destination folder exists for your installation of FlexNet inventory agent, and if not create
it.

The default paths for each platform are:
o OnWindows, C:\Program Files (x86)\Flexera Software\Agent
e OnLinux, /opt/managesoft/bin.

b. From your local ShortLifeAMI working folder, copy these files into the destination folder on your

instance:
» DefaultSchedule.nds
e InventorySettings.xml
e Only on Windows, mgssetup.ini
e Onlyon Linux, tmpconfig.ini.
¢. ForLinuxonly, also copy your amended mgsft_rollout_response fileto /var/tmp/ onyourinstance.

d. Collect the downloaded installer for FlexNet inventory agent from your working folder, and run the
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installer on your instance, installing FlexNet inventory agent into the prepared destination folder.

The installer automatically configures the custom settings declared in the configuration file (either
mgssetup.iniormgsft_rollout_response, depending on platform). For more information about
running the installation, see the Agent third-party deployment: Details chapter of the Gathering FlexNet
Inventory PDF, focusing on the installation topic for your preferred platform.

e. When installation is complete, in the same destination folder and for both platforms, run the following
command to install your default schedule:

start ndschedag.exe -t machine .\DefaultSchedule.nds

i
= Tip: When creating your AMI in the following steps, make the name for this image meaningful, such as "Short-

life instances", to remind you of the special conditions embodied in the AMI.

10. Only for Windows: complete the remaining steps in the AWS document to Sysprep your instance, finishing by
clicking Shutdown with Sysprep (or, for pre-2016 versions of Windows, click OK and confirm Yes to run Sysprep
and shut down the instance).

R‘ Important: If you are using EC2Launch on Windows 2016, in the Ec2 Launch Settings dialog, be sure to leave
the Set Computer Name check box clear. This allows Sysprep to clear the computer name from the instance
as it shuts down, so that new instances launched from this image each receive a unique device name.

11. Only for Linux (for an EBS-backed image):
a. Navigate to your instance configuration.

For example, if you are creating a new instance, select the third tab across the top of your console,
showing 3. Configure Instance.

b. If necessary, scroll down, and expand the Advanced Details panel.

c. Inthe User data field, add the following two lines As text to ensure that each Linux instance reports a
unique device name in its inventory (lines are wrapped here for publication, but each command should be
entered on a single line):

sudo sed -i

"s/MachineID=/MachineID=$(curl
http://169.254.169.254/1latest/meta-data/instance-id/)/g"

tmpconfig.ini

/opt/managesoft/bin/mgsconfig -i /var/tmp/
tmpconfig.ini

The first line replaces the unfinished MachineID setting in the tmpconfig. ini file with a setting
completed with the Instance ID, which is recovered in the standard way from the AWS metadata for the
current image. The second line runs a small FlexNet utility that merges the new value into the standard
config.ini for the Linux-based FlexNet inventory agent. These two lines of code are run as the instance
is being instantiated, before the FlexNet inventory agent is run. The result is that, whenever an instance is
launched from the image you are creating, FlexNet inventory agent takes the MachineID setting from
the config.ini file, and reports that unique device name as part of its uploaded inventory.

d. If yourinstance is running, stop it now. (Making an AMI from a stopped instance is preferred for lower risk
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and better stability in your image.)
12. Monitor the Instances page in the Amazon EC2 console, until the state for your chosen instance displays stopped.
13. Follow your preferred process to create an AMI from that stopped instance.

For example, on Windows, since you have already installed AWS Tools for Windows PowerShell, you could use
the cmdlet New-EC2Image. For Linux, in the navigation pane, you can choose Instances, select your instance,
and then choose Actions > Image > Create Image, and provide the necessary details. For more information on
creating AMIs, see either of:

o https://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/Creating_EBSbacked_WinAMI.html
o https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-ebs.html.

This AMI is now ready to instantiate short-lived instances. As soon as each instance is spawned, the embedded FlexNet
inventory agent gathers inventory from the instance, and immediately uploads it to the bootstrap inventory beacon.
Depending on the resources on each instance, this process may take around 2-5 minutes, after which the instance can
be stopped (but remember, not terminated if you wish to track related software licenses in FlexNet Manager Suite).

Configuring an AMI for Longer-Life
Instances

FlexNet Manager Suite 2022 R1 (On-Premises)

An AWS EC2 instance that runs for a longer period (such as at least a day or two) can take part in the normal processes
for inventory collection that you use for any virtual machines, whether on-premises or in the cloud. The requirements
include:

 Installing the latest approved FlexNet inventory agent into the image

» Adding a customized configuration file that identifies both the download location for requesting the initial policy for
FlexNet inventory agent on the instance, and the upload location for inventory

« Ensuring a unique name for each instance created from this AMI.

Both the operational schedule for FlexNet inventory agent, and the latest InventorySettings.xml providing
enhanced inventory-gathering functionality, are delivered automatically as part of policy. However, this can take a
couple of days in the worst case; so if you wish you may also include a start-up schedule and
InventorySettings.xml inthe image to shorten the time to full functionality of FlexNet inventory agent. If you do
so, both of these are over-written automatically once policy is fully operational. (You can find some notes about these
additional documents in Configuring an AMI for Short-Lived Instances.)

These guidelines cover both Windows and Linux instances, so skip the parts that do not apply to your platform.

=
[_] To prepare an AMI for longer-life instances:
1. Inthe web interface for FlexNet Manager Suite, navigate to Discovery & Inventory > Inventory Settings.
The Inventory Settings page displays.

2. Collect the template configuration file:
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3.
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¢ Fora Windows-based AMI, click Download bootstrapping template file, and save mgssetup.initoa

convenient working folder (such as C: \temp). (Do not change the file name.)

o For aLinux-based AMI, in the Gathering FlexNet Inventory PDF (available through the title page of online help),
copy the text from Agent third-party deployment: Sample UNIX Bootstrap Configuration File and save it as
mgsft_rollout_response in a convenient working folder (such as C:\temp).

From the Inventory agent drop-down list, select the version of FlexNet inventory agent you want to install in your
AMI, and save it to your working folder.

In general, install the latest available version, subject to your corporate policies. This provides access to the latest
functionality. For example, to include advanced inventory for AWS EC2, you must use FlexNet inventory agent
13.2.0 or later.

In your preferred flat text editor, customize your bootstrapping template file to be used for FlexNet inventory
agent in your AWS EC2 environment as follows, saving the edited version in a separate subfolder.

For Windows, the only mandatory change is to identify the download location for requesting policy, as described
below. (On Windows, all other requirements are delivered through policy; but for safety we'll also provide an
upload location.) On Linux, FlexNet inventory agent requires both an upload location and a download location.
As always, on either platform, experts may also customize other preferences needed for your implementation, as
described in the platform-specific topics in the Gathering FlexNet Inventory PDF:

o Agent third-party deployment: Edit the Configuration File for Microsoft Windows
« Agent third-party deployment: Configure the Bootstrap File for UNIX.

The download (and upload) locations require a URL to the host inventory beacon. Best practice is to provide a
DNS alias for your chosen inventory beacon, so that when circumstances change, a simple switch of the alias
leaves any running and future instances fully operational, without requiring changes to the AMI.

e ForWindows, inmgssetup.ini:

a. Locate this section for Common preferences, and uncomment (remove the leading semi-colon) and edit the

following settings:

5; Registry settings to be created under
; HKLM\Software\ManageSoft Corp\ManageSoft\Common

[Common]

desc@® = UploadSettings\Bootstrap Server\Protocol
vale = http

descl = UploadSettings\Bootstrap Server\Priority
vall = 100

desc2 = UploadSettings\Bootstrap Server\AutoPriority
val2 = False
desc3 = UploadSettings\Bootstrap Server\Host

val3 = beacon.fnms.com
desc4 = UploadSettings\Bootstrap Server\Port
vald = 80

desc5 = UploadSettings\Bootstrap Server\Directory
val5 = /ManageSoftRL/
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desc6 = DownloadSettings\Bootstrap Server\Protocol

valée = http
desc7 = DownloadSettings\Bootstrap Server\Priority
val7 = 100

desc8 = DownloadSettings\Bootstrap Server\AutoPriority
val8 = False

desc9 = DownloadSettings\Bootstrap Server\Host

val9 = beacon.fnms.com

desc1l0 = DownloadSettings\Bootstrap Server\Port

valle = 80

descll = DownloadSettings\Bootstrap Server\Directory
valll = /ManageSoftDL/

b. Optionally, modify the Protocol values if you want to use HTTPS (val® = https,andvalé = https).

c. You must customize the Host preference (shown above asval3 = beacon.fnms.comandval9 =
beacon.fnms. com) to your chosen DNS alias (or preferred host setting) and your own enterprise name if
the inventory beacon is located in your enterprise network rather than on an AWS EC2 instance. For an
inventory beacon hosted on an AWS instance, you can identify its DNS hostname on the AWS console
(select Instances in the navigation pane, choose the instance hosting the inventory beacon, and read its
DNS hostname in the details pane).

-

= Tip: If you have an inventory beacon on an AWS instance, your installations of FlexNet inventory agent
on other instances can be configured to use the private DNS hostname for accessing the inventory
beacon (provided that both are within the scope of your VPC). The private hostname has greater
stability, particular if the inventory beacon host is stopped and started from time to time.

d. Optionally, customize the port settings at val4 and val1e (for example, if you are switching to the HTTPS
protocol, the default port is 443).

B’ Important: The Directory preference is mandatory, and in each case must be set as shown above.

e. Create a subfolder (such as LongLifeAMI) and save your edited mgssetup.ini there. Do not change the
file name, which is mandatory.

o ForLinux,inmgsft_rollout_response:

a. Inthe first section of the file, customize the setting for the download location (see also the comments for
the upload location, next):

# The initial download location(s) for the installation.

# For example, http://myhost.mydomain.com/
ManageSoftDL/

# Refer to the documentation for further
details.

MGSFT_BOOTSTRAP_DOWNLOAD=http://beacon.fnms.com:8080/ManageSoftDL/

b. In the next section of the file, customize the setting for the reporting (upload) location:
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# The initial reporting location(s) for the installation.

# For example, http://myhost.mydomain.com/
ManageSoftRL/

# Refer to the documentation for further
details.

MGSFT_BOOTSTRAP_UPLOAD=http://beacon.fnms.com:8080/ManageSoftRL/

You may customize the protocol to HTTPS if required, and omit or customize the port number as
required. You must customize the host URL (shown above as beacon.fnms . com) to your chosen DNS
alias (or preferred host setting) and your own enterprise name if the inventory beacon is located in your
enterprise network rather than on an AWS EC2 instance. For an inventory beacon hosted on an AWS
instance, you can identify its DNS hostname on the AWS console (select Instances in the navigation pane,
choose the instance hosting the inventory beacon, and read its DNS hostname in the details pane).

R] Important: In each case, the trailing /ManageSoftDL/ (download location) or /ManageSoftRL/
(upload or reporting location) is mandatory, and must be specified as shown above.

c. Create a subfolder (such as LongLifeAMI) and save your edited mgsft_rollout_response there. Do
not change the file name, which is mandatory.

d. Unlessyou already have a strategy and practice that gives every Linux instance a unique name, also create
a new text file for your Linux AMI, called tmpconfig.ini, with exactly the following two lines:

[ManageSoft\Common]
MachineID=

This file is deliberately incomplete at this stage, and is to be completed at instance start-up, as described
later.

This completes the preparation of materials for your AMI for instances of this expected life. Now continue to use
these materials to prepare the AMI. For both platforms, the high-level process is to customize a running instance,
and then save it as an AML.

For a Windows-based AMI, the recommended best practice is to run Sysprep, as this can easily ensure that each
instantiation from this AMI receives a unique device name. For Sysprep, AWS offers two different sets of scripts to
assist, with separate documentation:

o ForaWindows 2016 AMI, use EC2Launch, and see https://docs.aws.amazon.com/AWSEC2/latest/
WindowsGuide/ec2launch.html#ec2launch-sysprep

« For an AMI for an earlier version of Microsoft Windows, use the EC2Config service, and see
https://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/ami-create-standard.html

For a Linux AMI, the following notes relate to an EBS-backed instance, since this is the simpler process, and the
flexibility of the resulting instances is greater (for example, supporting stopping an instance without necessarily
terminating it). If you have instead chosen to use an instance store-backed instance, follow the AWS
documentation closely, and give it priority where there may be any disparities with this document. Choose from
either:

e https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-ebs.html (preferred, for your EBS-
backed instance)
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o https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-instance-store.html (for an instance
backed by the instance store).

5. Following the AWS documentation, select (or create), launch and connect to your chosen instance from which you
are creating your AMI.

6. To customize your instance:

a. Ensure that the destination folder exists for your installation of FlexNet inventory agent, and if not create
it.

The default paths for each platform are:
o OnWindows, C:\Program Files (x86)\Flexera Software\Agent
e OnLinux, /opt/managesoft/bin.
b. From your local ShortLifeAMI working folder, copy these files as shown onto your instance:

e ForWindows, copy mgssetup.ini into the destination folder C: \Program Files (x86)\Flexera

Software\Agent
o ForLinux, copymgsft_rollout_responseinto /var/tmp/ onyourinstance.

c. Collect the downloaded installer for FlexNet inventory agent from your working folder, and run the
installer on your instance, installing FlexNet inventory agent into the prepared destination folder.

The installer automatically configures the custom settings declared in the configuration file (either
mgssetup.iniormgsft_rollout_response, depending on platform). For more information about
running the installation, see the Agent third-party deployment: Details chapter of the Gathering FlexNet
Inventory PDF, focusing on the installation topic for your preferred platform.

L
= Tip: When creating your AMI in the following steps, make the name for this image meaningful, such as "Long-

life instances", to remind you of the special conditions embodied in the AMI.

7. Only for Windows: complete the remaining steps in the AWS document to Sysprep your instance, finishing by
clicking Shutdown with Sysprep (or, for pre-2016 versions of Windows, click OK and confirm Yes to run Sysprep
and shut down the instance).

|_b Important: If you are using EC2Launch on Windows 2016, in the Ec2 Launch Settings dialog, be sure to leave
the Set Computer Name check box clear. This allows Sysprep to clear the computer name from the instance
as it shuts down, so that new instances launched from this image each receive a unique device name.

8. Only for Linux (for an EBS-backed image):
a. Navigate to your instance configuration.

For example, if you are creating a new instance, select the third tab across the top of your console,
showing 3. Configure Instance.

b. If necessary, scroll down, and expand the Advanced Details panel.

c. Inthe User data field, add the following two lines As text to ensure that each Linux instance reports a
unique device name in its inventory (lines are wrapped here for publication, but each command should be
entered on a single line):

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)

199


https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-instance-store.html

Images for Different Kinds of Instances

sudo sed -i

"s/MachineID=/MachineID=$(curl
http://169.254.169.254/1latest/meta-data/instance-id/)/g"

tmpconfig.ini

/opt/managesoft/bin/mgsconfig -i /var/tmp/
tmpconfig.ini

The first line replaces the unfinished MachineID setting in the tmpconfig. ini file with a setting
completed with the Instance ID, which is recovered in the standard way from the AWS metadata for the
current image. The second line runs a small FlexNet utility that merges the new value into the standard
config.ini for the Linux-based FlexNet inventory agent. These two lines of code are run as the instance
is being instantiated, before the FlexNet inventory agent is run. The result is that, whenever an instance is
launched from the image you are creating, FlexNet inventory agent takes the MachineID setting from
the config.ini file, and reports that unique device name as part of its uploaded inventory.

d. If yourinstance is running, stop it now. (Making an AMI from a stopped instance is preferred for lower risk
and better stability in your image.)

9. Monitor the Instances page in the Amazon EC2 console, until the state for your chosen instance displays stopped.
10. Follow your preferred process to create an AMI from that stopped instance.

For example, on Windows, since you have already installed AWS Tools for Windows PowerShell, you could use
the cmdlet New-EC2Image. For Linux, in the navigation pane, you can choose Instances, select your instance,
and then choose Actions > Image > Create Image, and provide the necessary details. For more information on
creating AMlIs, see either of:

o https://docs.aws.amazon.com/AWSEC2/latest/WindowsGuide/Creating_EBSbacked_WinAMI.html
o https://docs.aws.amazon.com/AWSEC2/latest/UserGuide/creating-an-ami-ebs.html.

This AMI is now ready to instantiate longer-life instances. As soon as each instance is spawned, FlexNet inventory agent
asks its bootstrap inventory beacon for policy. Once downloaded, its device policy triggers delivery of your global
schedule for inventory collection by the locally-installed FlexNet inventory agent, as well as the latest
InventorySettings.xml file that brings enhanced functionality.
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Appendices: Technical Data

FlexNet Manager Suite 2022 R1 (On-Premises)

The following topics do not include content you need for set-up or operation of the Amazon connector. These are the

deep-down technical data that you can ignore until you have a real need.

Appendix 1: Cmdlets in the Amazon
connector

FlexNet Manager Suite 2022 R1 (On-Premises)

The connection from FlexNet Manager Suite to the AWS EC2 service relies on the AWS Tools for Windows PowerShell (as
described in Prerequisites and Setting Up). Within that toolset, the Amazon connector uses the following PowerShell

cmdlets:

Get-AWSRegion — To identify the available AWS geographic regions where your instances may be running

Get-EC2Instance — To return the list of the instances (virtual machines) you own, and then collect summary

inventory details on each one
Get-EC2Host — To identify any dedicated hosts you have available in each region

Get-EC2ReservedInstance — To return inventory details on any instance/capacity you have reserved in an

Availability Zone
Get-IAMUser — Used as a test for connection success

Get-IAMPolicy — To retrieve information about the specified managed policy, including the policy's default

version and the total number of IAM users, groups, and roles to which the policy is attached

Get-IAMPolicyVersion — To retrieve information about the specified version of the specified managed policy,

including the policy document
Get-IAMAttachedRolePolicylList — Lists all managed policies that are attached to the specified 1AM role

Get-IAMAttachedUserPolicylList — Lists all managed policies that are attached to the specified IAM user
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o Get-IAMGroupForUser — Lists the IAM groups that the specified IAM user belongs to

e Get-STSCallerIdentity — To return details about the IAM user or role whose credentials are used to call the

operation

* Get-IAMRole — To retrieves information about the specified role and the role's trust policy that grants permission

to assume the role

¢ Use-STSRole — To return a set of temporary security credentials that you can use to access AWS resources that you

might not normally have access to

o Set-AWSProxy — Specifies the proxy setting for the following interactions through other cmdlets

Appendix 2: Data Imported by Amazon
connector

FlexNet Manager Suite 2022 R1 (On-Premises)

The Amazon connector returns information about each AWS instance, and its host. All instances are subsequently
displayed in the Cloud Service Provider Inventory page. Hosts are never displayed in this page, as in general hosting
is variable and controlled by AWS.
.
= Tip: One exception where you have direct control is the 'dedicated host' Like all other host types, dedicated hosts do
not appear in the Cloud Service Provider Inventory listing; but they do automatically appear in inventory device
listings, such as the All Inventory page, where you can search for them using the Hosted in property. Any instances
from the Cloud Service Provider Inventory listing that are hosted on your dedicated host also display a link to the
dedicated host properties in the Host column.

Instance data
.
= Tip: All kinds of instances return this set of data, whether they are virtual machines or bare metal instances. The
latter return an Instance type starting with 13..

If the data gathered through the Amazon connector matches inventory collected from another source, the Cloud
Service Provider Inventory page includes a hyperlink to open the inventory device properties page for the instance.
Putting that another way, inventory device records are not created when the Amazon connector is the sole source of
information; but they are created when inventory is returned from another source that covers the cloud instance (one
possible example is having FlexNet inventory agent running locally on the instance). In this latter case, linked records
exist in both the ComplianceComputer and CloudServiceInstance tables.

Some data is additional to the normal content collected as inventory. For example, the InstanceTenancyID, used for
identifying whether the current device isaDedicated instance,orisaninstance runningOn dedicated host,is
imported into the CloudServiceInstance table, and, as Availability type, is visible in both the Cloud Service
Provider Inventory page and the Cloud Hosting tab of the inventory device properties (where inventory exists for the
instance).

.

= Tip: AWS "bare metal instances" behave like other instances in terms of data gathered and records created.
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When there is an inventory device record for an instance, the inventory-related values imported through the Amazon
connector (and shown below in alphabetical order) are displayed in the separate Cloud Hosting tab of the inventory
device properties:

e Availability type

e Availability Zone

« Cores

e« Creation date (andtime)

e Host ID (useto linkto host)

o Image ID (forthe AMI, or Amazon Machine Image, from which the instance was instantiated)
¢ Instance ID

e Instance region

¢ Instance type

e Last known state

e Lifecycle mode (displayed as Lifecycle in the Cloud Service Provider Inventory page, and as Purchased option

in the Cloud Hosting tab of the inventory device properties)
e MAC address
e Network ID

e Threads per core.

Host data

If the host is a "dedicated host" (which means that your enterprise has exclusive use and detailed control), an inventory
device record is automatically created for the dedicated host in the ComplianceComputer table (with the resulting
property sheet). Separate inventory device records are not created for any other kind of host; and hosts (other than
dedicated hosts) are not listed separately on the Cloud Service Provider Inventory page.

v

= Tip: For dedicated hosts, the following properties are displayed on the Cloud Hosting tab of the inventory device
properties.

The following properties (listed alphabetically) are collected for hosts of all types through the Amazon connector:

e Availability Zone
¢« Cores

e Creation time

e Host ID

e« Instance region
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« Instance type

e SocketsVcpu.

Appendix 3: Enhanced Inventory Gathered
by Agent

FlexNet Manager Suite 2022 R1 (On-Premises)

As well as the high-level data gathered from the AWS EC2 connection, FlexNet inventory agent (version 13.1 or later)
gathers addition inventory data for each AWS instance where FlexNet inventory agent is locally installed. To do so,
FlexNet inventory agent accesses two AWS-internal URLs:

e http://169.254.169.254/1latest/meta-data/instance-1id returns the unique identifier for the AWS EC2
instance.

e http://169.254.169.254/1latest/dynamic/instance-identity/document returns a JSON-formatted
value containing data about the instance where FlexNet inventory agent is locally installed. For example:

{
"devpayProductCodes" : null,

"marketplaceProductCodes" : [ "labc2defghijklm3nopgrs4tu" ],
"availabilityZone" : "us-west-2b",
"privateIp" : "10.158.112.84",
"version" : "2017-09-30",

"instanceId" : "i-1234567890abcdef0",
"billingProducts” : null,
"instanceType" : "t2.micro",
"accountId" : "123456789012",

"imageId" : "ami-5fb8c835",
"pendingTime" : "2018-11-19T16:32:117",
"architecture" : "x86_64",

"kernelId" : null,

"ramdiskId" : null,

"region" : "us-west-2"

These two data points are then embedded within the normal . ndi inventory file as a pseudo-hardware WMI class
called MGS_AWSComputerSystem. The class looks similar to this example (lines wrapped for presentation):

<Hardware class="MGS_AWSComputerSystem" Name="ec2amaz-vrkiu@p" Evidence="metadata">
<Property Name="instance-id" Value="1i-1234567890abcdef0"
Evidence="/latest/meta-data/instance-id"/>
<Property Name="document" Value="ewogICJwcml2YXR1SXAiIDogIjE3Mi4zMS4yLjEXxNiIs...."
Evidence="/latest/dynamic/instance-identity/document"/>
</Hardware>

After a full inventory import, these details are eventually saved in the CloudServiceInstance tablein the
compliance database.
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This part of the reference introduces the FlexNet connector to Microsoft Azure, enabling you to

o Collect Azure virtual machine data

o Track the license model for Windows Server and SQL Server in the cloud, particularly for installations that are taking
advantage of the Microsoft Hybrid Benefit (AHB) that allows you to "bring your own license" (BYOL), re-purposing
licenses originally purchased to authorize product installations in your on-premises environment in one of two ways,

either:

o Transferring the license entitlements to cover installations running on instances in Azure instead; or

o Instrictly limited cases, using the same license entitlements to simultaneously authorize installations on-premises

and in Azure.

Tracking cloud license models for each instance using AHB requires that the connector uses the Microsoft Az module of
PowerShell cmdlets for managing resources in Azure.

(4

= Tip: If you have previously implemented the Azure connector (prior to version 2020 R2.3, internally identified as 16.3.0),
the earlier connector used an earlier and less capable module called AzureRM, which is now outdated, no longer
receiving bug fixes, and not capable of supporting future functionality. For this reason, best practice is to uninstall the
old AzureRM module, and replace it with the current Az module. While strongly recommended, this is not mandatory;
but ifyou persist in using the old connector with the AzureRM module, you cannot track any cloud license model utilizing
the Azure Hybrid Benefit.

Because the Azure connector gathers information that is separate from, and does not include, full hardware and software
inventory, this reference covers more than the connector itself. As well as details of prerequisites, set up, and data
gathering with the connector, the part includes some insights into:

» Processes for gathering complete hardware and software inventory for your cloud-based instances
« Considerations for license management.

In fact, using those guidelines, you could configure inventory gathering in Azure without using the connector at all.
Provided that you are deploying the latest FlexNet inventory agent (13.2.x or later), inventory alone even returns the
cloud service provider. What the connector adds is:

« Automatically setting the Hosted in property in the inventory device records created when inventory is returned
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o Adding the cloud service provider and instance details when these are missing from inventory collected by legacy
versions of FlexNet inventory agent, or from third-party inventory sources

» Populating the Cloud Service Provider Inventory page with records of instances currently running in your Azure
environment, including a few properties that are additional to the normal hardware and software inventory

» Importing permanent records of instances that were previously running but that have now been terminated (and for
which, as a result, any prior inventory devices records have now been deleted)

o Triggering automatic deletion (completed at the next full import and compliance calculation) of any inventory device
record linked to an instance that is now terminated

o Importantly (when the Microsoft Az module is in use), tracking use of the Azure Hybrid Benéefit to license installations of
Microsoft Windows Server and Microsoft SQL Server in the cloud.

This reference focuses on background about the connector, and additional material you need in order to build license

management around the connector. You will not find details about making the actual connection here.

=

I==|' Note: The Microsoft Azure inventory connector does not collect virtual machine information for virtual machines
managed by Microsoft's classic deployment model. For these devices we recommend you use an alternative such as the
inventory spreadsheet upload, the Business Importer or simply through editing manually.

- |

|=| Note: Containers are not currently supported.

Step-by-step instructions for configuring the connection to Azure are available in the online help at FlexNet Manager
Suite Online Help > Inventory Beacons > Inventory Systems Page > Connecting to External Inventory Systems >
Managing PowerShell Connections > Managing Azure Connections.
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Prerequisites and Setting Up

FlexNet Manager Suite 2022 R1 (On-Premises)

The connector to Microsoft Azure is configured on a convenient inventory beacon, for which there are the following
prerequisites:

o The operating system is either:

o Windows Server 2008 R2 SP1 or later

o Windows 7 SP1 or later
» FlexNet Beacon software has been updated to release 17.1.0 (shipped with FlexNet Manager Suite 2021 R1) or later
» You must log onto the inventory beacon, and run FlexNet Beacon, using an account with administrator privileges

¢ .NET Framework 4.7.2 or later is installed (installation instructions and downloads start from
https://docs.microsoft.com/en-us/dotnet/framework/install/)

o PowerShell 5.1 or later is running (PowerShell 7.x and later is recommended)

¥
= Tip: To check the version of PowerShell installed on your inventory beacon:

1. As administrator, run Windows PowerShell.

2. Execute the cmdlet:

$PSVersionTable.PSVersion

« The PowerShell execution policy is set to RemoteSigned

o FlexNet inventory agent version 15.0.0 (released with FlexNet Manager Suite 2020 R1) or later is available on the

inventory beacon

* Aweb browser is installed and enabled on the inventory beacon

H’ Important: If you have configured your existing connection to Microsoft Azure using the original AzureRM module
(downloaded from Microsoft), this must be uninstalled before you install the newer Az module. To uninstall the
original module:

1. Onyour inventory beacon, logged in as Administrator, run PowerShell.
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2. Uninstall the AzureRM module with the following command:

uninstall-module AzureRM

o Microsoft Az for Windows PowerShell version 6.1.0 or later is required by the Azure Resource Graph module.

= Tip: Although the connector is compatible with the Microsoft Az module version 5.2.0 or later, version 6.1.0 or later

is required for compatibility with the Azure Resource Graph module which provides the latest performance
improvements.

If you have Az modules already installed in your environment, update to the latest Az modules:
1. Ensureyou are in a Windows PowerShell session run as administrator.

2. Execute the command:

Update-Module -Name Az -Force

[=%

L ] Note: If you run into any issues while updating Az modules, please try uninstalling and reinstalling the Az modules,
always while in a Windows PowerShell session run as administrator:

o Touninstall:
Get-InstalledModule -Name Az* | Uninstall-module
o Toinstall:

Install-Module -Name Az -AllowClobber

¥
= Tip: To check the version of the Az module installed on your inventory beacon:

1. As administrator, run Windows PowerShell.

2. Execute the cmdlet:

Get-Installedmodule az

Additional versions are available for download from https://www.powershellgallery.com/packages/Az/.

o Microsoft Azure Resource Graph module version 0.11 or later is installed (remembering that this requires Microsoft Az
for Windows PowerShell version 6.1.0 or later, as mentioned above). Flexera recommends that you install this as it
optimizes performance, especially for large-scale implementations in Azure.

¥
= Tip: To install this module on your inventory beacon:

1. Ensure you are in a Windows PowerShell session run as administrator.

2. Execute the command:

Install-Module -Name Az.ResourceGraph

3. Validate your installation with the cmdlet:
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Get-InstalledModule -Name 'Az.ResourceGraph’

On the Azure side, you must:

« First decide in which Microsoft Azure "environment" your connector will operate. All the connection details and
credentials are specific to the environment, and cannot be interchanged. The default environment is AzureCloud
(the value used if no other environment is specified for the connection). Other currently-available environments can

be determined using the Azure cmdlet:
(Get-AzureRmEnvironment) .Name
Examples include:
o AzureChinaCloud
o AzureGermanCloud
o AzureUSGovernment.
Your choice of environment is specified when configuring the connection.

o Choose or create two service principal identities:
o Either the built-in role Virtual machine contributor, ora custom object with read access to

Microsoft.Compute/virtualMachines

o Either the built-inrole SQL Virtual machine contributor, oracustom object with read access to

Microsoft.SqlVirtualMachine/sqlVirtualMachines.

Step-by-step instructions for configuring the connection to your chosen Azure environment are available in the online
help at FlexNet Manager Suite Online Help > Inventory Beacons > Inventory Systems Page > Connecting to External
Inventory Systems > Managing PowerShell Connections > Managing Azure Connections.
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Thinking about Inventory and
Licensing

FlexNet Manager Suite 2022 R1 (On-Premises)

In many ways, collecting inventory and working out license consumption for instances in Microsoft Azure is much the
same as licensing virtual machines on host servers sitting within the datacenter in your own offices. However, there are
some differences that are worth thinking about. For example, within your own datacenter, you have full control of, and
presumably full inventory for, the host server as well as the VMs running on it; and for some license types, host details
are relevant even when licensing software on a virtual machine. Depending on what you purchase, this may not be the
case in Microsoft Azure.

The following topics bring together some points to consider, first about inventory collection, and then about licensing.

Collecting Inventory from Instances

FlexNet Manager Suite 2022 R1 (On-Premises)

The connector to Microsoft Azure gathers useful information, but it cannot gather information valuable for license
consumption calculations from each of the instances running in your Azure cloud. To gather useful inventory from all
instances, best practice is to include the FlexNet inventory agent (release 13.2.buildNumber or later) in the Microsoft
Azure managed VM image from which your devices are instantiated. For details, see the Azure documentation Create a
managed image of a generalized VM in Azure for Windows, or for Linux see How to create an image of a virtual machine
or VHD.

Unique device naming is critical

It is critical to your license management in Microsoft Azure to ensure that each instance is uniquely named on
instantiation. If you do not do this, incoming inventory reports are not differentiated, and are interpreted as updated
inventory from a single device, named with the default device name provided by the base image.

By default, the internal name of a virtual machine is the same as the external name given to it when it is created. While
you can change the internal name of a virtual machine, you cannot change the external name of the virtual machine as
displayed in the Azure portal.

Resource names for virtual machines are immutable. So, if you need to change names, you need to redeploy your
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virtual machine. You can do this by deleting the current virtual machine, while maintaining the current virtual machine
disks, and then creating a new virtual machine using the correct name and point it to the previously maintained disks.

To ensure a device name for each instance that is unique over time, methods vary across platforms. In summary:

» The easiest method on Windows is to use Sysprep when creating your managed VM image, leaving the name unset

so that a new name is provided on instantiation.

e For Linux, if you already provide for unique Hostname values on all your instances, no further action is required; and
otherwise, a little extra preparation can ensure that the unique InstanceID for each instance is also returned in
inventory as the MachineID, where it differentiates all returned inventory as coming from devices with distinct

names.

Schedule specialization
Scheduling inventory collection by the locally-installed FlexNet inventory agent requires:

e Provide an upload location (ManageSoftRL) for inventory collection

* Omit any download location, since the instance life-cycle is projected to be too short to require any policy update or
system-wide schedule update

o Trigger inventory collection on start-up, followed immediately by inventory upload to the defined ManageSoftRL
(this cycle might typically require 3-5 minutes all up, a figure which may change based on other customizations you
may want to include in your managed VM image)

o Provide a back-up schedule of daily inventory collection.

« Keep in mind, as well, that removing the normal paths for policy update also removes the normal updates to
InventorySettings.xml, which includes a range of advanced capabilities for FlexNet inventory agent, including
Oracle inventory collection and advanced inventory techniques for Microsoft and other vendors. Your strategy
therefore includes embedding your most recently downloaded InventorySettings.xml in your managed VM
image (and later, updating it as required). For more guidance on customizing instances, see Configuring an Azure VM

Image for Instances.

Planning your inventory beacons

The final major question is the location of your inventory beacon(s) for uploading inventory data from these instances.
Depending on the reliability of network communications between your cloud-based instances and your own enterprise
network, you may choose either:

« Torun (at least) one instance within your Azure cloud as an inventory beacon, ready 24/7 for any of your instances in
the cloud to upload their inventory. This is especially valuable for instances:

o Where the locally-installed FlexNet inventory agent has no opportunity to retry uploads around any network
failures; and

o where fast network speeds may best support your planned life-cycle for these instances.

The cloud-based inventory beacon can then provide a more rugged upload to your enterprise network, since it has
longer up-time and built-in mechanisms for retrying any uploads that are interrupted by transient networking

issues.
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¢ Run an inventory beacon within your enterprise network (or even, potentially, in a demilitarized zone outside your
firewall), to which all the cloud-based instances have network access, allowing them to upload their inventory files
as and when needed.

Choosing between these alternative places for your inventory beacon may require balancing questions of security and
performance against cost. Whichever choice you make, a good practice is to use a DNS alias to identify the inventory
beacon, so that you can quickly and easily make changes without disrupting the rest of your infrastructure.

¥
= Tip: As for all communication between your enterprise network and the Microsoft Azure network, an Amazon Virtual

Private Cloud (VPC) is required for either of the above architectures; and if you require a link from your inventory
beacon in the Azure cloud to your central application server in your datacenter, consider a hardware VPN connection
as well (see the Microsoft Azure documentation for details).

Keep in mind that an inventory beacon does not normally initiate ('push') communication to FlexNet inventory agents
installed on your Microsoft Azure instances. (The only exceptions are for the 'remote execution' tasks known as
adoption and zero footprint inventory collection, neither of which you expect to use in a cloud environment.) Since all
other communications are initiated by the FlexNet inventory agent ('pull' communications, such as policy updates,
collection of self-update packages, and the upload of inventory), this means that your implementation only needs to
point the FlexNet inventory agent on each instance to its bootstrap inventory beacon. You do not need to known details
like the IP addresses (public or private) for the instances reporting inventory through the FlexNet inventory agent.

Inventory records and exceptions

After a full inventory import and license reconciliation, you can expect to see records created/updated in FlexNet
Manager Suite as follows:

o Forevery instance where the locally-installed FlexNet inventory agent has uploaded inventory, an inventory device
record

« Similarly, for every instance reporting inventory through a third-party tool (such as SCCM), an inventory device
record

« For every cloud instance appearing in data from the Azure PowerShell connector, regardless of whether it appears in
uploaded inventory or not, a cloud instance record in the CloudServiceInstance table (and of those, the ones

that also have an inventory device record show a link to it in the Cloud Service Provider Inventory page)

o Fordedicated hosts identified through the Azure PowerShell connector (and only dedicated hosts, not any other kind

of host), an inventory device record for the host.

You will not find inventory device records for any of the following:

» Acloud instance that does not report inventory
» Ahost device that is anything other than a dedicate host (such as a default host, or a host for dedicated instances)
» Any instance that you have terminated.

Terminated instances are a special case.

1. Before termination, the running instance may have had an inventory device record (provided that it was reporting
inventory).

2. When you terminate the instance, Microsoft Azure keeps the terminated instance visible through the API for about
an hour, and if you have implemented your Azure PowerShell connector on an inventory beacon with the default
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30 minute schedule, the termination is imported through the connector, and the record in the
CloudServicelInstance table is updated with the terminated status. (This record, with its terminated status, is
visible in the Cloud Service Provider Inventory page, if you set the filters on that page appropriately.)

. Atthe next full inventory import (by default, overnight, immediately before the license compliance calculations),

any inventory device record linked to a terminated instance is deleted, because you do not want terminated
instances consuming from your licenses.

. Of course, the terminated instance no longer reports inventory; but its previously-recorded inventory is still in the

inventory database (and in normal processes is not cleaned up for a while). Although the next full import (typically
the next night) normally imports records from the inventory database, for terminated instances this is prevented
by the terminated flag in the CloudServiceInstance table. This prevents the deleted inventory device record
from reappearing.

Should you ever need to review the software previously installed on a terminated instance, you can:

1.

2,

Navigate to Discovery & Inventory > Cloud Service Provider Inventory.

Change the default filter (top left) for Include terminated instances to Yes.

. Optionally, filter the Last known state column to show only Terminated.

. Optionally, use other filters, such as Instances reported in an appropriate period, or the Instance type and

Instance region columns, to narrow your search for this instance.

. Check the Image ID column to identify the original image from which this instance was launched (you may need

to drag this column out of the column chooser).

. Through your Azure console, identify this managed VM image, and inspect its software load and resulting license

impacts.

Data integration

Inventory from a hosted instance may come from multiple sources, and must be integrated correctly. Various rules are
used depending on the sources being combined:

» PowerShell connector + current FlexNet inventory agent are linked by:

o CloudServiceProviderID (displayed as the Cloud service provider name in the web interface)

Matching of the incoming data with existing inventory device records (that is, determining whether this is an update to
an existing record, or a new record) uses the standard device matching rules, with the Cloud service provider and
Instance ID checked as last priority.

Finally, the merging of data between the PowerShell connector and the current FlexNet inventory agent uses these
priorities:

1.

2.

If one source contains a data point that the other does not, the data is used.

If both sources contain the same data point but with different values, the data with the most recent inventory date
is used.

. If different values were imported on the same day, the FlexNet inventory agent is given priority if it has been set as

the primary inventory source.

. Otherwise, the data is used from the most recently created inventory source, with the winning source visible in the

inventory device properties as Last inventory source.
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BYOL Licensing Considerations

FlexNet Manager Suite 2022 R1 (On-Premises)

The Azure connector does not return full inventory from instances running in Azure, and so does not create inventory
device records. There are two special cases to distinguish:
1. Ifthe import from the Azure connector is matched with another record of full software and hardware inventory,
the matching process creates an inventory device record. Full software and hardware inventory may be returned
from an Microsoft Azure instance when either:

« FlexNet inventory agent is locally installed on the instance, usually because it is part of the Azure VM Image

from which the instance was launched

« You configure zero footprint inventory collection from an inventory beacon that has network access to your
target instances, and credentials saved in its Password Manager store

» You have some third-party tool (such as Microsoft SCCM) collecting inventory from your Azure instances, and

these results are then being imported into FlexNet Manager Suite.

As always for all inventory devices, the installations found in software inventory for that device consume
entitlements from the licenses to which each software record is linked.

2. Arecord may be created and displayed in the Cloud Service Provider Inventory page to show the cloud license
model (BYOL or PAYG) discovered for instances that may benefit from the Azure Hybrid Benefit (AHB). AHB allows
you to benefit from licenses originally purchased to cover on-premises installations of either Microsoft Windows
Server, or Microsoft SQL Server, in either of two ways (subject to active Software Assurance): re-purposing them to
cover cloud instances instead; or in the special case of Windows Server Datacenter edition, using them to
simultaneously authorize both on-premises and cloud instances in Azure. However, in order to determine what
software should be licensed (with or without AHB), and measure license consumption, you still need to arrange for
inventory collection covering these instances, for example through:

« The FlexNet inventory agent locally installed on the instance

» Remote inventory collection by an inventory beacon with network access and appropriate credentials for the
instance (called zero footprint inventory collection in the Gathering FlexNet Inventory reference)

o Athird-party inventory tool.

In those cases where inventory is received that matches your Microsoft Azure instance records, there are a few special

consideration.

Beware of terminating instances

For some special purposes, instances in the Microsoft Azure cloud may be launched, run for a short period (from a few
minutes to a few hours), and then shut down until needed again.

Itis quite possible to configure the Azure VM Image from which instances are launched so that inventory is collected
and uploaded through one or more inventory beacons to your FlexNet Manager Suite application server (for details, see
Configuring an Azure VM Image for Instances).

However, the licensing implications are quite different when you stop an instance than when you terminate an instance:

o The assumption is that a stopped instance may be restarted when required, and resume operation with (quite likely)
the same software installed. It is therefore reasonable to calculate license consumption for such an instance, and, if
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you use the configuration described in Configuring an Azure VM Image for Instances, this happens as usual for virtual
machines (whether those are VMs within your enterprise network or instances in the cloud).

» Aterminated instance cannot be restarted, and if you are choosing BYOL for instances that you terminate, you should
check your license terms carefully and make appropriate provision. The working assumption in FlexNet Manager
Suite is that a terminated instance should no longer consume from your software licenses, just as license
consumption stops when you uninstall software from a device, or decommission a hardware asset. As described in
Collecting Inventory from Instances, this is achieved by permanently deleting any inventory device record that may
have previously been created for the instance that is now terminated. All resources attached to the terminated
instance will remain and you can then manually delete these resources as desired. (See the same topic for a way of
re-discovering the software load for a terminated instance, and hence its potential license implications.)

The complexity of managing licenses on transient instances is why it is more common to purchase these based on a
fully-loaded image provided by (and licensed through) Microsoft Azure. However, if you need repeated runs of an
instance for special purposes, and such an instance must include software for which you provide the license (BYOL),
consider running such an instance as a stop/start instance, rather than terminating it and re-launching it, to simplify
your license management.

Thirty-minute inventory and IBM PVU licenses

The default schedule for the Azure connector is to have it run every 30 minutes. Coincidentally, this happens to be the
same interval that IBM requires for hardware checks of devices linked to IBM PVU licenses (when you have IBM's
approval to use FlexNet Manager Suite as the source for sub-capacity licensing calculations, for which see the Sub-
Capacity Licensing with IBM PVU chapter of the FlexNet Manager Suite System Reference PDF, available through the title
page of online help).

However, each of these coincidental but distinct schedules has its own separate reasons:

o The Azure connector should run every 30 minute to allow it to capture transient information that Azure keeps
available for only an hour, so that you can track your terminated instances where required. This is the connector
schedule, and the connector does not return sufficient inventory detail to satisfy the IBM requirements.

o The hardware check for IBM PVU licenses must run every 30 minutes as part of your amended contractual agreement
with IBM. This is an inventory schedule that controls operations of FlexNet inventory agent embedded on an
operational instance.

If you are providing IBM PVU licenses for use in the Microsoft Azure cloud, and have the IBM amended agreement to
allow sub-capacity calculations within FlexNet Manager Suite, these two default schedules conveniently satisfy both
requirements within Azure. However, be aware of the following requirements:

¢ IBM PVU licenses in the BYOL model are not appropriate for short-lived instances that are then terminated (see
previous section about the pitfalls of terminating instances with BYOL). Start/stop operations can be used when
necessary, as long as the instance is maintained and not terminated.

o Persistent (unchanging) inventory device names and matching instance IDs are critical to this license model,
allowing proper calculations of peak consumption values over time. For details about setting a unique but persistent
device name for inventory, see Collecting Inventory from Instances.

o Asalways, full hardware and software inventory (from the instance) is required for IBM PVU licensing. Compliance
with your IBM license requires regular software inventory (daily is recommended best practice) as well as the
30-minute hardware check. Use of the FlexNet inventory agent is also mandated by your adjusted license
agreement. The techniques in Collecting Inventory from Instances prepare an Azure VM Image from which you can
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launch instances with the operational FlexNet inventory agent embedded, satisfying those requirements.

o Asalways, the first full software and hardware inventory must be uploaded and processed on the central application
server before the 30-minute hardware checks take effect. (This allows the calculation of updated rule targets that
identify all devices affected by IBM PVU licensing processes.) Typically the relevant compliance calculations take
place overnight, after which the revised device policy must be distributed through the inventory beacon hierarchy to
affected installations of FlexNet inventory agent, bringing with it the special schedule for the hardware check. All of
this process means that in the normal course of events, IBM PVU operations typically are running effectively from the
day after an instance is launched with PVU-licensed software in operation.

Uncapped calculations except on dedicated hosts

Some license types allow that, where the total license liabilities for many VMs on the same host theoretically exceed
factors like the total number of cores available on the host, the summing process is 'capped' or given an upper limit by
the actual capacity of the host. For example, if five VMs on a host are each allocated 2 cores, for a total of 10 allocated
cores when the host actually only has 8 cores available, then, just as in reality the time-sharing between the VMs limits
the cores in use at any moment, so also the license rules cap (or reduce) the calculated figure (10 cores) to the total
capacity of the host (8 cores).

Obviously, capping of consumption calculations requires inventory not only of all the VMs on a host, but also of the
host itself. However, in the case of Microsoft Azure instances, inventory details are not available for any host types other
than 'dedicated hosts', over which you have full control. This means that on all other, non-dedicated hosts in Azure,
capping of license calculations cannot occur.

All calculations for BYOL licensing of instances on non-dedicated Azure hosts are based entirely on the inventory taken
from the instances themselves, without capping. This does not expose you to any risk of under-licensing (provided that
allinstances are returning inventory); the only risk is that you may perhaps be over-calculating the consumption that
might apply on a known host with capping applied.

However, this may not be an issue at all. Carefully check your BYOL terms and use rights. You may find that software
publishers already disallow capping in cloud environments, because of the impossibility of tracking instances that may
pop up now on this host and now on another, depending on resource allocations within Azure.
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Configuring an Azure VM Image for
Instances

FlexNet Manager Suite 2022 R1 (On-Premises)

The easiest way to collect inventory from all your cloud-based instances is to ensure that they are launched from an
Azure image that already contains everything needed for the collection of FlexNet inventory. The requirements include:

Installing the latest approved FlexNet inventory agent into the image
Adding a customized configuration file that identifies the upload location for inventory

Installing a customized schedule to manage FlexNet inventory agent in the resulting instances, triggering inventory
gathering on start-up (and best practice is to include a backup schedule for further inventory collection in case an
instance from this AMI runs for an unexpectedly long time)

Including the current version of InventorySettings.xml that provides advanced functionality for FlexNet

inventory agent, since the short lifetime does not allow for normal policy-based downloads

Ensuring a unique name for each instance created from this Azure VM Image.

At this summary level, the requirements are the same for Windows and Linux platforms. In the details, of course, there
are platform specifics.

=
[_] To prepare an Azure Resource Image:

1. Inthe web interface for FlexNet Manager Suite, navigate to Discovery & Inventory > Inventory Settings.

The Inventory Settings page displays.

2. Expand the Inventory agent for download section.

3. Collect the template configuration file:

o ForaWindows-based AMI, click Download bootstrapping template file, and save mgssetup.initoa

convenient working folder (such as C: \temp). (Do not change the file name.)

 For aLinux-based AMI, in the Gathering FlexNet Inventory PDF (available through the title page of online help),
copy the text from Agent third-party deployment: Sample UNIX Bootstrap Configuration File and save it as
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mgsft_rollout_response in a convenient working folder (such as C:\temp).

4. From the Inventory agent drop-down list, select the version of FlexNet inventory agent you want to install in your

218

AMI, and save it to your working folder.

In general, install the latest available version, subject to your corporate policies. This provides access to the latest
functionality. For example, to include advanced inventory for Microsoft Azure, you must use FlexNet inventory
agent 13.2.0 or later (see Appendix 3: Enhanced Inventory Gathered by Agent).

. Inyour preferred flat text editor, customize your bootstrapping template file to be used for FlexNet inventory agent

in your Microsoft Azure environment as follows, saving the edited version in a separate subfolder.

For Windows, the only mandatory change is to identify the upload location for gathered inventory, as described
below. On Linux, FlexNet inventory agent requires both an upload location and a download location. As always,
on either platform, experts may also customize other preferences needed for your implementation, as described

in the platform-specific topics in the Gathering FlexNet Inventory PDF:

» Agent third-party deployment: Edit the Configuration File for Microsoft Windows

o Agent third-party deployment: Configure the Bootstrap File for UNIX.

The upload (and download) locations require a URL to the host inventory beacon. Best practice is to provide a
DNS alias for your chosen inventory beacon, so that when circumstances change, a simple switch of the alias
leaves any running and future instances fully operational, without requiring changes to the virtual machine image.

e ForWindows, inmgssetup.ini:

a. Locate this section for Common preferences, and uncomment (remove the leading semi-colon) and edit the

following settings:

; Registry settings to be created under
; HKLM\Software\ManageSoft Corp\ManageSoft\Common

[Common]

desc@® = UploadSettings\Bootstrap Server\Protocol

vale = http

descl = UploadSettings\Bootstrap Server\Priority

vall = 100

desc2 = UploadSettings\Bootstrap Server\AutoPriority

val2 = False

desc3 = UploadSettings\Bootstrap Server\Host

val3 = beacon.fnms.com

desc4 = UploadSettings\Bootstrap Server\Port

vald = 80

desc5 = UploadSettings\Bootstrap Server\Directory

val5 = /ManageSoftRL/

b. Optionally, modify the Protocol value if you want to use HTTPS (vale = https).

¢. You must customize the Host preference (shown above asval3 = beacon.fnms.com) to your chosen

DNS alias (or preferred host setting) and your own enterprise name if the inventory beacon is located in
your enterprise network rather than on an Azure instance. For an inventory beacon hosted on an Azure

instance, you can identify its public and private DNS hostnames on the Azure console (select Instances in
the navigation pane, choose the instance hosting the inventory beacon, and read both its public and private
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DNS hostnames in the details pane).

7
=" Tip: If you have an inventory beacon on an Azure instance, your installations of FlexNet inventory agent

on other instances can be configured to use the private DNS hostname for accessing the inventory
beacon (provided that both are within the scope of your VPC). The private hostname has greater
stability, particular if the inventory beacon host is stopped and started from time to time.

d. Optionally, customize the port setting (for example, if you are switching to the HTTPS protocol, the default
portis 443).

RJ Important: The Directory preference is mandatory, and must be set as shown above.

e. Create a subfolder (such as SysPrepAgent) and save your edited mgssetup.ini there. Do not change the
file name, which is mandatory.

e ForLinux,inmgsft_rollout_response:

a. Inthe first section of the file, customize the setting for the download location (see also the comments for
the upload location, next):

# The initial download location(s) for the installation.

# For example, http://myhost.mydomain.com/ManageSoftDL/

# Refer to the documentation for further details.
MGSFT_BOOTSTRAP_DOWNLOAD=http://beacon.fnms.com:8080/ManageSoftDL/

b. In the next section of the file, customize the setting for the reporting (upload) location:

# The initial reporting location(s) for the installation.

# For example, http://myhost.mydomain.com/ManageSoftRL/

# Refer to the documentation for further details.
MGSFT_BOOTSTRAP_UPLOAD=http://beacon.fnms.com:8080/ManageSoftRL/

You may customize the protocol to HTTPS if required, and omit or customize the port number as required.
You must customize the host URL (shown above as beacon . fnms. com) to your chosen DNS alias (or
preferred host setting) and your own enterprise name if the inventory beacon is located in your enterprise
network rather than on an Azure instance. For an inventory beacon hosted on an Azure instance, you can
identify its DNS hostname on the Azure console (select Instances in the navigation pane, choose the
instance hosting the inventory beacon, and read its DNS hostname in the details pane).

R] Important: In each case, the trailing /ManageSoftDL/ (download location) or /ManageSoftRL/
(upload or reporting location) is mandatory, and must be specified as shown above.

c. Inthe last line of the file, switch the value to prevent policy running after installation, as short-lived
instances do not have time to wait for policy and its outcomes:

MGSFT_RUNPOLICY=0

d. Create a subfolder (such as SysPrepAgent) and save your edited mgsft_rollout_response there. Do
not change the file name, which is mandatory.

e. Unlessyou already have a strategy and practice that gives every Linux instance a unique name, also create a
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new text file for your Linux virtual machine image, called tmpconfig. ini, with exactly the following two
lines:

[ManageSoft\Common]
MachineID=

This file is deliberately incomplete at this stage, and is to be completed at instance start-up, as described
later.

6. For either platform, copy the following and paste it into a plain ASCII text file, and save it in your SysPrepAgent
folder as DefaultSchedule.nds (this file name is mandatory). Of course, you may choose to unwrap those lines
wrapped for readability here.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE Schedule PUBLIC "Flexera Inventory Manager schedule"
"http://www.managesoft.com/dtd/schedule.dtd">

<Schedule NAME="Default Schedule" TIMEDATESTAMP="20180903T044104Z"
SCHEDSCHEMA="60" >
<Event NETWORK="False"
NAME="Generate Inventory"
CATCHUP="Never" ID="{FO65A477-B500-4611-8340-3BF313FB785B}">
<LogicalCommand PARAM=" -o UserInteractionLevel=Quiet”
ACTION="Report" COMPONENT="Tracker"/>
<Trigger TYPE_PARAM="0" TIMESTART="143950"
DATESTART="20180903" TYPE="Logon" MAXDELAY="0"/>
</Event>
<!-- Following two events are optional (see notes) --!>
<Event NETWORK="False"
NAME="Generate Inventory" IDLEDURATION="86400"
CATCHUP="Never" ID="{FO65A477-B500-4611-8340-3BF313FB785B}">
<LogicalCommand PARAM=" -o UserInteractionLevel=Quiet"
ACTION="Report" COMPONENT="Tracker"/>
<Trigger TYPE_PARAM="1" TIMESTART="001000"
DATESTART="20180903" TYPE="Daily" REPEAT="21600"
TIMEWINDOW="3600" DURATION="86400"/>
</Event>
<Event NETWORK="False"
NAME="Upload Client Files"
CATCHUP="Never" ID="{9CB87BAE-2829-498C-8643-10A9BD3BFA56}">
<LogicalCommand PARAM="-a"
ACTION="Upload" COMPONENT="Uploader"/>
<Trigger TYPE_PARAM="1" TIMESTART="002000"
DATESTART="20180903" TYPE="Daily" REPEAT="600"
DURATION="86400"/>
</Event>
</Schedule>

The first event in this schedule triggers machine inventory collection on startup (TYPE="Logon"), and the
tracker component automatically attempts an upload to the bootstrap inventory beacon as soon as inventory
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gathering is complete. If you are certain that all instances from this image are short-lived, only this event is
required. If you are using an instance, and you choose to stop and restart your instance (rather than to terminate
and re-launch it), this inventory is checked on each restart.

In addition, two further schedule events provide easy management of cases where an instance proposed to have a
short life in fact keeps on running for some longer time.

The second event also generates inventory, and is triggered every 6 hours (REPEAT="21600", with all times
expressed in seconds), to start within an hour thereafter (TIMEWINDOW="3600"). However, this inventory
collection is different than the first case, because here the FlexNet inventory agent does not repeat the inventory
collection if it has been successful within the last 24 hours (IDLEDURATION="86400"). This means that,
effectively, the FlexNet inventory agent checks four times a day whether there has been a successful inventory
collection in the last 24 hours, and if not, it runs a new inventory collection.

In a perfect world, the third event is redundant because the tracker component uploads inventory as soon as it
is collected. This third, separate upload event is a catch-up to work around transient network issues. It checks
every 10 minutes to see whether any inventory files have failed to upload (and are therefore still waiting in the
staging folder). In normal cases, nothing is waiting, and the uploader shuts down immediately, causing
negligible load on the instance. But where there have been networking issues, upload is attempted again every 10
minutes until all files are successfully uploaded and removed from the staging folder.

7. On a convenient inventory beacon, navigate to %CommonAppData%\Flexera Software\Staging\Common\
ClientConfiguration,take a copy of InventorySettings.xml, and save it to your SysPrepAgent working
folder.

This completes the preparation of materials for your virtual machine image for instances of this expected life. Now
continue to use these materials to prepare the virtual machine image. For both platforms, the high-level process is
to customize a running instance, and then save it as a virtual machine image.

For a Windows-based VM Image please refer to the following link:

 https://docs.microsoft.com/en-us/azure/virtual-machines/windows/tutorial-custom-images
For a Linux-based VM Image please refer to the following link:
+ https://docs.microsoft.com/en-us/azure/virtual-machines/linux/tutorial-custom-images

8. Following the Azure documentation, select (or create), launch and connect to your chosen instance from which you
are creating your Azure VM Image.

9. To customize your instance:
a. Ensure that the destination folder exists for your installation of FlexNet inventory agent, and if not create it.

The default paths for each platform are:

e OnWindows, C:\Program Files (x86)\ManageSoft
e OnLinux, /opt/managesoft/bin.

b. From your local SysPrepAgent working folder, copy these files into the destination folder on your
instance:

¢ DefaultSchedule.nds

o InventorySettings.xml
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e Only on Windows, mgssetup.ini
e Onlyon Linux, tmpconfig.ini.
c. ForLinuxonly, also copy your amended mgsft_rollout_response fileto /var/tmp/ onyourinstance.

d. Collect the downloaded installer for FlexNet inventory agent from your working folder, and run the installer
on your instance, installing FlexNet inventory agent into the prepared destination folder.

The installer automatically configures the custom settings declared in the configuration file (either
mgssetup.iniormgsft_rollout_response, depending on platform). For more information about
running the installation, see the Agent third-party deployment: Details chapter of the Gathering FlexNet
Inventory PDF, focusing on the installation topic for your preferred platform.

e. When installation is complete, in the same destination folder and for both platforms, run the following
command to install your default schedule:

start ndschedag.exe -t machine .\DefaultSchedule.nds

This virtual machine image is now ready. As soon as each instance is spawned, the embedded FlexNet inventory agent
gathers inventory from the instance, and immediately uploads it to the bootstrap inventory beacon. Depending on the
resources on each instance, this process may take around 2-5 minutes, after which the instance can be stopped (but
remember, not terminated if you wish to track related software licenses in FlexNet Manager Suite).
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Appendices: Technical Data

FlexNet Manager Suite 2022 R1 (On-Premises)

The following topics do not include content you need for set-up or operation of the Microsoft Azure connector. These are
the deep-down technical data that you can ignore until you have a real need.

Appendix 1: Cmdlets in Azure PowerShell

FlexNet Manager Suite 2022 R1 (On-Premises)

The connection from FlexNet Manager Suite to the Microsoft Azure service relies on the Az Tools for Windows
PowerShell (as described in Prerequisites and Setting Up). Within that toolset, the connector uses the following
PowerShell cmdlets:

e Connect-AzAccount — To log into Microsoft Azure
e Disconnect-AzAccount — To log out of Microsoft Azure

e Get-AzEnvironment — To identify the environments currently available in Microsoft Azure (such as

AzureChinaCloud, AzureCloud, AzureGermanCloud, AzureUSGovernment)

e Get-AzLocation — To identify the available Azure geographic regions of the instance type (size in Microsoft term)

where your instances may be running
e Get-AzSqlVM — To return the list of the SQL virtual machines you own, and then collect the cloud license model
e Get-AzVMSize — To return the list of the instances type based on location

¢ Get-AzVM— To return the list of the instances (virtual machines) you own, and then collect summary inventory

details on each one

« Search-AzGraph — To return the list of instances for a batch of subscriptions.
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Appendix 2: Data Imported by Microsoft
Azure Connector

FlexNet Manager Suite 2022 R1 (On-Premises)

The PowerShell connector for Microsoft Azure returns information about each Azure instance, and its host. All instances
are subsequently displayed in the Cloud Service Provider Inventory page; and those tracking installations of
Microsoft Windows Server or SQL Server also display the cloud license model (BYOL for bring your own license, or PAYG
for pay as you go) in use for each instance. Hosts are never displayed in this page, as in general hosting is variable and
controlled by Microsoft Azure.

Tip: One exception where you have direct control is the 'dedicated host' Like all other host types, dedicated hosts do
not appear in the Cloud Service Provider Inventory listing; but they do automatically appear in inventory device
listings, such as the All Inventory page, where you can search for them using the Hosted in property. Any instances
from the Cloud Service Provider Inventory listing that are hosted on your dedicated host also display a link to the
dedicated host properties in the Host column.

Instance data

7
= Tip: All kinds of instances return this set of data, whether they are virtual machines or bare metal instances. The
latter return an Instance type starting with 13..

There is one condition where the Cloud Service Provider Inventory page includes a hyperlink to open the inventory
device properties page for the instance: if the data gathered through the connector matches inventory collected from
another source (one possible example is having FlexNet inventory agent running locally on the instance). In this case,
linked records exist in both the ComplianceComputer and CloudServiceInstance tables.

Some data is additional to the normal content collected as inventory. For example:

e TheInstanceTenancyID, used foridentifying whether the current device is aDedicated instance,orisan
instance runningOn dedicated host,isimported into the CloudServiceInstance table, and, as Availability

type, is visible in both the Cloud Service Provider Inventory page and the Cloud Hosting tab of the inventory
device properties (where inventory exists for the instance)

o The cloud hosting model is displayed in the Cloud Service Provider Inventory page as SQL server mobility and/or
Windows server AHB - both of these columns may display PAYG or BYOL, where the license model is known (and
remain blank when it is not). Note that the connector returns only the license model that is applicable if and when
the relevant product is installed on the instance - it is not an inventory report showing whether either product is
installed. If you subsequently add full software and hardware inventory for this instance, and the inventory is
matched to this record in the next license compliance calculations, a link is added in the Device name column so
that you can open the inventory device properties and see what software is actually installed.

.
= Tip: Azure "bare metal instances" behave like other instances in terms of data gathered and records created.
When there is an inventory device record for an instance, the inventory-related values imported through the Microsoft

Azure connector (and shown below in alphabetical order) are displayed in the separate Cloud Hosting tab of the
inventory device properties:
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+ Account

« Availability type

« Availability zone

e Cores

» Create date

¢ HostID

* ImagelID

« Instance ID (Azure VmId, which is also UUID of the VM)
+ Instance type

« Instance region

« Last known state (state of the instance, will be mapped to Started, Stopped, Suspended, Terminated, or

Unknown)
¢« MAC address
o NetworkID

¢ Purchased option

Threads per core.

.I/"..
W Tip: The inventory device record does not store any information about cloud license model for any cloud instance.

Cloud license model for an instance running SQL Server or Windows Server applications is available in the Cloud
Service Provider Inventory page under the columns SQL server mobility and Windows server AHB respectively.

Appendix 3: Enhanced Inventory Gathered
by Agent

FlexNet Manager Suite 2022 R1 (On-Premises)

As well as the high-level data gathered from the Microsoft Azure connection, FlexNet inventory agent (version 13.1 or
later) gathers addition inventory data for each Azure instance where FlexNet inventory agent is locally installed. To do
so, FlexNet inventory agent accesses the following Azure-internal URL:

e curl -H Metadata:true "http://169.254.169.254/metadata/instance?api-version=YYYY-MM-DD"
— you must replace YYYY-MM-DD with the api-version date to return the unique identifier for the Azure instance. For
example:

curl -H Metadata:true "http://169.254.169.254/metadata/
instance?api-version=2018-10-01"

o Toview the api-version dates enter curl -H Metadata:true "http://169.254.169.254/metadata/
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instance" which will return an error message which identifies the api-versions. For example:

{

"error": "Bad request. api-version was not specified in the request. For more
information refer to aka.ms/azureimds", "newest-versions": [

"2018-10-01",

"2018-04-02",

"2018-02-01"

]

}

o http://169.254.169.254/metadata/instance returns a JSON-formatted value containing data about the
instance where FlexNet inventory agent is locally installed. For example:

{
"devpayProductCodes"” : null,
"marketplaceProductCodes"” : [ "labc2defghijklm3nopgrs4tu"” ],
"availabilityZone" : "us-west-2b",
"privateIp" : "10.158.112.84",
"version" : "2017-09-30",
"instanceId" : "i-1234567890@abcdef0",
"billingProducts” : null,
"instanceType" : "t2.micro",
"accountId" : "123456789012",
"imageId" : "ami-5fb8c835",
"pendingTime" : "2018-11-19T16:32:11Z2",
"architecture" : "x86_64",
"kernelId" : null,
"ramdiskId" : null,
"region" : "us-west-2"

These two data points are then embedded within the normal . ndi inventory file as a pseudo-hardware WMI class
called MGS_CloudMetadata. The class looks similar to this example (lines wrapped for presentation):

<Hardware class="MGS_CloudMetadata" Name="ec2amaz-vrkiu@p" Evidence="metadata">
<Property Name="instance-id" Value="1i-1234567890abcdef0"
Evidence="/latest/meta-data/instance-id"/>
<Property Name="document" Value="ewogICJwcml2YXR1SXAiIDogIjE3Mi4zMS4yLjEXxNiIs...."
Evidence="/latest/dynamic/instance-identity/document”/>
</Hardware>

After a full inventory import, these details are eventually saved in the CloudServiceInstance tablein the
compliance database.
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Data Platform Integration

FlexNet Manager Suite 2022 R1 (On-Premises)

This part introduces the integration between FlexNet Manager Suite and Data Platform, an umbrella product that includes
both Technopedia and Normalize.

The method of integration is a straight-forward connector, available without special installation on your inventory
beacons (including any inventory beacon you may have installed on your central application server). On the Data
Platform side, an enhanced license term and a new data pack are required (see Configuring the Data Platform Connector
for details).

Such simplicity means that the main use for the documentation in this part is to understand the mapping between
« Database tables and columns that underlie Normalize, and
o The destination tables and columns in the compliance database for FlexNet Manager Suite.

Also important is the embedded commentary on the current limitations of Data Platform as a sole data source driving
license compliance calculations. When you have multiple inventory sources, imports from Data Platform can be a
valuable addition to your data gathering.

Supported version

The Data Platform v5 connector supports import only from version 5 of Normalize.
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Integration with Data Platform v5

FlexNet Manager Suite 2022 R1 (On-Premises)

Data Platform version 5 (formerly from BDNA, and now from Flexera) combines Technopedia, a reference catalog with
120 million datapoints across more than 1.7m products, and Normalize, which provides a unified view of the data
applicable to your environment.

To integrate this data for your use in license and asset management within FlexNet Manager Suite, release 2022 R1
includes a connector that imports normalized data from Normalize v5 into your compliance database. The imported
dataincludes:

* Records of inventory devices (for both physical servers and virtual machines) found in your environment by the
inventory tools (such as Microsoft SCCM or BMC ADDM) that are feeding into Normalize v5

» Details of applications recognized within your enterprise through those tools

« Installation records that link the found software to the inventory devices where it is installed

» Details of end-users who log onto the inventory devices

» Where available, records of application usage (how often, and for how long, an end-user utilized an application).

Application records are dealt with in the same way as inventory data from any other source. This means that the data
representing applications within Normalize v5 is imported into FlexNet Manager Suite in the first place as inventory
evidence (in this case, as installer evidence). What happens next depends on the details of the software:

o Ifthe application is already known to the Application Recognition Library (ARL), and therefore has a Flexera ID
included in the import from Data Platform, the evidence is recognized by the ARL and a matching installed application
record is created (if it did not exist already) and displayed in the Installed Applications page. For such records, the
inventory evidence type is set to FlexeralD, and the installer evidence record is linked to the application record.

¥
= Tip: It may happen that the application is only recognized by a later update of the ARL than is currently deployed in

your enterprise. If this occurs, a widget on the System Health Dashboard highlights the need to refresh your local,
downloaded ARL (or you can wait until the next automated download, which typically happens each weekend).

« Iftheinstaller evidence is not [yet] recognized by the ARL, then following normal system processes, it cannot be
linked to an application record, and it remains in the Unrecognized Evidence page, in the listing under the Installer
evidence tab. For these cases, the inventory evidence type is displayed as Data Platform. (Future updates to Data

Platform and the ARL may mean that the same installer evidence re-imported thereafter may be recognized, and an

228 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)



Integration with Data Platform v5

installed application record automatically created at that time. For this reason, it is best not to manually trigger
application creation from such records of public applications, but to wait for Flexera's continuing alignment work to
automatically complete the links for you. If you find such a case that is needed in your enterprise with some urgency,
you can ask Flexera to prioritize its delivery through a later release of the ARL.)

¥
= Tip: Asubset of these unrecognized cases may be application records that you created locally within your

enterprise (records that in Data Platform are called "private applications', and in FlexNet Manager Suite are called
"local applications"). As such records may never be matched by the ARL, you may wish to start from the
unrecognized evidence record to re-create your local application record within FlexNet Manager Suite. In summary,
best practice is to manually trigger the creation of application records only for locally-created, 'private’
applications; and to await updates from Flexera for 'public’ applications.

Connector, not adapter
The integration with Data Platform v5 is not strictly an "adapter", for the following reasons:

« It does not require any custom XML file to be maintained through either the Inventory Adapter Studio or the Business
Adapter Studio

o Thereisno need (nor purpose) for any staging database

« Thereis no separate download and installation required (with the possible exception of the initial release, where
shipment of the connector is not synchronized with the product release; but in future it is embedded as a standard
part of the product).

Instead, this integration is through a connector that is available on any up-to-date inventory beacon. You set up the
import in exactly the same way as for any other inventory connection: specifying the details in the new inventory
connection dialog on the Inventory systems page on your preferred inventory beacon; and nominating your preferred
schedule for the regular imports. Full details are included below in Configuring the Data Platform Connector.

Inventory gaps and limitations

Following topics cover the mapping of data from within Data Platform to the import tables within the compliance
database in FlexNet Manager Suite. (Hints are also given for tracking data from the import tables to the operational
tables within the compliance database, with further information being available in the FlexNet Manager Suite Schema
Reference PDF, available through the title page of online help.) Within those topics are specific comments about the
impact of particular inventory gaps on tracking your license compliance.

At a high level, inventory gathered only from Normalize v5 is insufficient for:
« Oracle Processor license calculations (missing the partial number of processors)
« IBM PVU license calculations (missing the partial number of processors)

o Any licenses that rely on details about the host settings for virtual machines, such as assigned core or processor
counts (for VMs, this connector can only import the virtual host, and no other details of the VM, including pools,
clusters, capping and the like). Notice, however, that inventory is normally gathered separately both from the
virtualization host and from available guest machines, so that records are available for each device's view of its own

properties.
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Validate your data processes

When there are inventory gaps, the best-practice work-around is to add a second inventory source that fills the gaps, and
allow FlexNet Manager Suite to merge the sources to produce a unified data set. The risk factor is that record merging
may fail (because of different values in key fields), leading to duplicate records in your compliance database that cause
over-counting.

Such a case is the possible merging of imports from Data Platform with another source, such as the FlexNet inventory
agent. One of the key fields for merging inventory device records is the domain name that the device reports, and
currently the values for domain are by default saved differently. Data Platform v5 typically saves a flat domain name
(such as flexera); and while FlexNet Manager Suite can handle either format, by default is saves and uses the DNS
domain name format (distinguished name) that includes the root domain (such as flexera. com). At first glance this
difference looks high-risk; but there is a compliance database table that helps to resolve this issue, called the Domain
table. Since this stores both the fully-qualified distinguished name for the domain, and also its flat name, it allows
reliable matching between the two forms, provided that it has been populated with the appropriate records before a
mapping is requested.

So, to prevent duplicate inventory device records, it is important to ensure that the Domain table is populated with all
your domain names in both formats before importing from Data Platform (or indeed, any other inventory source that
reports the flat name for domains). There are three ways to do this, of which the first is best practice:

« Run an import from Active Directory. This populates the Domain table appropriately with both domain name formats.
« Import FlexNet inventory, since the FlexNet inventory agent reports both name formats.

¢ Importinventory from Microsoft SCCM 2012 or later, since from that release, SCCM also reported the domain name in
both formats.

The first option is clearly preferable since it gives the most complete coverage of all your domains. Therefore, before
importing from Data Platform, ensure that your Active Directory imports are up-to-date.

i
= Tip: If you have domains that are outside the reach of your Active Directory implementation, you can create a

spreadsheet and write a business adapter to populate the Domain table.

A match between host name, domain, and serial number is sufficient for merging (de-duplicating) inventory device
records. Where these high-priority values are not available, FlexNet Manager Suite continues checking lower-priority
properties including:

e HostIdentifyingNumber
« HostType
e ILMTAgentID.

Since all these properties are unavailable from Data Platform v5 (see Imported Computers (Inventory Devices)), this
makes correct mapping between the naming formats of your domains all the more important in avoiding duplicate
device records.

|_b Attention: Even when you follow best practice and use the above techniques to populate the Domain table with both
the flat name and the distinguished name for each domain, issues with domain reporting may still cause creation of
duplicate records for computers or users. This is because some data sources (notably HP-UD and ADDM) report domain
properties for users and computers in ambiguous ways, and where overlapping data comes from another source
(including coming through Data Platform even from the same original source), duplicate records may result. You may
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both prevent and repair such duplication simply by setting your Primary inventory source to a known-good choice
from the overlapping sources, such as SCCM, FlexNet inventory, or Data Platform. (To find this setting, navigate to the
system menu (% ¥ in the top right corner), choose Data Inputs and select the Inventory Data tab). To clear duplicate
records previously created through this issue, set your good source that's reporting the domain as primary, and wait
for (or trigger) a full import and compliance calculation. By default, these full imports and calculations happen
overnight, so you can check that your previous duplicates are cleaned up the day after adjusting your primary
inventory source.

If you are considering the use of two data paths for overlapping inventory records (such as having a common source
imported directly into FlexNet Manager Suite on the one hand, and imported through Data Platform v5 on the other),
one caveat to be aware of is the need for additional expertise. Suppose that you are trying to analyze a problem with
recognition of a particular application. With two data paths, you must first determine which data path delivered the
record, because the recognition logic differs between the paths:

If the path was direct from the inventory source (such as SCCM) into FlexNet Manager Suite, then the evidence rules in
the Application Recognition Library (ARL) must be assessed for effective matching.

If that path from the inventory source led through Data Platform v5, you first need expertise to analyze the
recognition process within that domain, because it is Data Platform (and in particular Normalize v5) that has
recognized the application. In addition, you must validate that Data Platform v5 is supplying a Flexera ID for the
application it recognizes, and that the same Flexera ID is listed as evidence in your installed ARL — otherwise, despite
its initial recognition, the 'application' languishes in the Unrecognized Evidence page within FlexNet Manager Suite.

In summary, combining both data paths provides a growth opportunity.

Supported versions

The connector is validated for operations between Data Platform v5 and FlexNet Manager Suite 2018 R1. Within that
framework, the following recommendations apply:

Data Platform: The preferred release of Data Platform (and in particular, Normalize) is 5.5.4 (or later), as this release
fixed a problem where, for virtual machines, imported data contained incorrect values for the count of Cores and
Threads (or logical processors). Both these values are visible in FlexNet Manager Suite on the Hardware tab of the
inventory device properties. In the same location, you may also manually override both these values when a
correction is needed, and your overridden values are unaffected by future inventory imports (for more details, see the
online help for the Hardware tab).

FlexNet Manager Suite: While formal validation is limited to release 2018 R1 and later, informal spot testing suggests
backward compatibility of the connector should extend back to at least release 2017 R1 of FlexNet Manager Suite.

|_¢ Important: If you are testing with an earlier version of FlexNet Manager Suite, be sure that, on all relevant
inventory beacons, you remove the superseded folder C: \Programbata\Flexera Software\Compliance\
ImportProcedures\Inventory\Reader\BDNA before distributing the new Data Platform v5 folderasa
replacement (full details about the new folder are included in Configuring the Data Platform Connector).
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Configuring the Data Platform
Connector

FlexNet Manager Suite 2022 R1 (On-Premises)

Configuring the Data Platform connector is a one-time task, and quite straight-forward. Thereafter, the imports continue
at the intervals you schedule. Have ready your connection details for the Normalize v5 database.

3
[_] To configure the Data Platform connector:

1. To minimize the risk of duplicate records when you have imports from multiple inventory sources, ensure you have
completed Active Directory imports from all your domains.

For more details, refer back to Integration with Data Platform v5. For guidance about Active Directory imports, see
FlexNet Manager Suite Help > Inventory Beacons > Active Directory Page.

2. If necessary, apply for your updated Data Platform license to enable integration with FlexNet Manager Suite, by
contacting your Flexera Support consultant.

This updated license is available free of charge to existing customers who have implemented Data Platform. It
authorizes additional functionality and a new data pack. If you are unsure whether you already have this updated
license, there are two ways you may check:

» You can send a question to Data Platform Support
 You can run the following SQL statement against your Normalize v5 database:

Select IS_SUBSCRIBED from BDNA_CP where CP_NAME = ‘Technopedia Flexera Mapping’

If the result returns Y, your Data Platform instance includes the license term, and you may skip ahead to step 4.

If it returns N, you need to apply for the license update.
3. When you receive the updated activation key:

a. In BDNA Admin, navigate to the Preferences page.

b. Enure that the Registration tab is selected (top left).

c. Delete the current contents of the Activation Key field.
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d. Copy the key in full from the email you received, and paste it into the Activation Key field.
e. Click Register New Key.
4. Download the new data pack:
a. Navigate to the Technopedia page in BDNA Admin.
b. Click Start Catalog Sync, and wait for the data pack to download.
5. Ensure that the Data Platform connector is in place in your FlexNet Manager Suite implementation.

You can check whether the Data Platform connector is already in place by inspecting any inventory beacon, or (for
an on-premises implementation) your central application server (in a multi-server implementation, check the
batch server). In each case, open Windows Explorer and navigate to C: \ProgramData\Flexera Software\
Compliance\ImportProcedures\Inventory\Reader.Ifyou find afolder there called Data Platform v5,
your connector is already in place, and you may skip ahead to the next major step. If not, switch to a web browser
to obtain your copy:

a. Right-click the zip archive, and choose Extract All....

b. Navigate through the unzipped archive to Adapter Tools for FlexNet Manager Suite 2022 R1.zip>
Data Platform v5.

c. CopytheData Platform vs5 folderin its entirety to C: \ProgramData\Flexera Software\

Compliance\ImportProcedures\Inventory\Reader onyourchosen inventory beacon.

¥
= Tip: Copy the folder to the same location on your central batch server (or server hosting that

functionality), and FlexNet Manager Suite automatically transmits it to all your inventory beacons as
part of their regular policy update. Allow an hour or two (depending on how many inventory beacons
you have) for this process to complete.

6. Ensure that you have your preferred schedule for imports from Data Platform set on the appropriate inventory

beacon:

a. Loginto the inventory beacon interface as an administrator (for example, in the Windows Start menu,
search for FlexNet Beacon, right-click it, and select Run as administrator).

L
= Tip: Remember that you must run the inventory beacon software with administrator privileges.

b. From the Data collection group in the navigation bar, choose Scheduling.

c. Ifthereis not already a suitable schedule in the list, click New... and complete the details (see the online
help for that page for more information). Otherwise, identify the schedule you will use.

7. Define the connection to your Data Platform implementation:
a. Select the Inventory systems page (in the same group), and then click New....
If you used the down arrow on the split button, use only the SQL Server option.

b. Complete the details, using a name that is distinct within the first few characters so that it is recognizable in

a narrow column.

|_b Important: Take care that:
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o The Source Type isData PlLatform v5
« You provide the connection details for your Normalize database (not the Technopedia one).
See the help for this page for more details. When you are done, click Save.
8. Select your new connection from the displayed list, and click Schedule....

9. Inthe dialog that appears, select the name of your chosen schedule for inventory collection through this
connection, and click OK.

10. At the bottom of the FlexNet Beacon interface, click Save, and if you are done, also click Exit.

i

= Tip: Consider whether you want to select your connection, and click Execute Now, before you exit.
The connection is now configured, and imports data from Data Platform on your chosen schedule. Shortly after each
import is completed, the inventory beacon automatically uploads the resulting inventory to the central application
server. After the next full import and compliance calculation (typically scheduled overnight), the inventory is visible in
the web interface of FlexNet Manager Suite.
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Data Mappings, Gaps, and Impacts
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The following topics provide a mapping between the source tables (and their columns) in the Normalize v5 database,
and the corresponding destination tables and columns in the compliance database within FlexNet Manager Suite. This
mapping covers only the first stage of the process, into the tables with names starting Imported. . .. These are
effectively staging tables that hold the data between the upload from Data Platform, and the major transition (or import)
into the operational tables in the compliance database, normally followed immediately by the license compliance
calculations (the calculations of consumption against entitlements). The descriptions also identify the operational
tables where the data eventually resides, and for a more detailed understanding of those tables and their columns, see
the FlexNet Manager Suite Schema Reference PDF, available through the title page of online help.

The topics are separated by the target Imported. . . tables, each of which is aligned with a particular data object within
FlexNet Manager Suite. Within each listing, the columns are in the same order that they appear in the Schema Reference,
for your convenience if you are cross-referencing both documents.

As well as the list of imported data, a second list within each topic identifies the values that cannot be imported through
Data Platform v5, together with notes on the impact that these gaps have on compliance calculations. Some gaps affect
the suitability of this data source when you are managing certain types of licenses.

Each topic lists every column within the relevant Imported. . . table, so that if you are working across both this and the
Schema Reference, there is no ambiguity about any column: it is either listed in the imports, or in the list of items missing
from the import. Notice that this means some columns included for completeness appear in the list of "missing" items
when in fact there is no expectation that they should be imported from any inventory source (or, to put it another way,
they are correctly omitted from the import). These items are marked as "internally generated" by FlexNet Manager Suite.

Exempted kinds of data
The following kinds of data are not imported from Data Platform v5 to FlexNet Manager Suite:

« File evidence — this evidence type is not needed from Data Platform, as the import of installer evidence includes all
required information

« WMI evidence — this evidence type is not needed from Data Platform, as the import of installer evidence includes all

required information

« Client access evidence (used for Microsoft Client Access Licenses, or CALs) — this evidence is not available in Data
Platform v5
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o App-Vevidence — this evidence is not available in Data Platform v5, and App-V application usage cannot be tracked if
Data Platform v5 is the single inventory source

« Oracle Database and Oracle option evidence, and Oracle GLAS evidence — this evidence is not imported from Data
Platform v5, so that recognition of Oracle Database version and edition, or of Oracle options, is not possible if Data
Platform v5 is the single inventory source (but this information, along with detailed content to deliver to Oracle
License Management Service, is fully available within FlexNet Manager Suite using the FlexNet inventory agent).

Comparison of Sources

FlexNet Manager Suite 2022 R1 (On-Premises)

This topic has two parts:

« Acomparison of the inventory sources that are supported by FlexNet Manager Suite and Data Platform v5

« For data sources fully supported by both, a summary of the inventory gaps (some of which may affect compliance
calculations) with data imported from each source either directly into FlexNet Manager Suite, or firstly into Data
Platform and then imported from Data Platform v5 into FlexNet Manager Suite.

For additional detail, down to the level of individual data fields, refer to subsequent topics.

Supported inventory sources
For each of the data sources (listed alphabetically), this table displays:

* "Y"when either product offers out-of-the-box support for imports from that source
« Ablankin either product's column when the data source is not supported

o "C"when either product has a custom extractor/adapter available to collect data from the source and import it into
the connecting product.

I:- Tip: Support in FlexNet Manager Suite may be offered through a connector, requiring minimal configuration other
than identifying the source; or an adapter, which may require a separate download and installation, and possibly
setting up a staging database. In addition, FlexNet Manager Suite supports the development of custom adapters, for
example, through the Inventory Adapter Studio (see The Inventory Adapter Studio). For Data Platform, the equivalent
terminology is extractor.

Inventory source FlexNet Manager Suite Data Platform v5
Symantec IT Management Suite (formerly Altiris) Y C

App-V Standalone Y

BMC BladeLogic Client Automation (previously Marimba) Y C

BMC Discovery (previously ADDM) Y Y

EdgeSight for Citrix Virtual Apps (previously XenApp Y

EdgeSight)
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Inventory source FlexNet Manager Suite Data Platform v5
Citrix XenApp server agent (for Citrix Virtual Apps) Y

FlexNet Inventory Manager (previously ManageSoft) Y

FlexNet Manager for Engineering Applications Y

HP Discovery and Dependency Mapping Inventory Y C

(DDMI)

HPE Universal Discovery (HP-UD) Y Y

IBM BigFix Platform (previously Tivoli Endpoint Y Y

Manager)

IBM License Metric Tool (ILMT) or HCL BigFix Inventory Y
(see note 1)

JAMF Pro (previously Casper) C Y
Microsoft Exchange ActiveSync Y
Microsoft Office 365 Y
Microsoft SCCM (previously SMS) Y Y
Salesforce Y
SAP (through FlexNet Manager for SAP Applications) Y
ServiceNow (see note 2) Y
SolarWinds Orion C Y
Symantec IT Management Suite (formerly Altiris) Y C
Tanium Asset C Y

D Note: In the table above:

1. Forimports from IBM License Metric Tool (ILMT), only applications with IBM as the Publisher are recognized
by the Application Recognition Library. For imports from HCL BigFix Inventory, applications from all publishers
may be recognized.

2. FlexNet Manager Suite does provide for integration with ServiceNow, but in this case it is not importing raw
inventory. ServiceNow is regarded as a source of business data rather than inventory data for FlexNet Manager
Suite.

Inventory gaps by import path

The following four inventory sources (column 1) are fully supported by both FlexNet Manager Suite and Data Platform
v5. Based on the import path, there may be gaps in the imported inventory, and these gaps may be significant enough
to prevent compliance calculations for related license types:

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition) 237



Data Mappings, Gaps, and Impacts

o The middle column identifies inventory gaps when FlexNet Manager Suite imports inventory data directly from each
source

» Thefinal column identifies inventory gaps if the inventory is first imported into Normalize v5 (within Data Platform),

and subsequently imported from there into FlexNet Manager Suite.

Data source Direct import to FlexNet Manager  Import through Data Platform
Suite

BMC Discovery (previously ADDM) No inventory gaps. All virtualization data is missing.

HPE Universal Discovery (HP-UD) No inventory gaps. Advanced virtualization data missing

(see note below).
DNS domain name missing (domain
flat name is available).

IBM BigFix (previously Tivoli All virtualization data is missing. All virtualization data is missing.
Endpoint Manager)

Microsoft SCCM (previously SMS) All virtualization data is missing. Advanced virtualization data
missing.
DNS domain name missing (domain
flat name is available).

D Note: This table distinguishes between:

o Simple virtualization calculations for technologies like VMware ESX and Hyper-V — these require only the host/
guest relationships to be tracked

» Advanced virtualization calculations for hardware partitioning technologies like HP-UX vPar, IBM LPAR, and Solaris
zones — these require tracking of greater detail, such as partial processors and processor pool information.
Information about clusters and host affinity (and the like) is also included in the advanced class.

And obviously, "all virtualization data" includes both of the above.

Imported Installer Evidence

FlexNet Manager Suite 2022 R1 (On-Premises)

The ImportedInstallerEvidence table is a staging table used for input of records about installation evidence. From
here, de-duplicated and normalized records are merged into the InstallerEvidence table.

InstallerEvidence typically lists installer evidence left behind after a particular item of software has been installed
on a computer. In the case of imports from Data Platform v5, applications identified there are first imported as installer
evidence. As always, this installer evidence is tested against rules saved in the Application Recognition Library (ARL),
and when matched, the appropriate application record is added to the InstalledApplications table (if it does not
already exist there), and is linked to the installer evidence. This application record is then visible in the Installed
Applications page of the web interface for FlexNet Manager Suite. A record of installer evidence that cannot be
matched by the ARL appears in the web interface on the Unrecognized Evidence page.

This process means there are three cases to consider, any of which may produce inventory gaps that can impact
compliance calculations:
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1. For applications recognized within Data Platform, and for which the normalized installer evidence has been
mapped to an entry in the Application Recognition Library (ARL): there is no inventory gap as such, since at a
minimum all these items are recognized within FlexNet Manager Suite; but in a few cases, some application
variants (such as interface language, hotfix number, or platform) may be recognized by either tool but not the
other.

2. For applications recognized within Data Platform, for which there is as yet no mapping to the ARL: the
unrecognized evidence in FlexNet Manager Suite may mean that license consumption is under-counted because
the applications have not been recognized within FlexNet Manager Suite, and therefore the licenses cannot
measure consumption against the 'missing' applications.

3. For applications not recognized within Data Platform, but which could have been recognized by the ARL from
other inventory sources: where Data Platform is your only data source, the unrecognized application may result in
under-counting of license consumption.

There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedInstallerEvidence table, that are not available from Data
Platform v5.

Data mapping for imported installer evidence

The following listing matches the source data from Data Platform v5 with the equivalent column in the
ImportedInstallerEvidence table. Other columns from the ImportedInstallerEvidence table cannot be
populated from Data Platform v5, and so are omitted here (and shown below). For more details on the database tables
and columns within FlexNet Manager Suite, please see the FlexNet Manager Suite Schema Reference PDF, available
through the title page of online help.

Data Platform (Table)/Column FNMS (Table)/Column Notes

The identifier used in Data Platform
for the installer evidence.

(MATCH_HOST_SW_PROD) /
CAT_SW_UUID

(ImportedInstallerEvidence)/
ExternalInstallerID

(MATCH_HOST_SW_PROD) /
CAT_PRODUCT_NAME or the Flexera
ID for the application if available in

(ImportedInstallerEvidence)/  The display name of the software
recorded in Data Platform, which is

imported only when there is no

DisplayName

ARL_ID
@,
Tip:Aprefixofarl://is
prepended to the ARL_ID on
import.

(MATCH_HOST_SW_PROD) /
CAT_VERSION or an empty string
when the Flexera ID for the

(InstallerEvidence)/Version

application is available

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)

Flexera ID available. When the
Flexera ID is returned instead, this
allows matching in the ARL, which
then supplies its standard display
name for the application instead.

When the Flexera ID is known, the
value is left empty for later supply
from the ARL. For applications
unknown in the ARL, the version
value isimported from Data
Platform.
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Data Platform (Table)/Column

(MATCH_HOST_SW_PROD) /
CAT_MANUFACTURER or an empty
string when the Flexera ID for the
application is available

Hard-coded values:

e FlexeraIDwhenitisavailablein
(CAT_FLEXERA_ARL)/ARL_ID

« BDNA when the Flexera ID for the

application is not available.

(CAT_FLEXERA_ARL)/ARL_ID when
the Flexera ID is available, or an
empty string

FNMS (Table)/Column

(ImportedInstallerEvidence)/
Publisher

(ImportedInstallerEvidence)/
Evidence

(ImportedInstallerEvidence)/
ProductCode

Data not imported from Data Platform v5

Notes

When the Flexera ID is known, the
value is left empty for later supply
from the ARL. For applications
unknown in the ARL, the publisher's
name is imported from Data
Platform.

When the Flexera ID is known, the
evidence type FlexeralID reflects
this. Otherwise, when Data Platform
is unaware of any matching entry in
the ARL, it is identified as the
evidence type.

I{-r"l Tip: The internal database
value BDNA is replaced with
Data Platform for presentation
in the web interface.

The Flexera ID (withoutthe arl://
prefix) is used when available.
Otherwise an empty string.

These columns in the ImportedInstallerEvidence table cannot be populated by inventory imports from Data

Platform v5. These missing data points do not impact license compliance calculations. For further details about these
columns, please see the schema reference.

e ComplianceConnectionID — internally generated

e AccessModeID (relevant only to file evidence, whereas this import is of installer evidence).

Imported Computers (Inventory Devices)

FlexNet Manager Suite 2022 R1 (On-Premises)

The ImportedComputer table is a staging table used for input of inventory device records. From here, de-duplicated

and normalized records are merged into the ComplianceComputer table.

There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedComputer table, that are not available from Data Platform v5,

and the impact of these gaps on license reconciliation calculations where these rely on data from only this source.

Data mapping for imported inventory devices

The following listing matches the source data from Data Platform v5 with the equivalent column in the
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ImportedComputer table. Other columns from the ImportedComputer table cannot be populated from Data

Platform v5, and so are omitted here (and shown below). For more details on the database tables and columns within

FlexNet Manager Suite, please see the FlexNet Manager Suite Schema Reference PDF, available through the title page of

online help.

Data Platform (Table)/Column FNMS (Table)/Column

Fabricated from: (ImportedComputer)/ExternallD
(MATCH_TASK_DET)/ The format is of this form (shown with
PROCESS_ID nonsense values):

(MATCH_TASK_DET) / TASK_NAME
and the checksum for the same
(MATCH_HOST_0S) /HOST_ID

PID123|TheTask|654321:Host789

(MATCH_HOST_0S) / HOSTNAME (ImportedComputer)/ComputerName

(MATCH_HOST_O0S) / DOMAIN (ImportedComputer)/Domain

(MATCH_HOST_0S) /
DISOVERED_0S_NAME

(ImportedComputer)/
OperatingSystem

(MATCH_HOST_0S) /
DISOVERED_0S_PATCH_LEVEL

(ImportedComputer)/ServicePack

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)

Notes

An external ID is fabricated from
the various details shown
(truncated as required and joined
with various separator
characters). This is then mapped
through the
ImportedStringMapping table
to convert string IDs to integer
IDs.

The name of the computer.

¢ In Windows, this is the NetBIOS
name of the local computer, as
returned by
GetComputerName()

o For UNIX-like platforms, it is
the host name of the machine,
as returned by
gethostname(2).

The domain reported by the
computer.

D Note: Data Platform exports
a domain flat name, while the
ImportedComputer table
handles either a flat or DNS
domain name, but the DNS
domain name is preferred.
Watch out for possible
problems merging device
records obtained from
multiple inventory sources.

The operating system of the
computer.

The service pack installed for the
operating system.
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Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_HOST_0S) / (ImportedComputer)/ The number of processors in the
CALC_NUM_OF_PHYSICAL_CPUS  NumberOfProcessors computer.

(MATCH_HOST_0S) / (ImportedComputer)/ProcessorType The type of processor in the
DISC_CPU_MODEL computer.

(MATCH_HOST_O0S) / (ImportedComputer)/MaxClockSpeed The maximum clock speed of the
DISC_SPEED_MHZ fastest processor in the computer.
(MATCH_HOST_0S) / (ImportedComputer)/NumberOfCores  The number of cores in the
CALC_NUM_OF_CORES computer.

Note: Currently Data
Platform gets an incorrect
result from virtual machines
(defect repair estimate
1Q2018). This affects the
consumption calculations for
all license types that use cores
as a metric (most of these
assume 1 core per processor
when the number of cores is
not available):

o Device (Core-Limited)
« Core Points

e IBMPVU

 Microsoft Server Core

o Microsoft Server/
Management Core

o Oracle Processor.

(DISC_ALL_0S)/TOTALMEMORY (ImportedComputer)/TotalMemory The total RAM in the computer, in
bytes.
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Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_HOST_HW_PROD_MODEL)/ (ImportedComputer)/ChassisType The type of case of the computer.

CAT_TAXONOMY_CATEGORY2 Some license types use this
information to optimize the
licensing position, particularly
with desktop and laptop
computers. Types used in Data
Platform are mapped to typesin
FlexNet Manager Suite as follows:

Data Platform FNMS

Empty Unknown
Handhelds Tablet
Notebooks Laptop

Mainframes Main System

Chassis
Servers Rack Mount
Chassis
All others Desktop
(DISC_HDDS) / The count of (ImportedComputer)/ The number of hard drives in the

entries for this device NumberOfHardDrives computer.

Note: Collected into Data
Platform only by a legacy
extractor or custom extractor.
FlexNet Manager Suite
imports it where it is
available.
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Data Platform (Table)/Column FNMS (Table)/Column Notes
(DISC_ALL_OS)/ (ImportedComputer)/TotalDiskSpace The totalsize of all hard drivesin
LOCALFILESYSTEMSPACETOTAL the computer. The results differ

for inventory collected from

SCCM directly by FlexNet Manager
Suite, or indirectly through Data
Platform v5:

o The FlexNet connection
imports the physical disk space
(DISK_DATA)

« Data Platform imports the
logical hard drive space
(v_GS_Logical_DISK).

(DISC_NICs)/ The count of (ImportedComputer)/ The number of network cards in
entries for this device NumberOfNetworkCards the computer.
(DISC_MONITORS)/The countof  (ImportedComputer)/ The number of graphics cards in
entries for this device NumberOfDisplayAdapters the computer.

Note: Collected into Data
Platform only by a legacy
extractor or custom extractor.
FlexNet Manager Suite
imports it where it is
available.

(DISC_NICs)/IP_ADDRESS (ImportedComputer)/IPAddress The IP address of the computer.

(DISC_NICs)/MACADDRESS (ImportedComputer)/MACAddress The MAC address of the
computer.
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Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_HOST_HW_PROD_MODEL)/ (ImportedComputer)/Manufacturer The manufacturer of the

CAT_MANUFACTURER computer hardware. Some
Failover to examples include:
(DISC_COMPUTERSYSTEM) /

¢ On Windows, the SMBios
MANUFACTURER manufacturer (the WMI
Manufacturer property of the
‘Win32_ComputerSystem’

class).

¢ On Linux, ‘Manufacturer’ in the
‘System Information’ section
resulting from the ‘dmidecode’
command. Sample command:
‘dmidecode -s system-
manufacturer’

¢ On Solaris x86, as for Linux,
with failovers first to ‘sysinfo
SI_HW_PROVIDER’ and then to
‘ModelNo’.

« On Solaris SPARC, the ‘sysinfo
SI_HW_PROVIDER’. Typically
this value is ‘Sun_Microsystems’

or, more recently, ‘Oracle

Corporation’. Failover to the

‘ModelNo’.
e On HP-UX, the string literal ‘HP".

e OnAIX, the ‘modelname’
system attribute preceding the
comma character. For example,
if the ‘modelname’ system
attribute is ‘IBM,8202-E4B’, then
use ‘IBM’. This value is typically
‘IBM’.
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Data Platform (Table)/Column

(MATCH_HOST_HW_PROD_MODEL) /

CAT_HARDWARE_PRODUCT and
CAT_HW_MODEL, joined with a
space

Failover to
(DISC_COMPUTERSYSTEM) /
MODEL

(MATCH_HOST_0S) /
SERIALNUMBER

Failover to (DISC_ALL_0S)/
SERIALNUMBER

(DISC_HOSTS_USERLOGON) /
DOMAIN_USERNAME

(DISC_ALL_OS)/ScanDate

Hard-coded value Data
Platform
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FNMS (Table)/Column

(ImportedComputer)/ModelNo

(ImportedComputer)/SerialNo

(ImportedComputer)/
LastLoggedOnUser

(ImportedComputer)/InventoryDate

(ImportedComputer)/InventoryAgent

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)

Notes

The model of the computer
hardware or the virtual machine.
This value is defined for the
context of the current execution
environment, rather than the
physical server that may be
hosting a virtual machine or
partition. For examples across
operating systems, see the
schema documentation.

The hardware serial number of
the computer. The goal of this
value is to be tied to the physical
hardware, partition or virtual
machine and to be as unique as
possible across all computers in
the organization. This is due to its
use in tracking computers,
particularly after an operating
system rebuild. This value is also
used to socialize computer
inventory from different
inventory sources, and is used to
map virtual machine guest
operating system inventory to the
VM host on which the virtual
machine is running.

The DOMAIN\SAMAccountName
of the user last logged onto the
computer. Data Platform uses the
flat domain name.

The date the computer last had
inventory reported.

The name of the person or tool
that performed the last inventory.



Data Platform (Table)/Column FNMS (Table)/Column

(MATCH_HOST_CPU) / (ImportedComputer)/
DISC_NUM_OF_SOCKETS NumberOfSockets

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)
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Notes

The number of sockets in the
computer.

PR

‘lﬂ-’l

Tip: Data Platform supplies
this value from Technopedia.
Other inventory sources
supported by FlexNet
Manager Suite cannot gather
this value from inventory; and
in general, for compliance
calculations where the
number of sockets is not
available in inventory, the
value is approximated by
using the number of
processors (which is
satisfactory when there are
no empty sockets in the
inventory device). In devices
that have any empty sockets,
non-blank information from
Technopedia is superior.
Notice that certain Oracle
license types (such as Oracle
Database Standard Edition)
have a restriction on the
number of sockets on the host
server.
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Data Platform (Table)/Column FNMS (Table)/Column Notes
(MATCH_HOST_CPU) / (ImportedComputer)/ The number of logical processors
CALC_NUM_OF_LOGICAL_CPUS NumberOfLogicalProcessors in the computer.

D Note: Currently Data
Platform gets an incorrect
result from virtual machines
(defect repair estimate
1Q2018). This affects the
consumption calculations for
all license types that use
processors as a metric:

 Device (Processor-Limited)
o Microsoft Server Processor
e Processor

e Processor Points.

Data not imported from Data Platform v5

These columns in the ImportedComputer table cannot be populated by inventory imports from Data Platform v5. The
majority of these missing data points do not impact license compliance calculations (these are listed here without
comment). Those that do have an impact are noted below. For further details about these columns, please see the
schema reference.

e HardwareInventoryDate

e ServicesInventoryDate

e ComplianceConnectionID — internally generated
e ComplianceComputerID — internally generated

e ComplianceDomainID — internally generated

e IncompleteRecord — Thisis always set to zero for imports from Data Platform (that is, the imported record is
regarded as 'sufficient' for its normal use in license compliance calculations, subject to the known limitations
described in these pages).

e PartialNumberOfProcessors — Absence of this value prevents subcapacity license consumption calculations for

IBM PVU and Oracle Processor licenses.
e UntrustedSerialNo
e FullDetailsFromExternalID
e FullDetailsFromComplianceConnectionID

e ComplianceComputerTypeID — Thisis the foreign key to the ComplianceComputerType table, identifying
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whether the device is a VM, a VM host, and so on. Compliance impact: Prevents (unrecognized) VDI templates
consuming from a license. Prevents (unrecognized) VMs from observing license rules that require (or disallow)
consumption by VMs.

o TILMTAgentID — Forimports from ILMT, identifies the device as a candidate for subcapacity calculations on any
related IBM PVU license(s). Compliance impact: Device consumption may be at full capacity, and calculated only
when a full inventory import and compliance calculation is run (typically, once daily).

¢ FNMPComputerUID

e HostIdentifyingNumber — Useful for matching records from different sources, but no direct effect on compliance

calculations.
o HostType — Useful for matching records from different sources, but no direct effect on compliance calculations.
e IsRemoteACLDevice
e IsDuplicate
e LegacySerialNo
« UUID
¢ IMEI
¢ PhoneNumber (for mobile devices)
¢« EmailAddress (for mobile devices)

e CalculatedUser — Typically, calculated by FlexNet Manager Suite as the most frequent user in the last ten log-on

records. Data Platform v5 only reports this last logged on user name (LastLoggedOnUser); but this is sufficient.
e LastSuccessfulInventoryDate
e MDScheduleGeneratedDate
e MDScheduleContainsPVUScan
e FirmwareSerialNumber
e MachineID

e IgnoredDueTolicense.

Imported VMs and Hosts

FlexNet Manager Suite 2022 R1 (On-Premises)

The ImportedVirtualMachine table is a staging table used for input of virtual machine records, including their host
server. From here, de-duplicated and normalized records of the VM properties are merged into the VirtualMachine
table; and if not already present, records for both the VM and the host are added to the ComplianceComputer table.

-
= Tip: This data is in addition to the inventory imported for the virtual machine (and, separately, its host) and imported
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as part of the inventory device records. For details, see Imported Computers (Inventory Devices).

There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedVirtualMachine table, that are not available from Data
Platform v5, and the impact of these gaps on license reconciliation calculations where these rely on data from only this
source.

Data mapping for imported virtualization records

The following listing matches the source data from Data Platform v5 with the equivalent column in the
ImportedVirtualMachine table. Other columns from the ImportedVirtualMachine table cannot be populated
from Data Platform v5, and so are omitted here (and shown below). For more details on the database tables and
columns within FlexNet Manager Suite, please see the FlexNet Manager Suite Schema Reference PDF, available through
the title page of online help.

Data Platform (Table)/Column FNMS (Table)/Column Notes
Fabricated from: (ImportedVirtualMachine)/ A computer ID for the host is
(MATCH_TASK_DET) / HostComputerID fabricated from the various
PROCESS_ID The format is of this form (shown with details shown (truncated as
(MATCH_TASK_DET)/ TASK_NAME  nonsense values): required and joined with various
and the checksum for the same separator characters). This is then
e VIRTUAL HoSTeUEer PID123|TheTask|654321:Host789  mapped through the
( - - ) ImportedStringMapping table
HOST_ID . .
0ST_. to convert string IDs to integer
IDs.
(MATCH_HOST_HW_PROD_MODEL)/ (ImportedVirtualMachine)/ The type of virtual machine.
CAT_MANUFACTURER VirtualMachineType Values from Data Platform are
transformed as follows:
e Microsoft becomes
VMType.HyperV
e VMware becomes
VMType.VMware
e Any other value becomes
VMType.Unknown.
(DISC_ALL_OS)/ (ImportedVirtualMachine)/ As Data Platform has only one
OSCOMPUTERNAME ComputerName name for the VM, the previous

value is replicated here (again).

(MATCH_HOST_HW_PROD_MODEL)/ (ImportedVirtualMachine)/ModelNo The model number reported for
CAT_HW_MODEL the VM.

Failover to

(MATCH_HOST_HW_PROD_MODEL)

/DISCOVERED_MODEL
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(MATCH_HOST_HW_PROD_MODEL) /
CAT_MANUFACTURER

(ImportedVirtualMachine)/
Manufacturer

Fixed value Data Platform (ImportedVirtualMachine)/

InventoryAgent

(DISC_ALL_OS)/
OPERATINGSYSTEM_TYPE_LABEL

(ImportedVirtualMachine)/
GuestFullName

Fabricated from: (ImportedVirtualMachine)/
(MATCH_TASK_DET)/ VMComputerID
PROCESS_1ID The format is of this form (shown with

(MATCH_TASK_DET)/TASK_NAME ~ Nonsense values):

and the checksum for the same
(DISC_VIRTUAL_HOSTGUEST)/
Guest_ID

PID123|TheTask|654321:Host789

Data not imported from Data Platform v5

Data Mappings, Gaps, and Impacts

Notes

The manufacturer visible to the
guest OS running on the VM.

The tool that provided this
inventory record.

The operating system configured
for the guest.

A computer ID for the guest is
fabricated from the various
details shown (truncated as
required and joined with various
separator characters). This is then
mapped through the
ImportedStringMapping table
to convert string IDs to integer
IDs.

The following columns in the ImportedVirtualMachine table cannot be populated by inventory imports from Data

Platform v5. Notice that several of them (such as NumberOfProcessors, NumberOfHardDrives, and IPAddress)

have matching data points imported as part of the inventory device import for the same guest machine. While several

of these missing data points do not impact license compliance calculations, the following gaps are significant:

o When the original input to Data Platform was from BMC Discovery (ADDM), information about virtual machines (and

hosts) is not available. In contrast, when the data source for Data Platform was Microsoft SCCM, the identification of

hosts and guests is available for supported platforms such as Hyper-V.

w3

W Tip: This is the inverse of the result obtained when FlexNet Manager Suite takes inventory from these sources
directly (rather than through Data Platform). In the this unmediated case, inventory from SCCM does not include
the host/guest, and the inventory from ADDM does include the host/guest relationship. Of course, if you have
multiple inventory sources collecting from a common target device, the results are merged within FlexNet Manager

Suite to provide the most complete record possible.

« When data is available (from inventory sources such as Microsoft SCCM into Data Platform), the import from Data

Platform to FlexNet Manager Suite is missing information about resource pools, vMotion, and partitions. This means

that, when Data Platform v5 is the only inventory source for these machines, compliance calculations are impossible

for consumption from some licenses such as IBM PVU, Microsoft, or Oracle server licenses.

For further details about these columns that are missing data, please see the schema reference.

¢ VMName
e VCObjectID
e FriendlyName

e« UUID

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)
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e TotalMemory

e PoolName

¢ CPUUsage

¢ MemoryUsage

e MaxNumberOfLogicalProcessors
e VMEnabledStateID

e NumberOfProcessors

¢ ProcessorType

¢ NumberOfNetworkCards

e ComplianceConnectionID

e VMLocation

e Po0lType

e ZoneResourceManagementMethodType
e AffinityEnabled

e CPUAffinity

e CoreAffinity

e PartitionID

e PartitionNumber

e FullComputerName

e« IPAddress.

Imported Installation Records

FlexNet Manager Suite 2022 R1 (On-Premises)

The ImportedInstalledInstallerEvidence tableis a staging table used to collect records of which installation

evidence has been found on what inventory devices. From here, de-duplicated and normalized records are merged into
the InstalledInstallerEvidence table.

InstalledInstallerEvidence is asimple table that mainly links installer evidence records with inventory device
records. In the case of imports from Data Platform v5, only the two external IDs are needed, with other values supplied
by FlexNet Manager Suite as and when required. The first listing below maps the two columns from Data Platform
source to FlexNet Manager Suite destination. Below is a list of the remaining columns in the
ImportedInstalledInstallerEvidence table that are not populated by this import (and do not need to be).
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Data mapping for imported installed installer evidence

The following listing matches the source data from Data Platform v5 with the equivalent column in the
ImportedInstalledInstallerEvidence table. For more details on the database tables and columns within

FlexNet Manager Suite, please see the FlexNet Manager Suite Schema Reference PDF, available through the title page of
online help.

Data Platform FNMS (Table)/Column

(Table)/Column

(MATCH_HOST_SW_PROD) / (ImportedInstalledInstallerEvidence) The same value asthe
CAT_SW_UUID /ExternalInstallerEvidenceID (ImportedInstallerEvidence)

/ ExternalInstallerID.

Fabricated from: (ImportedInstalledInstallerEvidence) An externalID forthe inventory
(MATCH_TASK_DET)/ / ExternalID device is fabricated from the
PROCESS_ID The format is of this form (shown with various details shown (truncated
(MATCH_TASK_DET)/ nonsense values): as required and joined with
» - various separator characters). This
TASK_NAME and the 5
— PID123|TheTask|654321:Host789 is then mapped through the

checksum for the same
(MATCH_HOST_SW_PROD) /

ImportedStringMapping table
to convert string IDs to integer IDs.

HOST_ID The same value as the
(ImportedComputer)/
ExternallD.

(MATCH_HOST_SW_PROD) / (ImportedInstalledInstallerEvidence) The installation date recorded for

DISCOVERED_INSTALLDATE /InstallDate the installer evidence.

Data not imported from Data Platform v5

These columns in the ImportedInstalledInstallerEvidence table cannot be populated by inventory imports
from Data Platform v5. These missing data points do not impact license compliance calculations. For further details
about these columns, please see the schema reference.

» ComplianceConnectionID — internally generated
e ExternalInstanceID

« DiscoveryDate (will be set to the date of firstimport from this connection).

Imported Users

FlexNet Manager Suite 2022 R1 (On-Premises)

The ImportedUser table is a staging table used for input of records about users. From here, de-duplicated and
normalized records are merged into the ComplianceUser table.

ComplianceUser stores information about end-users in the enterprise, including contact details, login details, and
inventory source details (if applicable). End-users are the people using computers within your enterprise (as distinct
from operators, who are people permitted to use FlexNet Manager Suite).
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There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedUser table, that are not available from Data Platform v5.

Data mapping for imported users

The following listing matches the source data from Data Platform v5 with the equivalent column in the ImportedUser
table. Other columns from the ImportedUser table cannot be populated from Data Platform v5, and so are omitted
here (and shown below). For more details on the database tables and columns within FlexNet Manager Suite, please
see the FlexNet Manager Suite Schema Reference PDF, available through the title page of online help.

Data Platform (Table)/Column FNMS (Table)/Column Notes

(DISC_HOSTS_USERLOGON) / (ImportedUser)/ExternallD Mapped through the

USERDOMAIN and USERLOGON ImportedStringMapping table to

combined convert string IDs to integer IDs.

(DISC_HOSTS_USERLOGON) / (ImportedUser)/Domain The domain of the end-user. Data

USERDOMAIN Platform exports the flat domain
name.

(DISC_HOSTS_USERLOGON) / (ImportedUser)/SAMAccountName The login name (SAM account name)

USERLOGON of the end-user.

Hard-coded value Data Platform (ImportedUser)/InventoryAgent The name of the person ortool that
performed the last inventory.

Data not imported from Data Platform v5

These columns in the ImportedUser table cannot be populated by inventory imports from Data Platform v5. These
missing data points do not impact license compliance calculations. For further details about these columns, please see
the schema reference.

e ComplianceConnectionID — internally generated
¢ UserName

e ComplianceDomainID

e LocationID

e FirstName

¢ LastName

e Email

« EmployeeNumber

¢ CostCenter (asreported in SAP)

e ComplianceUserID — internally generated

o ComplianceDomainID — internally generated
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o IsBlacklisted — internally generated

e MapUsingEmailAddress.

Imported Software Usage

FlexNet Manager Suite 2022 R1 (On-Premises)

The ImportedInstalledInstallerEvidenceUsage tableis a staging table used to collect records of actual use of
applications related to installation evidence found on inventory devices. From here, de-duplicated and normalized
records are merged into the InstalledSoftwareUsageData table.

There are two listings below. The first maps what is imported from Data Platform v5. The second lists values that
FlexNet Manager Suite expects to load into the ImportedInstalledInstallerEvidenceUsage table, that are not
available from Data Platform v5, and the impact of these gaps on license reconciliation calculations where these rely on
data from only this source.

Data mapping for imported usage related to installer evidence

The following listing matches the source data from Data Platform v5 with the equivalent column in the
ImportedInstalledInstallerEvidenceUsage table. Other columns from the
ImportedInstalledInstallerEvidenceUsage table cannot be populated from Data Platform v5, and so are
omitted here (and shown below). For more details on the database tables and columns within FlexNet Manager Suite,
please see the FlexNet Manager Suite Schema Reference PDF, available through the title page of online help.

Data Platform (Table)/Column FNMS (Table)/Column Notes

(MATCH_SOFTWARE_METERING) / (ImportedInstalledInstaller The start date is set to a string formatted
USAGE_YEAR and USAGE_MONTH_N EvidenceUsage)/StartDate similarly to ISO 8601 (except for the
Failover to slash separator: 2019/04/01) by
(MATCH_SW_RECENTLY_USED_APPS) conjoining the year and month-number
/ LASTUSEDDATE from Data Platform, and adding an

assumed day for the first of the month.
Only if there is no value available by this
path, we use the date available from the
alternate table shown.
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Data Platform (Table)/Column

Fabricated from:
(MATCH_TASK_DET) / PROCESS_ID
(MATCH_TASK_DET) / TASK_NAME
and the checksum for the same
(MATCH_SOFTWARE_METERING) /
HOST_ID

(MATCH_SOFTWARE_METERING) /
CAT_SW_UUID

(MATCH_SOFTWARE_METERING) /
USAGECOUNT plus TSUSAGECOUNT

(MATCH_SOFTWARE_METERING) /
LASTUSEDDATE

Failover to
(MATCH_SW_RECENTLY_USED_APPS)
/ LASTUSEDDATE

(MATCH_SW_RECENTLY_USED_APPS)
/ LASTUSERDOMAIN, then a backslash
\, then LASTUSERLOGON

FNMS (Table)/Column

(ImportedInstalledInstaller
EvidenceUsage)/ExternallID

The format is of this form (shown with
nonsense values):

PID123|TheTask|654321:Host789

(ImportedInstalledInstaller
EvidenceUsage)/
ExternalInstallerID

(ImportedInstalledInstaller
EvidenceUsage) /NumberOfSessions

(ImportedInstalledInstaller
EvidenceUsage)/LastUsedDate

(ImportedInstalledInstaller
EvidenceUsage)/ExternalUserID

Data not imported from Data Platform v5

Notes

An external ID is fabricated from the
various details shown (truncated as
required and joined with various
separator characters). This is then
mapped through the
ImportedStringMapping table to
convert string IDs to integer IDs.

'{.;'I Tip: If the
MATCH_SOFTWARE_METERING table
cannot provide a host ID, it is taken
from
MATCH_SW_RECENTLY USED_APPS.

The identifier used in Data Platform for
the installer evidence.

I:-r Tip: If the
MATCH_SOFTWARE_METERING table
cannot provide an external ID, it is
taken from
MATCH_SW_RECENTLY_USED_APPS.

If the number of sessions in which the
evidence was in use cannot be
calculated by this method, the default
value 1isinserted.

The last known date when usage of the
application is recorded (in one table or
the other).

The end-user identified in the source as
using the software. The identifier is
fabricated by conjoining the flat domain
name and logon name (separated by a
backslash).

These columns in the ImportedInstalledInstallerEvidenceUsage table cannot be populated by inventory

imports from Data Platform v5. These missing data points do not impact license compliance calculations. For further
details about these columns, please see the schema reference.
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e ComplianceConnectionID — internally generated

e ExternalInstanceID (used only for Oracle).
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HP DDMI Adapter

FlexNet Manager Suite 2022 R1 (On-Premises)

This part introduces the FlexNet adapter for importing data from HP DDMI (for those enterprises that have not yet
migrated to HPE Universal Discovery, for which see HPE Universal Discovery Adapter).
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Purpose and Architecture of the HP
DDMI Adapter

FlexNet Manager Suite 2022 R1 (On-Premises)

The FlexNet adapter for HP Discovery and Dependency Mapping Inventory (HP DDMI) collects data from your HP DDMI
implementation, and stores it in an intermediate staging database. From there, the FlexNet Manager Suite importers
bring the data into the compliance database so that you have a single, unified view of all inventory sources, and of the
impact that the collected inventory has on your license position.

The work is done in two separate stages, and by two separate components:

o The FlexNet DDMI agent reads inventory directly from the HP DDMI incoming inventory (. xsf) files, and writes the

data into the staging database.

» The FlexNet DDMI adapter connection connects to the staging database, massages the data into the format required

for integration with FlexNet Manager Suite, and imports it to the compliance database.

This architecture is summarized in the following diagram, with the numbers described below:
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HP DDMI Server

Agent

FlexNet
Manager
Suite

1. XSFfiles (compressed XML files) are produced by HP agents and uploaded to a central HP DDMI server.

2. XSFfiles are imported into the databases for HP DDMI and HP uCMDB. These two stages are the normal operation
of HP DDMI, and are unaffected by the presence of the FlexNet adapter.

3. The first component of the FlexNet adapter for HP DDMI (an agent which may be installed on the HP DDMI server,
where the XSF files are uploaded, or on any other device with read access to the same collection of XSF files) reads
the uploaded files and writes the data into the staging database required for this adapter. Copying the data from
the original XSF files allows FlexNet Manager Suite to capture evidence that, if unrecognized by HP DDMI, is

otherwise discarded.

4. The data import connection (configured from an inventory beacon, which is not shown in this simplified diagram)
links to the staging database, extracts the latest data, and uploads it to the compliance database for FlexNet

Manager Suite.
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Installation and Configuration

FlexNet Manager Suite 2022 R1 (On-Premises)

Everything needed to set up the FlexNet adapter for HP DDMI is included in the Adapter Tools archive available from the
Flexera Customer Community. You need credentials supplied by Flexera to access this download. The download
includes:

» Two SQL scripts to define the schema for, and populate stored procedures for, the staging database.
» The agent executable FnmpDDMIAgent . exe, and an accompanying CommandLine.d11 to enable command-line use.

This chapter includes all the details needed for installation and configuration. There are validation notes are included at
each stage of the set-up.

This chapter assumes that you have a functional implementation of HP DDMI, and an account with sufficient privileges
on your HP DDMI server to install the agent executable there (or similar in your chosen location, if you are placing the
agent elsewhere).

Download Adapter Tools Archive

FlexNet Manager Suite 2022 R1 (On-Premises)

The Adapter Tools archive includes content for many adapters, and is updated on the Flexera website from time to
time. Start this procedure using a web browser on a computer that has good network accessibility from all the
machines needing installations for your adapter.

=
[_] To download the adapter tools archive:

1. Download the Adapter Tools for FlexNet Manager Suite 2022 R1.zip archive. One path is through the

Flexera Community:

7
" Tip: Your Community credentials are required for login.

a. Loginto community.flexera.com.
b. Inthe top right, in the navigation bar, expand More and select Product and License Center.

c. Under the right-hand list of products that includes FlexNet Manager Suite, click LET'S GO! (and
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subsequently wait for the redirection to occur).

d. Ontherightside, scroll down through the list of Your Downloads and click FlexNet Manager Platform.
The Download Packages page for FlexNet Manager Platformappears.

e. Inthe Latest Versions tab, click FlexNet Manager Suite 2022 R1.

A EULA page may appear. If so, click I agree to accept the license, as this grants access to the list of
Downloads.

f. Inthe list of available Downloads, in the Files tab, in the File Name column, click Adapter Tools for
FlexNet Manager Suite 2022 R1.zip.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet Manager
Suite 2022 R1.zip commences.

g. Inyour browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C: \temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it to
the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....

The folders are now available for the range of adapters in the Adapter Tools archive.

Creating the Staging Database

FlexNet Manager Suite 2022 R1 (On-Premises)

The FlexNet adapter for HP DDMI requires a staging database, which is used as follows:

o The agentinstalled on your HP DDMI server reads the DDMI inventory files directly, performs minimal data
rationalization, and saves the results to the staging database

o The connection from FlexNet Manager Suite reads the data from the staging database, shapes it appropriately, and
uploads it to the compliance database.

The staging database can be created on any convenient instance of Microsoft SQL Server that meets the following
criteria:

« Provides high-speed network access from the HP DDMI server (or other location of the installed agent), and from an
appropriate inventory beacon that can upload to the application server for FlexNet Manager Suite

» Allows read/write access to the account running the FlexNet agent on the HP DDMI server, and read access by the
service account running the BeaconEngine service on the inventory beacon (or you may choose to implement

either a special Windows account and an SQL account to collect the DDMI staged data)
 Isrunning an instance of Microsoft SQL Server 2012 or later.

The staging database size will be roughly equivalent to the sum of the inventory (. xs) files uploaded to your HP DDMI

server. The agent overwrites any previous record from the same device with the latest inventory upload, to that the net
database size does not grow appreciably larger than the sum of the source inventory files.

Your download of the Tier 1 adapters archive (see Download Adapter Tools Archive) included two SQL scripts that can
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assist with creating the staging database. You can achieve this through SQL Server Management Studio, or from the
command line as described in the following procedure. Use whichever approach best suits your enterprise practices.

=
[_] To create the staging database from the command line:

1.

Navigate through the unzipped tools archive to Tier 1 Adapter Tools>HP Discovery and Dependency
Mapping Inventory Tools>SQL.

. If necessary, copy the script DDMIStagingSchema. sql from the this folder of your unzipped adapter archive to a

temporary folder on your staging database server.

. Logged in on the database server as an account with read/write access to the database, open a command prompt.

. Inthe command prompt window, execute the following command, as amended:

sqlcmd -S ServerName\InstanceName -i TemporaryPath\DDMIStagingSchema.sql

where:

« »

o ServerName is the name of the server hosting Microsoft SQL Server 2012 or later. Use a “.” (dot) if you are
running the staging script on the same server as the database instance; or if you are adapting these
instructions to a different environment, insert the server name or its IP address.

» InstanceName is the name of the database instance to use for the database staging tables. You can omit this

parameter (and the backslash separator) if the default instance name is being used.

o TemporaryPath is the location where you saved the SQL procedure.

Example:

sqglcmd -S .\Development -1 C:\temp\DDMIStagingSchema.sql

The database DDMIStaging is created with all necessary tables, indices, and so on.

. Similarly, execute the second script (with the same parameter substitution) to create the stored procedures

necessary in the staging database.

sqlcmd -S ServerName\InstanceName -i TemporaryPath\DDMIStagingProcedures.sql

Example:

sqlcmd -S .\Development -i C:\temp\DDMIStagingProcedures.sql

The staging database is now ready for operation.

7

Tip: If you wish to do so, you may now rename this database. Keep the name handy for the configuration processes
that follow.

The schema for the staging database (below) is, in the main, self-explanatory, reflecting the content of the . xsf files

found on your HP DDMI server. The one unique table is InventoryImportDate. This table lists the names of inventory

files that have already been loaded into the staging database, and saves the last modified date of each file as its most
recent inventory date. When the FlexNet agent scans through the inventories for possible import into the staging
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database, it uses this table to manage differential imports, only importing an inventory file if it is newer than the last
recorded inventory file of that name that was imported.
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StagedComputer StagedFileEvidence
Column Mare I Data Type I Allowe Mulls I Column Mare I Data Type I Allowe Mulls I
:|| ExternalComputerID int I :|| StagedFileEvidencell int I
AssetTag nvarchar(256) I FileMame nvarchar(256) I
_l Computerklame rivarchar{Z56) ¥ _l FileVersion rivarchar( 100} ¥
_l Domainualifiedame rivarchar( 100} ¥ _l Productyersion rivarchar( 100} ¥
_l DomainFlatiame rivarchar32) ¥ _l Producthlame rivarchar( 100} ¥
_l Operating3ywstem rvarchar(123) ¥ _l Company rivarchar( 100} ¥
_l ServicePack, rvarchar(123) ¥ _l Description rivarchar( 100} ¥
_l MNumberCfProcessars int ¥ _l FileSize int ¥
_l ProcessorType rivarchar{Z56) ¥ _l Language rivarchar{Z00) ¥
_l MaxClockSpeed int ¥ _l I
_l MNumberCfCares int ¥
_l MNumberCfSockets int ¥
| Totaltemory bigint 73 StagedComputerFileEvidence
_l ChassisTvpe rvarchar(123) ¥ Column Mame I Data Tvpe I Al Hulls I
_l Chassisserialumber nwarchar(100) ¥ _l ExternalFileID ink Il
_l MNumberCfHardDrives ink = _l ExternalComputerID int -
_l TokalDiskspace bigint ¥ _l StagedFileEvidenceID ink Il
_l Murmber CfrebworkCards  int ¥ _l FilePath riarchar{400) 2
_l MNumberCfDisplayada,,. it = _| I~
_l IPaddress nvarchar(256) ¥
_l MACAddress nvarchar(256) ¥
StagedUser
_l Manufacturer rvarchar(123) ¥ 9
Calurnn Marne I Cata Type I Al Bulls I
_l Madello nvarchar(128) ¥
_l ExternalUserID int [l
_l Seriallo nvarchar( 100) ¥
_l Userkame rcarchar (e I
_l LastLoggedonUser rivarchar(ad) ¥
_l Comain revarchar(100) [l
_l InventoryDate datetime ¥
_l SAMAccounthame rcarchar (e [l
_l InventoryAgent rvarchar(123) ¥ _| -
_ =
StagedWMIEvidence
Column Mare I Data Type I Allowe Mulls I
StagedDomain _| ExternalwMIEvidencelD | int r
Column Mame Data Tvpe I Al Hulls I _l ExternalComputerID int Il
_I Qualifiedrarne nvarchar(100) Il _l ClassMame nvarchar{s0) r
_I Flatname rvarchar(32) v _l Propertyhame rivarchar(s0) I
_I r _l Propertyitalue rivarchar{Z56) I
_ =
StagedInstallerEvidence
Calurnn Marne I Cata Type I Al Bulls I InventoryImportDate *
_I ExternalComputer D ink r Column Mame Data Type I Allows Mulls I
_I ExternalinstallerD int r _l InventoryFileMame nvarchar(256] -
_I DisplayMame rwarchar (256} [l _l InwentoryDate datetime [
_I Wersion revarchar(7) I _l r
_I Publisher revarchar(200) I
_I Evidence rrvarchar(3e) I
| r
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Configuring the FlexNet Agent for HP DDMI

FlexNet Manager Suite 2022 R1 (On-Premises)

The FlexNet agent for HP DDMI is the code entity that accesses the inventory (. xsf) files uploaded to your HP DDMI
server, and saves the resulting data to the staging database that you have just established. Operationally, it consists of
two parts:

o Asmall C# application (an .exe and a .d11) that acts only as a transport, decompressing the . xsf files (which are

compressed XML) and feeding them to the second part

» Astored procedure, already created in the staging database (see Creating the Staging Database), that unpacks the

XML elements and saves the resulting data in the staging database.
Clearly, it is only the first of these that is the focus of this topic.

The agent may be installed anywhere, as long as it has access to the folder on your HP DDMI server where the . xsf
inventory files are uploaded, and to the staging database. Optional locations include:

e Onthe HP DDMI server (optimal from a network performance viewpoint)

« On the server hosting the staging database

« Onaninventory beacon that has fast network access to both of the above

« Onany other computer meets that same requirement of fast network access to the data source and destination.

Although much of the inventory processing load is delegated to the SQL stored procedure, you can further control the
impact of the executable on its host device by specifying the number of CPU threads it devotes to throughput of the
.xsf files. In any case, the agent is normally scheduled to run only once daily in off-peak hours.

£
[_] To configure the agent executable:

1. Navigate through the unzipped tools archive to Tier 1 Adapter Tools>HP Discovery and Dependency

Mapping Inventory Tools >DDMIAgent.

2. Copy both the FnmpDDMIAgent.exe and CommandLine.d11 files to their new operational location.

I} Important: Both files must be installed in the same folder.
3. Identify or configure the account that is to run the agent.

A suitable account:

« Has execute rights on the device where the agent is installed

o Has at least read-only privileges on the folder where the . xsf inventory files are saved on your HP DDMI

server
» Hasread/write privileges on the staging database.
You may prefer to make this a service account to prevent interactive use.

4. Configure a Windows schedule task (or use your preferred scheduling tool) to trigger execution of the agent
running as your selected account on your preferred schedule.
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Choose a schedule to suit your environment. This should allow enough time to:

e Processall new . xsf files into the staging database

« Upload the results to the compliance database for FlexNet Manager Suite

« Align with the nightly full import and license compliance calculations, by default scheduled for 2am nightly.
A suggested schedule is daily at 10pm.

The task must invoke the FnmpDDMIAgent . exe executable with a command line that includes some of the
following parameters (the agent also supports -h to list command-line options):

FnmpDDMIAgent.exe
-s PathToInventories
-d StagingDBConnectionString
-1 LoggingLevel
-t TimeOutSeconds
-n ThreadCount

where the parameters are:

Switch M/O Value

-s Mandatory The location of the HP DDMI inventory files (no default value). The path may be
enclosed in double quotation marks, which are mandatory when there is any white
space in the file path. Example: "C:\HPDDMI\Inventories"

-d Mandatory  The connection string for the staging database (no default value). Example:
"server=172.16.38.83;Database=DDMIStaging; Trusted_Connection=yes"

-1 Optional An integer in the range 0-3 for the level of logging:

» 0:no logging (default value)
o 1:Errorsonly
o 2:Errors and warnings

» 3.Verbose logging.

-t Optional The number of seconds the executable should wait for a response to any command
given to the staging database. Default value is 3600 (an hour).

-n Optional An integer in the range 1-20 (default 5), being the number of CPU threads the agent
should use for processing the . xsf inventory files. Each thread invokes the database
stored procedures independently.

I:-- Tip: Depending on the hosting device architecture, optimum throughput is
achieved somewhere within the range of 1-20 threads, after which increasing the
number of threads overloads the system and decreases performance. Given the
variety of factors involved, there is no real substitute for experiment to determine

the optimum value for your environment.
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Example usage (all on one line):

FnmpDDMIAgent.exe
-s "C:\HPDDMI\Inventories"
-d "server=172.16.38.83;Database=DDMIStaging;Trusted_Connection=yes"
-12

When thus invoked, the agent reads through all updated XSF files in the source directory, and uploads their data
into the staging database. Files unchanged in the nominated path since the last upload are ignored.

. On the assumption that you already have . xsf files in the nominated folder on your HP DDMI server, you may

wish to run the agent once now, and use Microsoft SQL Server Studio to validate the content is stored in the
staging database. (Loading the staging database also provides material for testing the next stage of the process.) If
you enabled logging, you may also check the log file, which is written to the same folder where the executable is
running.

Configuring Upload and Import
Connection

FlexNet Manager Suite 2022 R1 (On-Premises)

With data arriving in the staging database, it's time to configure its upload to the central application server for FlexNet
Manager Suite, followed by its import to the compliance database. This process is configured on, and managed by, an

inventory beacon.

3
[_] To configure the connection for upload from the staging database:

1.

Run the inventory beacon interface (for example, in the Windows Start menu, search for FlexNet Beacon, right-
click it, and select Run as administrator).

.
= Tip: Remember that you must run the inventory beacon software with administrator privileges.

. Open the Inventory systems page.

Expand the pull-down beside the New... button below the list, and choose SQL Server.
The Create SQL Source Connection dialog appears.
Complete the details to define the connection to the staging database:

a. Create a distinctive Connection Name that is easily recognized in the list of connections (even when the
columns are narrow).

For example: HPDDMI Staging.
b. For Source Type, you must choose HP Discovery and Dependency Mapping Inventory (DDMI).
c. Provide the host name or IP address (in IPv4 format) for the Server hosting the staging database.

d. Choose the Authentication method that the BeaconEngine process should use to connect to the

database:
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o IfyouselectWindows Authentication,ensure thatthe service account that runs the
BeaconEngine process on this inventory beacon has (as a minimum) read access to the staging

database.

« With either of the remaining two options, specify the Username and Password in the next two fields.
Of course, validate that the nominated account has (as a minimum) read access to the staging
database.

e. Use the Test connection button to validate that you have specified the details correctly, and adjust if
necessary.

f. For the Overlapping Inventory Filter, accept the default Import the inventory from this source for
possible merging selection (unless you are in the process of migrating inventory collection away from HP
DDMI, in which case see the online help for the Inventory systems page).

g. Click Save to close this dialog and add your new connection to the list in the Inventory systems page.

5. If you do not already have a suitable schedule for this connection available on this inventory beacon, select the
Scheduling page, and click New... to open the Edit Schedule dialog and define one.

6. Back on the Inventory systems page, select the new connection in the list, and click Schedule... to select your
appropriate schedule in the Select schedule dialog. Click OK to confirm your selection.

7. Inthe main FlexNet Beacon interface, click Save to store your newly scheduled connection.

8. If you have already run the agent to populate your staging database, you may test the new connection by keeping
it selected in the list, and clicking Execute Now.

The upload, the resulting import (which follows immediately), and the subsequent license compliance
calculation may take some time to complete. You may monitor progress in the web interface for FlexNet Manager

Suite — navigate to the system menu (%" ¥ in the top right corner) and choose System Health > System Tasks,
and see the online help for that page. When the process is complete, you can inspect the inventory imported
from HP DDMI in the All Inventory page.

(d

= Tip: In the All Inventory page:
a. Add the Connection name to the listing from the column chooser
b. Display the simple filter bar

c. Filter for the name you have your HP DDMI connection (the suggestion was HPDDMI Staging).
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HPE Universal Discovery Adapter

FlexNet Manager Suite 2022 R1 (On-Premises)

You can use the HPE Universal Discovery (HPE-UD) adapter tool to collect and import inventory data from HPE Universal
Discovery System to FlexNet Manager Suite. The HPE-UD adapter fetches all hardware, software, and virtualization
information from the HPE-UD system and stores it in the compliance database maintained by FlexNet Manager Suite. The
HPE-UD adapter support is available only with FlexNet Manager Suite version 2015 and later.

]

| Note: The HPE-UD adapter tool works only with version 10.10, 10.11, 10.33-11.5, 2020.05, 20.08, 20.11, 21.05 of the HPE
Universal Discovery System. These versions do not support Solaris 11 zones, for which reason the HPE-UD adapter
cannot import these zones. Since host serial number and zone name are used for rationalizing duplicate inventory
records across different inventory sources, this may mean that a device imported through the HPE-UD adapter cannot
be merged with another record of the same device imported through another inventory source that supports zones
information.
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Selecting a Configuration

FlexNet Manager Suite 2022 R1 (On-Premises)

This chapter gives an overview of the architecture, working, and configuration of the HPE-UD adapter. Choose the
appropriate configuration for your enterprise before you implement the adapter.

Architecture and Working of the HPE
Universal Discovery Adapter

FlexNet Manager Suite 2022 R1 (On-Premises)
The HPE-UD adapter architecture has the following main components:

o HPE-UD Server: This server has the HPUD uCMDB database and HPE discovery tools installed on it. The HPUD
uCMDB database stores the HPE-UD inventory details.

« Staging Server: This server contains the Flexera HPUCMDBStage . exe tool and a staging database. The
HPuCMDBStage . exe tool retrieves topology maps by executing TQL queries on HPUD uCMDB. The retrieved
topology maps are stored in a staging database (UCMDB_Staging) present on the staging server. The query

execution is performed using the web service interface of HPUD uCMDB.

« FlexNet Manager Suite: The Compliance Reader component residing on this server fetches data from the staging
database and loads it into the FlexNet Manager Suite database when you run an inventory import.

The following diagram shows the architecture and working of the HPE-UD adapter:

Figure 6: Architecture and working of the HPE-UD adapter
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1. The HPuCMDBStage . exe tool extracts the inventory information through the web APl of HPUD uCMDB. This tool
executes Topology Query Language (TQL) queries on the HPUD uCMDB database and retrieves responses in the
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form of topology maps. With the default configuration, this tool stores the retrieved topology maps directly into
the staging database without storing them in XML files. However, you can configure this tool to write the retrieved
topology maps to XML files and then write data from those XML files to the staging database.

ﬂ Note: One topology map is generated for each TQL query executed on HPUD uCMDB.

2. The Compliance Reader component of FlexNet Manager Suite collects data from the staging database. When you
run an inventory import on the FlexNet Manager Suite server, the data extracted from the staging database is
written to the compliance database on the application server

The Adapter Executable

FlexNet Manager Suite 2022 R1 (On-Premises)

HPE Universal Discovery (HPE-UD) adapter uses the ucmdb-api to obtain the version of the uCMDB instance. It uses the
UcmdbService web service API to retrieve the topology maps by executing TQL queries on the uCMDB instance. You
can retrieve the WSDL definition of the UcmdbService web service APl from http://<uCMDB Server>/axis2/
services/UcmdbService?wsdl. The configuration of the staging tool includes the TQL queries that will be executed
on the HPUD uCMDB database. You don't have to import the TQL queries into the HPUD uCMDB database and there is no
need to deploy and maintain the TQL queries on every HPE-UD instance of your enterprise.

ﬂ Note: The URL to retrieve the WSDL definition of the UcmdbService web service APl may use 'https' instead of 'http'.
It may also include a port number. Please check with your HPE-UD system administrator for more details on the web
service URL.

The tool to query the web API has the following two parts:

* HPuUCMDBStage.exe — A console program capable of querying the UcmdbService API of HPE-UD and writing the
results into an SQL Server database, and optionally to XML files on the local file system. This program supports
command line arguments, available using HPUCMDBStage .exe -h. Here is the list of available command line

options.
-h This help
-x <settings file> Settings file
-s <address or URL> uCMDB server address or URL
-u <user name> uCMDB export user name
-p <password> uCMDB export user password
-c <connection string> SQL Server staging database connection string
-m <staging method> Set staging method (stage/staged/prestaged/stream)
-f <staging file path> Set the staging file path

e FNMPuCMDBSettings.xml — The self-documenting configuration file for HPUCMDBStage . exe which contains TQL

queries executed against HPE-UD, and can include connection settings for HPE-UD and SQL Server.

In operation, the executable, HPUCMDBStage . exe, extracts the inventory data from HPE-UD and saves it for further
processing. The value of the method parameter determines how the data is saved. The method parameter can have the
following values:

o Stage — This option enables you to save inventory data from HPE-UD to a series of XML files on the staging server
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(HPE-UD to XML). The XML files are not imported into the staging database, but you can review the extracted
inventory data. This option also enables you to collect inventory data from the HPE-UD servers that are not directly
connected to the staging server. You can manually copy and upload the inventory XML files to the staging server. Also
see the Prestaged method below.

« Staged — This options enables you to write the data extracted from the HPE-UD servers to XML files and then copy
the information to the staging database (HPE-UD to XML/SQL) where it can be imported into FlexNet Manager Suite
for use in compliance calculations.

« Prestaged — This option takes information stored in XML files (from the Stage and Staged method) and loads it into
a staging SQL database (XML to SQL). Inventory is not gathered from HPE-UD in this mode.

e Stream— This option enables you to extract the inventory information from HPE-UD and load it into the staging
database directly, without storing it in XML files on the staging server (HPE-UD to SQL). You can import these files to
into FlexNet Manager Suite for use in compliance calculations.

You can set the default values for the method parameter and all other parameters in the FNMPuCMDBSettings.xml
file. The adapter tool uses the default parameter values when you use it without other command-line options. The
settings file is self-documented and the matching command-line options are available using HPUCMDBStage .exe -h.

Files Created by the Staging Tool

The following files are created when the staging tool performs a read/write operation on the local disk of the staging
server. You can view the contents of the following files to review HPE-UD configuration item details that have been
extracted.

Filename Content

Computer.xml Details of computers and their properties.
Virtualization.xml Virtualization and partitioning details.

InstalledSoftware.xml Installed software evidence linked to each computer.
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Installation and Configuration

FlexNet Manager Suite 2022 R1 (On-Premises)

For on-premises implementations, the adapter XML files are included as a part of the FlexNet Manager Suite installation.
You need to download the staging tool, the configuration file, and the staging schema for this tool from
https://flexerasoftware.flexnetoperations.com,or from the Flexera Customer Community.

You need credentials supplied by Flexera to access this download. Details of the download are included in Download
Adapter Tools Archive.

o The HPE-UD adapter suits FlexNet Manager Suite releases 2015 and later for on-premises delivery.

o The build number for this adapter is 10.3.0.12006 (or higher). You can identify this number by right-clicking the
HPuCMDBStage. exe file in Windows Explorer, selecting Properties, and looking at the Details tab.

Save the zipped archive to a suitable temporary location, and unzip it.

Full details of setting up the HPE-UD adapter are included in this chapter. The following chapter (see HPE-UD Adapter
Operation) covers testing the completed installation and validating the results.

Download Adapter Tools Archive

FlexNet Manager Suite 2022 R1 (On-Premises)
The Adapter Tools archive includes content for many adapters, and is updated on the Flexera website from time to
time.

Start this procedure using a web browser on a computer that has good network accessibility from all the machines
needing installations for your adapter.

=
[_] To download the adapter tools archive:

1. Download the Adapter Tools for FlexNet Manager Suite 2022 R1.zip archive. One path is through the
Flexera Community:

;
" Tip: Your Community credentials are required for login.
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a. Loginto community.flexera.com.
b. Inthe top right, in the navigation bar, expand More and select Product and License Center.

c. Under the right-hand list of products that includes FlexNet Manager Suite, click LET'S GO! (and
subsequently wait for the redirection to occur).

d. Ontheright side, scroll down through the list of Your Downloads and click FlexNet Manager Platform.
The Download Packages page for FlexNet Manager Platformappears.
e. Inthe Latest Versions tab, click FlexNet Manager Suite 2022 R1.

A EULA page may appear. If so, click I agree to accept the license, as this grants access to the list of
Downloads.

f. Inthe list of available Downloads, in the Files tab, in the File Name column, click Adapter Tools for
FlexNet Manager Suite 2022 R1.zip.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet Manager
Suite 2022 R1.zip commences.

g. Inyour browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C: \temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it to
the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....

The folders are now available for the range of adapters in the Adapter Tools archive.

Selecting a Staging Server

FlexNet Manager Suite 2022 R1 (On-Premises)

Multiple configuration options are there to configure the staging server. You can install the staging server on any of the
following types of computers:

o Adedicated stand-alone server or a virtual machine.

» Any other suitable machine in your enterprise, such as a print server.

¢ Aninventory beacon.

o The central application server where FlexNet Manager Suite is installed.

The following are the requirements for a staging server:

¢ Microsoft Windows 2008 or later.

o Access to an instance of Microsoft SQL Server 2012 or later to host the staging database. You can implement the
staging database on the staging server or on a separate database server.

e Microsoft .NET 4.0 run time environment installed.

« Efficient network access to each HPE-UD server in your enterprise, using the HTTP or HTTPS protocols.
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Creating the Staging Database Tables

FlexNet Manager Suite 2022 R1 (On-Premises)

Once your selected staging server is able to access the Microsoft SQL Server instance, you can use the provided script to
create the staging database and set up the appropriate database tables. You can achieve this through SQL Server
Management Studio, or from the command line as described in the following procedure.

EI To create the staging database from the command line:
1. Download and install the Adapter Tools archive. For more information, see Download Adapter Tools Archive.
2. Navigate through the unzipped archive to Adapter Tools>HP Universal Discovery Tools>SQL.

3. If necessary, copy the script uCMDB_staging.sql from the SQL\ folder of your unzipped adapter archive to a
temporary folder on your staging server.

4. Open acommand prompt on the staging server.

5. Inthe command prompt window, execute the following command, as amended:
sqlcmd -S ServerName\InstanceName -i TemporaryPath\uCMDB_staging.sql

where:

o The database uCMDB_staging is created with all necessary tables, indices, and so on.

e ServerName is the name of the server hosting Microsoft SQL Server 2012 or later. You can install the database
on the staging server or on any remote server. You can use the name of the staging server or its IP address, or a
“.” (dot) if you are running the staging script on the same server as the database instance.

o InstanceName is the name of the database instance to use for the database staging tables. You can omit this

parameter if the default instance name is being used.

o TemporaryPath is the location where you saved the SQL procedure.

Example:

sqlcmd -S 192.100.0.20\Development -1 C:\temp\uCMDB_staging.sql

The staging database is now ready for operation.

Configuring HPE Universal Discovery
System

FlexNet Manager Suite 2022 R1 (On-Premises)

You must configure the HPE-UD adapter settings to include a user which can perform the Run Legacy API and the Run
Query by Definition actions on the HPE-UD system.
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£

[_] To create and configure a user in HPE-UD:
1. Inthe HPE-UD interface, click Security, Roles Manager.
2. Create a new role for FlexNet Manager import.

3. Select the role that you just created and click General Actions and assign the Run Query By Definition and the Run
Legacy API actions to this role.

4. Inthe HPE-UD interface, click Security, Users and Groups.

5. Create a new user for FlexNet Manager import.

6. Click the Roles tab and assign the role that you created in Step 2 to this user.

7. Click the Permissions Overview tab and review the assigned permissions for this role.

8. Click Data Flow Management, Universal Discovery, Zone-Based Discovery and expand the Mapping Options
section in Preferences.

9. Check the Raw OS Installed Software and set the Include option to name=. *. This enables HPE-UD adapter to
capture all raw installation evidence.

You have created and configured an HPE-UD user for use in the HPE-UD staging tool. You must add this user to the
FNMPuCMDBSettings.xml file.

Installing and Configuring the Staging Tool

FlexNet Manager Suite 2022 R1 (On-Premises)

This procedure includes many separate sub-processes to complete the setup of the HPE-UD adapter.

L
[_] To install and configure the HPE-UD adapter:

1. Ensure that the account under which the adapter executable will run has read/write/execute permissions on this
uCMDB_staging database. Authentication may be through Windows authentication or SQL Server
authentication. Using Windows authentication, the default account is the username running the
HPuCMDBStage . exe adapter. The username and password for SQL Server authentication are specified in the
database connection string, which you may supply in FNMPuCMDBSettings.xml, or override with the -c option
on the command line.

2. To extract information from the HPE-UD system, the HPuCMDBStage . exe tool must have the required
permissions to query the HPE-UD system. You must create a user in the HPE-UD system and assign it with
permission to perform the Run Legacy APl and the Run Query by Definition actions. You must specify this user in
the FNMPUCMDBSettings.xml file. For more information on configuring the HPE-UD system, see Configuring
HPE Universal Discovery System.

3. Navigate to the fixed location on the inventory beacon where the inventory reader must find configuration files to
control its uploads. Verify the existence of the following path: C: \ProgramData\Flexera Software\
Compliance\ImportProcedures\Inventory\Reader\HP Universal Discovery.

4. Create a folder to contain the adapter executable and its configuration file. Location is not critical; a suggested
pathis under C:\Program Files\Flexera Software (for version 2015 and later, or for a stand-alone server
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that is not an inventory beacon or application server). In your chosen location, create a folder such as
HPUDAdapter.

. From the HPuCMDBStage\ folder within your unzipped archive, copy both HPUCMDBStage . exe and
FNMPuCMDBSettings.xml to your newly created folder (such as C: \Program Files\Flexera Software\
HPUDAdapter).

. Open your copy of FNMPUCMDBSettings.xml in a text editor of choice, and review the self-documenting
comments within that file. Modify the following values as required. Ensure that you specify the IP address of your
HPE-UD server. You can use the command line options to configure HPUCMDBStage . exe. Use the '-h' option to
get the list of available options.

o Update values in the first element describing the downstream connection to the HPE-UD server, including the
IP address, port, the account name and password for access. Keep a record of the account name and
password for registering with HPE-UD. The default values are:

<server protocol="http" address="10.200.20.138"
port="8080" username="exportuser" password="Pa$$word" timeout="3600"/>

7
= Tip: If you do not wish to record the password in the plain text configuration file, you can use a script to

retrieve the password from an encrypted store, and supply it as a command-line option when starting the
HPuCMDBStage . exe tool. Here is an example:

HPuCMDBStage.exe -p <password>

« Update the second element for the connection to the staging database. The default values are:

<database
connection-string="Server=.;Database=uCMDB_Staging;Trusted_Connection=yes;"/>

« Update the third element to configure whether, and where, the executable should save XML files of the
inventory collected from HPE-UD. The default value stores any XML files below the location of the executable:
<staging path="StagingData" method="stream"/> You may wish to redirect the path setting for

easier access for human inspection.

» Make sure that the user details in the <Server> section match with the user configured in the HPE-UD

system.

o Save the settings file.

7. Validate the HPE-UD adapter operation. For more information about validating the adapter, see Validating the

HPE-UD Adapter.

8. Assuming that you do not wish to trigger the adapter manually every time it needs to run, start Windows Task

Scheduler, and create a basic task to run the adapter.

R] Important: It is suggested that you schedule the adapter to run at times which cannot overlap with the
inventory reader uploading the results to the application server. Check the schedule for the compliance reader
on the central application server, and avoid this time slot.

By default, the inventory import (starting with the reader) is triggered around 2 am. Therefore you might
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consider scheduling this task for some time such as 10 pm daily. The command line for the scheduled task
(assuming that you have saved your preferred settings) is simply to invoke the executable. Any parameters not
specified on the command line are taken from the settings file in the same folder as the executable. Here is an
example:

HPuCMDBStage.exe -x <settings file>

This completes the configuration of the adapter executable.

278 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)



Operation and Validation

Operation and Validation

FlexNet Manager Suite 2022 R1 (On-Premises)

This section describes the normal operation of HPE-UD adapter and also lists the steps to validate its operation. This
section has the following tasks:

o HPE-UD Operation: See HPE-UD Adapter Operation

» Validating the HPE-UD Adapter: See Validating the HPE-UD Adapter

HPE-UD Adapter Operation

FlexNet Manager Suite 2022 R1 (On-Premises)
Normal operation of the HPE-UD adapter relies on the following sequence of events:

1. According to the scheduled instructions, the adapter reads the current content of the HPE-UD database and stages
the new data in the staging database after removing the previously stored data. A flag stored in the staging
database indicates the status of the data extraction. The resulting status is flagged within the database. For more
information on installing and configuring the staging tool, see Installing and Configuring the Staging Tool

2. Following the schedule on the central application server, and provided that the staging status is Success, the
import reader uploads this content to the inventory database.

3. The next compliance import brings the final data set into the compliance database, where it is automatically taken
into account for compliance calculations. As always, for compliance calculations to proceed, the inventory records
must be recognized by the Application Recognition Library, and you must have the resulting application records
linked to the appropriate license.

Validating the HPE-UD Adapter

FlexNet Manager Suite 2022 R1 (On-Premises)

3
U To validate the adapter operation:

1. Manually trigger the adapter executable.
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You can specify a value for the method parameter if you need to override the default settings set in the settings
XML file. For example:

'C:\Program Files\Flexera Software\HPUD\HPuCMDBStage.exe' -f 'C:\temp' -m staged

This will write XML files under your C: \ temp directory for review. It will also write data into the staging database.
2. Inspect the saved XML files to validate the inventory gathered.

3. Use SQL Server Management Studio to validate that the data is written to the staging database. Also review the
StagingState property in the uCMDBStagingDatabaseConfiguration table in the staging database.

Possible values are Running, Failed, or Success. This value must be Success before the HPE-UD data can be
uploaded from the staging database to the central inventory database.

4. Wait until the next inventory import and calculations have run. You might have to wait overnight for this.

5. Use FlexNet Manager Suite to validate that new evidence has been recovered. Identify which evidence has been
recognized by the ARL and which new rules are required. Link the applications to appropriate licenses.
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Managing Microsoft 365 Licenses

FlexNet Manager Suite 2022 R1 (On-Premises)

Microsoft 365 is a set of productivity tools available online (through a cloud-based subscription license) and offline
(installed locally). Microsoft 365 subscriptions include a range of productivity tools including Microsoft Office, Microsoft
Exchange, Microsoft SharePoint, Microsoft Yammer, and Microsoft Skype for Business product lines. Multiple subscription
plans (such as E1, E3, and E5) are available. Some of these plans allow you to install Office applications locally.

With detailed information about Microsoft 365, the chapters in this part may help you in managing Microsoft 365 licenses
through FlexNet Manager Suite.

—
1=

|==| Note: For managing a your subscription licenses for Microsoft 365, you may prefer to use the Flexera SaaS Manager
connector, which not only integrates information for Microsoft 365, but simultaneously imports information for all your
SaaS-based products you choose to manage there. If you choose the Flexera SaaS Manager connector, you should not
use either of the Microsoft 365 connectors described in this part.
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Microsoft 365 License Management
Considerations

FlexNet Manager Suite 2022 R1 (On-Premises)

Microsoft 365 licenses that allow local Office installations also allow you (subject to the chosen plan) to install Microsoft
365 on up to five PCs or Macs, and up to five tablets or smart phones, per Named User license. The following section
provides an overview of the tools provided in each enterprise plan.

With the FlexNet Manager for Clients product, you can use FlexNet Manager Suite to manage your Microsoft 365
subscriptions. You can:

« Validate that the desired users have the right plan
« Determine how many Microsoft 365 licenses you need to purchase, while negotiating license agreements
« Ensure that business units are not under- or over-subscribed.

Based on the selected plan, a subscription of Microsoft 365 may allow you to access multiple Office applications online
as well as offline (local installations) on up to five computers, and five tablets or smart phones. Because of this mixture,
the compliance calculations for Microsoft 365 licenses are different than other applications.

For example, the E3 plan allows you to install and use the following applications:

» Exchange Online Plan 2 for Microsoft 365

» Skype for Business Online for Microsoft 365
« Office Professional Plus for Microsoft 365

o Azure Rights Management for Microsoft 365
« SharePoint Online for Microsoft 365

¢ Yammer for Microsoft 365

¥
= Tip: For a detailed description of the available Microsoft 365 subscription plans, and the applications supported in

each plan, see the Microsoft 365 website.
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Considerations for managing Microsoft 365 licenses

To differentiate user records at various stages of processing, those already recorded within the compliance database of
FlexNet Manager Suite are here called "compliance users".

o Users: Each user imported from Microsoft 365 is mapped to the appropriate compliance user record within FlexNet
Manager Suite (by matching the Email or Alternate email field values). If an imported user cannot be mapped to any
compliance user, a new compliance user record is created with a dummy inventory device assigned to it. These users
consume against the Microsoft 365 multi-product license created for the Microsoft 365 tenant's subscription.

L
= Tip: There are frequently differences between a user's corporate email address (such as Sam. Doe@tmnis. com)

and the same user's email address registered in Microsoft Office 365 (such as
Sam.Doe@tmnisoffice365portal.com). Since only the email addresses are available for matching (given that
your Active Directory accounts are not reflected in the Microsoft 365 online service), this can lead to duplicated user
records. To avoid duplicate records, you can, prior to importing from Microsoft 365 Online Service, populate your
existing user records with the Microsoft 365 email address in the Alternate email field. You may want to consider
using a Business Adapter to make widespread updates. If you have not done this prior to importing from Microsoft
365 (and as a result some user records are now duplicated), you can update the Alternate email field in your AD-
based records at any time, and the next full import and compliance calculation automatically cleans up those
duplicates.

» Devices: Although the installed device information is available to Microsoft 365 administrators through the Microsoft
365 Admin Center, FlexNet Manager Suite imports no device information from Microsoft 365. Instead, imported users

are mapped to compliance users within FlexNet Manager Suite, and the inventory devices linked to those compliance

users are considered to be the accessing devices. The method of linking the inventory devices and users may be any
of assigned user, calculated user, or last logged on user (in descending order of priority, and all visible in the
Oownership tab of the inventory device properties). The system also handles the following exceptions:

o Missing device: If an imported user maps to a compliance user who is not linked to any inventory device, a dummy
remote device is created by using the naming convention User Name (Remote). Such a dummy device is not

treated as a managed device by FlexNet Manager Suite (and specifically, does not count as a licensed device for the

license for FlexNet Manager Suite itself).

o [nstallations on extra devices: If an installation of Microsoft 365 is detected on a device, and the device is not linked

to any compliance user matched to a user imported from Microsoft 365, the installation consumes from an existing

perpetual license.

* Mobile devices: Because FlexNet Manager Suite does not collect inventory from all mobile devices (such as iPads),
you may need to monitor these devices separately. You can get the details of installed devices from the Microsoft 365
Admin Center. If this reveals too many devices where a single named user is authoring or editing Microsoft 365
documents, you may need to deactivate Microsoft 365 from one (or more) of the mobile devices.

¥
= Tip: You can read or present documents on a deactivated copy of Microsoft 365.

o Localinstallations: A Microsoft 365 subscription is represented as a Named User license, with each user permitted to

have installations on multiple devices. Only Microsoft manages the access to Microsoft 365. Separately, if imported
inventory identifies a local installation related to Microsoft Office on an inventory device within your enterprise, the
compliance user linked to the inventory device is checked. If this compliance user is matched in the subscription for
Office 365, FlexNet Manager Suite assumes that the software installation is licensed. If the device user is not matched
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in the subscription for Office 365, FlexNet Manager Suite looks for an existing perpetual license to cover this
installation.

« Office versions: A perpetual license of Microsoft 365 enables you to downgrade to an earlier version, but the
subscription license does not. If you have a perpetual license of the older Office version, and you buy a subscription,
the license validity of the older version gets extended until the subscription expiry date.

« License entitlements: The entitlements data for Microsoft 365 is directly imported from Microsoft 365. When an
import matches an existing license record for Microsoft 365, its available entitlements are adjusted with each import.
On the other hand, if no license exists for an imported subscription to Microsoft 365, a new Named User license is
created for each subscription owned by each Microsoft 365 tenant, and the available entitlements are recorded there.
In the license properties for this automatically-created license:

o The Duration value (on the Identification tab) is set to Subscription.

o Initially, no purchases are linked (on the Purchase tab), since your entitlements are imported from Microsoft 365.
Should you wish to link purchases to this automatically-created license (for example, as a way of independently
keeping track of your subscription purchases), notice that the value of the Assigned column is set to @ (that is, the
effective quantity on any linked purchases does not affect your total entitlements in the usual way). As well, the
Entitlement status column displays Not contributing,to again remind you that for such a license, the
compliance calculations are based entirely on the entitlement figures imported from Microsoft, rather than on
purchase records.
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Managing Microsoft 365 Licenses
through FlexNet Manager Suite

FlexNet Manager Suite 2022 R1 (On-Premises)

Here is a high-level procedure for managing Microsoft 365 licenses using FlexNet Manager Suite.

3
[_] To manage Microsoft 365 licenses:

1. To avoid duplicate user records, ensure that the user email addresses recorded in Microsoft 365 are saved in the
user records visible in Enterprise > All Users.

These may be called "compliance users" after the compliance database table where they are saved. The Microsoft
365 email addresses may be saved in either the Email field or the Alternate email field (both on the Details tab of

the user properties). Common practice is to preserve the corporate email address in the first of these, and save the
one from Microsoft 365 in the Alternate email field.

¥

Tip: If you have many records to update, consider preparing a spreadsheet that lists your enterprise (Active
Directory) email addresses against the Office 365 email addresses for each user, and creating a business
adapter to update your records from the spreadsheet by inserting the Microsoft 365 email addresses into the
ComplianceUser.AlternateEmail column in your compliance database. Of course, if it is not practical to
do this preparation before your first import from Microsoft 365, you can add the Microsoft 365 email addresses to
your AD-based user records at any time. Thereafter, the next full import and compliance calculation removes
any duplicate user records, based on the now-matching email addresses.

2. Ensure that you have created and scheduled a connector from FlexNet Manager Suite for each tenant of Microsoft
365.

Typically, each enterprise is represented as a single tenant, although mergers and acquisitions may mean that

your enterprise has multiple Microsoft tenants. For details on how to create and schedule a connector to Microsoft

365, see Creating Connections to Microsoft 365.

=

I==| Note: The Microsoft 365 connector is the recommended connector to use to create a connection to Microsoft
365. However, if you would like instructions using the legacy Microsoft Office 365 (deprecated) connector, see
Creating Connections Using the Microsoft Office 365 (Deprecated) Connector.
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3. Duringthe next discovery and inventory collection (following a scheduled connection and the upload of the
resulting data), FlexNet Manager Suite creates or updates the following objects:

o Users: Each imported user from Microsoft 365 is mapped to the appropriate compliance user record (by
matching the Email or Alternate email field values). If an imported user cannot be mapped to any compliance
user, a new compliance user record is created with a dummy inventory device assigned to this user.

o Licenses: ANamed User multi-product license (MS-Tenant-name Office 365 (Plan XX)is created for
each subscription plan linked to each Microsoft tenant:
o This license is derived from a template provided in the downloadable libraries, and selected based on the

subscription plan identifier.

o The name of the Microsoft tenant is included as a prefix in the name of each of these licenses. This helps to
distinguish licenses when you have multiple Microsoft Online Service tenants.

o Multiple applications are linked to this license, as defined in the license template.

=X

|=| Note: If a particular plan is not currently supported by FlexNet Manager Suite, a license with no linked
application is created. When the support for this missing plan is added during subsequent automatic
updates to the SKU library and Application Recognition Library, a recommended license change appears,
suggesting that you link the newly-identified applications to the license.

o Onthe Use rights & rules tab of the license properties, in the License consumption rules section, the
Allocations consume license entitlements check box is set. This is because Microsoft 365 is a Named User

license, and allocations to the users must consume entitlements.
o On the Consumption tab of the license properties, the template sets the Allocation type to Permanent.
4. Review the All Users and All licenses pages to ensure that the required users and licenses have been created.

5. After license reconciliation has been completed, the Product Summary page shows the compliance status for
Microsoft 365.

6. Navigate to License Compliance > All Licenses. Filter the records to view Microsoft 365 licenses. You can check the
Consumed and Used columns to know how many subscription entitlements are being used.

7. You can also view the following reports for insights on Microsoft 365 license consumption:
e User license details
e License Overlap.

=Y

I=| Note: A subscription to a Microsoft 365 enterprise plan (except E1) allows you to install Microsoft 365 on up to
five PCs or Macs, and up to five tablets. FlexNet Manager Suite can only track the installation on devices that are
present within your enterprise network. If you wish to include any installation outside the enterprise network,

you can create a dummy inventory device and allocate a Microsoft 365 license to track the usage.

Changes in subsequent imports
Each subsequent import from Microsoft 365 updates the following for each license for Microsoft 365:

¢ Entitlement count

» Expiry date

286 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)



Managing Microsoft 365 Licenses through FlexNet Manager Suite

« Allocations correctly configured (as described above).
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Connecting to Microsoft 365

FlexNet Manager Suite 2022 R1 (On-Premises)

This chapter provides information about how FlexNet Manager Suite connects to Microsoft 365.

Connector overview

There are currently two connectors available. It is recommended that you use the use the Microsoft 365 connector, a
replacement for the existing Microsoft Office 365 (deprecated) connector. To help during the transition to the
Microsoft 365 connector, the legacy connector will remain available for a period of time. The following table provides an
overview comparison of the connectors. This table assumes you have installed the FlexNet Beacon released with FlexNet
Manager Suite 2019 R1 or later.

Connector Name Installation folder Notes

Microsoft 365 ProgramData\Flexera Note the following:

software\Compliance\ This Tier 1 inventory connector is now available to all

D Note: This is the latest ImportProcedures\ customers.
connector. Inventory\Reader\
Microsoft 365 ¢ The Source Type (on the inventory beacon) is
Microsoft 365 .
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Connector Name Installation folder

Microsoft Office 365 ProgramData\Flexera

(deprecated) Software\Compliance\
ImportProcedures\

D Note: This is the legacy Lnventory\Reader\
connector that is now Microsoft Office 365

deprecated.
Ij Note: This installation

folder name and path
remains unchanged.

Connecting to Microsoft 365

Notes
Note the following:

This Tier 1 inventory connector remains available

although deprecated and will longer be supported on a

future release.

« This connector's Source Type (specified on the
inventory beacon PowerShell dialog) is Microsoft
Office 365 (deprecated). However, If you have not
installed the FlexNet Beacon released with FlexNet
Manager Suite 2019 R1 or later, then Microsoft Office
365 (deprecated) will not appear as a Source Type
connection on the Create PowerShell Source
Connection dialog, and instead will remain Microsoft
Office 365.

Generating the Microsoft 365 license compliance position

To generate the compliance position for Microsoft 365 licenses, FlexNet Manager Suite needs information about
subscriptions and usage of Microsoft 365 licenses (both online and offline):

o The local inventory collection process (within your enterprise) returns the local installations of Microsoft Office that

are tied to your Microsoft 365 subscription(s).

« To get subscription and usage information from Microsoft 365 Online Service, the FlexNet Beacon must be configured
with an inventory connection of source type Microsoft 365 or Microsoft Office 365 (deprecated) for each tenant of

Microsoft 365. (Typically, each enterprise is a single Microsoft tenant; but your corporate history, including mergers

and acquisitions, may mean that your enterprise includes multiple Microsoft tenants. Each tenant may then have one

or more subscriptions to different licensing plans, such as Midsize Business or Enterprise.)

When you have created and configured the Microsoft 365 connection, the relevant inventory beacon imports the

licenses, users, and usage information from the Microsoft 365 Online Service account and uploads it to FlexNet Manager

Suite according to your chosen schedule. For details on how to create and schedule a connector to Microsoft 365, see
Creating Connections to Microsoft 365 or see Creating Connections Using the Microsoft Office 365 (Deprecated)

Connector.

Prerequisites and Configuration

Considerations

FlexNet Manager Suite 2022 R1 (On-Premises)

This topic describes prerequisites and configuration considerations for:

« Each inventory beacon that needs to download data from Microsoft 365

« The Microsoft 365 or Microsoft Office 365 (deprecated) connector.
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The inventory beacon

The inventory beacon that will collect inventory for Microsoft 365 in the cloud requires a 64-bit operating system:
Windows Server 2008 R2 SP1 or later, or Windows 7 SP1 or later.

Make sure that the following PowerShell connector prerequisite is met on each inventory beacon that needs to
download data from Microsoft Office. This requirement should have been met when the inventory beacon was
installed:

o PowerShell 5.1 or later, with the PowerShell execution policy set to RemoteSigned

¥
= Tip: Run PowerShell with administrator rights to execute the following commands:

To check the currently-installed version of PowerShell:

$PSVersionTable.PSVersion

To set PowerShell execution policy:

Set-ExecutionPolicy RemoteSigned

Only if you are using the Microsoft Office 365 (deprecated) connector, the following additional prerequisites must be
also met (and are not required for the Microsoft 365 connector):

o 64-bit version of the Microsoft Online Services Sign-in Assistant

o Microsoft Azure Active Directory Module for Windows PowerShell (Microsoft Office 365 uses Azure Active Directory to
manage user identities behind the scenes). Install the Microsoft Azure Active Directory Module for Windows
PowerShell with these steps:

1. Open an administrator-level PowerShell command prompt.

2. RuntheInstall-Module MSOnline command.

3. If prompted to install the NuGet provider, type Y and press ENTER.

4. If prompted that the installer is not signed, type Y and press ENTER

5. If prompted to install the module from PSGallery, type Y and press ENTER.

« Skype for Business Online, Windows PowerShell Module 64-bit version (see https://docs.microsoft.com/en-us/
skypeforbusiness/set-up-your-computer-for-windows-powershell/download-and-install-the-skype-for-business-

online-connector).

The inventory beacon also needs an appropriate version of the FlexNet Beacon software. The FlexNet Beacon released
with FlexNet Manager Suite 2018 R2 (13.1.1) or later is required to use the Microsoft 365 connector. However, installing
the FlexNet Beacon included in the 2019 R1 (13.2.0) or later release provides maximum ease-of-use with the Microsoft
365 connector by including auto-populated values on the Create PowerShell Source Connection dialog (that
otherwise need to be entered manually). In addition, if you are using a using a FlexNet Beacon released prior to FlexNet
Manager Suite 2019 R1, then Microsoft Office 365 (deprecated) will not appear as a Source Type connection on the
Create PowerShell Source Connection dialog, and instead will remain Microsoft Office 365.

Microsoft 365 connector configuration

There are three different possibilities for configuring your Microsoft 365 connector, each of which is described in detail
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in a following topic:

1. You can configure the Microsoft 365 connector using a multi-tenant app supplied by Flexera (and thus avoid
configuring your own app). This requires the Cloud Application Administrator and Reports Reader roles, so that
FlexNet Beacon can retrieve a token allowing read-only access to Microsoft Graph APIs. Microsoft Graph APIs allow
only an administrator to read Users, Subscribed SKUs, and Reports from Microsoft 365. For more
background, see https://docs.microsoft.com/en-us/azure/active-directory/users-groups-roles/directory-assign-
admin-roles. For a step-by-step procedure, see Using FlexNet Manager Suite’s Multi-Tenant App to Connect to
Microsoft 365.

2. You can configure the Microsoft 365 connector using your own single-tenant app. This offers two kinds of
authentication:

« You can use similar credentials to the first case of the Flexera-supplied app

« Importantly, you can instead configure a client secret that, for the lifetime that you declare, can be used to
collect the appropriate data (without using additional credentials).

A detailed procedure covering either kind of authentication is available from Registering an App to Connect to
Microsoft 365 Using the Azure Portal.

3. If necessary, you can use the Microsoft Office 365 (deprecated) connector. If the maximum privileges of Global
administrator cannot be used, then in order to collect usage data, the integration user must at a minimum have
Exchange administrator and Skype for Business administrator roles in Microsoft 365 (available as check boxes
under the Custom administrator role). For more information, see https://support.office.com/en-gb/article/
About-Office-365-admin-roles-da585eea-f576-4f55-a1le0-87090b6aaadd?ui=en-US&rs=en-GB&ad=GB. For a step-
by-step procedure, see Creating Connections Using the Microsoft Office 365 (Deprecated) Connector.

Network

For information relating to the network requirements for your firewall or proxy server, please refer to the Microsoft
documentation https://docs.microsoft.com/en-us/office365/enterprise/urls-and-ip-address-ranges. You may also like
to refer to the Flexera knowledge base article How to configure Office 365 connector in a proxy enabled environment or
firewall.

Creating Connections to Microsoft 365

FlexNet Manager Suite 2022 R1 (On-Premises)

I} Important: The FlexNet Beacon released with FlexNet Manager Suite 2018 R2 or later is required to use the Microsoft
365 connector. However, installing the FlexNet Beacon included in the 2019 R1 or later release provides maximum
ease-of-use with the Microsoft 365 connector by including auto-populated values on the Create PowerShell Source
Connection dialog (that otherwise need to be entered manually). In addition, Microsoft Office 365 (deprecated) will
not appear as a Source Type connection on the Create PowerShell Source Connection dialog, and instead will
remain Microsoft Office 365.

]

= Tip: The connector to Flexera SaaS Manager supersedes and overrides both the Microsoft 365 connector and the
Microsoft Office 365 (deprecated) connector. This means that if you implement the Flexera SaaS Manager connector,
any licenses that are created from imports through either of the Microsoft 365 connectors are automatically given a
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status of Retired, so that they have no impact on license reconciliation calculations. Instead, new licenses are
created from the Flexera SaaS Manager imports, and these are included in license reconciliations as usual. For further
details, see the online help for the Integrations tab of the System Settings page.

A separate connection is required for each tenant of Microsoft 365. (Typically, there is one tenant per enterprise; but
your corporate history, particularly of mergers and acquisitions, may mean that your enterprise has multiple Microsoft
tenants.) The inventory beacon requires this connection to import entitlements, users, and usage information from the
Microsoft 365 online account. Each per-tenant import covers all subscriptions for that tenant.

When you use the Microsoft 365 connector, there are two ways of creating connections to the Microsoft 365 online
service. Refer to the following sections for associated instructions:

o Using FlexNet Manager Suite’s Multi-Tenant App to Connect to Microsoft 365 — The Microsoft 365 connector uses a
pre-registered multi-tenant app that has been configured by Flexera for the purpose of collecting Microsoft Office
365 data. This app is configured to allow our customers to collect data without the hassle of registering an app in

their own instance.

o Registering an App to Connect to Microsoft 365 Using the Azure Portal — This second method registers an app within
your own Microsoft Office 365 instance.

L
= Tip: This second method allows for the use of a client secret to collect the token for interaction with Microsoft 365,

so that you do not need a user account and password with special privileges for reqular operation of the
connector.

If you use the Microsoft Office 365 (deprecated) connector, refer to the instructions in Creating Connections Using the
Microsoft Office 365 (Deprecated) Connector.

Using FlexNet Manager Suite’s Multi-Tenant App to
Connect to Microsoft 365

FlexNet Manager Suite 2022 R1 (On-Premises)

|_‘¢ Important: The instructions in this section are for use with the Microsoft 365 connector. This is the recommended
connector to use to create a connection to Microsoft Office 365 on an inventory beacon. If you would like instructions
for using the legacy Microsoft Office 365 (deprecated) connector, see Creating Connections Using the Microsoft
Office 365 (Deprecated) Connector.

|_¢ Important: The FlexNet Beacon released with FlexNet Manager Suite 2018 R2 or later is required to use the
Microsoft 365 connector. However, installing the FlexNet Beacon included in the 2019 R1 or later release provides
maximum ease-of-use with the Microsoft 365 connector by including auto-populated values on the Create
PowerShell Source Connection dialog (that otherwise need to be entered manually).

The Microsoft 365 connector uses a pre-registered multi-tenant app that has been configured by Flexera for the
purpose of collecting Microsoft Office 365 data. This app is configured to allow our customers to collect data without
the hassle of registering an app in their own instance. Use the following procedure to create a connection to Microsoft
365 on an inventory beacon using FlexNet Manager Suite's multi-tenant app.
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£
[_] To to create a connection to Microsoft 365 on an inventory beacon using FlexNet Manager Suite's multi-

tenant app:

. Loginto the inventory beacon interface as an administrator (for example, in the Windows Start menu, search for
FlexNet Beacon, right-click it, and select Run as administrator).

i
= Tip: Remember that you must run the inventory beacon software with administrator privileges.

. From the Data collection group in the navigation bar, choose Inventory Systems.
. Choose either of the following:

« To change the settings for a previously-defined connection, select that connection from the list, and click
Edit....

« To create a new connection, click the down arrow on the right of the New split button, and choose
Powershell.

. Complete (or modify) the values for the following required fields:

» Connection Name: The name of the inventory connection. The name may contain alphanumeric characters,
underscores or spaces, but must start with either a letter or a number. When the data import through this
connection is executed, the data import task name is same as the connection name.

» Source Type: Select Microsoft 365 from this list.

. Optionally, if your enterprise uses a proxy server to enable Internet access, complete (or modify) the values in the
Proxy Settings section of the dialog box in order to configure the proxy server connection.

« Use Proxy: Select this check box if your enterprise uses a proxy server to enable Internet access. Complete
the additional fields in the Proxy Settings section, as needed. If the Use Proxy check box is not selected, the
remaining fields in the Proxy Settings section are disabled.

» Proxy Server: Enter the address of the proxy server using HTTP, HTTPS, or an IP address. Use the format
https://ProxyServerURL:PortNumber, http://ProxyServerURL:PortNumber, or

IPAddress:PortNumber). This field is enabled when the Use Proxy check box is selected.

« Username and Password: If your enterprise is using an authenticated proxy, specify the username and
password of an account that has credentials to access the proxy server that is specified in the Proxy Server
field. These fields are enabled when the Use Proxy check box is selected.

. In the Microsoft 365 section, do the following:

a. Note that the following fields are auto-populated if you have installed the FlexNet Beacon released with
FlexNet Manager Suite 2019 R1 or later. If you have not installed this FlexNet Beacon, then manually enter
the following values into these fields:

o Token Endpoint: https://login.microsoftonline.com/common/oauth2/v2.0/token
« Application (client) ID: 5bb1a5a2-0d97-4335-9448-119f7b27aff9
o Redirect URI: https://login.microsoftonline.com/common/oauth2/nativeclient

+ Authentication Flow: from the drop-down, select Authorization Code.Additional fields are
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exposed.

o Authorization Endpoint: https://login.microsoftonline.com/common/oauth2/v2.0/

authorize

b. Next to the Refresh Token field, click the Generate... button to generate a refresh token that will be used
to integrate with Microsoft 365.

When you click the Generate... button to the right of the Refresh Token field, a Microsoft popup
appears asking you to Pick an account to use to log into Microsoft Office 365.

c. Choose an Active Directory account with Cloud application administrator role privileges and enter the
password.

(d

= Tip: The Cloud application administrator role is required in order for the FlexNet Beacon to retrieve
a token that allows read only access to Microsoft Graph. For more information, see
https://docs.microsoft.com/en-us/azure/active-directory/users-groups-roles/directory-assign-admin-
roles. The generated refresh token can only be used to access data that user sees and consents to
during the token generation process, which is offline read-only access to Active Directory and Reports
(directory.read.all, reports.read.all, and offline_access). Offline means the FlexNet Beacon can
connect and get data from Office 365 at schedule run without user actually signing in.

A Permissions requested dialog appears.

d. Click Consent on behalf of your organization to accept the read only permissions that will be granted to
the refresh token.

e. Click Accept.
The Refresh Token field is now populated.

7. Atthe bottom of the FlexNet Beacon interface, click Save.

(4
= Tip: Optionally, you may wish to select your connection, and click Execute Now, before you exit. You may

also want to schedule data imports through this connection, for which see Scheduling a Connection in the
online help.

8. When you are done, click Exit.

After a successful data import, the users, applications, licenses, and usage data are all visible in the appropriate pages
of FlexNet Manager Suite.

=2

|= Note: To know more about the operations available on the Inventory Systems page of FlexNet Beacon, see
Inventory System Page in the online help. For scheduling data imports through this connection, see Scheduling a
Connection, also in help.

FlexNet Manager Suite (On-Premises)

2022 R1

Registering an App to Connect to Microsoft 365
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Using the Azure Portal

FlexNet Manager Suite 2022 R1 (On-Premises)

|_¢' Important: The instructions in this section are for use with the Microsoft 365 connector. This is the recommended
connector to use to create a connection to Microsoft Office 365 on an inventory beacon. If you would like instructions
using the legacy Microsoft Office 365 (deprecated) connector, see Creating Connections Using the Microsoft Office

365 (Deprecated) Connector.

An alternative method to the instructions provided in Using FlexNet Manager Suite’s Multi-Tenant App to Connect to

Microsoft 365 is to register a single-tenant app in the Azure portal to connect to Microsoft 365 as shown in the steps in
this section. This requires Global Administrator privileges for the initial registration. Using this process, it is possible to

specify a client secret (under OAuth) to be used for regular operation of the connector, so that a separate user name
and password are not required for operational use.

[i] To register an app in the Azure portal to connect to Microsoft 365:
1. With an Azure account with Global Administrator privileges, login to the Microsoft Azure portal.
2. Inthe left navigation bar, click Azure Active Directory.
3. Click App registrations.
4. Click the New registration button.
The Register an application page appears.

5. Inthe Register an application page, do the following:

a. Inthe Name field, enter FlexNet Beacon.

b. Inthe Supported account types section, choose Accounts in this organizational directory only.

c. Click Register.

The Azure AD application is created, and its FlexNet Beacon overview page appears.

6. On the FlexNet Beacon page, click Authentication in the middle group of the navigation bar and do the
following:

a. Inthe Redirect URIs section, either:

o Choose the redirect you would like to use, such as https://login.microsoftonline.com/

common/oauth2/nativeclient;or

« Click Add URI to expose a field where you may enter your preferred value, and then click the check
mark at the end of that field.

b. Click Save at the top of the page.

After a period of time, the registration completes, and the FlexNet Beacon overview page is displayed.

7. If you wish to use a client secret to authenticate normal operations of the Microsoft 365 connector, add a client

secret for the FlexNet Beacon add-in:
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a. Inthe navigation bar, select Certificates & secrets.
b. Inthe Client secrets section of the page, click New client secret.
Anew Add a client secret panel appears.
¢. Add a Description, which acts as a friendly name for your client secret.
d. Choose how long your client secret should remain valid (between 6 months and two years).

Choose a period that best suits your business processes. Shortly before the client secret expires, you
need to generate a new client secret and update your add-in.

e. Click Add at the bottom of the panel.

Your new secret appears temporarily in the list of Client secrets.

|_¢' Important: You must immediately use the copy icon on the right of your new client secret value to
capture the client secret and save it to a secure location where you can refer to it later, as it will not be
shown in the Azure Partner Center again. Also record the Expires date, so you know the period of
validity of your client secret (best practice is to set a reminder in your preferred enterprise technology
calendar system to update the client secret shortly before it expires, as described in
https.//docs.microsoft.com/en-us/office/dev/store/create-or-update-client-ids-and-
secrets#bk_update).

f. Only after you have safely copied your new client secret, select APl permissions in the navigation bar,
and then click Add a permission > Microsoft graph > Application permissions.

These permissions are required for the connector to authenticate as itself, without user interaction.
g. Under Select permissions:
a. Expand Directory, and select Directory.Read.All.

b. Expand Reports, and select Reports.Read.All.

¥
= Tip: These permissions require admin consent, described next. The required button is only enabled

when you are an administrator and have selected the permissions as just described.

h. Above the set of permissions, click Grant admin consent for cLient-name. In the confirmation dialog
that appears, confirm the consent action.

The Status column in the list of permissions is updated with green check icons and Granted for
client-name against each permission. This completes the settings in the Azure portal, and you can
prepare to copy values into your inventory beacon interface.

i. Inthe navigation bar select Overview again, and from the tabs across the top, select Endpoints.
Keep this panel open for copying values to your inventory beacon interface in step 12.

8. Ontheinventory beacon that will exercise the connection to Microsoft 365, log into the inventory beacon
interface as an administrator (for example, in the Windows Start menu, search for FlexNet Beacon, right-click it,
and select Run as administrator).

Y
@ Remember: You must run the inventory beacon software with administrator privileges.
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9. To create a new connection, click the down arrow on the right of the New split button, and choose PowerShell.
10. Complete the following required fields:

« Connection Name: Enter the name of the inventory connection. The name may contain alphanumeric
characters, underscores or spaces, but must start with either a letter or a number. When the data import
through this connection is executed, the data import task name is same as the connection name. Example:

Microsoft 365 import

» Source Type: Select Microsoft 365 from this list.

11. Optionally, if your enterprise uses a proxy server to enable Internet access, complete the values in the Proxy
Settings section of the dialog box in order to configure the proxy server connection:

» Use Proxy: Select this check box if your enterprise uses a proxy server to enable Internet access. Complete
the additional fields in the Proxy Settings section, as needed. If the Use Proxy check box is not selected, the
remaining fields in the Proxy Settings section are disabled.

» Proxy Server: Enter the address of the proxy server using HTTP, HTTPS, or an IP address. Use the format
https://ProxyServerURL:PortNumber, http://ProxyServerURL:PortNumber, or

IPAddress:PortNumber). This field is enabled when the Use Proxy check box is selected.

« Username and Password: If your enterprise is using an authenticated proxy, specify the username and
password of an account that has credentials to access the proxy server that is specified in the Proxy Server
field. These fields are enabled when the Use Proxy check box is selected.

12. Complete the fields in the Microsoft 365 section:

The source contents for most fields in this section are waiting in your Azure session, opened to the FlexNet
Beacon product overview page.

a. Inthe Azure product overview, ensure that you have clicked the Endpoints tab (near the top), and have
open the panel listing multiple endpoints.

a. Click the Click to copy icon to the right of the OAuth 2.0 token endpoint (v2) field.
b. Paste this value into the Token Endpoint field in the inventory beacon interface.
b. InAzure, in the Overview page:
a. Click the Click to copy icon to the right of the Application (client) ID field.
b. Paste this value into the Application (client) ID field in the inventory beacon interface.

c. InAzure, in the Overview page, click the hyperlink in the Redirect URIs section. This opens the
Authentication page.

a. Click the Click to copy icon to the right of theRedirect URIs setting you selected; or if you specified
a custom URI, copy that URI.

b. Paste this value into the Redirect URI field in the inventory beacon interface.
d. Intheinventory beacon interface, from the Authentication Flow drop-down, choose either:

e Client Credentials ifyou are using a client secret to authenticate connection to Microsoft 365. A

Client Secret field appears: copy your client secret from the secure location where you previously
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saved it, and paste it into this field.

o Authorization Code if you are not using a client secret, and instead are using a refresh token to

authenticate connection to Microsoft 365. An Authorization Endpoint field appears.

a. InAzure, in the Overview page, click Endpoints again.
b. Click the Click to copy icon to the right of the OAuth 2.0 authorization endpoint (v2) field.
c. Paste this value into the Authorization Endpoint field in the inventory beacon interface.

d. To generate a Refresh Token to authenticate the connection to Microsoft 365, click the
Generate... button.

e. Inthe pop-up, loginto Azure with your account name and password.

f. InAzure, in the panel for Permissions requested, select Consent on behalf of your
organization, and click Accept.

g. Optionally, validate your settings in Azure by navigating to APl permissions, where your
Configured permissions list should display green "Granted" check marks for all four rights
under Microsoft Graph.

13. At the bottom of the FlexNet Beacon interface, click Test connection for a success message (or use the error
message to commence your trouble-shooting).

14. When the connection is successful, click Save.

(d

= Tip: Optionally, you may wish to select your connection, and click Execute Now, before you exit. You may
also want to schedule data imports through this connection, for which see Scheduling a Connection in the
online help.

15. When you are done, click Exit.

After a successful data import, the users, applications, licenses, and usage data are all visible in the appropriate pages
of FlexNet Manager Suite.

—
1=

|=| Note: To know more about the operations available on the Inventory Systems page of FlexNet Beacon, see
Inventory Systems Page in the online help. For scheduling data imports through this connection, see Scheduling a
Connection, also in help.

FlexNet Manager Suite (On-Premises)

2022 R1

Configuring Token Lifetimes in Azure Active
Directory

FlexNet Manager Suite 2022 R1 (On-Premises)

This section is for Microsoft Azure AD administrators who may want to configure the lifetimes of refresh tokens and
access tokens issued by Azure Active Directory. If your organization already have these set, these steps are not
necessary.
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FlexNet Beacon uses an Microsoft Azure Active Directory (AAD) native app for authentication when using Microsoft 365
inventory connections. You have a choice of whether to use the Flexera-created multi-tenant app for this
authentication, or to create your own single-tenant app.

¥
= Tip: The following discussion does not apply to a single-tenant app using a client secret.

When the authentication is complete and a user consents to access to the resource (Microsoft Graph) with read only
permissions, the Azure AD generates and sends two tokens: a refresh token and an access token. These tokens are
specific to the user, resource, and permissions. The refresh token is used to authenticate further in the future without
a need to login while the access token is a session token. Typically, a refresh token is saved and is used first in every
session to generate a new access token, once the access token is generated, it is then used in following calls within
that session.

Since these tokens can be used anytime without a need for a user to manually login, Azure AD allows you to configure
the lifetime for such tokens. After a refresh token expires, a user must login and consent to access to resources and
permissions to get a new refresh token generated. After an access token expires, an app can use a valid refresh token
to get a new access token.

The configuration of these tokens' lifetime is an Azure AD functionality and is applied to all applications in that tenant.
To configure these tokens, an Azure AD administrator must have the Azure AD PowerShell module installed. For more
information about these tokens, their default values and configuration, see https://docs.microsoft.com/en-us/azure/
active-directory/develop/active-directory-configurable-token-lifetimes.

£
[_] To configure lifetimes for the refresh token and an access token:
1. Run PowerShell as an administrator.

2. Install the Azure AD PowerShell module:
Install-Module AzureADPreview

3. Connect to Azure AD:
Connect-AzureAD

4. Check if you already have a token lifetime policy:

$defaultTokenPolicy = Get-AzureADPolicy | Where-Object {$_.Type -eq
"TokenLifetimePolicy" -and
$_.IsOrganizationDefault -eq $true}

5. Check whether a token policy exists:

$defaultTokenPolicy

6. If atoken policy exists, the previous command returns an object; otherwise, a blank. If a value is returned, you
may want to examine the current token policies by entering the following:.

$defaultTokenPolicy.Definition

7. Ifapolicy exists, it is returned. The following shows an example policy returned:
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PS C:\WINDOWS\system32> $defaultTokenPolicy.Definition

{
"TokenLifetimePolicy":
{
"Version":1,
"AccessTokenLifetime":"0.00:10:00",
"MaxInactiveTime":"90.00:00:00",
"MaxAgeSingleFactor":"until-revoked",
"MaxAgeMultiFactor":"until-revoked",
"MaxAgeSessionSingleFactor":"until-revoked",
"MaxAgeSessionMultiFactor":"until-revoked"
}
¥

The AccessTokenLifetime in the above example is set to 10 minutes which means that once an access token
is generated, it remains active for ten minutes, after which the app must retrieve another generated access
token. The MaxInactiveTime is set to 90 days which means that a refresh token expires after 90 days of
inactivity. The MaxAgeSingleFactor and MaxAgeMultiFactor are also related to refresh token and define

the maximum lifetime of a refresh token, based on the single or multi-factor authentication setting of your
organization.

If you want to add or update your Azure AD token lifetime settings, you need to decide on the new settings and
execute following (updating the lifetimes as you wish):

$newTokenPolicy = @('{

"TokenLifetimePolicy":

{
"Version":1,
"AccessTokenLifetime":"0.01:00:00",
"MaxInactiveTime":"90.00:00:00",
"MaxAgeSingleFactor":"until-revoked",
"MaxAgeMultiFactor":"until-revoked",
"MaxAgeSessionSingleFactor":"until-revoked",
"MaxAgeSessionMultiFactor":"until-revoked"

)
9. Now, if you did not have a token policy, execute the following.

New-AzureADPolicy -Type "TokenLifetimePolicy" -DisplayName
"OrganizationDefaultPolicyScenario”

-IsOrganizationDefault $true -Definition $newTokenPolicy
10. And if you had a token policy, execute the following command to update it.
Set-AzureADPolicy -Id $defaultTokenPolicy.Id -DisplayName

"OrganizationDefaultPolicyUpdatedScenario"
-Definition $newTokenPolicy

11. To validate that the policy has been applied correctly, execute steps 3 through 5.
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Creating Connections Using the Microsoft
Office 365 (Deprecated) Connector

I} Important: The instructions in this section are for creating a connection to Microsoft Office 365 using the legacy
Microsoft Office 365 (deprecated) connector. However, the Microsoft 365 connector is recommended connector to
use to create a connection to Microsoft 365 on an inventory beacon. For those instructions, refer to Using Flexera’s
Multi-Tenant App to Connect to Microsoft 365, or see Registering an App to Connect to Microsoft 365 Using the Azure
Portal.

Use the following procedure to create a connection to Microsoft 365 on an inventory beacon using the legacy Microsoft
Office 365 (deprecated) connector. A separate connection is required for each tenant of Microsoft 365. (Typically, there
is one tenant per enterprise; but your corporate history, particularly of mergers and acquisitions, may mean that your
enterprise has multiple Microsoft tenants.) The inventory beacon requires this connection to import entitlements,
users, and usage information from the Microsoft 365 online account. Each per-tenant import covers all subscriptions for
that tenant.

ot
U To create a connection to Microsoft 365:

1. Ensure that you have your preferred schedule for imports from Microsoft 365 set on the appropriate inventory
beacon:

a. Loginto the inventory beacon interface as an administrator (for example, in the Windows Start menu,
search for FlexNet Beacon, right-click it, and select Run as administrator).

7
= Tip: Remember that you must run the inventory beacon software with administrator privileges.

b. From the Data collection group in the navigation bar, choose Scheduling.

c. Ifthereis not already a suitable schedule in the list, click New... and complete the details (see Creating a
Data Gathering Schedule for more information)(see online help for more information). Otherwise, identify
the schedule you will use.

2. Select the Inventory Systems page (in the same navigation group).
3. Choose either of the following:

« To change the settings for a previously-defined connection, select that connection from the list, and click
Edit....

» To create a new connection, click the down arrow on the right of the New split button, and choose
Powershell.

4. Complete (or modify) the values for the following required fields:

» Connection Name: The name of the inventory connection. When the data import through this connection is
executed, the data import task name is same as the connection name.

« Source Type: SelectMicrosoft Office 365 (deprecated) from this list.
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=3

I==| Note: Ifyou have not installed the FlexNet Beacon released with FlexNet Manager Suite 2019 R1 or later, then
Microsoft Office 365 (deprecated) will not appear as a Source Type connection. Instead, Microsoft Office 365
will appear as the legacy connector source type.

5. Optionally, if your enterprise uses a proxy server to enable Internet access, complete (or modify) the values in the
Proxy Settings section of the dialog box in order to configure the proxy server connection.

» Use Proxy: Select this check box if your enterprise uses a proxy server to enable Internet access. Complete the
additional fields in the Proxy Settings section, as needed. If the Use Proxy check box is not selected, the

remaining fields in the Proxy Settings section are disabled.

« Proxy Server: Enter the address of the proxy server using HTTP, HTTPS, or an IP address. Use the format
https://ProxyServerURL:PortNumber, http://ProxyServerURL:PortNumber, or

IPAddress:PortNumber). This field is enabled when the Use Proxy check box is selected.

« Username and Password: If your enterprise is using an authenticated proxy, specify the username and
password of an account that has credentials to access the proxy server that is specified in the Proxy Server
field. These fields are enabled when the Use Proxy check box is selected.

6. Complete (or modify) the values in the Microsoft 365 section of the dialog. All of the following values are required:

=

I=| Note: If you have multiple tenants within Microsoft 365 (for example, separate subscriptions for different
corporate units or locations), you need to create a separate connector for each tenant using its own
credentials. Within each tenant, a single connection and a single import recovers data for all your

subscriptions (if you have multiple subscriptions).
« Username: Microsoft 365 tenant user name.
» Password: Microsoft 365 tenant password.
7. Save the connection.
8. Select your new connection from the displayed list, and click Schedule....

9. Inthe dialog that appears, select the name of your chosen schedule for inventory collection through this
connection, and click OK.

10. At the bottom of the FlexNet Beacon interface, click Save, and if you are done, also click Exit.

i
= Tip: Consider whether you want to select your connection, and click Execute Now, before you exit.

After a successful data import, the users, applications, licenses, and usage data are all visible in the appropriate pages

of FlexNet Manager Suite.

=

I==I Note: To know more about the operations available on the Inventory Systems page of FlexNet Beacon, see
Inventory System Page in the online help. For scheduling data imports through this connection, see Scheduling a
Connection, also in help.

=

I==I' Note: To know more about the operations available on the Inventory Systems page of FlexNet Beacon, see
Inventory Systems Page. For more about scheduling data imports, see Scheduling a Connection.
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FlexNet Manager Suite (On-Premises)

2022 R1

Troubleshooting Imports from Microsoft
365

FlexNet Manager Suite 2022 R1 (On-Premises)
The following sections provide help with troubleshooting imports from Microsoft 365:
» Troubleshooting Microsoft 365 Connector Imports from Microsoft 365

» Troubleshooting Microsoft Office 365 (Deprecated) Connector Imports from Office 365

Troubleshooting Microsoft 365 Connector Imports
from Microsoft 365

FlexNet Manager Suite 2022 R1 (On-Premises)

I} Important: The troubleshooting in this section applies to connections to Microsoft 365 that use the Microsoft 365
connector. For help with troubleshooting connections using the Microsoft Office 365 (deprecated) connector, see
Troubleshooting Microsoft Office 365 (Deprecated) Connector Imports from Office 365.

Symptom Recommendation

The Authorization Endpoint, Token Check whether you are using a FlexNet Beacon older than the one included
Endpoint, Application (client) ID or with FlexNet Manager Suite 2019 R1.. If so, you will need to manually enter
Redirect URI values are blankin the these values:

PowerShell connection dialog.
o Authorization Endpoint: https://login.microsoftonline.com/

common/oauth2/v2.0/authorize

« Token Endpoint: https://login.microsoftonline.com/common/
oauth2/v2.0/token

+ Application (client) ID: 5Sbb1a5a2-0d97-4335-9448-119f7b27aff9

o Redirect URI: https://login.microsoftonline.com/common/

oauth2/nativeclient
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Symptom Recommendation

Ablank pop-up screen appears You most likely need to set the PowerShell execution policy. Run PowerShell
when you click the Generate... with administrator rights to execute the following command:

button (next to the Refresh Token
field) when attempting to generate a
refresh token that will be used to
integrate with Microsoft 365.

Set-ExecutionPolicy RemoteSigned

You get a Need admin approval Ensure that the account used to connect to the Microsoft 365 tenant(s) has
dialog saying that the FlexNet the Cloud application administrator role. This role is required in order for
Beacon needs permission to access  the FlexNet Beacon to retrieve a token that allows read only access to

resources in your organization that Microsoft Graph. For more information, see https://docs.microsoft.com/en-

only an admin can grant. us/azure/active-directory/users-groups-roles/directory-assign-admin-roles.
You receive an authorization error This may be because the machines do not have permissions to access the
that informs that you are not Microsoft Authentication site. Ensure that you provide proxy information if
authorized to access this site. the machine uses proxy settings. Also, open a Web browser, navigate to

https://login.microsoftonline.com and log on when asked, to validate that
you can successfully authenticate on this machine.

If you still see issues, contact Flexera with information from this and other
steps. Note the steps that caused your issue and save any necessary
screenshots to report to Flexera. Also include what kind of authentication
service is used in your organization and what region and country the
machine and Microsoft 365 tenant reside. Note that some regions (e.g.,
Germany) have separate login URLs as explained in
https://docs.microsoft.com/en-us/azure/active-directory/develop/
authentication-national-cloud.

You receive an Inventory gathering  Errors like Inventory gathering failed. Error: The remote server returned

or Usage error. an error: (403) Forbidden may occur when the Reports Reader and Cloud
Application Administrator roles privilege are not present for the account
used to generate your token.

Troubleshooting Microsoft Office 365 (Deprecated)
Connector Imports from Office 365

FlexNet Manager Suite 2022 R1 (On-Premises)

I:i) Important: The troubleshooting in this section applies to connections to Microsoft Office 365 using the Microsoft
Office 365 (deprecated) connector. For help with troubleshooting connections using the Microsoft Office 365
connector, see Troubleshooting Microsoft 365 Connector Imports from Microsoft 365.

This process traces the path of data imported from Microsoft 365 Online Service through an inventory beacon to the
central application server of FlexNet Manager Suite. You may pick up at any stage of the process as needed for your
particular symptoms.
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oy
[_] To troubleshoot imports from Microsoft 365 Online Service:

1. Validate that you have licensed the FlexNet Manager for Datacenters product:

b.

Navigate to the system menu (& ¥ in the top right corner) in the web interface for FlexNet Manager Suite,
and click FlexNet Manager Suite License.

In the Licensed products section, scroll down to see the card for FlexNet Manager for Datacenters.

Inventory from a connection to Microsoft 365 Online Service cannot be imported or uploaded by an inventory
beacon without this license term being registered on the central application server. If it is missing, please
contact your Flexera representative for assistance.

2. Validate imports to the inventory beacon:

On the inventory beacon that connects to Microsoft 365, log into FlexNet Beacon using an account with
administrator privileges.

On the Inventory Systems page, select your connection to Microsoft 365, and click Execute Now
A confirmation shows that the extract has started. A typical import may take 2-3 minutes.

In the very top-left corner of the FlexNet Beacon interface, right-click the menu icon, and select Open log
file folder.

File Explorer opens.

. Ensure that you are viewing the ProgramData\Flexera Software\Compliance\Logging\

ComplianceReader folder.

. In Notepad, open the text document importer-[nnnn] that was modified on today's date, and scroll to

the bottom.
If the reading of data is still in progress, exit from Notepad, and try again in a few minutes.

A successful process shows the following at the end of the log file (with each line prefixed with the date
and time):

[INFO] © source data warnings
[INFO] @ errors, © warnings
[INFO] Import has been completed successfully

If, instead, there are warnings or errors in the log file, try to correct the issues. If all else fails, save the log
file to include with a Support ticket for Flexera. Typical issues at this stage may include:

« Proxy or firewall settings preventing access to the Internet
 Intermittent issues with the Internet or access to the Microsoft 365 portal

« Incorrect details for the account name or password accessing the portal (see Creating Connections
Using the Microsoft Office 365 (Deprecated) Connector for details of configuring this account)

» The connection has not been regularly scheduled (see the same topic), and so succeeds only when
executed manually.

Immediately after a successful import is completed, the inventory beacon attempts to upload the
archive of imported data to its parent (the parent may be another inventory beacon in the hierarchy, or
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the central application server):

* When the upload succeeds, the inventory beacon also saves a copy in C: \ProgramData\Flexera

Software\Beacon\IntermediateData\Uploaded, and preserves this copy for 14 days

o Ifthe upload fails, the imported archive stays in C: \ProgramData\Flexera Software\Beacon\
IntermediateData.
=
= Tip: If you are working on a disconnected inventory beacon (one that cannot access the central

application server), this IntermediateData folder contains the data files that you must transfer
to another location where uploads are possible.

g. To review the data imported from Microsoft 365, navigate to C: \ProgramData\Flexera Software\
Beacon\IntermediateData\Uploaded, and inspect the most recent relevant . zip file there.
7
= Tip: If the zip archive remains in the IntermediateData folder (on a connected inventory beacon),
there is an upload problem, as discussed below.

3. Todebug uploads from this inventory beacon to its parent, review C: \ProgramData\Flexera Software\
Compliance\Logging\ComplianceUpload\upload.log for details of any networking issues, and note the
URL of the next server in the upload chain. If this is another inventory beacon, repeat these reviews there, and so
on until you exhaust the hierarchy of inventory beacons.

The upload URL is in a log line that starts:

dateTime [Upload.UploadProcess ] [INFO] Uploading to http...

4. Once you have reached your application server (or inventory server, in a multi-server implementation), check
C:\ProgramData\Flexera Software\Compliance\Logging\WebResolvers\dispatcher.log forany

issues in resolving the inventory.

5. If you are unable to resolve problems, collect your logs together in a zip archive. Ask your registered support
contact (a designated person within your enterprise who has access rights and login details) to open a new
support case at https://community.flexera.com/t5/forums/postpage/board-id/@support, including a clear
description of the issue. Once the case has been saved, your support contact can use the Upload button (in the
Attachments section at the bottom) to attach your prepared zip archive of logs.
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Migrating to a New Microsoft
Connector

FlexNet Manager Suite 2022 R1 (On-Premises)

|_¢' Important: The instructions in this section are only applicable if you have previously used the Microsoft Office 365 (or
Microsoft Office 365 (deprecated) connector), have validated the data coming from the new Microsoft 365 connector,

and are ready to switch over completely to the new connector. There are a few basic steps to follow to migrate licenses
and relink contracts and purchase orders to the new license.

=
[_] To migrate from an older to newer Microsoft connector, migrate licenses, and relink contracts and purchase
orders to the new license:

1. Check your version of the FlexNet Beacon.

=X

I==| Note: The FlexNet Beacon released with FlexNet Manager Suite 2018 R2 (13.1.1) or later is required to use the
Microsoft 365 connector. However, installing the FlexNet Beacon included in the 2019 R1 (13.2.0) or later release
provides maximum ease-of-use with the Microsoft 365 connector by including auto-populated values on the
Create PowerShell Source Connection dialog (that otherwise need to be entered manually). In addition, if you
are using a FlexNet Beacon released prior to FlexNet Manager Suite 2019 R1, then Microsoft Office 365

(deprecated) will not appear as a Source Type connection on the Create PowerShell Source Connection
dialog, and instead will remain Microsoft Office 365.

2. Delete the connection to the old Microsoft Office 365 or Microsoft Office 365 (deprecated) connector.

1
I==| Note: Although the legacy connector name is now Microsoft Office 365 (deprecated), the previous name of the
this connector's Source Type was Microsoft Office 365.

3. Relink contracts and purchase orders to the new license.
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Oracle Enterprise Manager monitors and manages other Oracle software installed on customer sites. Therefore itis a
useful aid in gathering inventory from Oracle systems.

The Oracle Enterprise Manager (OEM) adapter, from Flexera, connects to Oracle Enterprise Manager, and extracts a file of
connection information for the Oracle systems it monitors. This file is in a standard format (TNSNames . ora) used by
Oracle. (In fact, if you already have files of the same name generated by Oracle, you can simply copy these to the
appropriate folder on an inventory beacon. This may be a viable alternative to using this adapter.)

When the file is saved to a special location on an inventory beacon (and the inventory rules for this inventory beacon
allow processing of TNSNames . ora files), the connection information in it can be used by FlexNet Manager for
Datacenters, a separately-licensed product within FlexNet Manager Suite, to collect software inventory information. This
document covers the set up and configuration to use the adapter as part of an Oracle inventory solution.

=

|==| Note: The sole purpose of the OEM adapter is to prepare a TNSNames . ora file as a method of discovery of Oracle
Database servers. There is a completely unrelated process where the normal FlexNet inventory of the database instance
used by Oracle Enterprise Manager (the OEM repository) also reveals the names of the Oracle database instances it
manages, as well as any Oracle options that have been enabled through the related console for Oracle Enterprise
Manager. This latter process requires neither an adapter nor any special configuration; it is a natural by-product of
gathering inventory from the OEM repository, whether by a locally installed FlexNet inventory agent, by direct inventory
collection through an inventory beacon, or by any other means of gathering FlexNet inventory from the OEM repository

database instance.

Terminology

Throughout, the Flexera adapter is referred to as the OEM adapter. The database for Oracle Enterprise Manager (to which
the OEM adapter connects) is referred to as the OEM repository.

The OEM adapter is tested for use with Oracle Enterprise Manager releases 12.1-13.5.
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Understanding the Oracle Enterprise
Manager Adapter

FlexNet Manager Suite 2022 R1 (On-Premises)

As well as providing a functional overview of the straight-forward OEM adapter itself, this chapter provides additional
background about the other aspects of your system that collaborate to provide Oracle introspection and inventory
reporting. As well, this chapter covers the prerequisites, content, and delivery of the OEM adapter.

How the Adapter Assists in Inventory
Gathering

FlexNet Manager Suite 2022 R1 (On-Premises)

The OEM adapter provides an alternative or additional method of discovering Oracle Database servers in your
computing estate. Discovery (by one means or another) is a prerequisite for collecting software inventory from the
Oracle servers.

The OEM adapter is installed on a convenient computer that has network access to Oracle Enterprise Manager and its
OEM repository. Typically, this computer may be a FlexNet Beacon. Multiple instances of the OEM adapter may be
installed (on one or more computers), each of which can connect with one instance of Oracle Enterprise Manager.

Numbers in the diagram (where "OEMA" identifies the OEM adapter) correspond to the process description below:
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L
[_] The process runs as follows:

1. The Windows scheduled task triggers the OEM adapter, which contacts its instance of Oracle Enterprise Manager,
and collects the connection data from the OEM repository.

2. The OEM adapter formats the data into a TNSNames . ora file, and saves it to a special location on the inventory
beacon.

You may configure the name of the saved file, and, if multiple instances of the OEM adapter save files to the same
inventory beacon, you must modify the file names so that the files do not overwrite each other.

=
i ] Note: This completes the function of the OEM adapter. The remainder of the process is standard operating
procedure for FlexNet Manager Suite with the FlexNet Manager for Datacenters product installed. If you

already have an operational system, several of these steps may already be completed.

3. You set up a special account with read-only permissions on your Oracle Database for all the tables and views
needed for Oracle introspection. One helpful practice is to use the same purpose-driven set of credentials on all
servers. A utility is available to help created the account(s) required with the correct permissions.

4. The same credentials must be recorded in the Password Manager on each of the relevant inventory beacons.

5. Inthe web interface for FlexNet Manager Suite, you define a subnet (or several subnets) that contain the Oracle
Database servers of interest; and you assign to these subnet(s) the inventory beacon(s) where the TNSNames . ora
files are being saved. (Assignments are distributed automatically to inventory beacon(s), along with rules.)

6. Continuing n the web interface, you create a rule with an action including Oracle inventory collection, with the
option to use TNS name file selected. The rule also has a target which matches the subnet(s) you are interested in.
This rule is automatically distributed to inventory beacon(s).

7. Ontheinventory beacon(s) of interest:
a. Therule and assignment are received.

b. Theinventory beacon assesses these, concludes that it is authorized to act, and looks for a any *.ora
file(s) in the special path on the inventory beacon.
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¢. Forany Oracle server which is both within the authorized subnet and listed in the . ora file, the inventory
beacon checks for credentials in its Password Manager, and tests them (from the most closely matching to
the most general) until either one gets a response (success), or there are no further applicable credentials
(failure).

d. When successfully logged in, the FlexNet inventory agent running on the inventory beacon, uses the
credentials to read the data necessary for Oracle introspection. It writes the data as an Oracle inventory
file into its staging folder.

e. Within a minute of completion, the regular upload process starts moving this inventory file to the central
application server (or, in a multi-server installation, the inventory server).

8. After the next inventory import and resulting consumption calculations, the Oracle inventory is available in the
web interface for FlexNet Manager Suite; and the Oracle servers originally identified in the TNSNames . ora file are

visible in the All Discovered Devices listing, displaying Yes in the Oracle column.

Prerequisites for the OEM Adapter

FlexNet Manager Suite 2022 R1 (On-Premises)

The OEM adapter must be installed on a computer with network access to Oracle Enterprise Manager, and requires read
access to certain tables and data views there (the required permissions are listed in Grant Permissions to Account).

The OEM adapter requires that, on the computer where it will execute, the Oracle client version 12.1 is installed. Only
the 32-bit version is supported: even for a Windows 64-bit computer, use 32-bit ODAC 12c Release 1 (12.1.0.1.0).

To take advantage of the information gathered by the OEM adapter, there are also the following requirements on the
remainder of the system. Once the OEM adapter saves a TNSNames . ora file, the subsequent gathering of Oracle

inventory requires that:

o The FlexNet inventory agent can access each Oracle system. This can be achieved either by installing the FlexNet
inventory agent on the target Oracle server(s), or by remote execution (Zero-footprint inventory gathering, a term
further explained in the Gathering FlexNet Inventory PDF, available through the title page of online help).

» You have FlexNet Manager for Datacenters, a separately licensed product within FlexNet Manager Suite.

.
= Tip: You can check whether your implementation has this product licensed in the web interface for FlexNet
Manager Suite:

1. Navigate to the system menu (%' ¥ in the top right corner) > FlexNet Manager Suite License.Go to the IT
Assets License page (Administration > IT Asset Management Settings > IT Assets License).

2. Check the list of Subscribed and purchased products on the right, looking for a card for FlexNet Manager for
Datacenters. If the card is present, you have this product licensed.

Components

FlexNet Manager Suite 2022 R1 (On-Premises)
The OEM adapter is supplied as an installer, called OEMAdapter. exe, which installs the following:

o OEM adapter executable and dependencies
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« OEM adapter configuration file

« OEM adapter scheduled task, which can be created during installation if desired.

Download Adapter Tools Archive

FlexNet Manager Suite 2022 R1 (On-Premises)
The Adapter Tools archive includes content for many adapters, and is updated on the Flexera website from time to
time.

Start this procedure using a web browser on a computer that has good network accessibility from all the machines
needing installations for your adapter.

oy
[_] To download the adapter tools archive:

1. Download the Adapter Tools for FlexNet Manager Suite 2022 R1.zip archive. One path is through the
Flexera Community:

;
= Tip: Your Community credentials are required for login.

a. Loginto community.flexera.com.
b. Inthe top right, in the navigation bar, expand More and select Product and License Center.

c. Under the right-hand list of products that includes FlexNet Manager Suite, click LET'S GO! (and
subsequently wait for the redirection to occur).

d. On theright side, scroll down through the list of Your Downloads and click FlexNet Manager Platform.
The Download Packages page for FlexNet Manager Platformappears.
e. Inthe Latest Versions tab, click FlexNet Manager Suite 2022 R1.

A EULA page may appear. If so, click | agree to accept the license, as this grants access to the list of
Downloads.

f. Inthe list of available Downloads, in the Files tab, in the File Name column, click Adapter Tools for
FlexNet Manager Suite 2022 R1.zip.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet Manager
Suite 2022 R1.zip commences.

g. Inyour browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C: \temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it to
the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....

The folders are now available for the range of adapters in the Adapter Tools archive.
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Installing the Adapter, and More

FlexNet Manager Suite 2022 R1 (On-Premises)

This chapter covers the fairly simple process of installing the OEM adapter. However, once installed, the OEM adapter is
only a small part of gathering Oracle database inventory. Therefore the remainder of this chapter assumes a fairly new
implementation of FlexNet Manager Suite, and introduces the other kinds of set up necessary for a working system of
Oracle introspection. Some of the latter may already be in place within your enterprise.

Installing the OEM adapter

FlexNet Manager Suite 2022 R1 (On-Premises)

The OEM adapter is normally installed on an inventory beacon that has high-speed network access to the Oracle server
to which the adapter must connect. It is possible to install multiple instances of the OEM adapter on the same
computer, each configured to access a different OEM repository. Each instance of the OEM adapter can access exactly
one OEM repository.

[i] To install the OEM adapter:
1. From the unzipped Adapter Tools archive, navigate into the Oracle Enterprise Manager Adapter folder.
For details about downloading the archive, see Download Adapter Tools Archive.
2. In Windows Explorer, execute the OEMAdapter. exe installer from that folder.

If this is the first installation of the OEM adapter on this computer, the welcome page appears, and you can click
Next. If another instance of the OEM adapter is already installed on this computer, the following screen appears.
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| Oracle Enterprise Manager Adapter - InstallShield Wizand
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3. If this page appears, choose either of the following:

a. Foran additional installation, click Install a new instance, and click Next. Follow the remaining
instructions below.

b. To change one of the instances previously installed, select the instance from the list on this page, click
Maintain or upgrade an existing instance, and click Next.

The Customer Information page appears.

ﬁ Oracle Enterprise Manager Adapter - InstallShield Wizard H

Customer Information
Please enter your information.

Lser Mame:

Organzation:

[

Provide the informabon below to Create'Run a task under a parBicular
| Domain\account. IF no information is provided the task will run as SYSTEM user,

| Doman\scounts [

Password: [

[ <Back [ next> || conca

4. |dentify the license owner, and the enterprise name, in the User Name and Organization fields respectively.

5. Provide credentials for the Windows scheduled task that triggers operation of the OEM adapter.

l'lf-.'l
W Tip: This account need not be the same as the one to access the OEM repository (identified in a later page).

Leave the fields blank to run the scheduled task as the local SYSTEM account on this computer.

D Note: To change timing or frequency of the scheduled task, use the Microsoft Windows facilities as usual. They
are not configurable through the installer.

6. Click Next>.

The Destination Folder page appears.
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£ Oracle Enterprise Manager Adapter - InstallShisld Wizard

Destination Folder

Instal Orade Enterprise Manager Adapter to:
_,-J C:\Program Files \Flexera{Orade Enterprise Manager Adspter |0

InstalShield

< Back. et >

Cancel

=

Chick Next to instal i this folder, or ﬁckour‘gehm:dmdm-

7. Optionally, click Change... to modify the supplied installation location.

D Note: If you are installing multiple instances of the OEM adapter on this computer, you must modify the path
so that each is installed in a separate folder. The InstallShield wizard offers the default folder © for the first

instance. Increment this value to give a unique folder for each instance.

I} Important: By default the OEM adapter saves the . ora file in the directory where it is executing (that is, the

one you specify here). This is useful as a holding bay where the files may be manually inspected for initial
testing/verification; but no automated processing of the . ora files occurs from this location. For automated

operation after initial testing, you must reconfigure the file path and name as described in Configure Data

Staging.
8. When satisfied with the location, click Next >.

The Database Connection Information page appears.

£ Oracle Enterprize Manager Adapter - InstallShisld Wizard

Database Connection Information
Provide the Datshass nformation to generate THEMames ora file

Pasword |

InstaltSheld

=2

< [Badc [

y

9. If necessary, confer with your Oracle DBA to complete details about the Oracle Database from which this instance

of the OEM adapter collects inventory:

In the Host field, identify the server where Oracle Enterprise Manager is installed.

b. The Port is used by the OEM adapter to access Oracle Enterprise Manager.
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c. Service Name identifies the Oracle service (for this database instance) that was defined when Oracle was
installed.

d. UserlD is the account name (with its related Password) accepted by Oracle Enterprise Manager for login
by the OEM adapter.

Suggestion: FNMS-OEMadapter.

When satisfied, click Next >, and the Email Configuration page appears.
( 5}1 Cracle Enterprize Manager Adapter - InstallShield Wizard 8

Email Configuration

Cenfiguration to recefve Emal when Adapter Fails

To Mail:

Froem Mad:

< Back et > Cancel

10. To receive email alerts when the OEM adapter encounters any errors:
a. Enter your email address as the To Mail value.
b. In From Mail, enter the email address from which the error alerts should come.

c. Inthe SMTP field, enter the fully qualified domain name (or IP address) of the email server.
;
=" Tip: Ensure that the To Mail and From Mail addresses are both recognized by this email server.
d. Click Next>.
The Ready to Install the Program page appears.

11. When satisfied, click Install.

The installer writes the OEM adapter executable (OEMAdapter . exe) into your chosen folder, and records your other
settings in a configuration file (OEMAdapter.exe.config) saved in the same folder. It also creates a scheduled task to
run the OEM adapter. To allow for multiple instances of the OEM adapter on the same computer, the scheduled tasks

are named based on the numbering of the installed instances. The default scheduled task for the initial installation on a
computer looks like this:
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You?ay update the scheduled task(s) as usual through the Microsoft interface.
Before using the OEM adapter in production, you must also do all of the following:

« Confirm that the account used to access Oracle Enterprise Manager (suggested name FNMS-0OEMadapter) has

adequate permissions to read from the OEM repository (see Grant Permissions to Account)
» Modify the location where the . ora file is saved for production use (see Configure Data Staging)

« Ensure that the appropriate subnets containing target Oracle servers are identified and assigned to the inventory
beacon where the TSNNames . ora file is saved (see Assign Beacon to Subnet)

» Configure the collection of Oracle inventory in the web interface for FlexNet Manager Suite (see Configure Collection
of Oracle Inventory)

« Set up accounts on each Oracle server with adequate permissions to gather inventory, with target machines being
based on the contents of the .ora file created by the OEM adapter (see Inventory-Gathering Accounts on Oracle
Servers)

» Register the same account(s) in the Password Manager for each relevant inventory beacon (see Save Inventory
Account in Password Manager).

Grant Permissions to Account
FlexNet Manager Suite 2022 R1 (On-Premises)

The account used to access Oracle (suggested name FNMS-OEMadapter) must have adequate permissions to tables
in the OEM repository. If you are setting up multiple instances of the OEM adapter, repeat the process for each adapter
(you may be using a common account name for all of them to access each distinct OEM repository, or providing each
with a unique account name). This task is normally completed by an Oracle DBA.

[i] To provide appropriate permissions and validate operation:
1. To grant adequate read permission, do either of the following:
a. Make the account (suggested name FNMS-OEMadapter) a member of the EM_ALLVIEWER role.
b. Give the account read permissions on the following:

o DBA_TABLES
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¢ MGMT_TARGETS

¢ MGMT_TARGETS_LOAD_TIMES
¢ MGMT_TARGET_TYPES

¢ MGMT_TARGET_PROPERTIES

2. When permissions have been set up, test as follows:

a. Login using the account name (suggestion: FNMS-0OEMadapter) and password registered during the
installation process.

b. Execute the following query against the OEM repository:

SELECT * from mgmt$Target

Note the number of rows returned.

c. Logout, and login using a DBroot account (or other account known to have full permissions); and
repeat the same query.

The same number of rows should be returned by the root account with full permissions, and by the
account for the OEM adapter with more limited and specific permissions.

3. Repeat the process and testing for any further instances of the OEM adapter accessing other distinct instances of
OEM repository.

Other Setup Activities

FlexNet Manager Suite 2022 R1 (On-Premises)

The OEM adapter is relatively straight-forward, and, as triggered by the Windows scheduled task set up during
installation, regularly collects data from Oracle Enterprise Manager and saves the data as a TNSNames . ora filein a
special location on the inventory beacon.

However, by itself, when the goal is to gather inventory from Oracle Database servers, the TNSNames . ora file is just the
first step. Many other 'cogs in the machine' need to do their part for the . ora file to be beneficial:

« You need a defined set of sites and subnets, most easily obtained by Active Directory import through an inventory
beacon.

o The subnet(s) containing your Oracle servers of interest must be assigned to the inventory beacon that collects the
TNSNames . ora file, and which subsequently collects the Oracle inventory (see Assign Beacon to Subnet).

« Aninventory rule must be defined that associates the target subnet with an action including inventory collection
using the TNSNames . ora file, and schedules its execution (see Configure Collection of Oracle Inventory).

¢ Quite separately from the account that queries the OEM repository to create the TNSNames . ora file, one or more
separate accounts must be defined that connect to the Oracle Database servers and collect the inventory data. There
are two parts to configuring these accounts:

o The accounts must be created and given adequate permissions on each Oracle Database server (there is a utility
available to assist with this, as described in Inventory-Gathering Accounts on Oracle Servers)
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o The same accounts must be registered in the Password Store on the inventory beacon (see Save Inventory

Account in Password Manager).

Strictly speaking, none of these are part of the OEM adapter; but all are integral to the process of Oracle introspection,

and therefore are at least summarized in the following sections.

Inventory-Gathering Accounts on Oracle Servers

FlexNet Manager Suite 2022 R1 (On-Premises)

The inventory beacon collects inventory from Oracle servers using accounts that must be registered at both ends.

=
[_] To set up inventory-gathering accounts on an Oracle server:

The downloaded SQL script gives the account read-only access to the following tables and views:

1. Open the knowledge base article:

2. Scroll to the bottom of the article, and click the link CreateOracleAuditUserQ200934.sql.

This downloads a SQL script that an Oracle DBA can review. (Ignore the text content which is for earlier
products.)

3. In aflat text editor, modify lines 8 and 9 of the script, replacing the default user name and password with
credentials of your choosing; and save the modified script.

To minimize configuration and maintenance effort, the same credentials can be implemented on each Oracle

Database server. Keep a note of these credentials, as you must also record them in the Password Manager on
the inventory beacon.

4. An Oracle DBA can run the script on each target Oracle Database server.

This (re)creates the user name on each run, and grants read access to a numbers of tables and views (shown
below) that are required for Oracle Database introspection.

applsys.
applsys
applsys
applsys
applsys

applsys.

fnd_app_servers

.fnd_nodes
.fnd_product_installations
.fnd_application_tl

.fnd_user

fnd_responsibility

apps.fnd_user_resp_groups

SYS.DBA

USERS

SYS.V_$PARAMETER

SYS.V_$INSTANCE

SYS.V_$DATABASE
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+ SYS.V_$OPTION

+ SYS.DBA_FEATURE_USAGE_STATISTICS
« SYS.DBA_ENCRYPTED_COLUMNS

« SYS.DBA_TABLESPACES

+ ODM.ODM_MINING_MODEL

+ ODM.ODM_RECORD

« DMSYS.DM$OBIECT

« DMSYS.DM$MODEL

+ DMSYS.DM$P_MODEL

« DVSYS.DBA_DV_REALM

« LBACSYS.LBAC$POLT

« OLAPSYS.DBA$OLAP_CUBES

+ SYS.DBA_AWS

« SYS.DBA_SEGMENTS

« SYS.DBA_CUBES

+ SYS.GV_$INSTANCE

+ SYS.GV_$PARAMETER

« MDSYS.ALL_SDO_GEOM_METADATA

« SYS.V_$SESSION

+ SYSMAN.MGMT_LICENSE_DEFINITIONS
« SYSMAN.MGMT_ADMIN_LICENSES

« SYSMAN.MGMT_LICENSES

« SYS.DUAL

+ SYSMAN.MGMT_LICENSE_CONFIRMATION
« SYSMAN.MGMT_TARGETS

« SYSMAN.MGMT_$TARGET

+ SYSMAN.MGMT_VERSIONS

+ SYSMAN.MGMT_INV_COMPONENT

e SYSMAN.MGMT_FU_REGISTRATIONS
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¢ SYSMAN.MGMT_FU_LICENSE_MAP
« SYS.DBA_REGISTRY

+ SYS.V_$LICENSE

« SYS.DBA_TABLES

« CONTENT.ODM_DOCUMENT

+ SYS.V_$VERSION

+ SYS.USER_ROLE_PRIVS

+ SYS.USER_SYS_PRIVS

« SYS.ROLE_SYS_PRIVS

+ MDSYS.SDO_GEOM_METADATA_TABLE
+ SYS.DBA_INDEXES

« SYS.DBA_LOBS

« SYS.DBA_OBJECTS

+ SYS.DBA_RECYCLEBIN

+ SYS.DBA_MINING_MODELS

¢ SYS.REGISTRY$HISTORY

« SYS.DBA_TAB_PARTITIONS

+ SYS.DBA_TAB_SUBPARTITIONS
« SYS.DBA_LOB_PARTITIONS

« SYS.DBA_LOB_SUBPARTITIONS
« SYS.V_$ARCHIVE_DEST_STATUS
+ SYS.DBA_SQL_PROFILES

« SYS.DBA_ADVISOR_TASKS

« SYS.DBA_SQLSET

« SYS.DBA_SQLSET_REFERENCES
+ SYS.DBA_FLASHBACK_ARCHIVE
¢ SYS.DBA_FLASHBACK_ARCHIVE_TS

e SYS.DBA_FLASHBACK_ARCHIVE_TABLES
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+ SYS.V_$BLOCK_CHANGE_TRACKING

e SYS.V_$CONTAINERS

Save Inventory Account in Password Manager
FlexNet Manager Suite 2022 R1 (On-Premises)
The accounts that collect Oracle inventory must exist in the Password Manager.

This process must be completed on the inventory beacon.

[i] To register an account in the Password Manager on an inventory beacon:
1. Loginto the inventory beacon, using an account that has administrator privileges.
2. Start the FlexNet Beacon software from the Windows Start menu.
3. Inthe navigation bar on the left, select the Password management page, and click Launch Password Manager.
The separate interface for the Password Manager opens.
4. In the Current credentials group, click New.

The controls in the Editor group are activated. When you are updating an existing entry, the controls are
populated with the currently saved values.

5. Provide a Logical name to identify this set of credentials.

Logical naming allows you to have one account name, but with different passwords on different servers. For
more, see the online help.

6. For Account type, choose Account on Oracle database.
7. Complete the User (account name) and Password.
8. Click View/Edit....

The Password Store: Password Filter dialog displays.

9. Use the Oracle service names filter to create a comma-separated list of the Oracle services for which this
account/password pair should be used.

The services names are visible in your . ora file. Filtering the account/password pair to apply only to specified
Oracle services provides maximum efficiency for login and introspection.

10. Click Apply to close the dialog, and continue to save the entry in the Password Manager.

Repeat the process as required until all your Oracle machines are covered by one or more entries in the
Password Manager. Thereafter you may exit the FlexNet Beacon interface.

Assign Beacon to Subnet
FlexNet Manager Suite 2022 R1 (On-Premises)

Before rules can take effect, inventory beacons must know their subnets.

322 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)



Installing the Adapter, and More

Itis a requirement for an operational system that your subnets are assigned to appropriate inventory beacons. This
summary covers only making adjustment for the collection of Oracle inventory.

=
[_] To assign subsets to an inventory beacon:

1. Inthe web interface for FlexNet Manager Suite, navigate to Discovery & Inventory > Subnets (in the Network
group).

This page is populated with the sites and subnets in your enterprise after you have completed an import from
Active Directory (for details, consult FlexNet Manager Suite Help > Inventory Beacons > Active Directory Page >
Importing from Active Directory).

2. Expand the appropriate site(s), using the + expander icon, until you can see the subnet that includes your Oracle
Database servers.

(d

= Tip: If the subnet does not yet appear in the listing, you can add its details manually. In the row for the
appropriate site, click the + sign on the right-hand end, and enter the subnet IP address in the new row that
appears.

3. If the Beacon name column shows Unspecified, click the editing (pencil) icon at the right-hand end of this

row.
The row becomes editable. Beware of accidentally over-writing the IP address, which initially has focus.

4. Inthe Beacon name column, use the drop-down list to choose the appropriate inventory beacon from the list of
those registered so far; and click the blue disk icon on the right to save your change.

Your chosen inventory beacon is now authorized to work in the subnet that contains your Oracle Database servers.
Now continue and create a rule that dictates what should happen within that subnet.

o [ ]
Configure Collection of Oracle Inventory
FlexNet Manager Suite 2022 R1 (On-Premises)
Rules must be established that allow Oracle inventory collection, including the use of . ora files.

Inventory rules are created on the Discovery and Inventory Rules page of the web interface for FlexNet Manager Suite.
Each rule has three parts:

o Atarget that identifies the machines on which the rule is to be exercised
o Actions that are the be performed on those target machines
o The schedule on which the rule is to be applied.

When an action includes permission to use a . ora file, the relevant inventory beacon uses the locally-available . ora
file to 'filter' the related target and identify the Oracle Database servers from which inventory should be collected. For
example, if you target an IP range that covers your server room, and include the action setting to apply the . ora file to
this range, then Oracle inventory is collected only from the matching machines listed in the . ora file.

Once a discovery and inventory collection has been completed, the individual Oracle Database servers are identified
in the list of discovered devices. Should you wish to change to tighter targeting rules, you can use this information to
redefine the target until (if you wish) it identifies exactly the Oracle Database servers and no others. Keep in mind that
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if you use this approach, you will need to adjust the target each time you vary the list of your Oracle Database servers.
To reduce this manual maintenance, keep a target that specifies an appropriate IP range (or ranges), and applies the
.ora file to this to identify the individual Oracle Database servers from which to collect inventory.

3
[_] To configure Oracle inventory collection:

1. In FlexNet Manager Suite, navigate to Discovery & Inventory > Discovery and Inventory Rules (in the
Discovery group).

2. Ifyou do not already have a target to reach the Oracle servers from which you want to gather inventory:
a. Onthe left side, select the Targets tab.
Fastpath: In the hints area across the top of the page, click Create targets. These hints can guide you
through the process.
b. On therightside, click Create a target.
c. The page appearance changes, allowing you to define a target.
d. Complete the details requested, with particular attention on Define machines to target.

Notice that:

 After you complete each definition for this control, a + icon is displayed that allows you to add more
to your definition of target machines. Use these lines to define a target sufficiently broad to capture
your Oracle Database servers.

« If you do not want the FlexNet inventory agent to be installed on these Oracle servers, be sure to
select Do not allow these targets to be adopted.

» You should likely also select Do not allow application usage tracking on these targets, since you
may not want to collect a large quantity of file evidence from these servers.

e. Click Save.
3. Ifyou already have an action for Oracle discovery, you can check its settings; or create a new one:
a. Click the Actions tab (or in the hints section, click Create actions).

b. If you wish to collect hardware inventory for these servers (perhaps to assist with licensing calculations
for your Oracle Database license), expand the General accordion and select Gather hardware and
software inventory.

(d

= Tip: You may want to clear the check box for Discover devices, if you are limiting this action
specifically to inventory collection for known Oracle Database servers identified in your . ora file.

c. Expand the Oracle database accordion.

d. If you are confident that every Oracle Database is identified in your . ora file, you may clear the check
box for Discover Oracle databases. Alternatively, if you may have rogue servers, leave this check box
selected, and the network within your declared target will be probed for other Oracle servers.

e. Select the check box for Also gather Oracle database inventory.
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Additional controls, if not already visible, are exposed.

f. Ensure that the Port scan check box is selected, and if necessary use the +icon to add additional ports to
the list until every port listed in your . ora file is included.

g. Ensure that the SNMP scan check box is selected.
h. Itiscritically important that you select the TNS names file check box.

This setting authorizes the relevant inventory beacons to apply any . ora files found in the 'magic path’
to the target used for this action (in the rule soon to be completed). This is the mechanism that most
efficiently restricts probing to the relevant servers.

i. Adjust other settings in other parts of the accordion to suit your environment, and click Save.
The action is stored, ready for inclusion in a rule.
4. Select the Rules tab (or in the hints area, click the third Create rules step).
a. Do either of the following:
« If you have an existing rule to review or modify, click the edit (pencil) icon on its right-hand end.
o Click Create arule (upper right) to define a new rule (as described in the following steps).
Arule builder work area appears above the list of existing rules.

b. Return to the Actions tab (for example, using the link in the rule builder), and on the row for your edited
Oracle action, click Add to rule builder.

The name of your action appears in the rule builder.

c. Return to the Targets tab (for example, using the link in the rule builder), and on the row for your edited
target, click Add to rule builder.

5. On theright side of the rule builder, click Schedule.
The rule builder changes to display controls for scheduling:
a. Choose avalue from the Frequency drop-down list.

This control sets the style of scheduling. For example, the Daily option lets you make further choices
about a pattern of days, and does not enforce inventory collection every day.

Option Notes

Once A single-shot trigger for inventory collection the next time the declared time
window occurs (you cannot nominate a future date). For example, if it is
4pm when you set a Once schedule for 8am, commencing within 4 hours,
inventory collection normally occurs next morning. Compare with As soon
as possible. Keep in mind the propagation delays for your changed
instructions, as described there.
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Option Notes

Daily An additional drop-down list, Every, appears so that you can choose the
pattern of days you want, extending the time intervals between inventory
collection in multiples of 24 hours. For example, you may wish to trigger
inventory collection every second day. The starting time is within the
Commence within time window following the next occurrence of your
Start time setting after the changed schedule is distributed (and received
by each installed FlexNet inventory agent). For example:

o Starttimeissetto8:00 am.
« Commence withinissetto 2 hours.

o The schedule is saved at noon today, and by default the inventory
beacon policy is distributed every 15 minutes.

» By default, each FlexNet inventory agent chooses a random time within a
one-hour window from 5am local time to request any policy (and
schedule) changes. Most devices therefore start using the changed
schedule tomorrow morning.

In short, the setting applies individually to each installed FlexNet inventory
agent, and does not synchronize the activities of all agents across your
enterprise to identical days.

Weekly New check boxes appear that allow you to choose specific days within the
weekly cycle when inventory should be collected. For example, you may
want collection on Sunday and Wednesday every week. Select (check) the
boxes for the days you prefer.

Monthly New controls appear that allow you to specify a pattern within the month:

» Choose the option for On day to nominate a particular day within the
month (such as the third Saturday). Make your choices from the two
drop-down lists adjacent. Notice that the option Last chooses the fifth
occurrence in months long enough to have one, and otherwise takes the
fourth occurrence.

» Choose the option for On date to nominate the calendar date within the
month.
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Option Notes

As soon as This is a single shot trigger which causes each FlexNet inventory agent to

possible randomize an inventory collection within the time window starting when it
receives this setting and lasting for the interval you specify in the
Commence within controls.

{-"I Tip: Any change you save to these settings is first collected by the
inventory beacons on the schedule specified by the Beacon settings
(further down this web page), by default checked every 15 minutes. Each
inventory beacon then prepares new instructions for any installed
FlexNet inventory agents that request an update to device policy (the
operational FlexNet inventory agent checks for updated policy once per
day, randomized across a one-hour window in the early morning; but
newly installed agents seeking their first policy make a request once
every 12 hours on UNIX-like platforms, or once every system restart on
Windows). Because of these propagation periods, As soon as

possible typically means starting early tomorrow morning.

6. Inthe rule builder, click Save as, give the rule a name you will recognize later in lists, and click Save.

If you accepted the default Enabled setting, the rule is ready to run on the schedule you have established.
(Remember to allow around 15 minutes for the new rule to be distributed to your inventory beacons.) When the rule is
executed on an inventory beacon, if a . ora file exists in the 'magic path’, the systems that lie both within the inventory
beacon's assigned subnet(s) and within the . ora file are targeted for Oracle inventory collection.
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Modifying the Adapter

FlexNet Manager Suite 2022 R1 (On-Premises)

This chapter covers changes you can make to the operations of the OEM adapter by modifying its configuration file. Read
the first topic for general guidance on the editing process, and choose the detailed subtopics based on what changes
you need.

Reconfiguring the OEM Adapter

FlexNet Manager Suite 2022 R1 (On-Premises)

During installation, you recorded your preferred settings for the OEM adapter, and no further work is required in the
installation process. You can however choose to modify the configuration of an instance of the OEM adapter at a later
stage.

=
[_] To reconfigure the OEM adapter:
1. In Windows Explorer, navigate to the correct folder for the appropriate instance of the OEM adapter.

Keep in mind that there may be several instances installed on a computer, accessing distinct instances of Oracle
Enterprise Manager.

2. Inyour preferred plain text (or XML) editor, open the OEM adapter’s configuration file, called
OEMAdapter.exe.config.

It is strongly recommended that you make a backup copy of the original configuration file, so that you can easily
revert your changes if there are problems.

3. Use the following subtopics to guide your changes to the configuration file.
4. When you have finished, save the updated file.

5. Either wait until the next scheduled run of the OEM adapter, or use the Windows scheduled task interface to
trigger an immediate test run to confirm that your changes work as expected.
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Updating Connection Details

FlexNet Manager Suite 2022 R1 (On-Premises)

You can change all details and credentials for connection to the Oracle Enterprise Manager instance.

When the OEM adapter is first run, it encrypts the connection details used to access the Oracle Enterprise Manager
implementation. Therefore, the process to edit the connection details is different, based on whether the OEM adapter
has been run since the connection details were last recorded. You can tell whether this is so by looking in the

configuration file.

The details are all stored in the <connectionStrings> element of the configuration file.

. Ifthe OEM adapter has been run since the details were recorded in the configuration file, the encrypted
<connectionStrings> element appears similar to this:

<connectionStrings
configProtectionProvider="DataProtectionConfigurationProvider">
<EncryptedData>
<CipherbData>
<CipherValue>AQAAANCMnd8BFdERjHOAWE/C1l+sBAAAAeNhcGMAVKOUVGNTQqOg/
WbQQAAAACAA

AAAAADZgAAWAAAABAAAACTO9kpn6BptpLVsXExg1UBAAAAAASAAACEAAAAEAAAAELCyiwz5A

XZWIOXZXFEP1iAAAAgAAPIQYe+GOAFScFMITYgAONDbAgZdRA9NBI1DNA2A1XxjeCskUs9+KNFV

U1PSFRV4ujta4@evf3I0Zy50dyHsIrJRCKOOGdhDblwh4ISEkpJk/
QDna6LeCbbtXXsQK2Lo

AHQc/plz77UkQZxnxkL5E1PIGH16A0jEXT2F5NGJELIX6GXbUXQDKNNDfi206XI/
CDbX8gCu

MonY1cTLYGe6+AQPpDgcY3rA02ZF0s7/Zb0cKOw7I0ZdB6H80IvrC1SzgNkVBd3YfLhP/
KOr

kQFP80orqj54BIW74E1v3VUZntelESgLASMYb/
FOAh3M5x12Q6ITX0QmVRGESrivsdqrényGz

S5APx2yVBUEcoVhpOMYURbEbBSW+6/
aydg8nY1DrcMzkP1XiZ0CQs4yZYHSWt3+bFEN30xh6X

KFH7Tpc8e5y9TqlBhwk+Kw6AFfZhcdewApJ4ZkGAr4ixE6gNgWXnomk2puKNFImhIfgLLIuQ
x9T00Uu2bjI9Y+dUlrcuov12hQX0Ch9nqOdmeIQHPXgw8//eHY0zwy2TgMcq2M2LxXRbQqCT
eWtlPlucIVyct9gnJI1lk2L3FSBNgMulCOmncR7MsGDBWoQMXnwC5+Y6P1GT455sP0edBQvIQIT

Jj7MCuzfgDD1R9c7wlgejTGmr13Kmf33tGPMRYPV7CPNET3DUVOAGQUAAAAAIEKjyqfEXxrbei
YJvG2usqYO3Nk=</CipherValue>
</CipherData>
</EncryptedData>
</connectionStrings>

In this case, delete the entire element and replace it with a plain text version as shown below.
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2. Ifthe OEM adapter has not been run since the configuration file was changed, it has a plain text form similar to
this (line wrapping has been added here for legibility). Replace the italicized placeholders with your own values,
as described below. Keep the connectionString attribute all on one line.

<connectionStrings>
<add name="OEMConn"
connectionString="Data Source=(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)
(HOST=HostIPAddress)
(PORT=PortNumber))
(CONNECT_DATA=(SERVICE_NAME=ServiceName)));
User Id=AccountName;Password=UnencryptedPassword;"></add>
</connectionStrings>

where the following details should be confirmed with your Oracle administrator:

o HostIPAddress isthe IP address of the Oracle server hosting Oracle Enterprise Manager
o PortNumber is the port that the OEM adapter should use to query Oracle Enterprise Manager
« ServiceName is the service name established when Oracle was installed on the Oracle server

o AccountName is the account (user name) that the Oracle administrator has established for accessing Oracle

Enterprise Manager

e UnencryptedPassword is a plain text rendition of the password for the same account (remembering that

all the connection details are encrypted together as soon as the OEM adapter runs next).
3. Save the amended configuration file.
The Password Store: Password Filter dialog displays.

4. Use the Windows schedule task interface to run a test of the OEM adapter to confirm that the connections details
were correctly entered.

L [
Configure Data Staging
FlexNet Manager Suite 2022 R1 (On-Premises)
Modify the name and location of the file of Oracle connection information.

The OEM adapter collects information about connections to Oracle systems from which you need to gather inventory
information. This file is in a standard Oracle format, used for their TNSNames . ora file. It is saved by default where the
OEM adapter is executing; but the default location for the OEM adapter does not support automated processing of the
TNSNames . ora file when the inventory beacon applies rules for gathering Oracle inventory. For the OEM adapter to
function seamlessly, you must customize the location as you edit the OEMAdapter.exe.config file.

Another reason to customize the file name is if you have multiple instances of the OEM adapter running from the same
computer (or if anyone manually adds TNSNames . ora files to the processing directory). Each instance must write to a
unique file name, so that one output does not over-write the other.

These settings live in an add element with the key attribute of ConnectionInfoFile.
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oy
[_] To configure data staging:

1. Inthe OEMAdapter.exe.config file, locate the appropriate element. Its default values are similar to the

following:

<add key="ConnectionInfoFile"
value="C:\Program Files\Flexera\Oracle Enterprise Manager Adapter\
TNSNames.ora"></add>

This reflects the default location of the OEM adapter, and must be modified.

2. Replace the value string with the new file path and name.

|_a] Important: The file name must use the extension . ora.

You may use a mapped drive on the local computer to specify a network path. This example shows the file in
the recommended 'magic path' on the inventory beacon where the . ora file is automatically processed to
filter' the target supplied from the central application server. Also notice the customized file name to avoid
naive overwriting of the TNSNames . ora file name by other copies saved here:

<add key="ConnectionInfoFile"
value="C:\ProgramData\Flexera Software\Repository\TNSNames\
TNSNames-01.ora"></add>
3. Save the amended configuration file.

The Password Store: Password Filter dialog displays.

4. Use the Windows schedule task interface to run a test of the OEM adapter to confirm that the staging file is saved
according to your revised specifications. Check the location (recommended: C: \ProgramData\Flexera
Software\Repository\TNSNames\) for the presence of a saved file immediately after the test run (if you wait
too long, the resulting file may be automatically uploaded and removed from this staging location).

Managing Email Alerts
FlexNet Manager Suite 2022 R1 (On-Premises)

You can turn the alerts off, changes their addresses, or switch email servers.

The OEM adapter can send email alerts any time that it encounters an error. Manage the emails with the following XML
elements in the OEMAdapter.exe.config file.

1. To stop email alerts entirely comment out the reference to the SmtpAppender like this:

<appender-ref ref="RollingFileAppender"></appender-ref>
<!-- <appender-ref ref="SmtpAppender"></appender-ref> -->

(The character sequence <! - - starts an XML comment, and the sequence - - > closes the comment.)

L
= Tip: Using this technique is preferable to deleting this line entirely, as this can be easily reversed if you decide

to reinstate email alerts in future. Notice that, depending on the configuration you saved, there may be other
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elements between the <appender-ref> tags.

2. To reconfigure the email alerts, locate the <appender> element, and modify three of its child elements by

changing the example values shown in italics here:

<appender name="SmtpAppender" type="logdnet.Appender.SmtpAppender">
<to value="toaddress@somedomain.com"></to>
<from value="fromaddress@somedomain.com"></from>
<subject value="OEM Adapter Error"></subject>
<smtpHost value="smtp.somedomain.com"></smtpHost>
</appender>

3. Save the amended configuration file.

The Password Store: Password Filter dialog displays.

Configure Logging
FlexNet Manager Suite 2022 R1 (On-Premises)

Change the path and file name for logging by the OEM adapter.

The log file name and location cannot be set during installation of the OEM adapter, but after installation, they can be
modified as follows:

o
[_] To configure logging:
1. Inthe OEMAdapter.exe.config file, locate the <appender> element called RollingFileAppender.

2. Editthe child <file> element by replacing the drive, path and file name shown as placeholders here:

<appender name="RollingFileAppender"
type="1logdnet.Appender.RollingFileAppender">
<file value="drive:\path\path\logfilename.txt"></file>
</appender?
3. Save the amended configuration file.

The Password Store: Password Filter dialog displays.

After the next run of the OEM adapter, inspect the log in your new location.
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Flexera SaaS Manager Connector

FlexNet Manager Suite 2022 R1 (On-Premises)

This part introduces the integration between FlexNet Manager Suite and Flexera SaaS Manager, a cloud-based product
designed to help you manage your licensing costs for SaaS-based software.

The method of integration is a straight-forward connector that you can configure on a single inventory beacon within your

enterprise.

This connector supersedes older connectors separately available for Salesforce and Microsoft Office 365. This part
includes detailed guidelines for retiring the old, and doing some data clean-up to normalize your records.
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The Flexera SaaS Manager Connector

FlexNet Manager Suite 2022 R1 (On-Premises)

Assuming that you have licensed both products, FlexNet Manager Suite allows you to make a connection to Flexera Saa$S
Manager - even though your FlexNet Manager Suite implementation is on-premises and Flexera SaaS Manager is a
cloud-only product - so that you can import data, and unify all your licensing information in the one place (sometimes
called having "a single pane of glass" to see all your licensing data).

The data flow with this connector is strictly one way (from Flexera SaaS Manager into FlexNet Manager Suite), and any
changes you make locally after the import are not reflected back into the source data in Flexera SaaS Manager. So data
maintenance remains separate, and happens in the product where you created the records. For example, if you
renegotiate your Saas license for a product to increase your entitlements, record the new number in Flexera Saa$
Manager, because that is the source of truth for this license. The information for display in FlexNet Manager Suite is
automatically updated in the nightly full inventory import and license reconciliation calculations.

To make it easier to switch contexts, the properties for every license imported from Flexera SaaS Manager display a link
to that product from within FlexNet Manager Suite (direct to the matching license record, if you are already logged in).
There is also a general link you can display in the top bar of FlexNet Manager Suite to make switching back easy, even
without opening any license properties.

For more information about setting up the Flexera SaaS Manager connector, and enabling the display of the top bar link,
see the summary in Configuring SaaS Manager Connector.

Even though the data flow is strictly one way, there are some changes you may choose to make within your FlexNet
Manager Suite record that are preserved during any update through the nightly imports:

« If you wish, you can customize the license name. For example, you might choose to add "from FSM" at the end of the
imported license name, to make it easier to identify or group these licenses in general listings. Since the license name
is not used for record matching, your customization is preserved through each nightly import.

* You may still link purchases or contracts to your imported licenses. However, it is important to understand that these
are now for information only, and have no impact on the available license entitlements or the nightly license
reconciliation. Your entitlements are part of the one-directional import, and consumption is counted exclusively
against the entitlements recorded in Flexera SaaS Manager (and imported from there).

e You may still choose to record details like ownership responsibility or group assignments against the imported
licenses, and these additions are preserved.

If you have previously been using other SaaS-related connectors, once you have switched over you should consider
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retiring those connectors, since their data overlaps with the imports from Flexera SaaS Manager. To avoid possible
confusion between licenses created by various connectors, you might also consider some data clean-up to normalize
your environment. For more information, see Deprecating Other Connectors.

This chapter concludes with some technical details about the data imported from Flexera SaaS Manager, where it is
staged in the FlexNet Manager Suite database, and where you can look in the web interface to review the imported data
(see Imported Data Mapping).
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Configuring SaaS Manager Connector

FlexNet Manager Suite 2022 R1 (On-Premises)

Prerequisites

For your on-premises implementation of FlexNet Manager Suite, integration with Flexera SaaS Manager works through a
suitable inventory beacon. The general requirements are:

* You have licensed Flexera SaaS Manager (in the cloud).

» You have chosen a single inventory beacon that will connect to Flexera SaaS Manager. Only a single connection is
permitted.

« The chosen inventory beacon is a top-level device with direct access to the Internet (optionally, through a proxy
server). It must not be a child inventory beacon that uploads to a parent inventory beacon.

« On this inventory beacon, FlexNet Beacon release 14.3.0 (shipped with 2019 R2.3) or later is installed.

« Thisinventory beacon has PowerShell 5.1 or later running on Windows Server 2016 or later, or on Windows 10 or
later; with the PowerShell execution policy set to RemoteSigned.

o The Windows Environment Variable PSModulePath includes the following path:

%ProgramFiles%\WindowsPowerShell\Modules

Set up

Creating the connection is straight-forward, declaring a PowerShell connector of type Flexera SaaS Manager. Full step-
by-step instructions are included in the online help (FlexNet Manager Suite Help > Inventory Beacons > Inventory
Systems Page > Connecting to External Inventory Systems > Managing PowerShell Connections > Managing
Flexera SaaS Manager Connections).

Scheduling

As part of setting up your connector on the inventory beacon, you selected a suitable schedule for FlexNet Beacon to
connect to Flexera SaaS Manager in the cloud, download any new/changed inventory, and subsequently upload this to
your inventory database. You chose the schedule so this process could be completed shortly before your nightly full
inventory import and license consumption calculation. This timing means that changes made in Flexera SaaS Manager
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yesterday are visible in the web interface of FlexNet Manager Suite today.

Validation
The day after configuring your connector, validate operations by:

 Identifying a licensed application listed in Flexera SaaS Manager.

» Finding the same application listed in FlexNet Manager Suite, and validate that the appropriate data is recorded. For
example, there is a SaaS User license attached (except for Microsoft Office 365, which should have a Named User
license attached).

For more information about validation, data rationalization, and connector clean-up, see Deprecating Other Connectors.
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Deprecating Other Connectors

FlexNet Manager Suite 2022 R1 (On-Premises)

When you configure your connection to Flexera SaaS Manager, you may need to delete one or more other connectors
that have overlapping functionality:

Connector name Set up instructions (to help identify the connector)
Microsoft Office 365 FlexNet Manager Suite Help > Inventory Beacons > Inventory Systems Page >
(deprecated) Connecting to External Inventory Systems > Managing PowerShell Connections >

Creating Connections to Microsoft Office 365 > Creating Connections using the
Microsoft Office 365 (Deprecated) Connector

Microsoft 365 FlexNet Manager Suite Help > Inventory Beacons > Inventory Systems Page >
Connecting to External Inventory Systems > Managing PowerShell Connections >
Creating Connections to Microsoft Office 365 > Using FlexNet Manager Suite’s Multi-
Tenant App to Connect to Microsoft 365

Salesforce FlexNet Manager Suite Help > Inventory Beacons > Inventory Systems Page >
Connecting to External Inventory Systems > Managing PowerShell Connections >
Managing Connections to Salesforce.com

If you have any of the above connectors in use, the licenses created from those imports are automatically marked as
Retired after overlapping licenses are imported from Flexera SaaS Manager, and the first full inventory import and
license reconciliation calculations are completed (typically overnight). The retired licenses no longer contribute to the
license consumption calculations, and are replaced in that role by the replacement licenses imported from Flexera SaaS
Manager. Therefore, using the 'old' connectors to import updates to the Retired licenses is now redundant, and you
might consider removing the old connectors and cleaning up their associated retired licenses.

In some cases, there may also be 'surplus' application records. This is particularly true if you have been using the
Salesforce connector, which returns Salesforce 'components’, each of which has been created as a separate

application record in FlexNet Manager Suite. In contrast, Flexera SaaS Manager returns just the one "Salesforce"
application, so that you may also wish to rationalize your application records, as described below.

& Caution: Do not delete one of the above connections too early - specifically, do not delete an existing connection until
data flow is established from your new Flexera SaaS Manager connection. If you leave your system without any
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connection for certain inventory items, and the nightly inventory import and license consumption calculations happen
when the relevant connection is still missing, all inventory imported from the missing connection is removed from
FlexNet Manager Suite. This is because it is assumed that there has been a clean-up in your computing estate, and
records are deleted to match the incoming data.

Use the following process to avoid both data loss (from deleting a connection too early) and data redundancy (from
leaving overlapping connectors and updating retired licenses).

=
[_] To manage switching between connectors:

1.

Identify one or more licenses created from imports through the connector(s) listed above.

These are licenses for the SaaS products you are tracking, and are perhaps best searched for by name in the All
Licenses page.

. Set up your connector to Flexera SaaS Manager.

For details, see the online help under Inventory Beacons > Inventory Systems Page > Connecting to External
Inventory Systems > Managing PowerShell Connections > Managing Flexera SaaS Manager Connections. To
work from just a summary, see Configuring SaaS Manager Connector in this section.

. Wait until tomorrow.

Once the connection is configured and scheduled, collected information is imported into the compliance
database of FlexNet Manager Suite during the next full inventory import and license consumption calculations. By
default, these are scheduled nightly.

. Validate that data has been imported from Flexera SaaS Manager.

a. It's convenient to filter the list of All Licenses by setting the License type column equal to SaaS User (or
Named user if instead you are investigating data for Office 365).

b. Look for pairs of licenses that may be similarly named.

L
= Tip: Licenses imported from Flexera SaaS Manager initially reflect exactly the license names you

created in Flexera SaaS Manager. Licenses imported with older connectors may have different naming
conventions. Two techniques may be helpful:

« Sorting by the Name column

« Adding the Status column from the column chooser (note that this is a separate column different than
the Compliance status column), where the licenses imported from old connectors now display
Retired.

c. Right-click each of the license names, and choose your browser's options to have the two sets of license
properties open for comparison, such as in two browser windows. In both cases, select the Identification
tab of the license properties.

Here are the key differences between the two licenses:
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Old license from deprecated connector New license from Flexera SaaS Manager

Status field displays Retired. Status field displays Active, and certainly not

This value is set while processing the import from retired.
your new Flexera SaaS Manager connector, and it
validates that the process has run.

Nothing extra in the title area of the license The title area of the license properties includes a
properties. hyperlink (just above the tabbed area) to navigate
to Flexera SaaS Manager and review the same
license there.
The presence of this link validates that this license
was created by the import from Flexera SaaS
Manager.

These two checks validate that the overnight processing of the import from has completed as expected.

5. You may choose to edit the name of your new license, for example by adding "from FSM" to the license name, to
eliminate ambiguity and reduce possible confusion.

The license name is not used for matching in future imports, and you may adjust the name as you require.
Check for any additional data management that you may want to do, as follows.

6. Inthe properties for the old, retired license, check for attachments or other data that you may wish to transfer to
the new license.

For example:

¢ Has anyone manually added Notes on the Identification tab? You may want to copy any important content to
the new license.

o Are any purchases shown on the Purchases tab? You may want to Remove these from the old license, and link
them instead to the new license.

Ej‘ Remember: Purchases linked to a license created from the Flexera SaaS Manager connector are purely
informational, and do not affect the available entitlements or the nightly license compliance calculations.
Your actual entitlements are recorded in and imported from Flexera SaaS Manager, and displayed in the
Compliance tab, either as a distinct quantity in the Extra entitlements field, or as an Entitlements are:
Unlimited setting.

« Similarly for the Contracts tab, you may want to swap any linked contracts to the new license. (As with
purchases, linked contracts are informational only on your new license.)

o Check other tabs for information to copy across (any regular charges on the Financial tab, any managerial or

other assignments on the Ownership tab, or less commonly for SaaS licenses, any Group assignment or
Restrictions).

7. In both sets of license properties, switch to the Applications tab, and review the applications linked to each
license. Decide on your corporate approach to the old application records - do you wish to remove old records that
are effectively replaced by new application records created through the Flexera SaaS Manager connector?

If you plan to remove the retired licenses from deprecated connector(s), you might also delete the application
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records that are attached only to those licences (check the Licenses tab in the application properties to make sure
that the application is linked to just the one license). Such records will be redundant clutter when their related
licenses are removed.

8. Depending on your corporate data retention policies, you may wish to do either of the following:

 Clean up: Close the browser tab displaying the properties of the old, retired license; and then delete the license
in the All Licenses page. (Using this option to delete the old licenses, it is especially important to follow
through with the later step below to remove the old connector - because if this old connector runs again, it will
recreate records for any licenses it finds.)

 Archive: Edit the name of the old, retired license to make it easier to identify in lists, reducing future confusion
of old with new (for example, insert "Retired - " at the start of the license name).

9. Repeat your chosen process for any/all other licenses that have been Retired following the import from Flexera
SaaS Manager.

L
= Tip: You can conveniently identify these in the All Licenses page by adding the Status column from the column

chooser (note that this is a separate column different than the Compliance status column), and then filtering
that column to show only the Retired value. Once you find a retired license, clear the filter and look for its
active replacement, as described in the earlier steps of this process.

10. On the inventory beacon where the old connector(s) were configured, log in as administrator, run FlexNet Beacon,
navigate to the Inventory systems page, and delete only the old connector(s).

You have now cleaned up licenses created through the old connectors, validated that your replacement licenses have
been created by the Flexera SaaS Manager import, updated these with any required additional data, cleaned up
application records as required, and removed the old connectors to remove overlapping data imports.
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Imported Data Mapping

FlexNet Manager Suite 2022 R1 (On-Premises)

Data imported through the Flexera SaaS Manager connector is matched to records previously imported through the
same connector into FlexNet Manager Suite (where available), or new records are automatically created.

|_b Important: Imports through the Flexera SaaS Manager connector do not update records created from other
connectors such as the Salesforce connector, the Microsoft 365 connector, orthe Microsoft Office 365
(deprecated) connector. For information about switching connectors and data clean-up, see Deprecating Other

Connectors.

The data flow through this connector is one way - some imported data points (such as the available entitlements) are
not editable within FlexNet Manager Suite, and must be edited within Flexera SaaS Manager and reimported in the next
nightly full inventory import. A link is provided on the property sheet of relevant licenses to help you switch contexts,
and you can also activate a button in the navigation bar for switching to Flexera SaaS Manager (see the Integrations tab
of the System Settings page). Similarly, deleting a matched data record (such as a license) within FlexNet Manager Suite
does not automatically delete the matching data in Flexera SaaS Manager, where the record must also be deleted
manually (otherwise the next inventory import simply recreates the matching record to align with the source data).

¥
= Tip: As well, deleting a license within Flexera SaaS Manager does not automatically delete the matching license in

FlexNet Manager Suite, even after the next import and license compliance calculation. Similarly, deleting an imported
application record does not delete the equivalent managed application within Flexera SaaS Manager. To delete a
license or managed application originating in Flexera SaaS Manager and mirrored within FlexNet Manager Suite, you
must access each of the records separately in the two products, and manually delete each one.

Almost all Saa$S products are handled identically in FlexNet Manager Suite, and represented with Saa$S User licenses. The
one exception is Microsoft Office 365: because a license entitlement here may authorize use either as a Saa$S application
or as a locally-installed application on a device, these are handled separately and represented as Named User licenses.
As a result, the data flows/storage is quite distinct for this case.

L
= Tip: Flexera SaaS Manager allows you to create one Office 365 license that is linked to multiple plans, such as Office

365 (E1) and Office 365 (E4). Because each plan brings with it changed license entitlements, within FlexNet Manager
Suite each plan for Office 365 is automatically given a separate license. This may mean that you see two (or more)
licenses in FlexNet Manager Suite that link back to the one source license in Flexera SaaS Manager.

The following tables show properties found in the user interface of Flexera SaaS Manager, and track their initial staging

342 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)



Imported Data Mapping

within the compliance database of FlexNet Manager Suite (with the database table name shown in the header of each
list), and their common property name in the web interface. Fields in the target table are omitted if no related data is

imported.

D Note: The following ImportedUser table is populated only for Microsoft Office 365 users. These records are linked to

existing user properties (CompLianceUser records) when these already exist; or else new user records are created.

Table 1: User data mapping for Office 365 (ImportedUser table)

FSM object/label

First name

Last name

Email

Hard-coded to 1

Unique ID in user properties

FNMS staging fields

FirstName (up to 128 characters)

LastName (up to 128 characters)

Email (up to 200 characters)

MapUsingEmailAddress

ExternallD

Example FNMS Ul / Notes

User properties > General tab > First
name

User properties > General tab > Last
name

User properties > Details tab > Email

Not visible. Attempts to match existing
compliance user record by email
address.

Not visible.

D Note: The following ImportedAccessingUser table is used for all SaaS products and licenses with the exception of

Office 365. (A user of both kinds of licenses appears separately in each of these imports.) Be aware that, for these SaaS
products, there may be accessing users who come from outside your enterprise (for example, if you allow consultants
or customers to access your Salesforce pages).

Table 2: User data mapping for other SaaS applications (ImportedAccessingUser table)

FSM object/label

Email

Email

Derived from the Email value

Internal ID

FNMS staging fields

UserName (up to 200 characters)

SAMAccountName (up to 64
characters)

DomainName (up to 100 characters)

ExternalAccessingUserID
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Example FNMS Ul / Notes

License properties > Consumption
tab > User

External users show their email
address. Users from within your
enterprise (who have been matched
on their email addresses) display
their full name as a hyperlink to their
user properties.

Not visible in user properties.

License properties > Consumption
tab > Domain name

Not visible. Used for record matching.
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Table 3: Access data mapping (ImportedClientAccessEvidence table)

FSM object/label

Internal ID app. id (not visible)

Managed Applications >
APPLICATION

Managed Applications > VENDOR

FNMS staging fields

ExternalAccessEvidenceID

ProductName

Publisher

Example FNMS Ul / Notes

Not visible. Used for record matching.

Application properties > General tab
> Product

Application properties > General tab
> Publisher

Table 4: Access counting (ImportedClientAccessedAccessOccurrence table)

FSM object/label

Internal ID AppUsr. id (not visible)

Hard-coded to 1 for each date

None. Uses the date when data is
imported from Flexera SaaS Manager
to FlexNet Manager Suite.

Does not use the Effective Date from
the License Details tab of the license
properties.

Last Activity listed for this user in the
Users tab of the application
properties.

FNMS staging fields

ImportedClientAccessed
AccessEvidenceID

AccessCount

InventoryDate

LicenseDate

AccessDate

Example FNMS Ul / Notes

Not visible. A separate record is
created for each pairing of a user and
application. For example, if UserA
accessed two SaaS applications, there
are two records.

License properties > Consumption
tab > Last used count

Inventory device properties >
General tab > Last inventory date

Not separately visible. Uses the
inventory date in a different format.

Application properties > Devices tab
> Last used date

Table 5: Evidence to application links (ImportedSoftwareTitleAccessEvidence table)

FSM object/label

Internal ID app. id (not visible)

Internal ID app. id (not visible) (same
value)

FNMS staging fields

ExternalSoftwareTitleID

ExternalClientAccess
EvidencelID

Example FNMS Ul / Notes

Not visible. Foreign key to the
ImportedSoftwareTitle table,
identifies an imported application

Not visible. Foreign key to the
ImportedClientAccessEvidence
table, identifies an imported record of
user access

D Note: The following mapping into the ImportedComputer table creates (if it does not already exist) a dummy device

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)



Imported Data Mapping

record (needed within FlexNet Manager Suite, but not available in Flexera SaaS Manager). Only a single dummy
computer record (for each connector) is required.

Table 6: Computer data mapping (ImportedComputer table)

FSM object/label FNMS staging fields Example FNMS Ul / Notes

None. Uses ExternallD Not visible -
ComplianceConnectionID.

Hard-coded to "Flexera SaaS ComputerName Inventory device properties >
Manager" General tab > Name
Hard-coded to "flexera.com" Domain Inventory device properties >

General tab > Domain name

Hard-coded to "Flexera SaaS SerialNo Inventory device properties >
Manager " with the numeric value of General tab > Serial number

the ComplianceConnectionID

appended

Hard-coded to "Flexera SaaS InventoryAgent Inventory device properties >
Manager" General tab > Last inventory source
Hard-coded "False" UntrustedSerialNo Not visible

Hard-coded "False" IsRemoteACLDevice Not visible

Hard-coded "False" IsDuplicate Not visible

Hard-coded "False" IgnoredDueTolLicense Not visible

Note: The following mapping into the ImportedSoftwarelicense table updates or creates either of two kinds of
license, matching those in Flexera SaaS Manager:

e Named User licenses for Microsoft Office 365

» Saa$ User licenses for any other imported Saa$ applications.

Table 7: License data mapping (ImportedSoftwareLicense table)

FSM object/label FNMS staging fields Example FNMS Ul / Notes
Not visible termId ExternallLicenselID Not visible
License properties > License Name LicenseName License properties > Identification

combined with the Name field tab> Name
(adjacent to the License Type

control). For example: G Suite - Monthly/User

Example value imported is:

o License name =G Suite

« Name = Monthly/User
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FSM object/label FNMS staging fields

Managed Applications >Vendor for PublisherName
most applications (when creating

SaaS User licenses); or for Named

User licenses, value take from SKU is

Microsoft Corporation.

# of Items Allowed as a number EntitlementCount

# of Items Allowed shows
Unlimited

UnlimitedConsumption

Set to 13 (the ID for the Named User ~ SoftwarelLicenseTypeID
license type)

License properties > Ending Date (or, ExpiryDate
in the list of Application Licenses,
the END DATE)

The prefix FLX-0365- followed by PartNo
the internal termSKU value (not
visible)

Hard-coded to true IsSubscription

Not visible Id SaasManagerLicenseID

Example FNMS Ul / Notes

License properties > Identification
tab> Publisher

License properties > Compliance tab
> Extra entitlements (see also next
item)

License properties > Compliance tab
> Entitlements are: Unlimited (see
also previous item)

License properties > Identification
tab> License type (displays as Named
User)

License properties > Identification
tab> Expiry date

License properties > Purchases tab >
Part no./SKU

License properties > Identification
tab> Purchased as displays
Subscription

Not visible - used for creating the
hyperlink from the license in FlexNet
Manager Suite back to the matching
license in Flexera SaaS Manager.

Note: The following mapping into the ImportedSoftwareTitle table updates or creates software titles
(application records) for SaaS applications other than Microsoft Office 365.

Table 8: Application data mapping (ImportedSoftwareTitle table)

FSM object/label FNMS staging fields Example FNMS Ul / Notes

Not visible the application id ExternalSoftwareTitleID Not visible.

APPLICATION, and Display Name in  FullName (up to 512 characters) Application properties > General tab
application properties >Name
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FSM object/label FNMS staging fields

As above, APPLICATION, and Display ProductName (up to 200 characters)
Name in application properties

Managed Applications list > PublisherName (up to 200
VENDOR characters)

Imported Data Mapping

Example FNMS Ul / Notes

Application properties > General tab
> Product

Application properties > General tab
> Publisher

Table 9: Application to License links (ImportedSoftwareTitleLicense table)

FSM object/label FNMS staging fields

ExternalSoftwareTitleID

ExternalSoftwarelLicenseID

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)

Example FNMS Ul / Notes

Not visible. Foreign key to the
ImportedSoftwareTitle table,
identifies an imported application

Not visible. Foreign key to the
ImportedSoftwarelicense table,
identifies a license created to match
the imported data
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Salesforce Subscription Management

FlexNet Manager Suite 2022 R1 (On-Premises)

The benefits of Salesforce subscriptions come at a significant cost for large organizations and licensing is complex.
FlexNet Manager Suite provides you with ways to better stay in charge of your Salesforce licensing and consumption.
FlexNet Manager Suite provides an inventory adapter so that you can import Salesforce license allocations and usage
data and then leverage FlexNet Manager Suite's tools to help you manage Salesforce licensing and consumption costs.
With FlexNet Manager Suite's integration with Salesforce, you can easily see unused Salesforce subscriptions, thereby
helping you strategize how to reduce costs at subscription renewal. FlexNet Manager Suite:

« Imports Salesforce license information and creates one SaaS User license for each instance of Salesforce that is
connected. In FlexNet Manager Suite, under the SaaS User license, a series of applications represents the Salesforce
users in your organization.

« Shows you consumption information in the Consumption tab of the license properties for each user in your
organization that is accessing Salesforce.

« Shows unused Salesforce subscriptions. To determine unused Salesforce subscriptions, you can specify a number of
days in a SaaS Usage Summary report and drill through to users to view which users have and have not accessed
Salesforce over that time period.

e Supports multiple Salesforce instances.
o Provides a list of accessing users for each Salesforce instance.

—
1=

|==| Note: You must be connected to Salesforce in order for FlexNet Manager Suite to provide Salesforce information.

=

I=I Note: For managing a your subscription licenses for Salesforce, you may prefer to use the Flexera SaaS Manager
connector, which not only integrates information for Salesforce, but simultaneously imports information for all your
SaaS-based products you choose to manage there. If you choose the Flexera SaaS Manager connector, you should not

use the Salesforce connector described in this part.
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Salesforce License Considerations

FlexNet Manager Suite 2022 R1 (On-Premises)

You can use FlexNet Manager Suite to review your Salesforce subscriptions. FlexNet Manager Suite provides a way for
you to:

« Review Salesforce license consumptions to help determine how many Salesforce licenses you need to purchase,
which in turn helps you negotiate license agreements.

¢ Ensure that business units are not under-subscribed.

—

- |
|=| Note: The first time you import your organization's license information from Salesforce, FlexNet Manager Suite
creates one Saa$ User license for each instance of Salesforce that is connected. If license information for a new user is
imported after the initial import, that information is imported to the original SaaS User license in FlexNet Manager
Suite. Each user imported from Salesforce is mapped to the appropriate accessing user record. These users consume

against the Salesforce multi-product license created for the Salesforce tenant.
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Viewing Salesforce License
Information with FlexNet Manager
Suite

FlexNet Manager Suite 2022 R1 (On-Premises)

The following provides high-level steps for viewing Salesforce license information using FlexNet Manager Suite.

gt
[_] To view Salesforce license information:

1. Ensure that you have created and configured a connector for each tenant of the Salesforce Online Service. For more
information, see Managing Connections to Salesforce.com.

2. Duringthe next discovery and inventory collection, FlexNet Manager Suite imports the following objects:

« Users: Each imported user from Salesforce.com is mapped to the appropriate accessing user record. If an
imported user cannot be mapped to any accessing user record, an accessing user record is created with a

dummy inventory device assigned to this user.

o Licenses: ASaaS User license is created for each Salesforce tenant (typically one tenant per enterprise,
although mergers and acquisitions may mean that your enterprise has multiple Salesforce tenants). Note the

following:

o This license is derived from a template provided in the downloadable libraries, and selected based on the

plan identifier.
o Multiple applications are linked to this license that represent feature and user licenses within Salesforce.

o The name of the Salesforce tenant is included in the name of each of these license and applications. The
name of the connector is included as well. This information helps to distinguish licenses when you have

multiple Salesforce tenants.
3. Review the All Users and All licenses pages to ensure that the required users and licenses have been created.

4. After license reconciliation has been completed, the Product Summary page should show the compliance status
for Salesforce.
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5. Navigate to License Compliance > All Licenses. Filter the records to view Salesforce licenses. You can check the
Consumed and Used columns to know how many subscriptions are being used.

6. You can also view the SaaS Usage report for insights on Salesforce license consumption.
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Connecting to the Salesforce Online
Service

FlexNet Manager Suite 2022 R1 (On-Premises)

To generate the compliance position for Salesforce licenses, FlexNet Manager Suite needs information about
subscription and usage of Salesforce licenses. To get the subscription and usage information from Salesforce.com, the
FlexNet Beacon should be configured with an inventory PowerShell connection of the Source Type of Salesforce for
each tenant of Salesforce. (Typically, each enterprise is a single Salesforce tenant; but your corporate history, including
mergers and acquisitions, may mean that your enterprise includes multiple Salesforce tenants.)

When created and configured with the Salesforce connection, the inventory beacon imports the licenses, users, and
usage information from the Salesforce.com account and uploads it to FlexNet Manager Suite according to the defined
schedule. according to the defined schedule. For details on how to create a connector to Salesforce, see Managing
Connections to Salesforce.com.

Managing Connections to Salesforce.com

FlexNet Manager Suite 2022 R1 (On-Premises)

i Tip: The connector to Flexera SaaS Manager supersedes and overrides the connector to Salesforce.com. This means
that if you implement the Flexera SaaS Manager connector, any licenses that are created for imports through the
Salesforce.com connector are automatically given a status of Retired, so that they have no impact on license
reconciliation calculations. Instead, new licenses are created from the Flexera SaaS Manager imports, and these are
included in license reconciliations as usual.

Use the following procedure to create a connection to Salesforce.com on the FlexNet Beacon (when you are not
integrating with Flexera SaaS Manager). FlexNet Manager Suite provides an inventory adapter to import Salesforce.com
license allocations and usage data. Operators can easily see unused Salesforce.com subscriptions which, in turn, allows
you to manage costs at subscription renewal. A connection is required for each organization of Salesforce.com. The
inventory beacon requires this connection to import all Salesforce.com licenses available to the enterprise, show
consumption for each allocated license, show unused subscriptions, and support multiple Salesforce.com instances.

You must make sure that the Salesforce tenant user has the required System Administrator privilege for this operation.
Also make sure that the following prerequisites are met on each inventory beacon that needs to download data from
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Salesforce (noting that the order of installation of prerequisite software may be significant). These requirements should
have been met when the inventory beacon was installed:

e PowerShell 5.1 or later is running on Windows Server 2008 R2 SP1 or later, or Windows 7 SP1 or later; with the

PowerShell execution policy set to RemoteSigned

¥
= Tip: The PowerShell execution policy can be set by running PowerShell with administrator rights and executing

the following command:

Set-ExecutionPolicy RemoteSigned

» Abrowser is installed with JavaScript enabled on the machine the inventory beacon software is installed on.
» A Javascript-enabled browser installed on the machine the inventory beacon software is installed on

¢ Theinventory beacon server supports Transport Layer Security (TLS) 1.2 in order for the connection to Salesforce to

work.

ot
[_] To create a connection to Salesforce.com:

1. Login to Salesforce and create a connected app. (A connected app is required for a connection to Salesforce.com
on the FlexNet Beacon to work.) For information about how to create a connected app in Salesforce, see
https://help.salesforce.com/articleView?id=connected_app_create.htm. Note the following:

When creating the connected app, ensure that you select Enable OAuth Settings, select the Enable for Device
Flow check box and select all Available OAuth Scopes. The connected app in Salesforce uses standard SAML
and OAuth protocols to authenticate, provide single sign-on, and provide tokens for use with Salesforce APIs. In
addition to standard OAuth capabilities, connected apps allow Salesforce admins to set various security policies
and have explicit control over who can use the corresponding apps. After creating the connected app in
Salesforce, you can view the app details in order to copy and paste the Consumer Key and Consumer Secret
values to the corresponding fields in the FlexNet Beacon PowerShell Source Connection dialog in Step 8.

2. Login to Salesforce and access the connected app to view details.

3. Inthe FlexNet Beacon interface, ensure that you have your preferred schedule for imports from Salesforce set on
the appropriate inventory beacon:

a. Loginto the inventory beacon interface as an administrator (for example, in the Windows Start menu,
search for FlexNet Beacon, right-click it, and select Run as administrator).

¥
= Tip: Remember that you must run the inventory beacon software with administrator privileges.

b. From the Data collection group in the navigation bar, choose Scheduling.

c. Ifthereis not already a suitable schedule in the list, click New... and complete the details (see the online
help for that page for more information). Otherwise, identify the schedule you will use.

4. Select the Inventory Systems page (in the same navigation group).
5. Choose either of the following:

« To change the settings for a previously-defined connection, select that connection from the list, and click
Edit....
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« To create a new connection, click the down arrow on the right of the New split button, and choose
Powershell.

6. Complete (or modify) the values for the following required fields:

« Connection Name: Enter a name for the inventory connection. The name may contain alphanumeric
characters, underscores or spaces, but must start with either a letter or a number. When the data import
through this connection is executed, the data import task name is same as the connection name.

o Source Type: Select Salesforce from this list.

7. Optionally, if your enterprise uses a proxy server to enable Internet access, complete (or modify) the values in the
Proxy Settings section of the dialog box in order to configure the proxy server connection.

» Use Proxy: Select this check box if your enterprise uses a proxy server to enable Internet access. Complete the
additional fields in the Proxy Settings section, as needed. If the Use Proxy check box is not selected, the
remaining fields in the Proxy Settings section are disabled.

« Proxy Server: Enter the address of the proxy server using HTTP, HTTPS, or an IP address. Use the format
https://ProxyServerURL:PortNumber, http://ProxyServerURL:PortNumber, or

IPAddress:PortNumber). This field is enabled when the Use Proxy check box is selected.

» Username and Password: If your enterprise is using an authenticated proxy, specify the user name and
password of an account that has credentials to access the proxy server that is specified in the Proxy Server
field. These fields are enabled when the Use Proxy check box is selected.

8. Complete (or modify) the values in the Salesforce section of the dialog box. All of the following fields require a
value:

—
=21

I==| Note: Ifyou have multiple organizations to Salesforce (for example, separate organizations for different
corporate units or locations), you need to create a separate connector for each organization using its own
credentials.

« Salesforce URL: Enter the address of the Salesforce URL to be used for generating a new token.
» Consumer Key: Copy this value from the Consumer Key field in the Salesforce connected app.

o Consumer Secret: Copy this value from the Consumer Secret field in the Salesforce connected app. In the

Salesforce connected app, click Click to reveal to view the value.

« Refresh Token: Click the Generate button to generate a refresh token that will be used to authenticate the
connection to Salesforce.

9. When you click Generate to the right of the Refresh Token field, a Web browser is launched in Salesforce.com
with an 8-digit code automatically populated in the Code field. In the Salesforce.com screen, do the following:

a. Click Connect. A Salesforce login page displays. If you are already logged into Salesforce, skip to step 8e.

b. Enter your Salesforce username. If there are multiple Salesforce accounts, select your username from the
Saved Username list or click Log In with a Different Username. A Password field appears.

c. Inthe Password field, enter your Salesforce password.

d. Click Login. An Allow Access page appears.
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e. Click Allow to allow Salesforce to access the FlexNet Beacon to have the refresh token sent back to
PowerShell Source Connection dialog. A message appears to notify you that the connection is successful.
Click Continue or close the browser.

D Note: The following table provides help with potential issues that you may encounter when attempting
to connect to Salesforce.

Table 10: Troubleshooting Salesforce Connection Errors

Error Description

Mandatory parameter(s) missing One or more of the fields in the FlexNet Beacon PowerShell
Source Connection dialog is missing a value. Ensure that all
mandatory fields contain values before clicking Generate to

the right of the Token field.
The remote name could not be The most common cause is that there is no Internet
resolved: connection available on the machine the inventory beacon
'login.salesforce.com' software is installed on. There may be other reasons such as

Salesforce.com being blocked or is currently down.

invalid_client_id The value that you entered for the Consumer Key field does
not match the Consumer Key value from the Salesforce
connected app. Copy the correct Consumer Key value from
the Salesforce connected app and paste it into Consumer
Key field in the FlexNet Beacon PowerShell Source
Connection dialog.

Timeout When the Web browser (that is invoked after clicking
Generate to the right of the Token field) is not responding in
atimely fashion, a Timeout error occurs. Some of the most
common scenarios that will trigger this error are:

o The Internet browser that was invoked when you clicked
Generate was subsequently closed inadvertently or
prematurely.

o Alogin error was encountered that may be the result of
incorrect login credentials.

» You may have waited too long before attempting to login

to Salesforce.

invalid_request You have clicked Deny instead of clicking Allow in Step 5e to
access the FlexNet Beacon to have the refresh token sent
back to PowerShell Source Connection dialog.

10. In the FlexNet Beacon PowerShell Source Connection dialog, click Save to save the connection.
11. Select your new connection from the displayed list, and click Schedule....

12. In the dialog that appears, select the name of your chosen schedule for inventory collection through this
connection, and click OK.
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13. At the bottom of the FlexNet Beacon interface, click Save, and if you are done, also click Exit.

¥

Tip: Consider whether you want to select your connection, and click Execute Now, before you exit.

After a successful data import, the users, applications, licenses, and usage data are all visible in the appropriate pages
of FlexNet Manager Suite.

- |
|
L

| Note: To know more about the operations available on the Inventory Systems page of FlexNet Beacon, see

Inventory Systems Page in the online help. For scheduling data imports through this connection, see Scheduling a
Connection, also in help.

FlexNet Manager Suite (On-Premises)

2022R1
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ServiceNow Integration with FlexNet
Manager Suite

FlexNet Manager Suite 2022 R1 (On-Premises)

Using the integration application for ServiceNow, you can exchange a limited set of data between FlexNet Manager Suite
and ServiceNow to provide a consistent view of your hardware and software estate, and related contracts. The Flexera
Integration app version 5.x has been updated and renamed from the FlexNet Manager Suite for Enterprises 4.x
application. The Flexera Integration app version 5.x is a scoped application and is now shared between FlexNet Manager
Suite, Flexera Data Platform, and IT Visibility, and is available in the ServiceNow store.

The Flexera Integration scoped app:
e Currently has only been confirmed and tested to support a ServiceNow cloud instance.
« Does not support ServiceNow on-premises instances on an Oracle database.

» May or may not work with a ServiceNow on-premises instance on a MySQL database. This position may change in the
future when Flexera has tested it further.

=

|=| Note: For any single instance of ServiceNow, only one source of Flexera data should be exporting data for consumption
by ServiceNow. The Flexera Integration app does not support resolving overlapping data. With a view to the long-term,
where you have a choice of all of the above, IT Visibility would be the common recommendation. However, notice that
this restriction applies to Flexera tools that are exporting data. The (quite separate) ServiceNow inventory connector
(see next section of this manual) does not export data to ServiceNow, being strictly an importer of inventory discovered
by ServiceNow. Therefore it is perfectly acceptable to use the same Flexera Integration app on the one instance of
ServiceNow to combine integration with (say) IT Visibility (or either of the other data exporters) with the ServiceNow

inventory connector.

ServiceNow provides cloud-based IT Service Management, while FlexNet Manager Suite is focused on Software Asset
Management. To help provide a unified view of your management data, there are two parts to the integration of these
systems, each of which is available independently:

« Data on hardware assets, application installations, and contracts can be exported from FlexNet Manager Suite and

imported into ServiceNow

« Data on assets and contracts can be exported from ServiceNow and imported into FlexNet Manager Suite.
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For the latest ServiceNow version compatibility information, refer to the Flexera Integration app listing within the
ServiceNow Store.

This ServiceNow documentation is divided into the following chapters:

o Key Concepts — key concepts to help you understand how and what type of data is merged with the integration
application, where to view merged data, insight into how source of truth settings structure data into an optimized view
with no duplicate or missing records

o Architecture, Components, and Prerequisites — background information including requirements you need to know to
get started with the integration application, as well as contextual information to help you understand the configuration
and operation of the integration

« Installation and Configuration — common tasks to be completed for all implementations, procedures for setting up
data flows from FlexNet Manager Suite to ServiceNow or from ServiceNow to FlexNet Manager Suite

o Operational Details — steps showing how the export of data from FlexNet Manager Suite works (to export hardware
inventory, installed applications, and contract data), and steps showing how the export of data from ServiceNow works
(to export asset and contract data)

» Appendices — integration property descriptions, a performance improvement tip to create additional indexes on your
ServiceNow instance, procedure to remove a previously-installed legacy integration application, and more.
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Key Concepts

FlexNet Manager Suite 2022 R1 (On-Premises)

Before using integration application for ServiceNow, it is helpful to understand some key concepts of the integration that
are described in the following sections:

o Data Types that Can Be Merged — data types that can be exported from FlexNet Manager Suite and from ServiceNow

o How Data Is Merged — introduces the role that transform maps play in merging data between FlexNet Manager Suite
and ServiceNow

« Source of Truth — how source of truth settings structure data into an optimized view with no duplicate or missing
records

o Where to View Merged Data — where to go in FlexNet Manager Suite and ServiceNow in order to view data that has
been merged by the integration application

« ServiceNow Computer and Application Records — table storage options in ServiceNow (Software Asset Management
(SAM) Foundation plugin tables, Configuration Management Database (CMDB) tables, or both) and a description of
how the integration application creates or updates computer records in ServiceNow and sets the Cl classes.

Data Types that Can Be Merged

FlexNet Manager Suite 2022 R1 (On-Premises)

The following table shows the data types that can be exported from FlexNet Manager Suite and data types that can be
exported from ServiceNow.

When exporting from: The following data types can be exported:
FlexNet Manager Suite Hardware inventory, installed applications, and
contracts.
ServiceNow Assets and contracts

D Note: When exporting from FlexNet Manager Suite, the three data types each correspond to a check box in the
ServiceNow export settings section in the Integrations tab on the System Settings page. You can export any or all
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of these data types to ServiceNow. When exporting from ServiceNow, assets and contracts can be included in the
export, as configured in scheduled jobs that can be accessed from either of the following ServiceNow menus: for
integration application 5.x, see Flexera Integration > Export Configuration > Scheduled Jobs, or for integration
application 4.x, see FlexNet Manager Suite > Scheduled Jobs.

How Data Is Merged

FlexNet Manager Suite 2022 R1 (On-Premises)

When data is merged between FlexNet Manager Suite and ServiceNow, transform maps are used to map the data. For
more information, refer to Transform Maps for ServiceNow Integration.

When data is merged between ServiceNow and FlexNet Manager Suite, business adapters are used to map the data. For
more information, refer to Business Adapter Mappings.

For both scenarios, an integration user needs to be created in ServiceNow so that both systems can communicate. For
more information, refer to Creating a ServiceNow Integration User.

Source of Truth

FlexNet Manager Suite 2022 R1 (On-Premises)

When exporting from FlexNet Manager Suite for import into ServiceNow, a source of truth needs to be defined between
systems in order to address any differences encountered during the merge. A set of integration properties are provided
in ServiceNow in integration application 5.x, see Flexera Integration > Integration Properties, or in integration app
4.x, see FlexNet Manager Suite > Integration Properties. The integration properties let you specify whether to accept
FlexNet Manager Suite as the source of truth for various data types. Choosing No for any option toggles that setting to
ServiceNow as the source of truth. For example, when merging inventory, if a record is not found with given criterion, a
new record will be created if FlexNet Manager Suite is source of truth for Adding Inventories. For more information
about source of truth integration properties, refer to Integration Properties.

ﬂ Note: For records of hardware inventory and installed applications, FlexNet Manager Suite is considered the
authoritative source of truth.

When exporting assets and contracts from ServiceNow for import into FlexNet Manager Suite, scheduled jobs need to
be configured. For more information about scheduled jobs, refer to Setting Up Data Flows from ServiceNow to FlexNet
Manager Suite. Then, the business adapters are used to import data into FlexNet Manager Suite. Assets and contracts
are both set as the source of truth by default; however, you can edit the business adapters to change these settings. For
more information, refer to Configuring FlexNet Beacon for Import.

ﬂ Note: For assets and contracts, ServiceNow is considered the authoritative source of truth.

Where to View Merged Data

FlexNet Manager Suite 2022 R1 (On-Premises)

The following table shows where to go in FlexNet Manager Suite and ServiceNow to view data that is merged by the
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integration application. This not only helps you understand the integration but also helps you understand where to go
in both systems in order to view and validate results.

Data type FlexNet Manager Suite ServiceNow menu location

menu location

Hardware Discovery & Inventory > All Integration application 5.x: Flexera Integration > Imported
inventory Inventory Records > Computers and in integration app 4.x: FlexNet
Manager Suite > Imported Records > Computers

Installed Applications tab of Software Installations tab (SAM) or Software Installed tab

applications inventory device properties. (CMDB) of a computer record

Contracts Procurement > All Integration application 5.x: Flexera Integration > Imported
Contracts Records > Contracts and in integration app 4.x: FlexNet

Manager Suite > Imported Records > Contracts

You may also want to compare inventory device properties.

Property FlexNet Manager Suite ServiceNow
General properties of inventory Inventory device properties Computer record (accessed by
device such as: device type (accessed by selecting arecord from  selecting a record from one of the
(Computer, Virtual machine), All Inventory) following menus. In integration
Manufacturer, Serial number, etc. application 5.x: Flexera Integration >

Imported Records > Computers and
in integration app 4.x: FlexNet
Manager Suite > Imported Records
> Computers

ServiceNow Computer and Application
Records

FlexNet Manager Suite 2022 R1 (On-Premises)

Installed Applications

When exporting installed application data from FlexNet Manager Suite for import into ServiceNow, you have the option
to select which tables store the data. Prior to integration application v4.0, installed application records were stored into
Software Asset Management (SAM) Foundation plugin tables. Integration application v4.0 and later gives you the option
to store imported application records into Configuration Management Database (CMDB) tables, SAM tables, or both. A
new integration property, Use CMDB and/or SAM tables for installation, has been added to the Integration
Properties page. As a result of this enhancement, the SAM Foundation plugin is no longer a requirement for using the
integration application. For more information, refer to Integration Properties.

Hardware Inventory

When hardware inventory records are exported from FlexNet Manager Suite to ServiceNow, the integration creates or
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updates computer records in ServiceNow. The integration also sets the correct Cl class on these records based on the
Inventory Device Type and Operating System. This enables viewing these records in the respective views within

ServiceNow. The following table shows the logic of how the Cl class of computer records are classified in ServiceNow
and also shows where to view the resulting records in ServiceNow.

Table 11: Hardware inventory exported from FlexNet Manager Suite and imported to ServiceNow

Inventory device
type of Inventory

record in FlexNet
Manager Suite

VM Host

Computer Virtual
Machine Mobile
Device

Operating system of
Inventory record in
FlexNet Manager
Suite

contains "Microsoft"
or "Windows"

contains "VMware"

anything else

contains "AIX"

contains "Solaris" or
"Sun OS"

contains "OS X"
contains "HP-UX"
contains "Unix"
contains "Linux"

contains "Microsoft"
or "Windows" and
contains "Server"

anything else

Cl class of Computer

record in
ServiceNow

Hyper-V server

ESX server

Visualization server

AlIX Server

Solaris Server

0OSX
HPUX Server
Unix Server

Linux Server

Windows Server

Computer

View in ServiceNow

Configuration > Hyper-V > Hyper-V Servers

Configuration > VMware > ESX Servers

no direct link, but you can enter the
following into the ServiceNow Filter
navigator to access view:
cmdb_ci_virtualization_server.list

Configuration > Servers > AIX
Configuration > Servers > Solaris

Configuration > Servers > 0S X
Configuration > Servers > HPUX
Configuration > Servers > Unix
Configuration > Servers > Linux

Configuration > Servers > Windows
Servers

Configuration > Base Items > Computer

For all the virtual machine records in an export, the import creates or updates Virtual Machine Instance records in
ServiceNow and sets the correct Cl class on these records based on the virtual machine type. The following table shows
the logic of how the Cl class of virtual machine records are classified in ServiceNow and also shows where to view the
resulting records in ServiceNow.

Table 12: Virtual machines exported from FlexNet Manager Suite and imported to ServiceNow

VM Type of Inventory record in

FlexNet Manager Suite

Cl class of Virtual Machine
Instance record in ServiceNow

View in ServiceNow

AWS EC2

362

EC2 Virtual Machine Instance

no direct link, but you can enter the
following into the ServiceNow Filter
navigator to access view:
cmdb_ci_ec2_instance.list
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Key Concepts

View in ServiceNow

Hyper-V Hyper-V Virtual Machine Instance

VMware VMware Virtual Machine Instance

Zone Solaris Virtual Machine Instance

LPAR

nPar

Oracle VM

SRP Virtual Machine Instance
vPar

WPAR

Unknown

"

Configuration > Hyper-V > Virtual
Machine Instances

Configuration > VMware > Virtual
Machine Instances

no direct link, but you can enter the
following into the ServiceNow Filter
navigator to access view:
cmdb_ci_solaris_instance.list

In integration application 5.x: Flexera
Integration > Imported Records >
Virtual Machines and in integration
app 4.x: FlexNet Manager Suite >
Imported Records > Virtual
Machines

R . . . .
W Tip: Integration properties allow you to choose whether to use FlexNet Manager Suite or ServiceNow as the source of

truth to create and update records. Another property allows you to choose whether FlexNet Manager Suite or
ServiceNow should be used as the source of truth to update Cl classes. See Adding Inventories, Updating inventories,
and Updating inventory class name (sys_class_name) in Integration Properties.
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Architecture, Components, and
Prerequisites

FlexNet Manager Suite 2022 R1 (On-Premises)
This chapter provides information you need to get started with the integration application.

The information is divided into the following sections:

» Architecture — architectural diagrams to help you understand both configuration and operation of the integration
between ServiceNow and FlexNet Manager Suite

» Prerequisites — requirements for integrating FlexNet Manager Suite and ServiceNow

¢ Download Adapter Tools Archive — how to download the Adapter Tools archive that includes content needed for
many adapters.

Architecture

FlexNet Manager Suite 2022 R1 (On-Premises)

This big-picture overview provides context for understanding both configuration and operation of the integration
between ServiceNow and FlexNet Manager Suite.

Because ServiceNow is cloud-based, and your implementation of FlexNet Manager Suite is on your premises, thereis a
level of separation required (for example, the products must be accessed in separate browser tabs/windows). The
following architecture allows for the necessary data flows between these two distinct systems.
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The following two processes (illustrated in the diagram) operate completely independently:

o The export of computer, application, and contract data from FlexNet Manager Suite into ServiceNow (purple arrow).
For details, see Process for Exports from FlexNet Manager Suite to ServiceNow.

o The export of computer and contract data from ServiceNow for import into FlexNet Manager Suite (gold arrows). For
details, see Process for Exports from ServiceNow to Process for Exports from FlexNet Manager Suite to ServiceNow.

Prerequisites

FlexNet Manager Suite 2022 R1 (On-Premises)

The following are requirements for integrating FlexNet Manager Suite release 2022 R1 and ServiceNow. At a high level,
you need:

« Afunctional implementation of FlexNet Manager Suite

* An operational ServiceNow instance

« Installation of the ServiceNow integration application

» AServiceNow integration account user with x_f1ls_flexera_fnms.admin role assigned
The following provides further details of these requirements:

« You need a functional implementation of FlexNet Manager Suite.

I} Important: To take full advantage of the features included in the v4.0 and later integration applications, it is
recommended that you run FlexNet Manager Suite 2019 R1 or later. For more information about limitations with
earlier releases of FlexNet Manager Suite, see the knowledge article Feature Support for ServiceNow Integration,
in the Flexera Customer Community.

o You must have a license issued by Flexera that permits use of the integration application. This license authorizes
all communications in both directions through the integration application. To check, in the web interface navigate

to the system menu (%" ¥ in the top right corner) and click FlexNet Manager Suite License. Check under the
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License details for ServiceNow integration enabled: Yes. Ifthisis notthe case, request the license from

your Flexera representative.

o You must have an operational inventory beacon that communicates with your central application server for
FlexNet Manager Suite.

o The FlexNet Manager Suite feature called ServiceNow Exporter must be installed. To check:

1. Onyour batch server, navigate to the installation directory for FlexNet Manager Suite.
2. Navigate down to the child directory DotNet\bin.
3. Validate that there is a ServiceNowExport folder, with content. If so, the check is satisfactorily completed.

4, If the folder is missing, you must re-reun the FlexNet Manager Suite installer, and ensure that the
ServiceNow Exporter feature is selected for installation. You should also re-reun the configuration
PowerShell script in order the create the required scheduled task. (For more information, see your copy of
the Installation Guide PDF, available through the title page of online help.)

* You must have an operational ServiceNow instance.

o For data flows from ServiceNow to FlexNet Manager Suite, you need a MID server configured for your ServiceNow

implementation.

7
=" Tip: If you prefer, your FlexNet Beacon and ServiceNow MID server can be implemented on the same physical

computer (provided that there are common communications requirements — for example, you don't have a
case where one requires a proxy server setting that the other cannot use).

o For data flows from FlexNet Manager Suite to ServiceNow: If your ServiceNow instance has the Software Asset
Management (SAM) Foundation plugin installed, you can choose to direct installed application data to SAM tables,
CMDB tables, or both. If your ServiceNow instance does not have the SAM Foundation plugin installed, you must
choose to direct Installed Application data to CMDB tables. For details on both, see Configuring the Software Asset
Management Foundation Plugin and see the description of the Use CMDB and/or SAM tables for installation

property in Integration Properties.

o Forinformation on supported versions, go to the ServiceNow Store and search for 'Flexera'.

[k
! ] Note: ServiceNow has deprecated older versions of Transport Layer Security (TLS). Requires version 1.2.

« Ifthisisyour first ever install of the FlexNet Manager Suite integration application for ServiceNow, you must install it
from the ServiceNow Store (see Installing the Flexera Integration Application from the ServiceNow Store), and then
any updates to the app are also done through the ServiceNow store. Alternatively, if you have previously installed an
earlier version of the integration using an update set, refer to the knowledge article Upgrading ServiceNow
Integration Application Using an Update Set in the Flexera Customer Community.

o For first time users, and if you will be exporting data from ServiceNow to FlexNet Manager Suite, two business
adapters (ServiceNowAssets.xml and ServiceNowContracts.xml) must be used for assets and contracts.
These can be found in the in the unzipped adapter tools archive (see Download Adapter Tools Archive). For more

information, refer to Configuring FlexNet Beacon for Import.
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Download Adapter Tools Archive

FlexNet Manager Suite 2022 R1 (On-Premises)
The Adapter Tools archive includes content for many adapters, and is updated on the Flexera website from time to
time.

Start this procedure using a web browser on a computer that has good network accessibility from all the machines
needing installations for your adapter.

=
[_] To download the adapter tools archive:

1. Download the Adapter Tools for FlexNet Manager Suite 2022 R1.zip archive. One path is through the
Flexera Community:

-
= Tip: Your Community credentials are required for login.

a. Loginto community.flexera.com.
b. Inthe top right, in the navigation bar, expand More and select Product and License Center.

c. Under the right-hand list of products that includes FlexNet Manager Suite, click LET'S GO! (and
subsequently wait for the redirection to occur).

d. Ontherightside, scroll down through the list of Your Downloads and click FlexNet Manager Platform.
The Download Packages page for FlexNet Manager Platformappears.
e. Inthe Latest Versions tab, click FlexNet Manager Suite 2022 R1.

A EULA page may appear. If so, click | agree to accept the license, as this grants access to the list of
Downloads.

f. Inthe list of available Downloads, in the Files tab, in the File Name column, click Adapter Tools for
FlexNet Manager Suite 2022 R1.zip.

A new browser tab may appear temporarily, and the download of Adapter Tools for FlexNet Manager

Suite 2022 R1.zip commences.

g. Inyour browser dialog, choose to save the file, and if the browser allows it, direct the saved file to a
convenient working location (such as C: \temp on a central, accessible server).

If your browser saves the file to a default location (such as your Downloads folder), move or copy it to
the appropriate working location when the download is finished.

2. Right-click the zip archive, and choose Extract All....

The folders are now available for the range of adapters in the Adapter Tools archive.
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Installation and Configuration

FlexNet Manager Suite 2022 R1 (On-Premises)

Because the system involves a number of different servers, there are several installation and configuration steps. These
are described in full in the following topics.

The information is divided into the following sections:

o Setting Up the Integration — common tasks that must be completed for all implementations

o Setting Up Data Flows from FlexNet Manager Suite to ServiceNow — required if you want to export the FlexNet
Manager Suite data on hardware assets, installed applications and contracts for use within ServiceNow

o Setting Up Data Flows from ServiceNow to FlexNet Manager Suite — required if you want to import assets and/or

contracts data into FlexNet Manager Suite.

Setting Up the Integration

FlexNet Manager Suite 2022 R1 (On-Premises)

Most of the groundwork on the FlexNet Manager Suite side has already been completed as part of product installation.
Therefore the balance of the work that is common to both directions of data flow involves setting up ServiceNow.

« In ServiceNow terminology, you need to install an integration 'application' in ServiceNow (see Installing the Flexera

Integration Application from the ServiceNow Store).

o There must also be a user account correctly configured in ServiceNow (see Creating a ServiceNow Integration User).

Installing the Flexera Integration Application from
the ServiceNow Store

FlexNet Manager Suite 2022 R1 (On-Premises)

The steps in this section provide steps for a first time install of the integration application for ServiceNow. If you have
previously installed an earlier version of the integration using an update set, instead refer to the knowledge article
Upgrading ServiceNow Integration Application Using an Update Set in the Flexera Community (login required).
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oy
[_] To install the integration application for ServiceNow from the ServiceNow store:

1.

2,

10.

11.

12.

13.

Log into ServiceNow Store with ServiceNow HI credentials.

In the Search box, enter Flexera Integration and press Enter.
Application information appears in the search results.

From the search results, click Flexera Integration.

Information about the application displays.

. In the right pane of the application window, view the Compatibility section to ensure that the integration

application is compatible with the version of ServiceNow that you require. If the version of ServiceNow that you
require is not listed, contact FlexNet Manager Suite Technical Support.

. Inthe right pane of the application window, click the Get button.

A notice appears.

. At the bottom of the notice, click Continue.

. On the Purchase of Flexera Integration page, choose the Make available on specific instances radio button.

and click the Select button.

A Select Instances dialog appears.

. In the Available Instances pane, double-click the instance that you want the app to be available on and click OK.

. Select the I accept check box (to accept terms of use and subscription terms and conditions) and click Get.

Log into the ServiceNow instance where you made the integration application available. (You selected this
instance in step 8).

In the Filter navigator, enter System Applications and then under System Applications, click Applications.
The Applications list appears.

Click the Downloads tab.

The Downloads list appears.

Scroll to the Flexera Integration application, and click the Install button.

The application now appears in the ServiceNow menu, displayed in the left-hand navigation panel as Flexera

Integration.

Creating a ServiceNow Integration User

FlexNet Manager Suite 2022 R1 (On-Premises)

This simple process sets up the user account used for integration between Service Now and FlexNet Manager Suite,
and assigns the user to the appropriate role. Complete this task while you are still logged into ServiceNow as an

administrator.

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)

369



Installation and Configuration

£
U To create the user account in ServiceNow:
1. In ServiceNow, go to User Administration > Users.

2. Click New, complete the properties for your new user, and click Submit.

I(-
' Tip: Take note of the user ID and password, which you will need again later in the set-up processes.

3. Once the creation process finishes, click the hyperlinked User ID for this user, and scroll down to Roles.
4. Click Edit, and select x_f1s_flexera_fnms.admin from the collection, and add to Roles List.
5. Click Save.

6. Close the user properties page.

Setting Up Data Flows from FlexNet
Manager Suite to ServiceNow

FlexNet Manager Suite 2022 R1 (On-Premises)

For records of installed applications and hardware inventory, FlexNet Manager Suite is considered the authoritative
source of truth. Data on installed applications and hardware inventory, as well as contracts, can be exported from
FlexNet Manager Suite to ServiceNow. The summary of the export process is:

1. On the batch server for FlexNet Manager Suite, a Microsoft scheduled task Export to ServiceNow initiates the
process.

2. The scheduled task launches an exporter utility for FlexNet Manager Suite which extracts the appropriate data and
transfers it to ServiceNow using API calls. This communication relies on all of:

o The URL of your ServiceNow instance
o The user account registered for accessing ServiceNow
* The communications token copied from ServiceNow and saved in FlexNet Manager Suite.

3. In ServiceNow, the FlexNet Manager Suite integration application processes the data received through the API
calls, and schedules imports of that data using the ServiceNow Import Set.

.{-'..
W Tip: The Transform Maps used during import to switch data from one product's formats to the other are also
defined in the integration application.
If you wish to make use of this data flow, you need to complete the following processes:
» Configuring ServiceNow for Import

« Configuring FlexNet Manager Suite for Export

« Optionally, you may customize the export from FlexNet Manager Suite using the guidelines in Configuring the Utility
for Export from FlexNet Manager Suite.
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Configuring ServiceNow for Import

FlexNet Manager Suite 2022 R1 (On-Premises)

Continue the following while still (or again) logged into ServiceNow with administrator privileges.

3
[_] To configure imports into ServiceNow:

1.

For service integration application v5.x, in the Flexera Integration group in the navigation bar, click Generate
Token. For service integration application v4.x, in the FlexNet Manager Suite for Enterprises group in the
navigation bar, click Generate Token.

From the account details you created earlier (see Creating a ServiceNow Integration User), insert the user ID in
the Username field and supply the Password, and click Generate OAuth Token.

AlongRefresh Token appears at the top of the page.

Copy this Refresh Token value, and transfer to the web interface of FlexNet Manager Suite.

. When doing Installed Application data export, decide what tables in ServiceNow that you want this data to go in.

To do this, in ServiceNow for integration application 5.x, navigate to Flexera Integration > Integration
Properties (or for version 4.x, navigate to FlexNet Manager Suite > Integration Properties). Then in that page,
from the Decide whether to use CMDB or SAM tables drop-down list and select one of the following options:

» Decide automatically — Import to SAM tables. If no SAM tables exist, data is instead imported to CMDB
tables.

» Use CMDB tables — Import to CMDB tables.
o Use SAM tables — Import to SAM tables. If there are no SAM tables, the import will fail.

» Use CMDB and SAM tables — Import to CMBD tables and SAM tables. If SAM tables do not exist, the import
will fail.

. Change the account used for processing the import in ServiceNow. To do this:

a. Forintegration application 5.x, go to Flexera Integration > Advanced > Scheduled Data Imports (or for
service integration application v4.x, go to FlexNet Manager Suite > Advanced > Scheduled Data
Imports).

The Scheduled Data Imports list appears.

b. Click FNMS Import Schedule.

—
=3

|==| Note: Flexera Schedule Import is currently only used by Flexera Data Platform. FlexNet Manager
Suite users should select FNMS Import Schedule.

c. Change the Run as user to the integration user. (This is the user ID that you created earlier (see Creating a
ServiceNow Integration User).

d. Click Update.
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Configuring FlexNet Manager Suite for Export

FlexNet Manager Suite 2022 R1 (On-Premises)

You need to complete this configuration once to commence operations. Repeat if your ServiceNow details change at
any time in the future. You may also use this same page to trigger an immediate export from FlexNet Manager Suite to
ServiceNow.

L
[_] To configure export from FlexNet Manager Suite:

1.

372

Ensure that you are (still) logged into FlexNet Manager Suite with an account that is a member of the
Administrator role, and that this account has the Configure access right.

. Inthe web interface, navigate to the system menu (#° ¥ in the top right corner) > System Settings, select the

Integrations tab, and expand the ServiceNow accordion.

L
= Tip: The Integrations tab is only visible when your account has the access rights described above.

In Instance URL, enter the protocol and path to your ServiceNow website (for example, https://YOUR-
INSTANCE.service-now.com).

. In Username, enter the account you use to access ServiceNow. This must exactly match the User ID value shown

in the ServiceNow interface (see Creating a ServiceNow Integration User).

. Paste the Token value from ServiceNow into the Token field on this page (see Configuring ServiceNow for

Import).

¥
= Tip: The Username is mandatory for FlexNet Manager Suite to commence the export process, but it is not

transferred back to ServiceNow, as the Token value alone is now sufficient for authentication.
=
I==|" Note: In future, if you wish to temporarily disable these data exports from FlexNet Manager Suite, you can

either disable the Windows scheduled task Export to ServiceNow or remove any one or more values

from Instance URL, Username, or Token.

. If necessary, change the default selection of data types to export to ServiceNow. It is best practice to export all

available data types.

¥ Warning: Hardware inventory details are critical to the ServiceNow data set. Contracts and installed
applications both have dependencies on assets in that system. If you clear the Hardware inventory check
box, you may produce gaps in the contract and software records imported into ServiceNow.

. Click Save.

When details are complete, the export from FlexNet Manager Suite to ServiceNow is triggered weekly at 3am on
Sunday mornings by default (if required, you may edit the Windows scheduled task Export to ServiceNow to
modify the schedule). If you need to trigger an additional export (for example, when commencing integrated
operations), continue with the rest of this process.

L
= Tip: While the first export of any given data type is always a full export of all active records, subsequent data
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transfers from FlexNet Manager Suite to ServiceNow are differential (that is, only data that is new or changed
since the last successful export of the same type is included). If you wish to transfer all available active data
(rather than the differential data set), select the Perform full export check box before continuing.

. Click Export to trigger an immediate export using the settings saved in the fields displayed above.

The Export button, and the scheduled task, trigger the command-line executable
fnmp_servicenow_export.exe, which:

» Extracts the required data of the first data type from your operations database (the normal order when all are
selected is hardware inventory, contracts, installed applications)

« Segments the data for easier transmission across the Internet, minimizing time-out risks with ServiceNow
» Reassembles the data into staging tables in ServiceNow
» Repeats the process for the next selected data type.

Separate transforms on your ServiceNow instance then map each data type from the staging tables to your
operational ServiceNow tables.

i
= Tip: Itis also possible to run the executable from the command line, provided you have a copy of the

ServiceNow token available (see Command-Line Tool for Export to ServiceNow).

To verify progress of a test run:

1.

In the ServiceNow navigation bar, for integration application 5.x, go to Flexera Integration > Import History >
Import Transactions (or for service integration application v4.x, go FlexNet Manager Suite > Integration
History > Import Transactions. Each of these transactions represents a data chunk* or segment transferred to
ServiceNow. The segmentation is necessary because of the large number of records that may need to be
transferred. When the data is received by ServiceNow, the integration application separately schedules each
transaction for import into the operational database tables in ServiceNow. As each transaction is completely
imported, its State column value is set to Succeeded.

. Similarly, access FlexNet Manager Suite > Integration History > Import Runs. Each data type exported from

FlexNet Manager Suite creates a separate entry here forimport into ServiceNow. For each data type, when all its
individual transactions have succeeded, the State value on the overall Import Run is also set to Succeeded.

Finally, when all the transferred data types have been successfully imported, a status report is sent to FlexNet
Manager Suite. On the System Settings page in the Integrations tab, the status is displayed under Last
completed export.

* The default configuration for data transfers from FlexNet Manager Suite to ServiceNow uses these values:

The number of database records included in each transferred segment: 2000

The number of retries if ServiceNow returns a connection failure: 2

The length of time to wait for ServiceNow to respond before timing out: 2 seconds

The maximum number of records of each data type to be included in the transfer, by type:

o

o

o

Hardware inventory: 500,000
Contracts: 500,000

Installed applications: 500,000.
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For details of configuring these additional elements in an on-premises implementation, see Configuring the Utility for
Export from FlexNet Manager Suite.

Configuring the Utility for Export from FlexNet
Manager Suite

FlexNet Manager Suite 2022 R1 (On-Premises)
Optionally, the configuration file for the export utility may be customized to suit your environment.

Several settings for the utility for exporting data from FlexNet Manager Suite are configurable, including:

« The maximum number of records for each data type (hardware inventory, installed applications, and contracts)
that may be transferred to ServiceNow in each export

o The maximum number of records in each data segment or 'chunk’ transferred
o Logfile location
e Maximum retries after failure of a web request.

All reside in one configuration file, called fnmp_servicenow_export.exe.config, located in the same folder as
the executable fnmp_servicenow_export.exe (which performs the data export from FlexNet Manager Suite to
ServiceNow) on your batch server (or, in a smaller implementation, the server hosting the equivalent functionality).
The default pathis instal lation-directory\DotNet\bin\ServiceNowExport.

3
U To configure exports from FlexNet Manager Suite:

1. Save a backup copy of the configuration file, for example as fnmp_servicenow_export.exe.config.orig,
so that you can revert if there are problems.

2. Open the configuration file fnmp_servicenow_export.exe.config in your preferred XML or plain text editor.
(Do not edit in a word processor that cannot save plain text files.)

3. Optionally, customize the values for data segmentation, retries, and timeout when the executable is accessing

ServiceNow.
Path/element Attribute Default Notes
<configuration> maxRetries "2t When ServiceNow is not
<fnmpGroup> responding, the executable will
<fnmp> retry each connection (one for
<baseConfig /> each data segment being

transferred) this many times. If
this number of retries is reached
for any data segment, the export
fails. Each successful connection
resets the count to zero. (If this
attribute is omitted, the
executable uses a default value of
10.)
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Path/element Attribute Default Notes
<configuration> timeout "2000" The maximum number of
<fnmpGroup> milliseconds to wait for a response
<fnmp> from ServiceNow. This timer is
<baseConfig /> applied independently to each

connection request (at least one
per data segment being
transferred). If ServiceNow does
not respond within this interval
(default 2 seconds), a new request
isissued (up to maxRetries). (If
this attribute is omitted, the
executable uses a default value of

30000.)
<configuration> maxRows "500000" Specifies the maximum number of
<fnmpGroup> application records that can be
<fnmp> exported in a single export.
<application />
<configuration> maxRows "500000" Specifies the maximum number of
<fnmpGroup> contract records that can be
<fnmp> exported in a single export.
<contract />
<configuration> maxRows "500000" Specifies the maximum number of
<fnmpGroup> hardware inventory records that
<fnmp> can be exported in a single export.
<inventory />
<configuration> numRecords "2000" The number of records in each
<fnmpGroup> XML-based data segment to be
<fnmp> transferred from FlexNet Manager
<records /> Suite to ServiceNow. To avoid

time-out issues with ServiceNow,
the total exported data (in each of
the three available types) is
chunked into segments containing
a maximum of this number of
records.

4. Optionally, configure the location for your log files.
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Path/element Attribute Default Notes
<configuration> value "C:\Temp You may adjust the path to store
<log4net> \Log the log files to suit your
<appender> preference. For on-premises
<file /> \ServiceNow_ installations, you may also
date.log" change the file name.

(All on one line)

With the other default values for the elements under appender, multiple passes on the same date append to the
end of the log file, and a new log file is commenced each day.

Setting Up Data Flows from ServiceNow to
FlexNet Manager Suite

FlexNet Manager Suite 2022 R1 (On-Premises)

Details of hardware assets and/or contracts, for which ServiceNow is considered the authoritative source of truth, can
be imported into FlexNet Manager Suite from ServiceNow. In summary, the process is:

1. Each data collection is triggered by a scheduled job in ServiceNow that invokes a script.

2. The script uses ServiceNow database views to gather the required data and transfersit, in chunks, to the
appropriate MID server.

3. The MID server writes the chunks into an XML file.

4. Aseparate schedule configured on the inventory beacon for FlexNet Manager Suite triggers an import through a
business adapter, collecting the XML file, transforming it, and uploading it to the central application server.

5. The normal import processes on the application server imports the data (transformed as appropriate) into the
operations databases for FlexNet Manager Suite.

If you wish to make use of this data flow, you need to complete the following processes:

o Setting Up a MID Server
o Configuring ServiceNow for Export
» Configuring FlexNet Beacon for Import.

No configuration of the central application server is needed, since this part of the integration leverages all standard
operating processes.

Setting Up a MID Server
FlexNet Manager Suite 2022 R1 (On-Premises)

You may already have an operational MID server (accessible from your chosen inventory beacon) that you wish to use
for data transfers from ServiceNow to FlexNet Manager Suite. If so, and the MID server is validated in ServiceNow, you
may skip this topic.
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On the other hand, you may prefer to set up a specific MID server especially for this integration. If so, follow these
steps while you are still logged into ServiceNow with administrator privileges.

=
[_] To set up a MID server that stages data from ServiceNow:

1.

2.

In the navigation bar, expand MID Server and click Downloads.
Click the link appropriate for your platform.

In the navigation bar, in the MID Server group, click Installation Instructions, and click the link appropriate to
your version of ServiceNow.

The documentation opens in a new tab.
Step through those instructions to complete installation of your MID server.

Take particular note of the exact name you give this MID server, as you will need it again soon. (It is also
available through MID Server > Servers.)

. Besure to validate your MID server (see the Validate the MID Server link on the MID Server installation page).

Configuring ServiceNow for Export

FlexNet Manager Suite 2022 R1 (On-Premises)

Now that you have a MID server installed, two further configuration points for ServiceNow remain:

 Identifying the MID server as the one to use for the exports to FlexNet Manager Suite

o Scheduling the exports from ServiceNow.

Continue the following while still logged into ServiceNow with administrator privileges.

-
[_] To configure ServiceNow for export:

1.

2,

In ServiceNow, go to Flexera Integration > Integration Properties.

In ServiceNow, in integration application 5.x, go to Flexera Integration > Integration Properties, or in
integration app 4.x, see FlexNet Manager Suite > Integration Properties.

In the list of Integration Properties, scroll down to the MID server name field (in the ServiceNow — FNMS
section), and enter the full name of the MID server.

Optionally, in the Export file path field, enter an alternative file path location to store the XML file (instead of the
default MID server location). Because the FlexNet Beacon reads this file using the business adapter, FlexNet
Beacon needs access to this file location.

Scroll down (if necessary), and click Save.

. In ServiceNow, in integration application 5.x, go to Flexera Integration > Export Configuration > Scheduled

Jobs, or in integration app 4.x, go to FlexNet Manager Suite > Scheduled Jobs.

The list of standard jobs to export data from ServiceNow is displayed, including:

e Export Assets from ServiceNow
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+ Export Contracts from ServiceNow.
Each of these jobs needs to be configured for your environment.
7. Add a Run as column to this page and enter the integration user ID in the column for both jobs. To do so:
a. Click the Personalized List (gear) icon in the upper left corner at the top of list of scheduled jobs.

b. On the Personalize List Columns dialog, select Run as from the Available columns and move it to the
Selected columns.

c. Onthe Scheduled Script Executions page, change the Run as user (that is blank by default) to the
integration user ID (see Creating a ServiceNow Integration User).

8. Click the first export task to schedule (such as Export Assets from ServiceNow).

The Scheduled Script Execution properties are displayed.

=X
[==| Note: The MID server collects the exported XML data in chunks, such that the XML file is not well formed until
the last chunk has been received. Be sure to schedule sufficient time for the exports to complete before the

scheduled import from the MID server into FlexNet Manager Suite.
9. Change the value in the Run field to your desired schedule.

These data exports may be large, based on the size of your ServiceNow repository. Acommon practice would be
to choose Weekly exports.

i
= Tip: ServiceNow by default limits its exports from the database to 10,000 records (for a general discussion,

see https://community.servicenow.com/community/blogs/blog/2014/08/01/increasing-the-export-limit, but
note that this page discusses limits for exports from the ServiceNow user interface grids, which are not
relevant to the database exports to FlexNet Manager Suite). You can modify the maximum number of records
exported from ServiceNow by having your ServiceNow administrator add the property
glide.db.max_view_records and setting a new limit. For instructions on adding the property, see
http://wiki.servicenow.com/index.php?title=Adding_a_Property#gsc.tab=0.

10. Use the additional fields that appear to complete configuring your scheduled job.

For example, for Weekly exports, set the Day, and Time of day, when the export should occur. An off-peak time
is preferable.

11. Click Update to save your changes.
Repeat the scheduling for the Export Contracts from ServiceNow task.

12. With both exports now scheduled, run a test of each by clicking Execute Now on the associated Scheduled
Script Execution properties page.

(This same button can be used to run the export if you chose the Run On Demand setting for the schedule.) Use
the test to assess the time taken to complete the export and finish a well-formed XML file on the MID server, as a
check on your scheduling plans. The test also allows you to troubleshoot any problems.

13. Monitor overall progress in ServiceNow by going to Flexera Integration > Export History > Export Runs in
integration application 5.x, and in integration app 4.x, go to FlexNet Manager Suite > Integration History >
Export Runs.

378 Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)


https://community.servicenow.com/community/blogs/blog/2014/08/01/increasing-the-export-limit
http://wiki.servicenow.com/index.php?title=Adding_a_Property#gsc.tab=0

Installation and Configuration

The State column on this view shows the progress of export, and the Stage column displays File
Completion when the XML file is done.

14. On the MID server, check for well-formed (complete) XML files.

The file names are of the form x_f1ls_flexera_fnms_ExportType.xml, where the placeholder ExportType
is either Asset or Contract.

This completes the configuration of ServiceNow for data flows from ServiceNow to FlexNet Manager Suite. These
same data flows also require some configuration of FlexNet Manager Suite to receive the data. This side of the
configuration is covered next.

Configuring FlexNet Beacon for Import
FlexNet Manager Suite 2022 R1 (On-Premises)

If you are not already familiar with importing business-related data to FlexNet Manager Suite, the following
terminology summary may help:

* A"business adapter" is an XML file that allows configuration of a connection to a source of business data, as well as
mapping of that data from the source format to the database tables and columns required in FlexNet Manager
Suite. The data from ServiceNow is handled as business data, and therefore data transfers make use of business
adapters.

» The "Business Adapter Studio" is a utility available on each inventory beacon for customizing and testing business
adapters.

o The "Business Importer" is the process that exercises the business adapters to the schedule you define, and
controls each import as defined in its business adapter.

In previous tasks, you have configured ServiceNow to run two exports that queue data about hardware assets and
contracts and send it to the MID server of your choice. On the MID server, the data is written into XML files. Once these
have been completed, two business adapters running on your inventory beacon collect this data and upload it to your
central operations databases. You must use the following process to configure these business adapters before they
can operate.

(4
= Tip: Clearly, the inventory beacon and the ServiceNow MID server must access a common folder for the transfer of

the XML files. It is possible that the FlexNet Beacon software and the ServiceNow MID server are installed on the
same physical machine; but if they are on separate machines, network access allowing a file share is required. This
means you may need to grant at least read access for the share on your MID server to two accounts on your
inventory beacon:

o The local administrator account with which you will log in now for configuring and testing your business adapters

« The account that runs your FlexNet Beacon Service, which will exercise the business adapters in production (by
default, this is the local SYSTEM account on your inventory beacon).

As well as access to the MID server, your inventory beacon requires access to the unzipped archive you downloaded
for the ServiceNow integration application to complete this process.
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oy
[_] To configure an inventory beacon for importing data for FlexNet Manager Suite:

1.

2,

10.

11.

12.

380

On your chosen inventory beacon, log in as a local administrator.

If necessary, validate that, from this server, you can access the file share where the MID server saves the
completed XML files.

. Inthe unzipped archive you downloaded for the ServiceNow integration application, open the Importer folder

and locate the two business adapters ServiceNowAssets.xml and ServiceNowContracts.xml.

. Copy these two files to the business adapters folder, CommonAppData%\Flexera Software\Beacon\

BusinessAdapter, on the inventory beacon.

. Start the FlexNet Beacon software from the Windows start menu on the inventory beacon, using the Run as

administrator option.

. Inthe interface for FlexNet Beacon, select the Business Importer page from the Connections group (in the left-

hand navigation pane).

The two adapters appear in the list of available business adapters.

. For each of these adapters in turn, select the adapter from the list, and click Edit.... In the following dialog, click

Edit Adapter.

The Business Adapter Studio opens, editing this adapter.

. In the Business Adapter Studio, select the top level import node (like ServiceNowAssets or

ServiceNowContracts)and locate the File name field. Complete the file path and file name for the

appropriate XML file on the MID server. If you have already exported data from ServiceNow to the MID server, you
may click the ... button and browse to the respective XML file in the folder on the MID server.

The following example from the assets adapter shows a path when the MID server and inventory beacon are
installed on the same physical computer:

C:\ServiceNow\MyMIDServerFolder\agent\x_fls_flexera_fnms_asset.xml

The following example from the contracts adapter shows a path when the MID server is separate, using UNC
format:

\ \MyMIDServer\ServiceNow\MyMIDServerFolder\agent\
X_fls flexera_fnms_contracts.xml

. When the file path and name are identified, click Refresh (just below the ... button).

Save the modified adapter; and repeat the process for the other adapter.
When both are completed and saved, close Business Adapter Studio.

If you have not already created the schedule(s) on which you want to run these adapters, switch to the
Scheduling page of the FlexNet Beacon interface, and create one or two now.

You may run these two business adapters on the same schedule, as the inventory beacon queues them and

runs them one after the other.

|_b Important: Remember that there is a delay between when the scheduled job starts executing in Service
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Now, and when the MID server finishes assembling the transmitted chunks into a valid XML file. You can test
the elapsed time for your environment by triggering each export, and waiting until, in the Export Runs view
(in ServiceNow), it reaches the Succeeded state. Allow a safety buffer for future data growth, and set the
schedule for the business adapters to run after the exports and assembly of the XML files are completed.

13. In the Business Importer page of the FlexNet Beacon, select each adapter in turn, and:
a. Click Schedule....
b. From the list of available schedules, select the one for each adapter.
c. Click OK.
d. Ensure that the adapter is marked as Enabled.
e. Repeat for the other adapter.
14. At the bottom of the inventory beacon interface, click Save to store your changes.

15. Optionally, if you have test data waiting for a system check, you can select each adapter in turn, and click
Execute Now.

The Business Importer takes the raw data from XML files, transforms it into the formats required for FlexNet
Manager Suite, and uploads it to the central application server.

To check the status of imports, in the web interface of FlexNet Manager Suite, navigate to the system menu (%" ¥ in the
top right corner) and choose either Data Inputs (in the Business Data tab) or System Health > System Tasks.

¥

= Tip: If you need to interrupt the export from ServiceNow, disable the scheduled jobs in ServiceNow, and disable the
relevant schedule(s) in FlexNet Beacon.
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Operational Details

FlexNet Manager Suite 2022 R1 (On-Premises)

The exchange of data between ServiceNow and FlexNet Manager Suite happens in a pair of independent processes
driven by schedules (either Windows scheduled tasks or schedules built in to the products).

As these schedules by default run on a weekly cycle, you may expect the data to be synchronized after the weekly runs
and up until either system is subsequently updated. If you require an intermediate synching after an important update
to one system or the other, you can also trigger either process manually.

The process flows are described in detail in the following topics. Notes about configuration and customization are
included.

For your on-premises implementation of FlexNet Manager Suite, the command-line utility is also documented here,
should you choose to run that directly.

Process for Exports from FlexNet Manager
Suite to ServiceNow

FlexNet Manager Suite 2022 R1 (On-Premises)
A Windows scheduled task Export to ServiceNow triggers exports to ServiceNow at 3am every Sunday morning.

If you are in an administrator role, you can also trigger an export through the web interface for FlexNet Manager Suite.

Navigate to the system menu (#" ¥ in the top right corner) and choose System Settings > Integrations. Expand the
ServiceNow section.

Process Details
1. On the central application server, when the export is triggered, a utility is launched that:

o Checks whether you have licensed the ServiceNow integration option from Flexera (if not, it shows an error in
the same page of the web interface).

o Tests your ServiceNow credentials in the ServiceNow export settings section of System Settings >
Integrations.
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2. Next, the utility checks whether ServiceNow is able to accept an import at this time:

o It checks whether arecord in Scheduled Data Imports,andanotherinData Sources,have been created
by the integration application. (Links to the relevant pages where you can inspect the records in ServiceNow
are under Flexera Integration > Advanced in integration application 5.x and in integration app 4.x under

FlexNet Manager Suite > Advanced.)

« Itensures that no prior import is already in process, checking that there is no record in the Import Runs table
orthe Import Transactions table that are incomplete (that is, have a State other than Succeeded or

Failed). Both lists are available for inspection in the FlexNet Manager Suite Integration History group.

If either of the checks fails, the utility abandons the export and displays an appropriate error.

3. The utility checks the connection with the operations databases for FlexNet Manager Suite. (If there is any failure,
the utility abandons the export and displays an appropriate error.)

4. All being well, the data export, transfer, and import processes are run for all data types (unless any of them have
been specifically excluded) in the following order:

a. Hardware inventory
b. Contracts

c. Installed applications

& Caution: In ServiceNow, contracts and installed applications both have dependencies on hardware
inventory. It is recommended that you do not exclude the hardware inventory, as this may result in
unpredictable gaps in other records when the correct dependencies cannot be established.

The data is collected in the way specified by the command-line options, for which see Command-Line Tool
for Export to ServiceNow. To prevent timeout issues, each data set is split into segments for transfer to
ServiceNow. Each segment is identified with a transaction ID, transaction type, and the data in an XML
chunk. ServiceNow returns a return code for each segment of data.

o If the return code shows a failure, the segment is retransmitted for a maximum number of tries (the
default value of 10 can be changed in the configuration file), after which the utility exits (skipping any
remaining exports) and returns 1 to the command line.

» While success continues, the utility waits for each data type to complete before commencing the next data
type.

5. In ServiceNow, as the first data chunk is received, the integration application creates a record in the Import Runs
table. (For details of the main columns in the Import Runs table, see Import Runs Columns.)

=

|| Note: If you have selected to store installed application data to SAM Foundation Plugin tables but the SAM
plugin is not found, then ServiceNow logs an error in the Application Log and returns an error code. In FlexNet
Manager Suite, the utility abandons the export and displays an appropriate error in the log file.

6. Foreach data chunk (including the first), ServiceNow creates a record in the Import Transactions table. (For

details of the main columns in the Import Transactions table, see Import Transactions Columns.)

7. When the transaction record is created, it returns a success code to FlexNet Manager Suite, which then processes
and transmits the next data chunk. This loop continues until all the records of a particular export type have been
transmitted.

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)

383



Operational Details

8. In ServiceNow, the inbound data chunks are written to staging tables (visible in the navigation panel under
Flexera Integration > Staging Records in integration application 5.x and in integration app 4.x under FlexNet
Manager Suite > Staging Records ) based on the transaction type:

inventory_export Inventory Imports (note that thisis hardware inventory)
application_export Application Imports

contract_export Contract Imports

connection_test Not applicable

export_status Not applicable

9. In ServiceNow, the integration application uses the Scheduled Data Imports andData Sources records to
process each Import Transaction record. The integration application queues the transaction records, and as
each record is processed, it sets its State to Succeeded. When all the transaction records for an Import Run are
completed, the integration application also sets its State to Succeeded.

10. During this processing loop, FlexNet Manager Suite continues polling the API for status. Only when it receives a
successful completion message does it resume the process with the next selected data type.

11. When the data has been collated from the individual transactions to the staging tables, transform maps are
executed to map the fields in the import set tables to fields in ServiceNow database tables. The final tables for
data from each transaction type are shown below. (For a complete set of the transform mappings, see Transform
Maps for ServiceNow Integration.)

Transaction type Ultimate Data Tables in ServiceNow

application_export Software Model,Discovery Model, Software
Installation,and Software Instance. Thetablesused are
dependent upon the Use CMDB and/or SAM tables for
installation integration property. For more information about
integration properties, refer to Integration Properties.

contract_export Contract and Lease Instance
|r-:|
= Tip: Check the Contract used by tab near the bottom of the

page of contract properties. This references all computers
linked to the contract.

inventory_export Product Model,Virtual Machine Instance,Computers

At the completion of this process, data exported from FlexNet Manager Suite is reflected in your ServiceNow data set.

Import Runs Columns
FlexNet Manager Suite 2022 R1 (On-Premises)

These are the major properties of the entries in the Import Runs view created as ServiceNow commences each data
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import. In integration app 5.x go to Flexera Integration > Import History > Import Runs and in integration app 4.x,
go to FlexNet Manager Suite > Integration Runs > Import Runs.

Column Notes

Number An automatically-generated sequential numbering of each created record in this
listing.
Import Id A GUID created by FlexNet Manager Suite as it exports the data, used to track activity

and exchanges for this particular import into ServiceNow.

Import Type The type of data being imported, being one of Inventory, Contract, or
Application.
State Values include:

o New — This default state is set when a record is created in the Import Runs listing.

o Waiting — ServiceNow has received the final data chunk for the particular

Import Type.

e Succeeded — All data chunks for this Import Run have been processed by

ServiceNow.

e Failed — For some reason (unspecified here), the import has failed.

Import Transactions Columns
FlexNet Manager Suite 2022 R1 (On-Premises)

These are the major properties of the entries in the Import Transactions view created as ServiceNow receives each
data segment for import. In integration app 5.x go to Flexera Integration > Import History > Import Transactions
and in integration app 4.x, go to FlexNet Manager Suite > Integration Runs > Import Transactions.

Column Notes

Number An automatically-generated sequential numbering of each created record in this
listing.

Import Run The ID of the import run of which this transaction is a part.

Import Type The type of data being imported, being one of Inventory, Contract, or
Application.
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Column Notes

State Values include:
¢ New — This default state is set when a record is created in the Import Transactions
listing.
+ Waiting — ServiceNow is processing another transaction received earlier.

e Processing — Set when the integration application invokes import of this

transaction.
o Succeeded — ServiceNow has completed the import of this transaction.

e Failed — For some reason (unspecified here), the import of the transaction has
failed.

Payload The segment of data, in XML format, that makes up this transaction.

Transform Maps for ServiceNow Integration
FlexNet Manager Suite 2022 R1 (On-Premises)

These transform maps map hardware, license, and contract data collected from FlexNet Manager Suite into
ServiceNow.

Data collected from FlexNet Manager Suite is initially held in staging tables within ServiceNow, and must be
transformed for insertion in the operational tables in your ServiceNow implementation. For example, the FNMS
Inventory -> Computer sethas columns that are matched with the Computers table in ServiceNow. Contract
data is first mapped into the Contracts table in ServiceNow, and a second transform map is run to provide links to
relevant Configuration Items (Computers).

The following tables show the standard transformations from the staging tables (the source) to operational tables (the
target) within ServiceNow. Items marked [Script] involve a data transformation, which may involve finding the
foreign key to another record, or conversion of units such as bytes to MB.

In each transform, the "(key)" fields are used for record matching. If a record already exists with identical key values
for fields so marked, it is updated; and if not, a new record is created.

D Note: There are integration properties that define:
o Whether a new record should be created in ServiceNow when a match for incoming data is not found
» Whether an existing record should be updated when a match is found

These properties can be modified in ServiceNow by navigating Integration Properties. In integration app 5.x go to
Flexera Integration > Integration Properties and in integration app 4.x, go to FlexNet Manager Suite >
Integration Properties.

The transform maps in this topic are separated into the following respective data group that they are used for:

o Transform maps for inventory data
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¢ Transform maps for installed application data

» Transform maps for contracts data

Transform maps for inventory data

Computer Model Transform

o Original data from FlexNet Manager Suite: Inventory

o Target tablein ServiceNow: Product Model [cmdb_model]

Source Display Name

ModelNo (key)
ChassisType
ComputerType
Manufacturer

ModelNo

Source Field
u_modelno
u_chassistype
u_computertype
u_manufacturer

u_modelno

Virtual Machine Transform

Target Display Name
Model number
Type
Model categories
Manufacturer

Name

» Original data from FlexNet Manager Suite: Inventory.

Target Field

model_number

type

cmdb_model_category

manufacturer

name

o Targettablein ServiceNow: Virtual Machine Instance [cmdb_ci_vm_instance]

Source Display Name

ComputerlD (key)
[Script]

[Script]

[Script]

[Script]

[Script]
ComputerName
Domain
IPAdress
MACAddress
Manufacturer
ModelNo

ModelNo
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Source Field
u_computerid
[Script]

[Script]

[Script]

[Script]

[Script]
u_computername
u_domain
u_ipaddress
u_macaddress
u_manufacturer
u_modelno

u_modelno

Target Display Name

FlexNet Computer ID
Is deleted
Correlation ID
Class

Disks size (GB)
Memory (MB)
Name

Domain

IP Address
MAC Address
Manufacturer
Model ID

Model number

Target Field

Operational Details

x_fls_flexera_fnms_computer_id

x_fls_flexera_fnms_is_deleted

correlation_id
sys_class_name
disks_size
memory

name
sys_domain
ip_address
mac_address
manufacturer
model_id

model_number
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Source Display Name Source Field Target Display Name Target Field

NumberOfProcessors u_numberofprocessors  CPUs cpus
SerialNo u_serialno Serial number serial_number
Computer Transform

« Original data from FlexNet Manager Suite: Inventory

o Target table in ServiceNow: Computer [cmdb_ci_computer]

Source Display
Name

ComputerlD (key)
[Script]

[Script]

[Script]

AssetID
CalculatedUser
ChassisType
ComputerName

ComputerStatus

ComputerType
DiscoveredDate
Domain

InventoryConnection
Name

InventorySource
IPAddress
IsDeleted
LastLoggedInUser
MACAddress
Manufacturer
MaxClockSpeed

ModelNo
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Source Field

u_computerid
[Script]

[Script]

[Script]

u_assetid
u_calculateduser
u_chassistype
u_computername

u_computerstatus

u_computertype
u_discovereddate

u_domain

u_inventoryconnection

name
u_inventorysource
u_ipaddress
u_isdeleted
u_lastloggedinuser
u_macaddress
u_manufacturer
u_maxclockspeed

u_modelno

Target Display
Name

FlexNet Computer ID
RAM (MB)
Correlation ID

Disk space (GB)
FlexNet Asset ID
Calculated User
Chassis type

Name

Status
(hardware_status)

Subcategory
Discovered date
Domain

Inventory Connection

Inventory Source
IP Address

Is deleted

Last logged in user
MAC Address
Manufacturer

CPU speed (MHz)

Model ID ->
model_number

Target Field

x_fls_flexera_fnms_computer_id
ram

correlation_id

disk_space
x_fls_flexera_fnms_asset_id
x_fls_flexera_fnms_calculated_user
chassis_type

name

hardware_status

subcategory
x_fls_flexera_fnms_discovered_date
sys_domain

x_fls_flexera_fnms_inventory_connection

x_fls_flexera_fnms_inventory_source
ip_address
x_fls_flexera_fnms_isdeleted
x_fls_flexera_fnms_last_logged_in_user
mac_address

manufacturer

cpu_speed

model_id
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Source Display Source Field Target Display Target Field

Name Name
ModelNo u_modelno Model number model_number
NumberOfCores u_numberofcores CPU core count cpu_core_count
NumberOfProcessors  u_numberofprocessors CPU count cpu_count
NumberOfThreads u_numberofthreads CPU core thread cpu_core_thread
OperatingSystem u_operatingsystem Operating System 0s
ProcessorType u_processortype CPU type cpu_type
SerialNo u_serialno Serial number serial_number

Transform maps for installed application data

Software Transform
¢ Used when you opt to use CMDB tables for Installed Application data.
« Original data from FlexNet Manager Suite: Application.

o Target table in ServiceNow: Software [cmdb_ci_spkg]

Target Field

Source Display Name Source Field Target Display Name
FlexeralD (key) u_flexeraid Flexera Unique ID
ApplicationID u_applicationid FlexNet Application ID
ApplicationName u_applicationname Package name
ApplicationVersion u_applicationversion Version
Classification u_classification Subcategory
ProductName u_productname Name
Publisher u_publisher Manufacturer

Software Instance Transform
» Used when you opt to use CMDB tables for Installed Application data.

« Original data from FlexNet Manager Suite: Application.

x_fls_flexera_fnms_id
x_fls_flexera_fnms_application_id
package_name

version

subcategory

name

manufacturer

o Targettable in ServiceNow: Software Instance [cmdb_software_instance]

7

/
‘" Tip: When application data is imported into ServiceNow, the installed application records are linked to their

computer record based on FLlexNet Computer ID. Thisis recommended and the most reliable way to link

records. However, if for any reason you need to link records based on Computer Serial Number; note that the

installed application records do have Computer Serial Number available and therefore you can manually edit

the transform map in ServiceNow to change the key to be Computer Serial Number.
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Source Display Name Source Field Target Display Name Target Field
FlexeralD (key) u_flexeraid Software -> Product Product Name
Name
[Script] (key) [Note 1] [Script] Installed on installed_on
[Script] [Script] Is deleted x_fls_flexera_fnms_is_deleted
DiscoveredAt u_discoveredat Discovered at x_fls_flexera_fnms_discovered_at
DiscoveredBy u_discoveredby Discovered by x_fls_flexera_fnms_discovered_by
FlexeralD u_flexeraid Flexera Unique ID x_fls_flexera_fnms_id
LastScanned u_lastscanned Last scanned x_fls_flexera_fnms_last_scanned
ProductName u_productname Name name
Note:

1. Aninstalled application record defines the installation of an application on a computer. A source record from
FlexNet Manager Suite in the Application Import [x_fls_flexera_fnms_application_import] table
has these values.

The import process creates or updates such a record in ServiceNow in the Software Instance
[cmdb_software_instance] table. The record links an application record in the Software
[cmdb_ci_spkg] table and a computer record in Computer [cmdb_ci_computer].

Field map, [Script] (key), finds a computer record in the Computer table based on source ComputerID
[u_computerid] inthe target FlexNet Computer ID [x_fls_flexera_fnms_computer_id] field.
Another field map, FlexeraID (key) finds an application record in the Software table based on the source
FlexeraID [u_flexeraid] fieldinthe target Flexera Unique ID [x_fls_flexera_fnms_id] field.

Software Model Transform
¢ Used when you opt to use SAM tables for Installed Application data.

« Original data from FlexNet Manager Suite: Application

o Target tablein ServiceNow: Software Model [cmdb_software_product_model]

Source Display Source Field Target Display Name  Target Field
Name
FlexeralD (key) u_flexeraid FlexNet Manager Id x_fls_flexera_fnms_id
ApplicationName u_applicationname FlexNet Application x_fls_flexera_fnms_application_name
Name
ApplicationVersion u_applicationversion Version version
Classification u_classification Type type
FlexeralD u_flexeraid Short description short_description
ProductName u_productname Name name
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Operational Details

Source Field

Target Display Name

Target Field

Name

Publisher

u_publisher Manufacturer manufacturer

Software Installation Transform

Used when you opt to use SAM tables for Installed Application data.

« Original data from FlexNet Manager Suite: Application

o Targettablein ServiceNow: 1abel [cmdb_sam_sw_install]

"

,,HJ

Source Display Name

ApplicationID (key)

Tip: When application data is imported into ServiceNow, the installed application records are linked to their
computer record based on FlexNet Computer ID. Thisis recommended and the most reliable way to link
records. However, if for any reason you need to link records based on Computer Serial Number; note that the
installed application records do have Computer Serial Number available and therefore you can manually edit
the transform map in ServiceNow to change the key to be Computer Serial Number.

Source Field Target Display Name Target Field

u_applicationid FlexNet Application ID x_fls_flexera_application_id

[Script] (key) [Note 1] [Script] Installed on installed_on
[Script] [Script] Is deleted x_fls_flexera_fnms_is_deleted
ApplicationVersion u_applicationversion Version version

DiscoveredAt

DiscoveredBy

u_discoveredat Last Discovered x_fls_flexera_fnms_last_discovered

u_discoveredby Discovered by x_fls_flexera_fnms_discovered_by

DisplayName u_displayname Display name display_name
FlexeralD u_flexeraid Discovery model -> discovery_model
prod_id
FlexeralD u_flexeraid Prod id prod_id
LastScanned u_lastscanned Last scanned last_scanned
Publisher u_publisher Publisher publisher
Note:

1. Aninstalled application record defines the installation of an application on a computer. A source record from

FlexNet Manager Suite in the Application Import [x_fls_flexera_fnms_application_import] table
has these values.

The import process creates or updates such a record in ServiceNow in the Software Installation
[cmdb_sam_sw_install] table. The record links an application record in the Software Discovery Model
[cmdb_sam_sw_discovery_model] table and a computer record in Computer [cmdb_ci_computer].

Field map, [Script] (key), finds a computer record in Computer table based on source ComputerID
[u_computerid] inthe target FlexNet Computer ID [x_fls_flexera_fnms_computer_id] field.
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Another field map, FlexeraID (key) finds an application record in the Software Discovery Model table
based on the source FlexeraID [u_flexeraid] field inthe target Prod ID [prod_id] field.

Transform maps for contract data

Contracts Transform

o Original data from FlexNet Manager Suite: Contracts

o Targettablein ServiceNow: Contract [ast_contract]

Source Display Name Source Field Target Display Name Target Field
ContractNumber (key) u_contractnumber Contract number vendor_contract
ContractName u_contractname Description short_description
ContractStatus u_contractstatus State state
ContractType u_contracttype Short Description short_description
EndDate u_enddate Ends ends
IsDeleted u_isdeleted Is deleted x_fls_flexera_fnms_is_deleted
StartDate u_startdate Starts starts
Vendor u_vendor Vendor vendor

Contract Instance Transform
« Original data from FlexNet Manager Suite: Contracts

o Targettablein ServiceNow: Lease Instance [ast_contract_instance]

Source Display Name Source Field Target Display Name Target Field

ContractNumber (key) u_contractnumber Contract ast_contract ->
vendor_contract

ContractType u_contracttype Contract Type contract_type

See note. See note. Configuration Item ci_item

Note: Script is run to query cmdb_ci_computer table. If the Cl is found, the script returns the sys_1id for REF. If
the Cl is not found, this field is left blank.

Command-Line Tool for Export to ServiceNow

FlexNet Manager Suite 2022 R1 (On-Premises)

This tool extracts data from the FlexNet Manager Suite operations database, and imports it into ServiceNow.

Note: This utility may be triggered in three different ways:
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» Automatically by a scheduled task

Operational Details

« Manually by an operator through the web interface for FlexNet Manager Suite. Navigate to the system menu (# ¥

in the top right corner) System Settings > Integrations.

e From the command line, as described in this topic.

In all cases, it exports the data specified to ServiceNow. However, when it is run manually from the command line,
the behavior of the utility then differs: it does not update the results in the web interface for FlexNet Manager Suite.
For this reason, automatic operations are the preferred method of operation; but this command line is available for

testing and troubleshooting.

Syntax:

fnmp_servicenow_export.exe
-url ServiceNow-URL
-user ServiceNow-account-name
-token ServiceNow-token
-endpoint ServiceNow-endpoint
-changes Boolean
-changesPeriod -numberOfDays
-changesSince YYYY-MM-DD
-connectionTest true
-withApplications Boolean
-withContracts Boolean
-WithHardwarelnventory Boolean

Option Sample value
-url https://YOUR-

INSTANCE .service-now.com
-user account@mydomain.com
-token 86 random alpha-numeric characters
-endpoint fnmp.do orapi/

x_fls_flexera_fnms/
integration/fnmstosn

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition)

Notes

Mandatory. The URL to your ServiceNow server
instance in the cloud. Use the HTTPS protocol.

Mandatory. This is the user name specified in the
appropriate credentials set within ServiceNow, the
same credentials from which the token is collected.

Mandatory. This is the refresh token copied from
ServiceNow.

Mandatory. Leave the value unchanged. This is the
integration point for ServiceNow.

)
!

Tip: While the endpoint is visible in ServiceNow
and could be modified there, it is also recorded in
the operations database for FlexNet Manager
Suite. Changing it in ServiceNow without a
matching change in the operations database will
cause automated exports to fail.
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Option Sample value Notes

-changes true Optional, with a default of true if it is not present.
When this option is not present, or when it is present
with a value of true (case insensitive), only
differential changes are included in all data exports
to ServiceNow. For the baseline from which
differences are measured, see the -changesSince or
-changesPeriod options. When this option is
present and has a value false, all data (from the
relevant period) is exported from the relevant tables
in FlexNet Manager Suite (which is likely to make the
data transforms in ServiceNow considerably more
time-consuming).

II':-- Tip: You may use the default value even for an
initial data transfer, or for the first transfer after
an upgrade from an earlier version of the
executable. Initial transfers are always the full
data set, with differential transfers following

thereafter.

-changesPeriod -5 Optional (no effect when not present). When
present, specifies the time window (as a number of
days) before the export for which changes are
included in the export. The negative sign is
mandatory. The example means that changes in the
previous five days are exported. Days are measured
as complete 24-hour blocks prior to the time of the
export.

-changesSince 2015-02-28 Optional. Use only when necessary to over-ride the
default date, which is the last run of the batch
scheduler on the central batch server for FlexNet
Manager Suite (or, for smaller on-premises
implementations, the server hosting this
functionality). The format is YYYY-MM-DD.

-connectionTest  true Optional. If this option is provided, and has a value
true (case insensitive), no data exports are
attempted. The executable attempts a connection to
ServiceNow, and reports the results (0 or 2 as
described below) on the console. In order to transfer
data from FlexNet Manager Suite to ServiceNow, this
parameter must either be omitted, or set to false.
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Option Sample value Notes

-withApplications false Optional. When omitted, it is assumed to be true,
and insatalled applications are included in the
export. If set to false, installed applications are
excluded from the export. Note that at least one of
these -with* parameters must be true.

-withContracts false Optional. When omitted, it is assumed to be true,
and contracts are included in the export. If set to
false, contracts are excluded from the export. Note
that at least one of these -with* parameters must

be true.
-WithHardware false Optional. When omitted, it is assumed to be true,
Inventory and hardware devices are included in the export. If

set to false, hardware devices are excluded from
the export. Note that at least one of these -with*
parameters must be true.

f'i\, Caution: In ServiceNow, contracts and installed
applications both have dependencies on
hardware inventory. It is recommended that you
do not exclude the hardware inventory, as this
may result in unpredictable gaps in other records
when the correct dependencies cannot be

established.
Exit Codes

0 Success

1 A data upload to ServiceNow has failed through the maximum number of retries set in the
configuration file.

2 Connection failure, being either of:
« Failed to connect to ServiceNow. Check the URL and account details for connection.
« Failure to connect to the FlexNet Manager Suite compliance database.

3 There is no valid license for execution of the export utility recorded for your enterprise.

4 Incomplete set of command-line parameters provided (see syntax listing above). Help information
is displayed in this case.

5 An invalid tenantUId was provided. (Not applicable to on-premises implementations.)

6 Export from FlexNet Manager Suite cannot proceed because ServiceNow has not completed

previous pending imports.
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Example: Examples

This example runs a connection test (because of the final parameter). Although the defaults are set for all data
transfers (installed applications, contracts, and hardware inventory), no exports occur. The command-line
result is @ for good credentials, and 2 for bad credentials.

fnmp_servicenow_export.exe
-token
DbBNKvekyBVGFxPXe7TAGooeyb5bsByB2jSubap2321AkerucGHn5Sn1aQasincR89. ..
-user myname@mycorp.com
-url https://myserver.service-now.com
-endpoint fnmp.do
-connectionTest true

The following example restricts the export to collect only hardware inventory. Because it is not mentioned, the
default true value includes hardware inventory, with the other two possibilities excluded. Because the
-changes and -changesSince options are both missing, only hardware changes occurring since the last

scheduled export are included.

fnmp_servicenow_export.exe

-token
DbBNKvekyBVGFxPXe7TAGooeyb5bsByB2jSubap2321AkerucGHn5Sn1aQasincR89. ..

-user myname@mycorp.com

-url https://myserver.service-now.com

-endpoint fnmp.do

-withContracts false

-withApplications false

This example covers all export types from FlexNet Manager Suite, but including only changes that occurred in
the previous 3 days, measured back in 24-hour blocks from the time the export is run. Assuming this example
is run at 1pm Thursday, it will export only changes from 1pm Monday to 1pm Thursday (all times are local on
the batch server). Strictly, -changes true is redundant, since this is the default.

fnmp_servicenow_export.exe

-token
DbBNKvekyBVGFxPXe7TAGooeyb5bsByB2jSubap2321AkerucGHn5Sn1aQasincR8&9. ..

-user myname@mycorp.com

-url https://myserver.service-now.com

-endpoint fnmp.do

-changes true

-changesPeriod -3
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Process for Exports from ServiceNow to
Process for Exports from FlexNet Manager
Suite to ServiceNow

FlexNet Manager Suite 2022 R1 (On-Premises)

How the import of data from ServiceNow works.

Process Details

1. Two scheduled jobs are run separately (and not at the same time) in ServiceNow.

D Note: These jobs are visible in Export Configuration > Scheduled Jobs (or Scheduled Jobs in 4.x) as Export
Assets from ServiceNow and Export Contracts from ServiceNow. Click the job names to make
them active or inactive, to modify the schedule, or to execute either one immediately.

2. When either job is executed, ServiceNow creates an XML file on the MID server with the data from the database
view. (In integration app 5.x go to Flexera Integration > Export Configuration > Database Views and in
integration app 4.x, go to FlexNet Manager Suite > Database Views.) The filename is
x_fls_flexera_fnms_asset.xml forassets or x_fls_flexera_fnms_contract.xml for contracts. The files
are overwritten with every export.

(]
W Tip: Within the Database Views, you can specify additional tables to join to the database view, or within a

table, you can add additional columns to join to the database view. To preview the records for an export
(without actually invoking the export), click the view name in that page to display the properties of the view;
and under the Related Links heading, click Try It.

3. After the export is executed in ServiceNow, a record is created under Export Runs, In integration app 5.x go to
Flexera Integration > Export History > Export Runs and in integration app 4.x, under FlexNet Manager Suite >
Integration History > Export Runs. ServiceNow updates the state of this record to Succeeded when the export is
successfully completed.

4. Two independent business adapters from FlexNet Manager Suite (on potentially independent schedules) connect
from your inventory beacon to your MID server, and collect the latest XML files saved there, converting them into
the intermediate data form required for business data uploads. (For details of the mapping between source data
in ServiceNow and destination fields in the FlexNet Manager Suite database, see Business Adapter Mappings.)

I} Important: The business adapters will fail if they are run while the XML files on the MID server are incomplete.
Be sure that the schedules for export from ServiceNow, and the running of the business adapters, allow
sufficient time for the export to be completed. For large data sets, this may be several hours.

5. Asthe adapters complete their run, the data set is uploaded immediately to the application server for FlexNet
Manager Suite. (There is also a catch-up upload task that runs overnight to retry any failed uploads.)

6. On aseparate schedule, the batch server starts a business import job. This imports data from the data package
into the FlexNet Manager Suite database.
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At the completion of this process, data exported from ServiceNow is reflected in your FlexNet Manager Suite data set.

Properties for Export Columns
FlexNet Manager Suite 2022 R1 (On-Premises)

These are the major properties of the entries in the Export Runs view created as ServiceNow commences each data
export. In integration app 5.x go to Flexera Integration > Export History > Export Runs and in integration app 4.x,
under FlexNet Manager Suite > Integration History > Export Runs.

Column Notes

Number An automatically-generated sequential numbering of each created record in this
listing.

Export Type The type of data being exported, either Contract or Asset.

Stage May have the following values:

e File Creation — Displayed when the integration application sends the opening
XML tag to the MID Server to be commence writing the XML file.

e Data Collection — Displayed while the integration application gathers the data
and sends it to MID Server to be written into the XML file. The data is sentin
multiple chunks of 500 records each.

e File Completion — Displayed when the closing XML tag has been sent to the
MID Server.

State Provides additional insight into the Data Collection stage in particular. Values

include:

o New — This default state is set when a record is created in the Export Runs listing.

e Processing — Theintegration application is reading from the ServiceNow

database and compiling a chunk of data.

o Processed — All database records required for the current chunk (maximum: 500)

have been prepared.
e Waiting — The data chunk is being transferred to the MID server.

e Ready — The MID server has notified that the data chunk has been added to the
XML file. At this point, the integration application sets the state back to
Processing and prepares the next chunk of data.

o Succeeded — All data chunks have been transferred, and no more are required.

e Failed — For some reason (unspecified here), the export has failed.
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Column Notes

Counter The number of database records that the integration application has read and
processed. Because the data is transferred to the MID server in a number of chunks,
the counter value is used as a cursor for reading the correct records from the
database for the next data chunk.

Business Adapter Mappings
FlexNet Manager Suite 2022 R1 (On-Premises)

Two business adapters are supplied as a standard part of the ServiceNow integration application for FlexNet Manager
Suite, and are used in the process of transferred asset and contract data from ServiceNow to FlexNet Manager Suite.
The following lists show the source data from ServiceNow, and the target (destination) fields in FlexNet Manager Suite,
for each of these adapters in turn.

7
' Tip: For special purposes, mappings can be added, removed, or changed by editing the business adapter(s) in
Business Adapter Studio on your inventory beacon.

In each listing, the first field shown is used for matching existing records (a key). During import, if the value in this field
already exists in the compliance database, the record is updated with the other values imported for this item.
Otherwise, a new record is automatically created in FlexNet Manager Suite.

In both listings below, "display" names are the names visible in the two products' web interfaces; and the Source
Field column shows a compound name made up of:

¢ An abbreviated reference to a ServiceNow database table name (see below)
¢ Anunderscore character
o The field name in the relevant database table (which name may contain additional underscores).

The mapping of the abbreviated references to the actual database table names in the ServiceNow database is:

e acntrctrepresentsast_contract

e ahrdwr represents alm_hardware

e cicomprepresents cmdb_ci_computer
* cmdbmdl represents cmdb_model

o Sysusr represents sys_user.

Assets Imports

o Business adapter file name: ServiceNowAssets.xml
» Original data source: ServiceNow database view x_f1ls_flexera_fnms_asset

« Destination table in FlexNet Manager Suite database: Asset
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Source Display Name

Source Field

Target Display Name

Target Field

Serial number
Asset tag

Asset Status
Configuration Item
Installed
Manufacturer

ModelNo

Notes:

cicomp_serial_number
ahrdwr_ asset_tag
ahrdwr_install_status
ahrdwr_ci
cicomp_install_date
cicomp_manufacturer

cicomp_model number

Serial Number
Asset Tag
Asset Status
Name
Installed on
Manufacturer

ModelNo

SerialNumber (key)
AssetTag
AssetStatus
ShortDescription
InstallationDate
Manufacturer

ModelNo

1. AssetStatusIDis aforeign key to the AssetStatus table, from which display values are drawn.

Note: AssetStatus is a mandatory field for asset records in FlexNet Manager Suite. If a record in ServiceNow has

a Status value that does not exist in FlexNet Manager Suite:

o The new status value is inserted into the AssetStatus table (you may also need to customize localized values of

this status, if other languages are in use within your enterprise)

o AnAssetStatus is automatically created for this new entry

e« TheAssetStatus is inserted into the asset record.

Ifyou are 'round-tripping' this data (that is, copying it back from FlexNet Manager Suite to ServiceNow at some
future point, to maintain synchronization), the new value is returned when appropriate.

Contracts Imports

» Business adapter file name: ServiceNowContracts.xml
» Original data source: ServiceNow database view x_f1s_flexera_fnms_contract

o Destination table in FlexNet Manager Suite database: Contract

Source Display Name Source Field Target Display Name Target Field

Contract number acntrct_vendor_ contract Contract Number ContractNo (key)

Description acntrct_description Information Comments

Display name cmdbmdl_display_name Contract type ContractTypelID [Note
1]

Ends acntrct_ends Expiry date EndDate

Short description acntrct_short_description Contract Name ContractName

Starts acntrct_starts Start date StartDate
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Source Display Name Source Field Target Display Name Target Field
State acntrct_state Status ContractStatusID
[Note 2]

Notes:
1. ContractTypelIDisa foreign key to the ContractType table, from which display values are drawn. Also see

note below.

2. ContractStatusIDisa foreign key to the ContractStatus table, from which display values are drawn.

Note: ContractTypelID is a mandatory field for contract records in FlexNet Manager Suite. If a record in
ServiceNow has a Display name value that does not exist in FlexNet Manager Suite:
o The new contract type is inserted into the ContractType table (you may also need to customize localized values
of this type, if other languages are in use within your enterprise)
e AnContractTypelD is automatically created for this new entry

e The ContractTypelD is inserted into the contract record.

Ifyou are 'round-tripping' this data (that is, copying it back from FlexNet Manager Suite to ServiceNow at some
future point, to maintain synchronization), the new value is returned when appropriate.
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Appendices

FlexNet Manager Suite 2022 R1 (On-Premises)

The following topics cover removal of any previously-installed legacy integration application (any version less than 4.0),
and improving the performance of ServiceNow with additional database indexes. A possible exception in the
ServiceNow log files is also explained.

Integration Properties

FlexNet Manager Suite 2022 R1 (On-Premises)

The Integration Properties page lets you specify export integration properties. In integration application 5.x, page is
accessible from Flexera Integration > Integration Properties, or in integration application 4.x, it is available from
FlexNet Manager Suite > Integration Properties. The integration properties let you choose whether to accept FlexNet
Manager Suite as the source of truth for various data types. Choosing No for any option sets ServiceNow as the source
of truth for that property and choosing Yes for any option sets FlexNet Manager Suite as the source of truth for that

property.

The descriptions in the following sections show you which properties are for use with exports from ServiceNow and
which properties are for use with exports from FlexNet Manager Suite.

Properties used when exporting from ServiceNow for input to FlexNet Manager Suite

The following table provides descriptions of properties to use when exporting from ServiceNow for input to FlexNet
Manager Suite.

Setting/Property Description

Exclude virtual machine assets Choose whether to exclude virtual machine assets from
the export from ServiceNow.

MID server name Enter the full name of the MID server.
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Export file path

Configure the log verbosity (View the Application logs
at System Logs - System Log - Application logs)

Appendices

Description

Optionally, enter a file path for where to store the
exported XML data file from ServiceNow (instead of
storing it in the default MID server location). Because the
FlexNet Beacon reads this file using the business
adapter, FlexNet Beacon needs access to this file
location.

Choose the desired level of log verbosity:

« Error

« Warning

+ Information
« Debugging

» Tracing

Properties used when exporting from FlexNet Manager Suite for input to ServiceNow

The following table provides descriptions of properties to use when exporting from FlexNet Manager Suite for input to

ServiceNow.

Setting/Property Description

FlexNet Manager Suite is source of truth for:

Choose Yes to accept FlexNet Manager Suite as the
source of truth for any of the following:

« Addinginventories

o Updating inventories

« Updating inventory class name (sys_class_name)
» Addinginstallations

« Updating installations

« Adding contracts

« Updating contracts

Choose No to any of the above settings to specify
ServiceNow as the source of truth for that setting.
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Setting/Property Description

Use CMDB and/or SAM tables for installations Choose what tables in ServiceNow that you want
imported data to go in:

« Decide automatically—Import to SAM tables. If no
SAM tables exist, data is instead imported to CMDB
tables.

« Use CMDB tables—Import to CMDB tables.

o Use SAM tables—Import to SAM tables. If there are no
SAM tables, the import will fail.

+ Use CMDB and SAM tables—Import to CMBD tables
and SAM tables. If SAM tables do not exist, the import
will fail.

Configure the log verbosity (View the Application logs Choose the desired level of log verbosity:

at System Logs - System Log - Application logs) . Error

« Warning
« Information
« Debugging

« Tracing

Additional ServiceNow Indexes for
Performance

FlexNet Manager Suite 2022 R1 (On-Premises)

Creating additional indexes on your ServiceNow instance substantially improves the intake of data exported from
FlexNet Manager Suite.

ServiceNow enables you to create your own database indexes. A worked example suggests that, with the following
indexes added, you can expect better than four-fold performance increase in the initial data transforms to finish the
import of data that has been exported from FlexNet Manager Suite.

Database table New column indexed

Contract [ast_contract] vendor_contract

Software Model x_fls_flexera_fnms_id
[cmdb_software_product_model]

Product Model [cmdb_model] model number

Computer [cmdb_ci_computer] x_fls_flexera_fnms_computer_id
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Database table New column indexed

Software Installation [cmdb_sam_sw_install] x_fls_flexera_fnms_application_id

Removing a Legacy Integration Application

FlexNet Manager Suite 2022 R1 (On-Premises)

The integration application for ServiceNow (from version 3.0 and later of the adapter) is a scoped application. The
previous integration applications used global scope. While two integration applications can be present in ServiceNow
at the same time (with different scopes), it is recommended that you remove any previously-installed integration
application for FlexNet Manager Suite after installing the newer version and successfully running the migration script.

Note: Using the following process to remove all the components of the legacy integration application (including its
menu, tables, scripts, and user interface components). As expected, this process does not remove any records from
ServiceNow core tables.

Fi] To remove a legacy integration application:
1. In ServiceNow, navigate to System Applications > Applications, and click FlexNet Manager Suite Integration.
2. Onthe page that appears, click Delete.
A confirmation dialog appears asking you to type in the word “delete”.
3. Enterdelete in the dialog, and click Ok.

The application deletion progress dialog appears, and the integration application is deleted.

‘L Tip: Sometimes deleting the integration application fails to remove the Scheduled Jobs it created. To check, or
to delete them manually:
a. In ServiceNow, navigate to System Scheduler > Scheduled Jobs > Scheduled Jobs.
b. Filter the list of scheduled jobs to find those with Name starting with Export.
c. Ifthe following scheduled jobs exist, delete them manually:

e Export Assets from ServiceNow

e Export Contracts from ServiceNow.

Configuring the Software Asset
Management Foundation Plugin

FlexNet Manager Suite 2022 R1 (On-Premises)

When you export application data from FlexNet Manager Suite for use in ServiceNow, the export utility
fnmp_servicenow_export.exe makes use of tables that are part of a plugin for ServiceNow. The naming of this
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plugin, and your method of enabling it, have changed considerably across various releases of ServiceNow. Choose the
appropriate step below depending on your current version of ServiceNow.

=
[_] Summary of procedures across ServiceNow releases:
1. Upto and including the Helsinki release of ServiceNow, the following applies:

o Theplugin nameis Software Asset Management,anditsIDis com.snc.software_asset_management.

 This plugin has a dependency on a second one named Software Asset Management Core with the ID

com.snc.sam.core.

» Your ServiceNow administrator can make the Software Asset Management plugin Active in the System
Plugins page of your ServiceNow instance. This action automatically makes the Software Asset Management
Core plugin active as well.

2. Forthe Istanbul release of ServiceNow, the following applies:

« Ifyou had activated the Software Asset Management pluginin an earlier version of ServiceNow, and your
ServiceNow instance has now been upgraded to Istanbul, there should be no need to activate the plugin a

second time.

o The plugin feature is called "Software Asset Management Template", but still accessed through the System
Plugins page of your ServiceNow instance.

o The plugin nameis Software Asset Management,anditsIDis com.snc.software_asset_management.
o (Thereis no visible dependency on any other plugin, as had been the case for earlier releases of ServiceNow.)

» Your ServiceNow administrator can make the Software Asset Management plugin Active in the System

Plugins page of your ServiceNow instance.
3. Forthe Jakarta release of ServiceNow, the following applies:

« Ifyou had activated the Software Asset Management pluginin an earlier version of ServiceNow, and your
ServiceNow instance has now been upgraded to Jakarta, there should be no need to activate the plugin a
second time.

« Confusingly, there is a new and different plugin named Software Asset Management Premium,anditsID

is com.snc.samp. Thisis used internally by a new SAM application that is subscription based.

|_b Important: This new subscription-based application and its plugin are not relevant to the integration with
FlexNet Manager Suite, and this subscription is not required for the integration. Do not be confused by the
similarities. Be aware that, when current ServiceNow documents refer to "Software Asset Management" or
"SAM", they are generally referring to the new application and the premium plugin it uses, and this is not
relevant to your project for integration with FlexNet Manager Suite.

o The plugin from previous releases, named Software Asset Management or Software Asset
Management Template, withitsID com.snc.software_asset_management,is no longer visible in the
System Plugins page of your ServiceNow instance. However, it is still supported for the Jakarta release, and is
still required for the integration between ServiceNow and FlexNet Manager Suite.
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Tip: Some documents from ServiceNow refer to this plugin as the "Base SAM plugin" or the "old SAM
plugin', and the like. Be prepared to be precise, and refer to its ID
com.snc.software_asset_management to be sure the correct plugin is identified.

» To activate the "base SAM plugin", send a request to ServiceNow Support to activate the Software Asset

Management Template plugin with the ID com.snc.software_asset_management on your ServiceNow

instance.

4. For the Kingston release of ServiceNow, the following applies:

o For the Kingston release, do not activate the earlier plugin named Software Asset Management, with its D

com.snc.software_asset_management. This legacy plugin is only applicable to the Jakarta and earlier

releases.

« Instead, for Kingston, activate the Software Asset Management Foundation plugin, withitsID

com.snc.sams. This plugin does not require any additional licensing.

« Contact ServiceNow Support to request activation of the Software Asset Management Foundation

plugin ( com.snc.sams).

Deleting Records from ServiceNow

FlexNet Manager Suite 2022 R1 (On-Premises)

If an asset or application record exists both in FlexNet Manager Suite and ServiceNow but is then deleted in FlexNet
Manager Suite, the records are marked for deletion in ServiceNow during the next export from FlexNet Manager Suite.
However, the records are not automatically deleted. To delete the records from ServiceNow, you need to create a Global
business rule and include a script with a condition: current.state == 'Succeeded’.

e
[_] To delete records in ServiceNow using a global business rule:

1. In ServiceNow, navigate to System Definition, and click Business Rule.

The Business Rules page appears.

2. Click New.

3. Do the following.

b.

In the Name field, enter a name for the rule:

From the Table field, select x_fls_flexera_fnms_import_transaction.
Ensure that the Application field is set to Global.

Select the Active check box.

Select the Advanced check box.

On the Advanced tab, enter the following in the Condition field:
current.state == 'Succeeded'’

On the Advanced tab, enter the following into the Script field:
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var util = new FNMSUtil();
util.removeIsDeletedRecordsFromTable('cmdb_ci_computer');
util.removeIsDeletedRecordsFromTable('cmdb_software_instance');
util.removeIsDeletedRecordsFromTable('cmdb_ci_vm_instance');

util.removeIsDeletedRecordsFromTable('cmdb_sam_sw_install');

Ij Note: The last line (util.removeIsDeletedRecordsFromTable('cmdb_sam_sw_install');
should only be included if your setup is using the SAM Foundation plugin.
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ServiceNow Inventory Connector

FlexNet Manager Suite 2022 R1 (On-Premises)

Separately from the sharing of information about contracts and assets described in the previous section, it is also possible
to use ServiceNow as an inventory source, importing data to help in your software asset management and, in particular,
license consumption calculations. To do this, you need to configure an inventory connector to collect and import the
additional information.

This inventory connector is quite different and separate from the "ServiceNow Integration" discussed in ServiceNow
Integration with FlexNet Manager Suite (and its following topics). It is quite possible to run both kinds of data exchange
within the same overall implementation, but it is very helpful to keep the concepts clearly separated. The key differences

are:
Functionality SN Inventory Connector SN Integration
Data flow From ServiceNow into FlexNet Manager Suite  Bi-directional
Data type Hardware and raw software inventory o Computer, normalized application data,
and contract records into ServiceNow
» Asset and contract records into FlexNet
Manager Suite
Data app Flexera Integration, from the ServiceNow Flexera Integration, from the ServiceNow
Store (common app) Store (common app)
Data import Simple inventory connector Two business adapters are required for the
imports into FlexNet Manager Suite.
Limitations

ServiceNow is not currently strong in collecting inventory from (or, in ServiceNow terminology, "discovery of")
partitioning technologies that provide virtualization on several UNIX-like platforms. If you are supporting these platforms,
best practice is to install the FlexNet inventory agent locally on them, reporting directly to your inventory beacon(s),
thereby allowing collection of all details needed for your license consumption calculations. This additional information
integrates smoothly with the information collected from ServiceNow, with details collected by FlexNet inventory agent
taking precedence.
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Because the ServiceNow inventory connector is strictly an importer of inventory discovered by ServiceNow, it can be
conveniently implemented on an instance of ServiceNow already running the Flexera Integration application for
integration with a separate Flexera tool that exports data to ServiceNow. The limitation is that only one of these exporting
tools (IT Visibility, Data Platform, or the FlexNet Manager Suite integration for contracts and assets as described in the
previous section) may be implemented at one time on the same instance of ServiceNow. However, once you have
selected just one of these exporting tools, it can operate in parallel with the ServiceNow inventory connector described in
this section.

What you will find
This section includes the following chapters:

» ServiceNow Inventory Connector covering all prerequisites and the architecture that underlies the use of the

connector.

o Setting up ServiceNow for the Inventory Connector provides details on all the setup required on the ServiceNow side
to prepare the inventory information for collection by the inventory connector. Many of these detail are very similar to
those described for ServiceNow configuration in the previous part; and if you are configuring both kinds of integration,
you only need the ServiceNow configuration done once. Details are repeated (and fine tuned) in this section for those

choosing to implement only the inventory connector.

« Configuring the Inventory Connector on the Beacon covers the FlexNet Manager Suite side of the inventory connector.
Again, this is familiar territory for those who have set up several connectors; but details are provided here again for

those not yet practised in this area.

« Technical appendices for this section give details of the data mapping on both sides of the inventory connector.
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ServiceNow Inventory Connector

FlexNet Manager Suite 2022 R1 (On-Premises)

The ServiceNow inventory connector allows you to import into FlexNet Manager Suite inventory collected from target
devices by ServiceNow (ServiceNow refers to this process as "discovery", whereas in FlexNet Manager Suite, "discovery"
refers to just finding devices on the network, and "inventory" refers to gathering information about the software and
hardware of the discovered device). With ServiceNow as an inventory source, the imported information includes both
hardware information and raw evidence of installed applications. Once imported, the information is shown in FlexNet
Manager Suite with a source type of either ServiceNow or ServiceWatch.

This introductory chapter gives useful orientation, and includes:

e Prerequisites

e Purpose and Architecture.

Prerequisites

FlexNet Manager Suite 2022 R1 (On-Premises)

To import from the ServiceNow inventory connector, you need all of the following:

« Your on-premises implementation of FlexNet Manager Suite must be release 2019 R1 (part number 13.2.0) or later.

="

i ] Note: For releases earlier than 2020 R2, you must also receive (through your Flexera Customer Success Manager)
a file to install on your central batch server (or, in smaller implementations, whichever server is fulfilling that
function). This enhancement causes the necessary connector file to be downloaded to your inventory beacon in the
next download of beacon policy, so that the connector can be configured on the inventory beacon of your choice,
including those earlier versions.

« Aninstallation of FlexNet Beacon 13.2.0 or later (supplied with FlexNet Manager Suite 2019 R1), with good network
access to your chosen ServiceNow MID server on the one hand, and to your central application server for FlexNet
Manager Suite on the other.

¥
= Tip: It is possible to install your ServiceNow MID server on your inventory beacon, provided that there are common

communications requirements — for example, that you don't have a case where one requires a proxy server setting
for reaching remote servers that the other cannot use. (No proxy is required or possible between the inventory
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beacon and the MID server, since data exchange at this level uses a simple file share.)
The inventory beacon you choose:

o Must have PowerShell 5.1 or later running on Windows Server 2012 or later, or on Windows 7 SP1 or later.

o Must have the Microsoft Windows environment variable PSModulePath set to include the following path:

%ProgramFiles%\WindowsPowerShell\Modules

« Animplementation of ServiceNow release 5.3.316 or later - that is, one of the ServiceNow releases:

o Madrid

o New York
o Orlando
o Paris.

o At least one of the following ServiceNow plugins (enabling the collection of the raw inventory information):

o Discovery plugin - data is imported only when discovered by ServiceNow, so this one is mandatory; and it is also a
prerequisite for the following:

o SAM plugin - this plugin provides additional information in the file
flexera_software_install_export_set.csv, and without this additional plugin, that . csv file remains

empty.

 Flexera Integration application version 5.0.316 (or later) installed on ServiceNow (obtaining and installing this
application are described in Setting up the Integration Application).

Purpose and Architecture

FlexNet Manager Suite 2022 R1 (On-Premises)

The ServiceNow inventory connector lets you use ServiceNow as an inventory source for FlexNet Manager Suite. With it,
you can import raw evidence of software installations, along with hardware details of discovered devices, for use in
your central software asset management (SAM) views and license consumption calculations. The connector does not
import normalized data about what applications are installed - only the installation evidence is imported, so that, as
normal, you rely on the Application Recognition Library to map that imported evidence to individual applications.

The inventory information discovered by ServiceNow first needs to be extracted and made accessible. This is done with
the Flexera Integration app, available through the ServiceNow store (see installation and configuration instructions in
Setting up the Integration Application). The Flexera Integration app saves the data in the . csv file format on your
chosen ServiceNow MID server.

On your chosen inventory beacon, the ServiceNow inventory connector connects to the MID server and extracts the
data from the . csv files, and uploads the inventory to the central application server for FlexNet Manager Suite. Your
chosen inventory beacon may be either a free-standing server, or co-installed on your batch server (or whichever of
your central server(s) fulfils that role).
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Setting up ServiceNow for the
Inventory Connector

FlexNet Manager Suite 2022 R1 (On-Premises)

Much of the setup on the ServiceNow side is almost identical for the inventory connector as it is for the integration of
asset and contract data discussed in the previous section (ServiceNow Integration with FlexNet Manager Suite). Both
require use of the Flexera Integration application, both need a suitable account to run that app, and both require
scheduling and set-up on a ServiceNow MID server. If you are using both forms of data sharing, you may already have in
place much that is covered in this chapter; but should still cherry-pick the details you may need to adjust. For those
whose only sharing of ServiceNow data is through the inventory connector, you may find all the details in this chapter
helpful. These include:

e Setting up the Integration Application
o Creating a ServiceNow Integration User
e Setting Up a MID Server

o Scheduling Inventory Exports.

Setting up the Integration Application

FlexNet Manager Suite 2022 R1 (On-Premises)

Use this process either for a first time installation of the Flexera Integration application in ServiceNow, or to upgrade to
the latest version of that integration app.

[j] To install the integration application for ServiceNow from the ServiceNow store:
1. Loginto ServiceNow Store with ServiceNow HI credentials.
2. Inthe Search box, enter Flexera Integration and pressEnter.
Application information appears in the search results.

3. From the search results, click Flexera Integration.
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Information about the application displays.

4. Inthe right pane of the application window, view the Compatibility section to ensure that the integration
application is compatible with the version of ServiceNow that you require. If the version of ServiceNow that you
require is not listed, contact FlexNet Manager Suite Technical Support.

5. Inthe right pane of the application window, click the Get button.
A notice appears.
6. Atthe bottom of the notice, click Continue.

7. On the Purchase of Flexera Integration page, choose the Make available on specific instances radio button.
and click the Select button.

A Select Instances dialog appears.
8. Inthe Available Instances pane, double-click the instance that you want the app to be available on and click OK.
9. Select the I accept check box (to accept terms of use and subscription terms and conditions) and click Get.

10. Log into the ServiceNow instance where you made the integration application available. (You selected this
instance in step 8).

11. In the Filter navigator, enter System Applications and then under System Applications, click Applications.
The Applications list appears.

12, Click the Downloads tab.
The Downloads list appears.

13. Scroll to the Flexera Integration application, and click the Install button.

The application now appears in the ServiceNow menu, displayed in the left-hand navigation panel as Flexera
Integration. While you are logged into ServiceNow, complete the next process to set up the appropriate operating
account (if you do not already have one.)

Creating a ServiceNow Integration User

FlexNet Manager Suite 2022 R1 (On-Premises)

This simple process sets up the user account used to run the Flexera Integration app in Service Now, and assigns the
user to the appropriate role. Complete this task while you are still logged into ServiceNow as an administrator.

=
[_] To create the user account in ServiceNow:
1. In ServiceNow, go to User Administration > Users.

2. Click New, complete the properties for your new user, and click Submit.

;
= Tip: Take note of the user ID and password, which you will need again later in the set-up processes.

3. Once the creation process finishes, click the hyperlinked User ID for this user, and scroll down to Roles.

4. Click Edit, and select x_f1s_flexera_fnms.admin from the collection, and add to Roles List.
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5. Click Save.

6. Close the user properties page.

Setting Up a MID Server

FlexNet Manager Suite 2022 R1 (On-Premises)

You may already have an operational MID server (accessible from your chosen inventory beacon) that you wish to use
for inventory transfers from ServiceNow to FlexNet Manager Suite. If so, and the MID server is validated in ServiceNow,

you may skip this topic.

On the other hand, you may prefer to set up a specific MID server especially for this inventory connector. If so, follow
these steps while you are still logged into ServiceNow with administrator privileges.

=
[_] To set up a MID server that stages data from ServiceNow:
1. Inthe navigation bar, expand MID Server and click Downloads.
2. Click the link appropriate for your platform.

3. Inthe navigation bar, in the MID Server group, click Installation Instructions, and click the link appropriate to
your version of ServiceNow.

The documentation opens in a new tab.
4. Step through those instructions to complete installation of your MID server.

Take particular note of the exact name you give this MID server, as you will need it again soon. (It is also available
through MID Server > Servers.)

5. Be sure to validate your MID server (see the Validate the MID Server link on the MID Server installation page).

Scheduling Inventory Exports

FlexNet Manager Suite 2022 R1 (On-Premises)

Now that you have a MID server installed, two further configuration points for ServiceNow remain:
« Identifying the MID server as the one to use for the inventory exports to FlexNet Manager Suite
o Scheduling the exports from ServiceNow.

Continue the following while still logged into ServiceNow with administrator privileges.

L
[_] To schedule inventory exports from ServiceNow:
1. In ServiceNow, go to Flexera Integration > Integration Properties.

2. Inthe list of Integration Properties, scroll down to the MID server name field (in the ServiceNow — FNMS
section), and enter the full name of the MID server.

3. Optionally, in the Export file path field, enter an alternative file path location to store the . csv files.
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By default, the . csv files are saved in a folder called export under the installation folder of the MID server
software. You may use this folder, or another. Keep in mind that the inventory connector on the inventory beacon
must have access to this file location, in order to read the . csv files. Take note of the name used so that you can
correctly configure the connection from the inventory beacon.

4. Scroll down (if necessary), and click Save.
5. Still in ServiceNow, go to Flexera Integration > Advanced > Scheduled Data Exports.
The Scheduled Data Exports node includes standard jobs to export inventory from ServiceNow, including:
¢ Flexera Scheduled Computer Export
o Flexera Scheduled Software Export
o Flexera Scheduled Software Install Export.
Each of these jobs needs to be configured for your environment.

6. Click the first export task to schedule (such as Flexera Scheduled Computer Export).(Check the alerts bar
at the top, as you may need an additional click there to allow editing the values for your chosen export task.)

The Scheduled Data Export properties are displayed. As you consider your timing, remember that this export
forms only a part of the overall process, which also includes the inventory connection from your inventory
beacon, the following upload to the central application server, and the import in time for the nightly license
reconciliation calculations.

7. Change the value in the Run field to your desired schedule.

These data exports may be large, based on the size of your ServiceNow repository. Acommon practice would be
to choose Weekly exports.

i
= Tip: ServiceNow by default limits its exports from the database to 10,000 records. You can modify the

maximum number of records exported from ServiceNow by having your ServiceNow administrator add the
property glide.db.max_view_records and setting a new limit. For instructions on adding the property,
see http://wiki.servicenow.com/index.php?title=Adding_a_Property#gsc.tab=0.

8. Use the additional fields that appear to complete configuring your scheduled job.

For example, for Weekly exports, set the Day, and Time of day, when the export should occur. An off-peak time
is preferable.

9. Click Update to save your changes.

Repeat the scheduling for the Flexera Scheduled Software Export and Flexera Scheduled
Software Install Export tasks.

10. With all exports now scheduled, run a test of each by clicking Execute Now on the associated Scheduled Script
Execution properties page.

(This same button can be used to run the export if you chose the Run On Demand setting for the schedule.) Use
the test to assess the time taken to complete the export and finish a well-formed . csv file on the MID server, as a
check on your scheduling plans. The test also allows you to troubleshoot any problems.

11. Monitor overall progress in ServiceNow by going to Flexera Integration > Export History > Export Runs.

Inventory Adapters and Connectors Reference FlexNet Manager Suite 2022 R1 (On-Premises Edition) 417


http://wiki.servicenow.com/index.php?title=Adding_a_Property#gsc.tab=0

Setting up ServiceNow for the Inventory Connector

The State column on this view shows the progress of export, and the Stage column displays File Completion
when the . csv files are done.

12. On the MID server, check for complete . csv files.

i_] Note: If you are not using the SAM plugin with ServiceNow, the exported

flexera_software_install_export_set.csv file will be empty.

This completes the configuration of ServiceNow for data flows from ServiceNow to FlexNet Manager Suite. The final
stage is to configure FlexNet Manager Suite to import the inventory information.
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Configuring the Inventory Connector
on the Beacon

FlexNet Manager Suite 2022 R1 (On-Premises)

For those familiar with setting up inventory connections in FlexNet Beacon, the ServiceNow inventory connector is very
straightforward, since it simply imports the data already saved by ServiceNow on the MID server. For those less familiar,
the two stages are covered in this chapter:

» Choosing the appropriate schedule

» Configuring the connector.

Updating Older Inventory Beacons

FlexNet Manager Suite 2022 R1 (On-Premises)

From release 2020 R2 of FlexNet Manager Suite, inventory beacons include the ServiceNow inventory connector
configuration controls. For releases from 2019 R1 through 2020 R1, your existing inventory beacons support the
operation of the connector, but do not yet have the configuration controls in place. If you wish to continue using your
existing earlier implementation and installed inventory beacons, you can easily enhance your existing implementation
to provide the configuration controls.

The process involves a simple installation on your central batch server (or in smaller implementations where this is not
a separate server, whichever server is fulfilling that function). Thereafter the automatic process of beacon policy
distribution provides the necessary update to all your connected inventory beacons, so that you can then use the
guidance in subsequent topics to configure the inventory connector as usual.

3
[_] To update inventory beacon versions 13.2.0 through 15.0.x:

1. Contact your Flexera Customer Success Manager or Support representative, and ask for the ServiceNow inventory
connector enhancement package.

2. Use the details supplied to download the enhancement.

Notice that the download includes a file of instructions.
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Carefully follow the instructions provided to install the package on your central batch server (or functional
equivalent).

. Wait 24 hours for the automated processes to distribute the enhancement to all your connected inventory

beacons.

With your inventory beacons automatically upgraded, you can now proceed with scheduling and configuring your

ServiceNow inventory connector.

Setting the Import Schedule

FlexNet Manager Suite 2022 R1 (On-Premises)

The schedule for the inventory connector on the inventory beacon forms the 'bridge' between the completed exports
from ServiceNow on the one hand, and the nightly inventory imports and compliance (license consumption)

calculations on the other. For example:

« If you have chosen a weekly schedule for export of inventory data from ServiceNow (see Scheduling Inventory

Exports), then there is no point in scheduling anything more frequent for the import from the inventory beacon -

repetitive uploads from unchanged . csv files just create unnecessary system load.

 Ideally, if you want to see the latest inventory from ServiceNow as early as possible after it has been updated, your

inventory beacon schedule should allow for data collection, upload to the application server, and import, all prior to

the overnight license consumption calculations, so that results are ready for you next morning.

These considerations may mean that you need a custom schedule for import from the ServiceNow inventory connector.
It is convenient to have such a schedule configured before you set up the actual inventory connector, so that you can
include the schedule within its configuration (rather than revisiting later).

L
[_] To choose or configure a schedule for import:

1.

420

Run the inventory beacon interface (for example, in the Windows Start menu, search for FlexNet Beacon, right-
click it, and select Run as administrator).

-
= Tip: Remember that you must run the inventory beacon software with administrator privileges.

From the Data collection group in the navigation bar, choose Schedules.

. Review the list of available schedules (and in particular, the Summary column), to see whether you have an

existing schedule than can be re-used for the ServiceNow inventory connector, taking into account the schedule
optimizations mentions above.

« Ifso, your work here is done: skip ahead to configuring the connector itself.
« If not, continue here to create a purpose-built schedule.
Click New....

The Edit Schedule dialog appears.

. Complete the details:

a. Make the Schedule name distinct within the first few characters, such as SNInvikly.
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b. Select the radio button for the kind of schedule to align with your ServiceNow exports (such as weekly)
and set the day and time the schedule triggers the inventory connector.

Remember that this is local time on the inventory beacon. Take into account any time differences
between this local time and time on the MID server on one hand, and the central application server on
the other.

Click OK to write the schedule into the list on the Scheduling page.

The list of schedules now contains unsaved information, shown by the trailing asterisk on the Scheduling* entry
in the navigation bar. You may save now, or you can apply your newly-created schedule to the new ServiceNow
inventory connector (as follows) before saving.

Setting Connector Details, and Validation

FlexNet Manager Suite 2022 R1 (On-Premises)

Ensure that your chosen inventory beacon meets all the prerequisites listed in Prerequisites. Step through the following
process while you are still logged into FlexNet Beacon as administrator.

3
[_] To configure the ServiceNow inventory connection on the inventory beacon:

1.

In FlexNet Beacon, in the Data collection group, click Inventory systems.
The list of current connections for this inventory beacon appears.

Below the list, select the down arrow at the right of the Next... button, and from the drop-down options, choose
PowerShell.

The Create PowerShell Source Connection dialog appears.

. Create a Connection Name.

Make the name meaningful within the first few characters, as it will appear in lists with fairly narrow columns.
From the Source Type drop-down, choose ServiceNow.

On inventory beacon versions 16.0.0 and later, two additional sets of controls (for test mode, and filter for
overlapping records) appear in the lower part of the same dialog. (The proxy server settings remain disabled, as
these cannot apply for this connector.)

. Ensure that the Source Folder field contains the correct path to the folder on the MID server where the . csv files

are saved.

By default, this is the export folder under the MID server installation directory. You may have customized this
path (see Scheduling Inventory Exports). Ensure that the exact path is specified here.

. If your inventory beacon is version 16.0.0 or later, in the Overlapping Inventory Filter section, choose what

action the importer should take if inventory for the same server(s) is returned from another source as well as from
ServiceNow.

Alikely example is if you have some UNIX-like servers with a locally-installed FlexNet inventory agent returning
inventory, while the same servers are included in inventory collected by ServiceNow. Also keep in mind that
there may be large differences in the default schedules for different inventory sources: for example, FlexNet
inventory may be collected daily, and ServiceNow inventory may be imported only once every 7 days. For
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10.

reasons like these, a typical choice for the ServiceNow inventory connector is Import the inventory from this
source for possible merging, where you may also have inventory incoming from locally-installed FlexNet
inventory agents, and you have given the FlexNet Manager Suite inventory source a higher priority - this allows it
to improve the inventory gathered from partitioned technologies on UNIX-like platforms.

. When all data is complete, click Test connection.

You cannot save the connection details if the connection test fails. Either:
« If the Test connection fails and displays an error message:

a. Click OK to close the message.

b. Review and correct the connection details.

c. Retest the connection (and repeat until your changes are successful, in which case click OK and resume
from the next step).

d. If you cannot get the connection test to succeed, click Cancel to cancel the addition of these connection
details, and seek further assistance.

« If the inventory beacon can successfully access the MID server folder using the details supplied, a Test
connection succeeded message displays. Click OK to close the message, so that your new connector is

displayed in the underlying list of connectors.

. When your connection test is successful, select your new connection from the displayed list, and click Schedule...

. Inthe dialog that appears, select the name of your chosen schedule for inventory collection through this

connection, and click OK.

At the bottom of the FlexNet Beacon interface, click Save, and if you are done, also click Exit. Your work here is
done.

-
[_] To validate your configuration:

11.

12.

13.

422

Be sure to wait until after the next scheduled execution of the ServiceNow export through the Flexera

Integration application.

On the ServiceNow MID server, use the File Explorer to check the contents of the output folder (by default, the
export folder under the MID Server software installed directory, although you may have customized this

location).
You should see three . csv files (these file are not cleaned up between exports, and are over-written next time):

o flexera_computer_export.csv
o flexera_software_export.csv
o flexera_software_install_export_set.csv.

The presence of these well-formed . csv files confirms that all the configuration elements on the ServiceNow

side are correct.

After the overnight inventory import and license consumption calculations, navigate in FlexNet Manager Suite to
the All Inventory page, and apply a simple filter to the Last inventory source column, where the column contains

ServiceNow.
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The first-time appearance of even one entry with that value means that the export from ServiceNow, the
collection by the inventory connector, the upload from the inventory beacon to the application server, the
import, and the compliance calculations have all succeeded. Remember that some servers which were in fact
discovered by ServiceNow may not be visible in your filtered list - if they were also inventoried by a higher-
priority inventory source (such as a locally-installed FlexNet inventory agent), they will be listed against that
higher-priority source (and may, for example, display FlexNet Manager Suite).
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Appendices: Data Flows
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The following appendices are for those wanting a deep technical dive into the properties extracted from ServiceNow and
imported as inventory into FlexNet Manager Suite.

The Flexera Integration application (for configuration details, see Setting up the Integration Application) is scheduled to
produce three . csv files in a folder on your chosen MID server (see Setting Up a MID Server, where you may have
customized the folder, or used the default path of export under the ServiceNow MID Server installation directory).

Each of these tasks runs independently, and each is documented in a separate topic below.

I} Important: The outputs depend on which ServiceNow plugins you are using:

« Discovery plugin - data is imported only when discovered by ServiceNow, so this one is mandatory; and it is also a

prerequisite for the following:

e SAM plugin - this plugin provides additional information in the file
flexera_software_install_export_set.csv, and without this additional plugin, that . csv file remains

empty.

Itis also important to know that the connector 